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Where do | start?

Introduction

Where do | start?

Start by reading this introduction in its entirety. It contains useful general information
about the Modeller user interface and details of how the examples are formatted.

Software requirements

The examples are written for use with version 15.1 of LUSAS software products.

The LUSAS software product (and version of that product) and any product options
that are required in order to run an example will be stated in a usage box like this:

For software product(s): | All (except LT versions)
With product option(s): Nonlinear

Note that Composite examples can be run in any software product if a Composite
product option has been purchased. Similarly, LUSAS Analyst or LUSAS Composite
products can run bridge or civil examples if a Bridge or Civil product option was
purchased. The LUSAS Academic software product will run any example.

What software do | have installed?

To find out which software product(s), which version of that product, and which
software options are installed and licensed for your use run LUSAS and select Help >
About LUSAS Modeller and press the Key Information button to display a dialog
that lists the facilities and options supported by your software license.

About the examples

The examples are of varying complexity and cover different modelling and analysis
procedures using LUSAS. The first example in this manual contains detailed
information to guide you through the procedures involved in building a LUSAS model,
running an analysis and viewing the results. This fully worked example details the
contents of each dialog used and the necessary text entry and mouse clicks involved.
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The remaining examples assume that you have completed the fully worked example and
may not necessarily contain the same level of information. It will benefit you to work
through as many examples as possible, even if they have no direct bearing on your
immediate analysis interests.

Except where mentioned, all examples are written to allow modelling and analysis to be
carried out with the Teaching and Training version of LUSAS which has restrictions on
problem size. The teaching and training version limits are currently set as follows:

500 100 250 1500 10
Nodes Points Elements Degrees of Freedom Loadcases

Because of the modelling and analysis limits imposed by the Teaching and Training
Versions some examples may contain coarse mesh arrangements that do not necessarily
constitute good modelling practice. In these situations these examples should only be
used to illustrate the LUSAS modelling methods and analysis procedures involved and
should not necessarily be used as examples of how to analyse a particular type of
structure in detail.

Other worked examples

A separate worked examples manual Application Examples Manual (Bridge, Civil &
Structural) contains application-specific examples for civil, structural and bridge
enegineering.

User Manuals for optional software products and options, such as IMD Plus, or Rail
Track Analysis contain worked examples to illustrate the use of each.

Format of the examples

Headings

Each example contains some or all of the following main headings:

U Description contains a summary of the example, defining geometry, material
properties, analysis requirements and results processing requirements.

¢ Objectives states the aims of the analysis.
e Keywords contains a list of keywords as an aid to selecting the correct
examples to run.

o Associated Files contains a list of files held in the \<Lusas
Installation Folder>\Examples\Modeller directory that are associated with
the example. These files are used to re-build models if you have problems, or




| Geometry
| Point >
Coordinates...
| Geometry

Point >
Coordinates...

Format of the examples

can be used to quickly build a model to skip to a certain part of an example,
for instance, if you are only interested in the results processing stage.

O Modelling contains procedures for defining the features and attribute datasets
to prepare the LUSAS model file. Multiple model files are created in some of
the more complex examples and these therefore contain more than one
‘Modelling’ section.

O Running the Analysis contains details for running the analysis and
assistance should the analysis fails for any reason.

0 Viewing the Results contains procedures for results processing using
various methods.

Menu commands

Menu entries to be selected are shown as follows:

This implies that the Geometry menu should be selected from the menu bar, followed
by Point, followed by the Coordinates... option.

Sometimes when a menu entry is referred to in the body text of an example it is written
using a bold text style. For example the menu entry shown above would be written as
Geometry > Point > Coordinates...

Toolbar buttons

For certain commands a toolbar button will also be shown to show the ‘short-cut’
option to the same command that could be used instead:

The toolbar button for the Geometry > Point > Coordinates... command is
shown here.

User actions

Actions that you need to carry out are generally bulleted (the exception is when they are
immediately to the right of a menu command or a toolbar button) and any text that has
to be entered is written in a bold text style as follows:

e Enter coordinates of (10, 20).

So the selection of a typical menu command (or the equivalent toolbar button) and the
subsequent action to be carried out would appear as follows:

@ Enter coordinates of (10, 20).




| File
[New...
| File
| Script >
| Run Script...
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Selecting the menu commands, or the toolbar button shown will cause a dialog box to
be displayed in which the coordinates 10, 20 should be entered.

Filling-in dialogs

For filling-in dialogs a bold text style is used to indicate the text that must be entered.
Items to be selected from drop-down lists or radio buttons that need to be picked also
use a bold text style. For example:

e In the New Model dialog enter the filename as frame_2d and click the OK
button to finish.

Grey-boxed text

Grey-boxed text indicates a procedure that only needs to be performed if problems
occur with the modelling or analysis of the example. An example follows:

Rebuilding a model

@ Start a new model file. If an existing model is open Modeller will prompt for any
un-saved data to be saved before opening the new file.

e Enter the file name as example

To recreate the model, select the file example_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

Visual Basic Scripts

Each example has an associated set of LUSAS-created VBS files that are supplied on
the release Kkit. These are installed into the \<Lusas Installation
Folder>\Examples\Modeller directory. If results processing and not the actual
modelling of an example is only of interest to you the VVBS files provided will allow
you to quickly build a model for analysis. These scripts are also for use when it proves
impossible for you to correct any errors made prior to running an analysis of an
example. They allow you to re-create a model from scratch and run an analysis
successfully. For more details refer to Creating a Model From The Supplied VBS files.
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Format of the examples

Modelling Units

At the beginning of each example the modelling units used will be stated something like
this:

“Units used are N, m, kg, s, C throughout”

Model units are specified as part of the creation of a new model and are reported at all
times in the status bar at the bottom of the Modeller window. Once set, for all dialogs
with grid cells permitting dimensional input, the units expected are displayed as a
tooltip when the cursor is hovered over the input cell.

Timescale Units

Timescale units are specified as part of the creation of a new model and can be changed
on the Model Properties dialog. Choosing a timescale unit dictates how time-based
values are displayed on dialogs during modelling, and how they are output when
processing results

lcons Used

Throughout the examples, files, notes, tips and warnings icons may be found. They can
be seen in the left margin.

Files. The diskette icon is used to indicate files used or created in an example.

Note. A note is information relevant to the current topic that should be drawn to your
attention. Notes may cover useful additional information or bring out points requiring
additional care in their execution.

Tip. A tip is a useful point or technique that will help to make the software easier to
use.

Caution. A caution is used to alert you to something that could cause an inadvertent
error to be made, or a potential corruption of data, or perhaps give you results that you
would not otherwise expect. Cautions are rare, so take heed if they appear in the
example.
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Running LUSAS Modeller

Start LUSAS Modeller from the start programs menu. This differs according to the
operating system in use, but typically is done by selecting:

Start > All Programs > LUSAS 15.x for Windows > LUSAS Modeller
A licence option will need to be selected

The on-line help system will be displayed showing the latest changes to the
software.

Close the on-line Help system window.

(LUSAS Academic version only)

Select your chosen LUSAS product and click the
OK button. (2]




Creating a new model / Opening an existing

model

When running LUSAS for
the first time the LUSAS
Modeller Startup dialog will
be displayed. This dialog
allows either a new model to
be created, or an existing
model to be opened.

Note. When an existing
model is loaded a check is
made by LUSAS to see if a
results file of the same name
exists. If so, you have the
option to load the results file
on top of the opened model.

Note.

data.

If creating a new model the
New Model dialog will be
displayed.

e Enter information and
make selections for
the new model and
click the OK button.

Product specific menu entries
for the selected software
product in use e.g. Bridge or
Civil will be added to the
LUSAS Modeller menu bar.

Saving model files

xl

If an existing model is loaded, that in a previous session caused a crash to
occur in LUSAS Modeller, options are provided to help you to recover your model

New Model

File: details

File name I

Working Folder @ Default ¢ Current ¢ User-defined

Save in | CHLUSASLE0VProjects

]

i~ Model details

Title |

IN;kaQ;S;C 'l

Model units

Timescale units ISeconds 'I Job mo. I
IStru:tural Vl Wertical axis IR oy
Startup template INone 'I |

Analysis type

i~z

Cancel

o]

Help

The worked examples as written do not generally advise you where to save a model,
and by default the New Model dialog will initially save files to the <LUSAS Installation
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Folder>\Projects directory. For the purposes of carrying out the various examples of
interest this is acceptable, but note that for real ‘live’ projects it may be beneficial to
save models in separate projects folders, each named according to the individual
projects that will be undertaken. This can assist with backup and eventual deletion of
data on a project-by-project basis.

Specifying the saved location of results/intermediate files

The LUSAS Configuration Utility can be used to specify where files created in the
course of building a model are saved. See the online help pages for details of how to
access this tool. Using this facility, the location of files that are created in the course of
a building a model and running the various analyses associated with it can be specified
as bheing:

Q Within a folder for each model, within a folder called ""Associated Model
Data" This is the default setting. Note that the model file itself does not reside
within the folder created.

Q Within a folder with the same name as the model Note that the model file
itself does not reside within the folder created.

O Within the same folder as the model (This was the Version 14.7 behaviour)

U To a specified folder where the location can be defined by internal LUSAS
tokens and ordinary text. For example, the token%ModelLocn% is substituted
with the working current folder for the model; and %ModelName% is
substituted with the model's file name. Relative links (e.g. ..\ to use the parent
folder) can alternatively be specified.

For the purposes of carrying out the worked examples these settings do not need to be
changed.

Creating a Model from the Supplied VBS Files

If results processing and not the actual modelling of an example is only of interest, the
VBS files provided will allow you to quickly build a model for analysis.

Proceed as follows to create the model from the relevant VBS file supplied:

| File

New... @I Start a new model file.

e Enter the file name as example name and click OK

e In general, ensure that the User interface selected is of the same type as the analysis
to be carried out.




| File
Script >
Run Script...

The LUSAS Modeller Interface

&l Select the file example_name_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

Note. VBS scripts that create models automatically perform a File > Save menu
command as the end.

Some additional modelling may need to be carried out prior to an analysis being run.
See individual examples for details.

The LUSAS Modeller Interface

The principal regions and components of theModeller user interface are shown on the
following image and are described below.

= Toolbar buttons

Treeview

[[oadcaszs T semults fila + |

]lfum =

[Losdcase & results file d
aohE =
. v .

Far ek, Pl it LR L E ERA WA TR St ke

Main Menu and Toolbars

The main menu and associated toolbars which contain toolbar buttons provide the
means to define model related geometry and other data. On initial start-up of
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LUSAS Modeller the Main, Define and View Toolbars are displayed. All toolbars can
be shown, hidden, or customised, using the View> Toolbar menu item.

View window

A View Window is where each model is developed and manipulated. Any number of
view windows can be created with each displaying a unique view of a model. Pre-
defined view layers inside each window hold model information that can be generally
manipulated in the current view window as required.

Modelling in LUSAS

A LUSAS model is graphically represented by geometry features (points, lines,
surfaces, volumes) which are assigned attributes (mesh, geometric, material, support,
loading etc.). Geometry is defined using a whole range of tools under the Geometry
menu, or the buttons on the Toolbars. Attributes are defined from the Attributes menu.
Once defined attributes are listed in the Treeview.

Treeviews

Treeviews are used to organise various aspects of the model in graphical frames. There
are a number of Treeviews showing Groups E‘ Attributes E,‘Analyses E; Utilities

E‘ and Reports E‘

O The Layers E‘Treeview controls the display of selective model data and
results data to a view window.

U The Groups E‘Treeview is used to store selected user-defined collections of
objects (geometry, nodes or elements) under a collective name.

Q The Attributes E‘I’reeview is where defined contains information relating to
the model; the element type and discretisation on the geometry; section
properties and thicknesses; the materials used; how the model is supported or
restrained; and how the model is loaded.

U The Analyses |__|:)(LTreeview shows all analyses defined; loadcases defined
including analysis control loadcases defined during the modelling stage;
results loadcases containing solutions for results processing; loadcase
combinations and envelopes; and IMD and Fatigue calculations.

Q The Utilities E‘Treeview contains utility items used in the definition of
model geometry or attributes, or to control an analysis, or to provide a
particular functionality, such as to define a load combination or produce a
report for example.

10



The LUSAS Modeller Interface

O The Reports E‘Treeview contains a user-defined folder structure of reports,
chapter and image entries to allow a report to be generated in a variety of
formats.

Treeviews use drag and drop functionality. For example, an attribute in the Attributes
reeview can be assigned to model geometry by dragging the attribute onto an
object (or objects) currently selected in the graphics window, or by copying and pasting
an attribute onto another valid Treeview item as for instance, a group name, as held in

the Groups E‘Treeview.

Text Output Window

The Text Output Window displays messages and warnings during a modelling session.
When an error message or warning relating to a particular object is written to the text
output window, extra information is usually available by double-clicking on that line of
text.

Browse Selection

This window is not displayed by default but can be viewed using the View> Browse
Selection menu item. Once visible it will contain a list of all currently selected items
which may then be individually deselected.

Browse Cyclable Items

This window is not displayed by default but can be viewed using the View> Browse
Cyclable Items menu item. Once visible it will contain a list of all cyclable items.
These may then be individually selected or deselected.

Browse Selection Memory

This window is not displayed by default but can be viewed using the View> Selection
Memory> Browse Memory Selection menu item. Once visible it will contain a list of
all items currently in Selection Memory which may then be individually deselected.

Status Bar

The Status Bar displays progress messages and help text during a modelling session, the
model units, the current cursor position in model units (if the model is displayed in an
orthogonal plane) and the item or number of items in the current selection. The View>
Status Bar menu item may be used to hide or show the Status Bar.

Data Tips and Tooltips

Data tips and tool tips provide basic information about whatever is under the cursor.
Datatips generally report information relating to the model geometry, attributes and

11
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assignments etc. Tool tips report on uses of toolbar buttons or expected input for grid
cells etc.

Context Menus

Although commands can be accessed from the main menu, pressing the right-hand
mouse button with an object selected usually displays a context menu which provides
access to relevant operations. Treeview panels also have a context menu which provides
access to additional functionality such as editing of data, control of visibility,
visualisation of assignments, and selective control of results plotting on selected
attributes.

Properties

General information relating to a model is presented in property dialogs. Properties may
relate to the whole model or the current window, or a single geometric feature - in fact
most objects have properties. To view an object’s properties, select it, press the right
mouse button, then choose Properties from the context menu

Getting Help

LUSAS contains a comprehensive Help system. The Help consists of the following:

e The Help button @ on the Main toolbar is used to get context-sensitive help on
the LUSAS interface. Click on the Help button, then click on any toolbar button or
menu entry (even when greyed out).

e Most dialogs include a Help button which provides information on that dialog.

e Selecting Help > Help Topics from the main menu provides access to all the Help
files.

xl

If the Help Contents, the Help Index and the Search facility are not shown
when a help page is first displayed pressing the Show button will show these tabs in the
HTML Help Window.

12



Description

Linear Analysis of a
2D Frame

For software product(s):

LUSAS Civil & Structural LT and above, or
LUSAS Bridge LT and above

With product option(s):

None.

Description

A simple 2D frame is
to be analysed. The
geometry of the frame
is as shown.

All members are made
of mild steel with a
Young's modulus of
210E9 Pa, a Poisson's
Ratio of 0.3 and a mass
density of 7860 kg/m3.

The structure is

+«—20—>»«—20—>

*
1.0

1
|

%2.0%’4—2.0—»

—

77

ez

subjected to two loadcases; the self-weight of the structure, and a sway load at the top

of the left-hand column.

The units of the analysis are N, m, kg, s, C throughout.

Objectives

The required output from the analysis consists of:

U A deformed shape plot showing displacements caused by the imposed loading.
U An axial force diagram showing stresses in the members.

13
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Modelling

Linear Analysis of a 2D Frame

Keywords

2D, Frame, Beam, Standard Sections, Fleshing, Copy, Mirror, Deformed Mesh,
Axial Force Diagram, Shear Force Diagram, Bending Moment Diagram, Fibre
Results, Saved view, Report, Printing Results.

Associated Files

U frame_2d_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller
For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a New Model
e Enter the file name as

Frame 2D ~Fils dekais
- File name I Frame_20
e Use the Default Working folder & DeFauk € Current © User-defined
working folder. Savein [crsasisoipropets ]

~Model details
Title: | Sirmple: 20 Frame

Model units IN,m,kg,sJC 'I
e Set the model units to Timescale units |Second5 :I' Job no. I—

e Enter the title as
Simple 2D Frame

be N'm’kg’s’c Analysis bype IStructuraI 'I Vertical axis (o] Oy 7
e Ensure the timescale Startup templte [20 beom e
units are Seconds (e e e

e Ensure the analysis
type is Structural

e Select the startup template 2D Beam. This populates the Attributes & treeview
with useful basic line mesh and support entries.

14



| Geometry
| Point >
Coordinates...
| Geometry
Line >
Points...
| Geometry
Line >
Points....
| Geometry
Line >
Points...

Modelling

o Select the Vertical Y axis option.
o Click the OK button.

Note. Save the model regularly as the
example progresses. This allows a
previously saved model to be re-loaded if a
mistake is made that cannot be corrected
easily.

v
The Undo button ﬂ may also be used to
correct a mistake. The undo button allows

any number of actions since the last save to
be undone.

Feature Geometry

El Enter coordinates of (0, 0), (0, 3), (4,

2. Dragabox -
around these 2 1"
Points to create !

a\ertical lineon |
the centre line L _ _|

of the Frame k

1
|
|
|
|

| 1. Drag a box
I around these 2
I Points to create

(S

I

I

I

I

|

I

I

I

I | the left hand
I I column
I

L

k

3) and (4, 4) to define the main setting-out points for one-half of the portal frame. Use
the Tab key to move to the next entry field on the dialog. With all the coordinates

entered click the OK button.

Note. Sets of coordinates must be separated by commas or spaces unless the ‘Grid
Style’ method is chosen. The Tab key is used to create new entry fields. The Arrow

keys are used to move between entries.

e Select the Points on the left-hand side of the model.

il Connect the selected Points with a Line representing the left-hand column of the

portal frame.

e  Select the pairs of Points on the right hand side of the model.

il Connect the selected Points with a Line representing the right-hand vertical

member on the frame centreline.

o Create the horizontal member by selecting the appropriate Points and define a Line

in a similar manner.

e Select the Points at the top of the left hand column and the apex of the roof. (Hold
down the Shift key to add the second Point to the initial selection).

il Connect the selected Points with a Line representing the sloping member of the

frame.

15



Linear Analysis of a 2D Frame

To create the vertical roof member at quarter span the 2 Lines shown are split into equal
divisions to create the points required and the new line is then defined.

e Select the lower line (first) and the
upper line (second) of those shown
(Hold down the Shift key to add the
second Line to the initial selection).

Select these 2
Lines to he split ™~
[ |

|
| Geometry e Enter the number of divisions for —8— -
|Li|§sr—'> both Lines as 2 L— Ak
Yy plttlng >
In Equal e Ensure that Delete original lines
Divisions. .. Drag a box

after splitting is set so that the

original Lines are deleted and click around these 2

the OK button. Points
e Drag a box around the 2 Points just iy
created.
i
G . .
| eL?:;e"y > il Create the Line representing the
[Poaints... internal member.

This completes the geometry definition for the half-frame.

Model attributes now need to be defined and assigned to the model.
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| Attributes

Mesh >
Line...

Modelling

Note. LUSAS Modeller works on a define and
assign basis where attributes are first defined,
then assigned to features of the model. This can
be done either in a step-by-step fashion for each
attribute or by defining all attributes first and
then assigning all in turn to the model.

Q Attributes, once defined, are displayed in
the &b Treeview. Unassigned attributes
appear ‘greyed-out’.

O Attributes are then assigned to features by
dragging an attribute dataset from the &

Treeview onto previously selected
features.

Tip. Useful commands relating to the
manipulation of attributes can be accessed by
selecting an attribute in the & Treeview, then
clicking the right-hand mouse button to display a
shortcut menu.

Meshing

g IE & |® |2 |

-4 frame_2d.mdl =

=55 Attributes [22]

B3 Mesh (9]

Ea Line [9)
----- 1:Divisionz=1
----- Z:Divisionz=2
----- ADivigionz=3
----- 4:Divizionz=4
----- B:Divizionz=5
----- B:Divisionz=h
----- 7:Divisions=7
----- 8:Divizionz=0
----- & 9:Thick Beam
B3 Geometric [1]
=23 Surface (1]

i T:Unit Thickne
=53 Material [1)
B3 Isatropic [1]

o 1:Mild Stesl U
=53 Supports [11]

----- 1:Pirned

..... 2:Fully Fixed

The Line features are to be meshed using two-dimensional beam elements. A 2D thick
beam element is automatically provided in the & Treeview but to show the process

involved another will be defined:

e Select Thick beam, 2 dimensional, Linear elements.

e  Set the number of divisions to be 1

e Enter the attribute name as Thick Beam then click OK

o  Select the whole model. (Ctrl and A keys together).

e Drag and drop the mesh attribute Thick Beam from the & Treeview onto the

selected model Lines.

Note. When an assignment is made confirmation of the assignment is written to the

Text Output Window.
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Linear Analysis of a 2D Frame

Material Properties

| Attributes e Select material Mild Steel from
Ma'\’;lertial. - > the drop-down list, leave the Meteil [ el =]
(Matenia’ Lbrary:.. grade set as Ungraded and click |
OK to add the material attribute 28| Ungiaded B
to the c&; Treeview.
. —P i
e With the whole model selected Ympef'es »
(Ctrl and A keys together) drag SHEE RS B
and drop the material attribute Poissor's rafio | 0.300
Isol (Mild Steel Ungraded) Derei
. ensity | 7.B00E3
from the e?b Treeview onto the
SeIeCted features. Coefficent of thermal expansion I 0.011E-2
n]4 Cancel Apply | Help |

Geometric Properties

| Attributes . . .
[Geometric > The standard sections dialog will appear.

Section Library ...

e Inthe Usage section select 2D Thick Beam

e Select the library of UK Sections
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Modelling

e Select section type CEELEEIEE
Universal Beams
(BS4)

_ BT || T —
o Select section name — |wesaisemesn =

127x76x13kg UB. T
e Enter the Attribute =
name as stanchion.

e Click the Apply
button to add the

Universal Beam
attribute to the &
Treeview.

e Change the library to
EU Sections

e Change the section
type to Equal Angles
and select  the
70x70x6 EA section
name.

e Enter the Attribute
name as roof
member

e Click the OK button
to add the Equal

Angle attribute to the &b Treeview.

Note. The orientation of the section is appended to the section name which is un-
editable. Attribute names (used for identification purposes) can be appended to the
section name to make selection of similarly sized members easier.
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Linear Analysis of a 2D Frame

Assigning Geometric Properties

e Drag a box around the Lines
representing the roof members.

e Drag and drop the geometry
attribute 70x70x6 EA major y 8 o
roof member from the
Treeview onto the selected Lines.

Drag a box around these members

e Select the Line representing the
left-hand vertical member.

e Drag and drop the geometry <:| Select this Line
attribute 127x76x13kg UB major £

y stanchion from the & Treeview
onto the selected Line.

e

Geometric assignments are visualised by default.

e Click in a blank part of the Graphics Window to
deselect the members.

El Select the isometric button to see the geometric
visualisation on the members.

El The Zoom in button can be used to check the
orientations.

@l Select the Home button to return the model to the
default view.

!l Select the fleshing on/off button to turn-off the -
geometric visualisation.

Supports

LUSAS provides the more common types of support by default. These can be seen in

the &b Treeview. The structure will be supported at the end of the stanchion which is in
contact with the ground with a fully fixed support condition.

Assigning the Supports

e Select the Point at the bottom of the left-hand vertical member.
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| Geometry
Line
Copy...

Modelling

e Drag and drop the support attribute Fully Fixed from the & Treeview onto the
selected feature.

e Ensure the Assign to points and All loadcases options are selected and click OK

Mirroring the Model

One half of the 2D frame has now been generated. This half can now be copied about a
mirror plane to create the complete frame.

e  Select the whole model (Ctrl and A keys together).

M Select Mirror, select Parallel to Y axis and enter 4 in X, and 0 in Z in the top
cellsand 4 in X, and 3 in Z in the lower cells to define the mirror plane.

e Click the OK
button to create
the full model.

Note. Features that v . #
are copied retain
their attributes. This
means that there is
no need to define the
mesh, material or 3
geometric properties 1. i
for the newly created
Lines as they will
already have the
attributes from the
original half of the model assigned.

Note. In mirroring the features the Line directions will have been reversed. The
orientation of Lines is important as it controls the local beam axes directions which will
define the sign convention used to present the results.

e In the Layers Treeview double-click on Geometry to display the geometry
layer properties. Select the Line directions option and click OK

The Lines orientations are shown.
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| Geometry

Linear Analysis of a 2D Frame

| Line
| Reverse

| Attributes

| Loading....

| Attributes

| Loading...

Select the 4 Lines to
be reversed. (Hold
down the Shift key to
add lines to the initial
selection).

The selected Line _
directions  will be 4 These Line
reversed. directions need

reversing

Once the Line %t

directions are

corrected, de-select the Line directions option in the geometry layer properties and
click the OK button.

Loading

Two loadcases will be considered; self weight, and a concentrated sway load acting at
the top of the left-hand vertical member.

Loadcase 1 - Self Weight

Loadcase 1 will represent the self-weight of the structure. This is modelled using a
constant body force which is an acceleration loading simulating the force of gravity
acting upon the structure.

Select the Body Force option and click Next
Enter a linear acceleration in the Y direction of -9.81

Enter the attribute name as Self Weight and click Finish to add the attribute to the
& Treeview.

Select the whole model (Ctrl and A keys together) and drag and drop the loading
attribute Self Weight from the &b Treeview onto the selected features.

Ensure that the Assign to lines and Single loadcase options are selected and the
loading is applied to Analysis 1 and Loadcase 1. Click the OK button and the
loading on the frame will be displayed.

Loadcase 2 - Sway Load

Loadcase 2 is a sway load acting at the top of the left-hand vertical member.

Ensure the Concentrated option is selected and click Next

Enter a concentrated load in the X direction of 500
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| File

Save

Running the Analysis

e Enter the attribute name as Sway Load and click Finish

e Select the Point at the
top of the left-hand

column. /T\T\

e Drag and drop the
loading attribute Sway [s
Load from the & Select this Point to assign
Treeview onto  the the concentrated load
selected Point.

e Ensure the Assign to
points and  Single
loadcase options are
selected, and that the selected analysis is Analysis 1. Change the loadcase name to
Loadcase 2.

e Click the OK button to assign the loading as the active loadcase with a factor of 1

Saving the Model.
El Save the model file.

Running the Analysis

&

With the model loaded:

El Open the Solve Now dialog. Ensure Analysis 1 is selected and click the OK
button to perform the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (5 Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U frame_2d.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.
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| File
[New...
| File
| Script >
| Run Script...

Linear Analysis of a 2D Frame

U frame_2d.mys this is the LUSAS results file which is loaded automatically
into the ‘X! Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

0 frame_2d_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as frame_2D

e To recreate the model, select the file frame_2d_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

;l Rerun the analysis to generate the results.

Viewing the Results

Selecting the Results to be Viewed

Analysis loadcase results are present in the () Treeview. The loadcase results for the
first results loadcase (Loadcase 1) is set active by default. This is signified by the active

results bitmap & in the () Treeview.

Deformed Mesh Plot

A deformed mesh plot is normally displayed initially to highlight any obvious errors
with an analysis before progressing to more detailed results processing. The deformed

24



Viewing the Results

shape will usually show up errors in loading or supports and may also indicate incorrect
material property assignments (e.g. where the results show excessive displacements).

For clarity, the geometry will be removed from the display to leave only the
undeformed mesh displayed.

e Inthe =" Treeview turn off the display of the Geometry and Attributes layers by
right-clicking on each layer name and selecting the On/Off menu item.

e  With no features selected click the right-hand mouse button in a blank part of the
Graphics window and select the Deformed mesh option. This will add the

deformed mesh layer to the Treeview. Accept the default properties by
selecting OK

Note. By default the maximum displacement is scaled to the magnitude defined on the
deformed mesh dialog so the deformed shape can be easily visualised. The exaggeration
factor used to multiply the displacements is displayed on the deformed mesh properties
dialog and can be defined if required.

The deformed mesh plot
for loadcase 1 (the default
active loadcase) will be
displayed on top of the
mesh layer.

e Turn off the Mesh
layer from the s
Treeview to leave
only the deformed
mesh displayed as
shown.
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| Analyses
[ Basic Combination

Linear Analysis of a 2D Frame

Defining a Combination

Combinations can be created to view the combined effects of multiple loadcases on the
structure.

The combination properties dialog will appear.

Basic Combination
Available Induded Load factor I 1.0 Grid. .. |
File Imodel j 17 File 1: 1: Loadcase 1

17 File 1: 2: Loadcase 2
MName Type | Res file |
(D 1:Loadcase 1 a
Q 2iloadcase 2 0

Al | I

Mame I Combination 1

Tvpe INone j

Close Zancel Lppli Help

Both available results loadcases should be added to the Included combination panel.

e Select Loadcase 1, hold the shift key down and select Loadcase 2. Click the LI
button to add the loadcases to the load combination.

e Click the OK button to finish.

Note. The load factor may be modified by selecting the included loadcase in the right
hand list and updating the factor or by updating the factor in the grid, which is
displayed by selecting the Grid button.

Note. To obtain the correct effect from the combined loads in this example, the
Combination should only include one occurrence of each loadcase.
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Viewing the Results

Viewing a Combination

o IntheZ Treeview right-click on Post Processing > Combination 1 and select the
Set Active option.

The deformed mesh plot will show the effect of the combined loading on the structure.

Marking Peak Values

e With no features selected click the right-hand mouse button in a blank part of the

Graphics window and select the Values option to add the values layer to the
Treeview.

The values layer properties will be displayed.

e Select Displacement results from the Entity drop down list and select the resultant
displacement RSLT from the Component drop down list.

e From the Values Display tab set 100% of Maxima values to be displayed.

e Set the number of
significant figures to
4

e Click the OK button
to display  the
deformed mesh plot

showing the
displacement at each Hom ¥ 0.0
node.

Note. Because this example is written for LUSAS LT versions that only allow one
model or results viewing window to be used the Values layer is best turned off prior to
adding further layers. In Standard and Plus versions of LUSAS multiple windows each
having different layers can be defined.

e Turn off the VValues layer in the = Treeview.

Axial Force Diagram

e With no features selected click the right-hand mouse button in a blank part of the

graphics window and select Diagrams to add the diagrams layer to the
Treeview.

The diagram properties will be displayed.

e Select Force/Moment — Thick 2D Beam results of axial force Fx in the members
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Linear Analysis of a 2D Frame

e Select the Diagram Display tab and select the Label values button.
e Select the Label only if selected option.

e  Change the number of significant figures to 4

e Click the OK button to finish.

The order of the layers in the Treeview governs the order that the layers are
displayed. To see the deformed mesh on top of the diagram plot the deformed mesh
layer needs to be moved down the Treeview to a position after the diagram layer.

e Inthe Treeview select the Deformed Mesh layer, click the right-hand mouse
button and select the Move Down option.

e Now add labels

to the columns

(vertical
members). Select [
the left hand
column, hold the
Shift key and
select the right 4

hand column.

An axial force diagram for each member will be displayed with values of Fx displayed
on the selected columns.

Shear Force Diagram

e In the Treeview
double-click on the
Diagrams layer. The
diagram properties will
be displayed.

e Select Force/Moment —
Thick 2D Beam results
of shear force Fy in the
members.

e Click the OK button to display a shear force diagram of stresses in each member
with labels on the selected vertical members.
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Viewing the Results

Bending Moment Diagram

e Inthe Treeview double-click on the Diagrams layer. The diagram properties
will be displayed.

e Select
Force/Moment -
Thick 2D Beam
results of bending
moments in  the
members Mz

e Click the OK button
to display a bending
moment diagram for
each member with labels on the selected vertical members.

Viewing Results on Fleshed Members

As an alternative to plotting diagram results stresses in beams can be plotted on fleshed
members.

e  Turn off the Diagrams layer in the = Treeview.

e Clickin a blank part of the Graphics Window to deselect the members.

El Select the isometric button.

e With no features selected click the right-hand mouse button in a blank part of the

graphics window and select Contours to add the contours layer to the
Treeview.

The contour properties will be displayed.

e  Select Stress — Thick 2D Beam results of axial and moment results in the members
Sx(Fx Mz)

Initially contours will be drawn at the current active fibre location on both stanchions as
seen on the left-hand image below. Fibre locations will be explained shortly.
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Linear Analysis of a 2D Frame

ll<x

I

ll Select the fleshing on/off button to visualise the stress results on the fleshed cross-
section as seen on the right-hand image above.

Viewing Force/Moment Results at Fibre Locations

As an alternative to plotting force and moment diagrams along nodal lines they can be
also plotted at pre-defined fibre locations on members and be superimposed on other
results plots. Standard steel sections have various extreme fibre locations pre-defined.
These fibre locations can be seen by expanding the Geometric Line entry in the in the

& Treeview and can be visualised by double-clicking the Geometric Line attribute
name and selecting the Visualise button.

Diagram Stress Results at Fibre Locations

e With no features selected right-click in a blank part of the graphics window and
select Diagrams to add the diagrams layer to the =" Treeview.

The diagram properties will be displayed.
e  Select Stress - Thick 2D Beam results of stress Sx(Fx, Mz) in the beam.

e Select the Diagram Display tab and select the Label values button. Change the
angle of the text to -45 and set the number of significant figures to 4.

e Select the Scale tab and set a local scale of magnitude 12mm.

e Click OK to display the stress diagram at Fibre location I1.
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[window
| save View...

| File

Save

| utilities

Reportin
New report...

Viewing the Results

v_TA» X vl ““J

Save the view

Leave the view name as Viewl and click OK to save the view entry into the Utilities

" treeview. Note that Saved views can be applied to other views and can also be
inserted into reports. This is the purpose of saving the view in this instance.

Save the Model
El Save the model file.

Note. When the model file is saved all load combinations, envelopes, saved views and
graph datasets, if defined, are also saved and therefore do not have to be re-created
when the model and associated results file is re-opened at a later date.

Creating a Report

Specified model and results details can be exported to a variety of output formats by
using the LUSAS report facility. Reports can include model and results data, saved
views, graphs, one-click reports, screen captures, user-content and additional text. A
report template, used to specify items to be included in a report, is saved in the Report

B Treeview when a model is saved. Multiple report templates are permitted.
On the Report dialog enter a report title of 2D Frame

e Leave the modelling units and the number of significant figures set to default
values.

e Enter a report name of Report 1 and click OK.
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Linear Analysis of a 2D Frame

A report entry will be created in the Report = Treeview.

e Inthe Report B Treeview right-click on Report 1 and select Add Chapter

e  With the Model properties tab selected select the All checkbox. By default this
will add All model property data for All loadcases for the Full model.

e Select the Loadcase/Basic combination results tab and click the Add button.

e  On the Results Entity dialog select Displacement from the entity pull-down menu
and click OK. By default this will add results for the Active loadcase (in this case
for the Basic Combination) for the Full model.

e Select the Add button again, select Force/Moment — Thick 2D Beam from the
pull-down menu and click OK.

e Select the Saved views tab and check (tick) the Saved view check-box to include
the contents of View 1 in the Report. By default this will add the view contents for
the Active loadcase for the Full model.

e Click OK to finish

Note. The default order of the report items in the Treeview (and hence the order of
any items on any exported report) can be changed by dragging and dropping the report
sections as required. Right-clicking on an item gives access to additional options, such
as modifying existing data or adding more chapters.

Viewing and Exporting a Report
e Inthe Report = Treeview right-click on Report 1 and select View Report

After a short pause whilst the report is created, the first page of the report will be
displayed. The contents of the report may be browsed using the ‘page forward’ and
‘page backward’ buttons at the top of the dialog.

ﬁl Select the Export Report button.

e  On the Export dialog and from the Format: drop-down menu select Adobe
Acrobat (PDF)

e From the Destination: drop-down menu select Application to open the file with
Adobe Acrobat and click OK

e On the Export Options dialog select a page range of All and click OK

This completes the example.
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Description

Importing DXF Data

For software product(s): | All (except LT versions)
With product option(s): None.
Note: This example exceeds the limits of the LUSAS Teaching and Training Version.

Description

This example shows the steps involved in importing DXF drawing data for use in
LUSAS.
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I T T Features imported

[ l from DXF file

The initial geometry shown is equivalent to that imported from a typical CAD general
arrangement drawing.

Modelling Objectives

The operations in the creation of the model are as follows:

O Import initial Point and Line feature information from CAD drawing.
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Modelling

Importing DXF Data

U Rationalise drawing to delete unwanted information.
O Re-scale imported features to establish analysis units of length (m).

Associated Files

O slab.dxf contains the drawing information available in DXF format.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as dxf_slab

e Use the default working folder.

o Enter the title as Imported DXF file of slab
e Set model units of kN,m,t,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Set the Startup template as None

e Ensure a vertical Z axis is set and click OK.

Importing DXF Model Data

With DXF data there may be situations where the DXF drawing units need to be
converted from scaled ‘paper’ dimensions into full size model dimensions as with this
example where modelling units of metres are required. This conversion of units can be
done in two ways:
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| File

Modelling

[Import...

1. By setting a pre-translation scale before importing the data

2. By transforming the data using a scale factor after importing the data

In both cases unless the paper dimensions are already known some measurement of data
will be involved in LUSAS prior to either re-importing or scaling the data. By using the
File > Import menu item and pressing the Advanced button entities can be selected for
inclusion/exclusion from import and LUSAS modelling-related features can be
automatically tidied or merged together. This example covers the use of scaling the data
after import. Notes describing the use of a pre-translation scale are at the end of the
example.

Importing the DXF Data for Scaling

Select the DXF file slab.dxf from the \<Lusas Installation
Folder>\Examples\Modeller directory and click the Import button.

Feature Geometry

=t
ERTRNRY
I

\ |
| |
: : Delete these Features
] i i
oL A

The DXF features are imported in scaled units defined by the drawing scale. These
features will need to be scaled to suit the units of the analysis. Only the features
defining the plan view are to be used in creating the analysis model. All other features
can be deleted.

e Drag a box around the Point and Line features on the other views of the bridge. Use
the Shift key to add additional features to the initial selection.
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Importing DXF Data

| Edit
Delete
| Geometry
| Point >

Distance between
points

E Delete the selected features, confirming that the Lines and Points are to be deleted.

The remaining features will form the basis of the slab definition, but some further
manipulation is required before a finite element model can be created.

Converting Units

The imported DXF drawing units are millimetres plotted at 1:100 scale, so these will
need to be scaled by 100 to get the actual full-size dimensions of the slab in millimetres.
These dimensions in millimetres will then need to be scaled by 0.001 to convert them
into metres. To save scaling the data twice, one scale factor of (100x0.001)=0.1 can be
used to convert the feature data into metres. Before scaling the model data it is worth
checking the dimensions of the slab.

To check the existing model dimensions, 2 sample Points on the centre line of the mid-
span support can be selected in turn and their coordinates obtained. If necessary zoom
in on the model to make Point selection easier.

El Use the Zoom in button to P /$<<.<\ f—'

enlarge the view to include both
. Select this Point
ends of the centreline. \\

il Return to normal cursor
selection mode.

A% NN
Select this Point \ \\\.\.
Y ™ —G

e Select the Point on the left-hand &=

edge of the slab deck as shown ; e
in the diagram

e With the Shift key held down,
select the Point shown on the right-hand edge of the deck.

A value between the Points selected of 202.075 will be displayed in the message
window.

o
il Resize the model to fit the graphics window.

Scaling the model units

e Drag a box around the slab to select all the features. (Or press the Ctrl and A keys
together).
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| Geometry
Point >
Move...
| Geometry
| Paint >
Distance between
points
| File
Save

Modelling

H Select the Scale option and enter a Scale factor of 0.1 in the X, Y and Z fields.
Leave the origin set as 0,0,0 and click OK

The slab dimensions will be scaled accordingly.

To check the new model dimensions, The same sample Points on the centre line of the
mid-span support are to be selected and their new coordinates obtained.

El Use the Zoom in

button to enlarge the
view to include both
ends of the centreline
as before.

il Return to normal

cursor selection mode.

Select this Point

e Select the Point on Select this Point
the left-hand edge — =t
of the slab deck as * -
shown in the
diagram

o With the Shift key held down, select the Point shown on the right-hand edge of the
deck.

A value between the Points selected of 20.2075 will be displayed in the message
window.

o
il Resize the model to fit the graphics window.

Save the model

El Save the model.

This completes the conversion and preparation of the DXF data model for use in
LUSAS. From the imported data, Surfaces would be defined, a mesh assigned to the
model, and geometric properties, supports and loading added.

This completes the example.
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Importing DXF Data

[Import...

Notes on importing the DXF data using a pre-transiation
scale

As an alternative to scaling data a pre-translation scale could be used. After importing
the DXF data and checking the model dimensions in LUSAS as previously described (if
required) the DXF file can be re-imported using a pre-translation scale to convert it into
the correct dimensions for use.

On the Import dialog select the DXF file slab.dxf from the \<Lusas Installation
Folder>\Examples\Modeller directory.

e Click the Advanced button
e On the Import Parameters dialog enter a pre-translation scale of 0.1
e Click the OK button

e  Press the Import button.

This completes the example.
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Description

A

Description

Arbitrary Section
Property
Calculation and Use

For software product(s): | All (except LT versions)

With product option(s): | None.

The section properties of an
arbitrary shaped box section are | |
to be computed and saved in a
user library. Section geometry is
supplied as a DXF file.

Units of N, mm, t, s, C are used.

Objectives
The required output from the
analysis consists of:
U Section Properties of a
box section
Keywords

Section Properties, Arbitrary Section, Holes, Local Library, Server Library

Associated Files

U box_section.dxf DXEF file containing geometry of section.
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Modelling

Arbitrary Section Property Calculation and Use

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File>
New to start a new model file. Modeller will prompt for any unsaved data and display
the New Model dialog.

Creating a new model

o Enter the file name as box_section

o Use the Default working folder.

e Enter the title as Box Section

e Set model units of N,mm,t,s,C

e Leave the Timescale units as Seconds

e Ensure an Analysis type of Structural is set.
e Set the Startup template as None

e Ensure the vertical axis is set to Z

e Click the OK button.

Discussion

The arbitrary section property calculator within LUSAS Modeller computes the section
properties of any open or closed section. Cross-sections are created either as a single
regular or irregular surface, or as a group of surfaces (including holes). Fibre definitions
(positions on the cross-section at which stresses or values can be plotted when viewing
results) are also created for each drawn section at the time of section property
calculation.

Caution. 2D cross-sections for section property calculation must be defined in the
XY plane.
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Modelling

Feature Geometry

|Fi||e e Set the Files of type drop-down menu to DXF Files (*.dxf)
|Import...

e Locate the box section.dxf file in the \<Lusas Installation
Folder>\Examples\Modeller directory and click the Import button to read in the
DXF file and create the cross section geometry as shown below.

Defining holes within a section

This is done by first defining a
surface that represents the total
extent of the box-section, then
defining a surface that represents
the void or hole, and then selecting
both the surrounding and inner
surface to create the hole in the
bounding surface.

e Drag a box around the
whole model

Geomet .
| f;’;ﬂ‘;g > J Create an outer Surface from the selected Lines.
[Lines...
e Now, drag a box around the ; ———————— 4 .
only the lines defining the void. l b -
L I I ]
[ [
Geomet .
| gﬁi& > J Create an inner Surface from the [ [
Lines... selected Lines. | !

X

Box select the lines defining the woid
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| Geometry

Arbitrary Section Property Calculation and Use

| Surface
|Holes
|Create

| File

|save...

e Select the outer Surface of the box-

section followed by the inner I
Surface representing the void. (Use
the Shift key to pick the inner 1
Surface to add it to the initial k
selection) 2
Select these two surfaces
e On the Create Holes dialog, ensure the [efZiEitiEs
pptlon Delete geometry defining holes ¥ Delete geometry defining holes
is selected.

. . OK C | Hel
A new singular Surface will be created, | concat | e |

containing a void. This can be seen by
clicking inside the outer perimeter of the box section and seeing that all lines are
selected.

El Save the cross-section model for any future modifications or for use with the
definition of any additional fibre locations.

The section properties can now be calculated as follows:
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| utilities

Calculator

Section Property

>

Arbitrary

Section...

Modelling

Calculating Section Properties
Select the Add to local library option.

Click the Apply button, and after a short wait the calculated section properties will
be displayed in the grid at the top of the dialog.

Arbitrary Section Property Calculator [ %]
— Calculated Properties
Area A 1.09398... |~
Second moment of area about » axis £33 328.705...
Second moment of area about y axiz lyy 390,837,
Product moment of area Iy -140.403...
T arsional constant J 310.523...

Effective shear area in # direction

Asy 471 67E3

Effective shear area in y direction

Agy 497 B5E3

Fiadius of gyration about » axiz ks 548149
Fadiug of gyration about y axis ky R97.713
Shear centre, distance from centroid along  axis e} 0334778
Shear centre, distance from centroid along v axis yo -48.811
‘warping torsional constant Ciw 784229,
Plastic neutral axis, distance from centroid along = axis “p -0.06188...
Plastic: neutral axiz. distance from centroid along y axis wp 22172
Plastic section modulus about = axis Zps B23.264...
Plastic section modulus about v axis Zpy BFFITE. —
Plastic torgional section modulus Zpt R78.548.
Angle to principal axis [anticlockwize +ve) Theta 0o -

¥ Annotate properties ¥ Automatic meshing

V¥ Recompute section properties W Add to local library

M awimum elements/line |15 3:

[ add to server libran

Mame bow_zection

Apply I Cloze Help

Click Cancel to close the dialog.

Note. There is no need to compute the section properties in the units they are to be
used in the analysis model because units conversion is carried out when the section
properties are extracted from the section library if it is found to be required.

Note. Section properties may be added to local (user) or server (all users) section
property libraries by selecting the appropriate option(s) prior to selecting the Apply
button. Alternatively you can deselect the ‘Recompute section properties’ option after
selecting the ‘Add local library’ or ‘Add server library’ options. By default the model
name is entered as the Section Name. This can be modified if required.
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| File
New...
| Attributes
| Geometric >
| Section library...

Arbitrary Section Property Calculation and Use

Notes on the automatic meshing used

The mesh used to compute the properties of each of the surfaces (and the holes) is
displayed in the graphics window. Centroid, Shear Centre and Plastic Neutral Axis
symbols and locations are also shown.

—— Centroid A =1.09398E6
Shear Centre lxx =328 705E9

L i i lyy = 390.837E9
I Plastic Neutral Axis Ixy =-140.403E6
A J  =310.523E9
[ T 4 Asx = 471.67E3
. Asy = 497 55E3
kx = 548.149

) / | LT ky =597.713
\ J \ / xo = 0334778
\ / NI ] yo =-48.811
J \ Cw = 7.84220E15

xp =-0.0618874
yp =221.172
Zpx = 523.264E6
Zpy = 577.77T8E6
\ f Zpt = 578.548E6
b Y | { Theta= 0.0
\ 1 f xc =515.275

\ | { yc =976.138

By default an element size is selected which will assign 15 elements to the longest side
and a minimum of 2 elements is applied to the shorter sides. This mesh may be adjusted
by deselecting the automatic mesh check box and changing the mesh size in the
Treeview. Alternatively, the maximum element on the longest side may be adjusted by
changing the ‘Max elements/line’ option as required prior to selecting the Apply button.
As with all finite element models the more elements used the more accurate the results
but the slower the calculation. A good compromise of 2 elements across all thin
sections has been found to provide reasonable results without using excessive
computation time.

Viewing and using sections in the user library

Ql Create a new model called Test and select units of N,mm,t,s,C from the drop
down list provided. Click OK.

e Select User Sections from the top-right drop-down on the dialog
¢ Browse for, and select the box_section name. The basic section will be visualised.

e Select the Visualise button and the fibre definitions will be seen. Click Close
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Modelling

Usage S 100%
[0 Thick Beam (Any beam) =] | |[oser sections =l =
Definition 1
Local B 1
' From Library I J 1
Ratation about centroid |0 | © 1
s
" Enter Properties 100% % - = .
=
= 2
i
&
I A3 Ad
Value
Cross sectional area (4] 1.09338E6
[ Second moment of area about p aris (iyy] | SRR
Second moment of area about 2 axis [122) 390 837ES i
Product mament of area (iyz] 140 403E6 I
Torsional constant [] 305239
Effective shear area iny diection (Aay) 471.67E3 -
Effective shear area in 2 diection [Asz] 497.55E3 L] PR = * 0y S L= T L = T
Eccenticity in y direction [ay] oo
Eceenticity in z drection [ez) [11] Create snrotation | [ Close | e
Yisualise.. . Tapering == Section details, .
Name [ LGeot = & e
ok | conced | ppy | veln |
Visualisation of local library item Visualisation of fibre locations

Fibre locations can be used to calculate beam stress results for plotting force and
moment diagrams. LUSAS automatically creates one for every extreme point on a
section.

e On the Geometric Line dialog, select the

Enter Properties option then press the s =
Section Details button.

100%

e Select the Fibre locations tab.

e Additional fibre locations can be added b o
manually to the library item by clicking in ... s o]
the Fibre locations area and pressing the COTEED || CEa
TAB key until a new line is created, and % Zﬁ%iﬁg Jﬂﬁ%i
then entering the coordinate of the fibre H e 8

location required.

e Press OK to save changes and return to the
Geometric Line dialog. G|

45



Arbitrary Section Property Calculation and Use

Tip. If additional fibre locations are required on the section use Modeller to obtain the
properties of any additional points on the saved model and enter the point coordinates
in the manner described above. Note that if invalid coordinates are used the fibre
location will be added to the nearest point on the outer perimeter of the section.

Finally, to add the local library section to the Attributes & Treeview (for subsequent
assignment to selected lines representing beams in the model) press the OK button.

This completes the example.
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Description

Simple Building Slab
Design

For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.

With product option(s): | None.

Note: The example as written exceeds the limits of the LUSAS Teaching and
Training Version. However, by not increasing the default mesh density to 8 divisions
per line (where shown) the analysis can be run using a default of 4 divisions per line.

Description
Four panels of a concrete slab Line Support
supported by a wall, columns and a T
lift shaft are to be analysed, with Panel A Panel B
reinforcement areas computed for
bending moment only. Shear and Slab Thickness 200mm 6m

- 40 N 2
displacement checks need to be | Somoreeo Nmm

carried out separately. The geometry Columns
of the slab is as shown. [ e \K] s
| L [
The slab is subjected to self-weight Panel C Panel D
and a live load.
2nf o T~ e 6m
The units of the analysis are N, m, Supports

kg, s, C throughout.

cend

6m

Objective [
|
\

U To produce areas of
reinforcement under ultimate
loads and check crack widths under service loads

N HEEE
|
F

Keywords

Slab Design, Holes, Reinforcement, Wood-Armer, RC Design, Steel Area, Load
Combinations, Smart Combinations, SLS, ULS, Cracking
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A

Modelling

Simple Building Slab Design

Associated Files

U slab_design_modelling.vbs carries out the modelling of this example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller in
the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

o Enter the file name as Slab_Design

e Use the Default working folder.

o Enter the title as Slab Design Example

e Select model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

o Select the Startup template Standard from those available in the drop-down list.
e Ensure the Z vertical axis is selected and click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.
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Modelling

Feature Geometry

G .
| fs"u”;ZCZ > _I Enter coordinates of (0, 0), (6, 0), (6, 6) and (0, 6)
~ [Coordinates... to define the lower left-hand area of slab. Use the Tab
key to move to the next entry field. With all the
coordinates entered click the OK button to create a
surface.
Fiiy
e  Select the newly created Surface.
|G§’$‘;Z S M Copy the selected surface with an X translation
“[copy...  of6. Click the OK button to create the new Surface.
e Use Ctrl + A keys together to select the whole
model.
|G|eS°leZtCZ 3 M Copy the selected surfaces with a Y translation of
“ICopy... 6. Click the OK button to define two new Surfaces.
o
Defining a Hole in a Slab i
Next, a hole representing the lift shaft needs to be defined. This is done by first creating
a surface representing the extent of the lift shaft and then selecting both the surrounding
and inner surface to define the hole.
G .
| B ~ 5] Enter coordinates of 2, 2), (4, 2), (4, 4) and (2,
Coordinates... 4) and click OK to define the extent of the hole.
o Select the lower left Surface and then the Surface
representing the lift shaft. (Use the Shift key to
pick the second Surface to add to the selection)
| Geometry e Ensure Delete geometry defining holes is
|Su:|fa|ce > selected A new singular Surface will be created. 5
oles >
(Ceate  This new surface containing the hole can be seen / =

checked by clicking in a blank part of the Graphics Window and then re-selecting the
lower-left hand surface.
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| File

Model Properties...

| Attributes

Mesh >
Surface...

| Attributes

Geometric >
Surface...

Simple Building Slab Design

Note. It is normally good practice to ensure that the orientation of surface axes (and
hence mesh element orientation) is consistent throughout the model. However, plate
elements, as used in this example, produce results based upon global axes and as such
ignore inconsistent element axes.

Meshing

By default lines normally have 4 mesh divisions per line. If you are using the Teaching
and Training version this default value should be left unaltered to create a surface
element mesh within the limit available. This will give a coarser mesh and
correspondingly less accurate results will be obtained. Otherwise, for this example, and
to give greater accuracy, 8 divisions per line will be used.

e Select the Meshing tab and set the default number of divisions to 8 and click the
OK button.

e Select the element type as Thick Plate, the element shape as Triangle and the
interpolation order as Quadratic. Select an Irregular mesh and ensure the
Element size is deselected. This forces the number of default line mesh divisions
to be used when meshing the surfaces. Enter the attribute name as Thick Plate and
click the OK button.

e With the whole model selected drag and drop

the mesh attribute Thick Plate from the &
Treeview onto the selected Surfaces =

In the vicinity of the lift core less elements are
required.

e Select the 4 lines defining the lift core and drag
and drop the line mesh attribute Divisions=4

from the & Treeview onto the selected Lines. 1

In this manner the mesh density on slabs can be o
varied according to the levels of detail required.

Geometric Properties

e Enter a thickness of 0.2. Enter the attribute name as Thickness 200mm and click
the OK button.

e With the whole model selected drag and drop the geometric attribute Thickness
200mm from the & Treeview onto the selected Surfaces.

Geometric properties are visualised by default.
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Modelling

¢ Inthe = Treeview drag and re-order the layers so that the Attributes layer is at the
top, the Mesh layer is in the middle, and the Geometry layer is at the bottom.

!l Select the fleshing on/off button to turn-off the geometric visualisation.

Material Properties

| Attributes .
| Material >
| Material Library...

Select material Concrete EU from the from drop-down list, select grade EN1992-

1-1 Table 3.1 fck=40MPa and click OK to add the material attribute to the &
Treeview.

e Select the whole model and drag and drop the material attribute 1sol (EN1992-1-1
Table 3.1 fck=40MPa) from the &b Treeview onto the selected Surfaces.

Supports

For clarity the mesh layer is not shown on these

diagrams. Select these
Points and

assign Fixed in Z

VIR
4

F—Ef

e Select the 6 points where the columns are
located.

e Assign the supports by dragging and dropping
the support attribute Fixed in Z from the
Treeview and assign to All analysis loadcases
by clicking the OK button.

N

e Select the 2 Lines representing the line support
and drag and drop the support attribute Fixed in

I

Select these 2

Z from the &% Treeview and assign to All
analysis loadcases by clicking the OK button.

Select only the top, bottom, and left-hand lines
defining the lift shaft and drag and drop the
support attribute Fixed in Z from the
Treeview and assign to All loadcases by clicking
the OK button.

Lines and assign
Fixed in Z

¥
w

Select these 3

] Lines and assign
] Fixed in Z
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| Attributes

Loading...

| Attributes

Loading...

Simple Building Slab Design

@l Select the isometric view i
button to check that all supports '
have been assigned correctly.

£ Wi Click this part of the

status bar to view the model from
the Z direction again.

Loading

Now the dead and live loading needs to be "
assigned to each slab panel of the building. This
is done using separate load cases so that the
loadcases can be combined to determine the
most adverse effects.

Select Body Force and click Next.

Enter an acceleration of -9.81 in the Z direction.

Enter an attribute name of Self Weight and click the Finish button.
Select the Global Distributed radio button.

Select the per unit Area option.

Enter -5000 in the Z Direction.

Enter the attribute name as Imposed Load 5kN/m2 and click the Finish button.

Firstly, right click on Analysis 1 > %
Loadcase 1 in the (X! Treeview, select the
Rename option and change the first
loadcase name to Panel A Permanent

Select the surface representing the top left-
hand panel (Panel A). =

Assign the dead loading by dragging and dropping the attribute Self Weight from
the &b Treeview onto the selection. The loading assignment dialog will be
displayed. Select the Single Loadcase option, the analysis Analysis 1 and loadcase
Panel A Permanent, then click the OK button.
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Modelling

Note. The loading assigned to each panel will be visualised as each loadcase is
assigned to the model

The (&' Treeview should now contain 8 !
loadcases consisting of a Permanent and
Variable loadcase for each panel.

Drag and drop the dataset Imposed Load 5kN/m2 from the & Treeview onto the
selection and change the loadcase name to Panel A Variable and click the OK
button.

Select the top right-hand panel (Panel B).

Assign the dead loading by dragging and dropping the attribute Self Weight from

the &b Treeview onto the selection. Change the loadcase name to Panel B
Permanent Leave the load factor as 1 and click the OK button.

Drag and drop the attribute Imposed Load 5kN/m2 from the & Treeview onto the
selection and change the loadcase name to Panel B Variable and click the OK
button.

Select the bottom-left panel (Panel C).

Assign the dead loading by dragging and dropping the attribute Self Weight from

the & Treeview onto the selection. Change the loadcase name to Panel C
Permanent and click the OK button.

Drag and drop the attribute Imposed Load 5kN/m2 from the & Treeview onto the
selection. Change the loadcase name to Panel C Variable and click the OK
button.

Select the bottom right-hand panel (Panel D).

Assign the dead loading by dragging and dropping the attribute Self Weight from

the &b Treeview onto the selection. Change the loadcase name to Panel D
Permanent and click the OK button.

Drag and drop the attribute Imposed Load
5kN/m2 from the &% Treeview onto the
selection. Change the loadcase name to F
Panel D Variable and click the OK
button.

= =
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| File

Simple Building Slab Design

| Save

Saving the model

El Save the model file.

Running the Analysis

A

With the model loaded:

El Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the @ Treeview
Addition files will be created in the directory where the model file resides, including:

U slab_design.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U slab_design.mys this is the LUSAS results file which is loaded automatically
into the ‘X! Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O slab_design_modelling.vbs carries out the modelling of the example.
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| File

New...

| File
Script >
Run Script...

Viewing the Results

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as slab_design
e To recreate the model, select the file slab_design_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

=
;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the @ Treeview, and load case results for the
last solved loadcase are set to be active by default.

(] TU m Off the Analysis: Analysis 1
Loadcase: 1:Panel A Permanent

Attributes layer N reus e s desoranayestms

the Treeview. E::nwpu:‘::qejn’:;g"cﬁnzlﬁ 5.‘?"‘3
. -13.5665E3
e In the Treeview Sosetees
. . -9.04436E3
right-click on results TS
loadcase Panel A 4 oazieE
Permanent and . aoTesEs
choose Set active e 13550503 at o 762

e With no features
selected, click the
right-hand mouse
button in a blank part
of the active window and select the Contours option to add the contours layer to

the & Treeview.

e Select entity Force/Moment - Thick Plate and results component MX(B) to see
the results for Permanent effects in Panel A.

Defining a Load Combination

The loadcases will be combined to provide the most adverse loading effects. This is
achieved using the smart load combination facility within LUSAS Modeller. For
Ultimate Limit State (ULS) design EN1990:2002 requires permanent actions to be
factored by 1.35 where unfavourable and 1.0 where favourable. Unfavourable variable
actions are factored by 1.5 and omitted where favourable. (These factors may be subject
to national variation)
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| Analyses

Smart

Combination...

Simple Building Slab Design

For permanent actions this is equivalent to a Permanent load factor of 1.0 and a
Variable load factor of 0.35 since 1.0 will always be applied and 0.35 will only be
applied if it creates an unfavourable effect.

For variable actions this is equivalent to a Permanent load factor of 0.0 and a
Variable load factor of 1.5 since the loading will only be applied if it creates an

unfavourable effect.

Note. Permanent load factor and Variable load factor refer to the LUSAS Smart
Combination definitions rather than the EN1990 definitions.

Creates a smart combination in the @ Treeview.

e Include all loadcases in the smart combination. To do this select the first load case
in the loadcase selector at the bottom-left of the then hold the Shift key down and

scroll down the list and select the last loadcase.

e Click the LI button to add these loadcases to the included list.

e Select the Grid button and set the permanent and variable factors as shown in bold

text in the table that follows:

Name Permanent Variable

Factor Factor

Panel A Permanent 1.0 0.35
Panel A Variable 0 1.5

Panel B Permanent 1.0 0.35
Panel B Variable 0 1.5

Panel C Permanent 1.0 0.35
Panel C Variable 0 1.5

Panel D Permanent 1.0 0.35
Panel D Variable 0 1.5

e Click the OK button to return to the combination properties

e  Change the smart combination name to ULS

e Click the OK button to complete the definition of the smart combination
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Viewing the Results

The maximum combination will produce the most adverse hogging moments whilst the
minimum combination will produce the most adverse sagging moments.

Note. When the properties of the max combination are modified the corresponding
min combination is updated automatically.

e Select ULS (Min)  commnoen w)

ULS (Min)

from the @ Treeview Entity: Force/Moment - Thick Plate

. . Component: MX(B) (Units: N.m/m)
with the right-hand i
mouse button and S1arees

ple the Set Active | “ense

-38.3361E3

-69.005E3

option. oo
-15.3344E3 "
. . -7.86722E3
e Select entity o moosnee s
FOrCe/MOment _ Minimum -69.005E3 at node 45

Thick Plate and
results component
MX(B) to combine,
applying the variable
factors based on the
bottom Wood Armer moments in the X direction and click the OK button.

Using the RC Slab Design facility

The RC Slab design facility enables calculation of required steel reinforcement areas
for ULS loadcases and calculation of crack widths for SLS loadcases. ULS
reinforcement design is based on calculated Wood-Armer moments whereas crack
width calculations are based on principal moments. The effective depth is computed
from the top and bottom reinforcement bar sizes and covers provided.

Caution. This example uses an irregular mesh of thick plate elements and for these
elements the results are output in global directions that, in this case, match the intended
reinforcement directions. In other modelling situations, if the elements in a model are
orientated such that their local axes vary from one another, or if an alternative
coordinate system is required, the results will need to be transformed to a consistent
direction. This can be achieved by either setting a local coordinate set or choosing an
appropriate results transformation option on a results layer property dialog prior to
opening the RC Slab Designer.
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Simple Building Slab Design

| Bridge e Ensure that United Kingdom == E B
: Design code
RC Slab Des'gn--- and BS EN 1992'1' Country [united Kingdom |
1:2000/NA:2005 are selected Desineode  [oEN T2 200 A0 =
from the dropdown list of r‘abm |
. - & From geor € Constant [250.0 mm
countries and design codes e —— i
A ’7 & ULS reinforcement design ~ SLSerack checking |
e Ensure slab depth is from ——
model geometry Characteristic yield strength of reinforcement (fyk) 00 mPs
Material factor for reinforcing steel (vs) [5
e Ensure that the option for ULS et o e o e
reinforcement  design  is Mo T -
selected Coefficient for long term and unfavorable effects (Acc) Jogs
Defaults < Back | Frsh | Cancel | Hep |

e Change the Characteristic yield
strength of the reinforcement to 460 and ensure the Characteristic cylinder strength
of concrete is 40

e Click Next to proceed to the RC Slab Design Reinforcement Details page.

RC Slab Design: Reinforcement Details x|
—Slab details —Rei layout
Tep T
Bar size Spacing (mm) :,"’ é “\KTOP layer 1
Bars in x ILa'yer1 j |1Z'|1m j I15’Dﬂ [:: ” o ‘,"'\
R

Bars i 2 1Zom x| [1500 L '
rsiny  [Layer [1zom [~ | - V Py
. - !
—Bottom reinf | Tﬁ:zp layer 2

Bar size Spacing (mm)
Barsinx |[Layer1 =] [12om =] [1500

Barsiny |layer2 [12om = [1500
—Cover ?:r\s( el Bottom layer 2
Top IZDD mm  Bottom IZD.D mm ! // ‘ ]
Skew angle of bars in y from x IE’DD deg L:w : "

Bars - ,,"'.Bottom layer 1

N Sy

Defaults < Back we>  |[[TFimsh ] cancel Help
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Viewing the Results

Enter the
reinforcement
details as shown on
the previous dialog
image.

Click Finish to
calculate the
reinforcement
requirements.

This will close the RC
Slab Designer dialog and
plot contours of required
bottom steel area in the X
direction based on the

active

Loadcase  (or

combination/envelope).

Combining on: MX(B)
ULS (Min)

Entity: RC Slab Design

Compenent: Steel Area (Units: mm#/m)

00
114,541
229.081
343822
458.162
972703
687.244
801784
916.325

Maximum 1.03087E3 at node 43 of element 7
Minimum 0.0 at node 18 of element 6

RC Slab Design to BS EN 1992-1-1:2004/NA: 2005

Calculation based on MX(B), rebar skew angle=80"

Slab depth from geometry

Charactenstic concrete cylinder strength =40.0N/mm?*

Charactenstic steel strength =460.0N/mm*

Top: cover=20.0mm, bar diameter in x =12.0mm, bar diameterin y =12.0mm
Bottom: cover=20.0mm, bar diameter in x =12.0mm, bar diameter in y =12.0mm

A floating toolbox is provided to enable results for all four layers of reinforcement to be
viewed without having to return to the slab designer dialog.

Plotting the contours of Utilisation displays the ratio of the applied moment to the
calculated moment capacity and provides a rapid check on the proposed reinforcement
arrangement.

To calculate results for the bottom steel in the Y direction
the primary Component currently in use must be changed:

Select ULS (Min) from the () Treeview with the right-
hand mouse button and pick the Set Active option.

Select Force/Moment — Thick Plate and MY(B) from
the drop-down lists to combine applying the variable
factors based on the Wood-Armer moments in the Y
direction and click the OK button.

If not turned-off, a message will be issued to warn that the
Component specified in the RC Slab Design Control dialog
is not consistent with the Component specified by the
Active loadcase.

Click OK to dismiss the warning message. The Slab

Designer will automatically recalculate for the new primary results Component
chosen [MY(B)], however the calculations will be based on MX(B) as shown in the

toolbox.

—ULS calculations

Bar sizes

Component II'v'Ix[B} "I

Steel areas

Tension control

Utilization

[ RC Slab Design

Close

Help
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Simple Building Slab Design

e Change the RC Slab Design Control Component to be MY (B). The Slab Designer
will recalculate the appropriate steel areas in the Y direction.

Note. The reinforcement design can be viewed in terms of required area, bar size and
utilisation by selecting the appropriate button in the toolbox.

Caution. The ULS design of reinforcement assumes that the slab is “under-
reinforced” and therefore the calculations are only valid when this holds true. The
contour plot “Tension Control” indicates whether the slab will undergo ductile failure
and is hence “under-reinforced.” Plots of Tension Control must therefore be checked to
ensure a valid design. For more information see the online help entry.

‘Combining on: MY (B)
ULS iMin)
Entity: RC Slab Design

Component: Steel Area (Units: mm?/im)
0o
120.74
241.481

362221
482962
603.702
724442
845183
965923

Maximum 1.08686E3 at node 90 of element 26
Minimum 0.0 at node 18 of element &

RC Slab Design to BS EN 1992-1-1:2004/NA 2005
‘Calculation based on MY(B), rebar skew angle=30°
Slab depth from geometry

‘Characteristic concrete cylinder strength =40.0N/mm?
Characternistic stee! strength =460.0N'mm?*

Top: cover=20.0mm, bar diameter in x =12.0mm, bar diameter in y =12.0mm
Bottom: cover=20.0mm, bar diameter in x =12.0mm, bar diameterin y =12.0mm

e The previous processes can also be repeated to plot contours of required top steel
reinforcement using the ULS (Max) combination for most adverse hogging
moments MX(T) and MY(T)

Concrete crack checking

The calculation of crack widths in the RC Slab Design facility is based on principal
moments rather than Wood-Armer moments used in reinforcement design. Effective
steel areas are interpolated based on the orientation of the principal moments with
respect to the steel directions. Extensive coverage of the crack calculation procedure is
provided in the help manual.

Crack widths will be calculated based on service loads and hence a new combination is
required.

e Click the Close button on the Slab Designer toolbox to clear the current
reinforcement results.
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Viewing the Results

| Analyses Creates a smart combination in the @ Treeview.

Smart
Combination...

e Include all the results loadcases (but not the two ULS combinations) in the Smart

combination. To do this select the first load case in the loadcase selector at the
bottom-left of the then hold the Shift key down and scroll down the list and select

the last loadcase.

e Click the il button to add these loadcases to the included list.

e By pressing the Grid button the load factors can be entered as follows

Name Permanent Variable
Factor Factor
Panel A Permanent 1.0 0
Panel A Variable 0 1.0
Panel B Permanent 1.0 0
Panel B Variable 0 1.0
Panel C Permanent 1.0 0
Panel C Variable 0 1.0
Panel D Permanent 1.0 0
Panel D Variable 0 1.0

e Click the OK button to return to the combination properties

e Change the smart combination name to SLS

e Click the OK button to complete the definition of the smart combination

e Select SLS (Min) from the (X Treeview with the right-hand mouse button pick the
Set Active option and set the Component of interest to MMin.

| Bridge This restarts the RC Slab Designer.
[RC Siab Design...

e On the main page change the design calculation option to SLS crack checking

e Press the Next button to navigate to the reinforcement details (for which the
previously entered values remain set as for the ULS design), and on this dialog
press Next again to access the crack width settings.




Simple Building Slab Design

e Enter / check the crack width settings as shown on the dialog.

RC Slab Design: Crack Width Settings x|
—C: ion properties Elastic moduli
Top (mm)  Bottom (mm) % Use code defined valves —————————————
Cover for crack spacing  |20.0 20.0 Creep coefficient (Phi) IZZ—
Allowzable crack width (mm) 0.3 ATTEERITE lm
~Tension stiffening e
© Include  Ignore & Interpolate Short term modulus of concrete GPa |35 0
— Effective elastic modulus for concrete —————————1 Long term modulus of concrete GPa 1.0
% Quasi-permanent
" Interpolated, based on proportion o SRS
Variable effects - Total effects (%) 500 Coefficient for load duration (Ki) 04
Permanent effects: Total effects (%] [20.0 B R e Y 08
Ci for strain distribution (K2) 0.5

" Interpolated, based on calculated proportion

o Coefficient for cover influence (K2)
Permanent effects from loadcase or combination

| =] @ J2 &) Jo.0 @© [o0

The variable moments are taken from the curmrently Coefficient for bar diameter (K2) 0.425
active loadcase. Crack widths are based on the

summed moments from the designated (permanent)
and active (varizble) loadcases

Defaults <Back | meds | Finish |[FTConee ] hep |

e Click the Finish button to plot contours of crack widths for the face of the slab
stated in the RC Slab Design Control.

e Click OK to ignore the message relating to “A maximum steel stress has been
calculated that has exceeded the service limits”.

Note. The maximum steel stress reported can be in either the top or bottom face of the
/ slab. In this case the high steel stress arises from hogging over the central support.

e Crack widths to the top and bottom faces of the slab can be viewed by changing the
Slab Face location to either Top, or Bottom in the RC Slab Control dialog.
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Viewing the Results

Combining en: MMin
SLS (Min)

Entity: RC Slab Design

Component: Max bottom face crack widths (Units: mm)

0.0
0.0508365
0.101673
015251
0203346
0.254183
0.305019
0.355856
0.406692

Maximum 0.457529 at node 78 of element 7
Minimum 0.0 at node 18 of element 6

RC Slab Design to BS EN 1892-1-1:2004/NA 2005
Calculation based on principal moments, rebar skew angle=90°

Slab depth from geometry

Charactenistic concrete cylinder strength =40 0N/mm*

c ic steel strength .

Effecti rete modulus=11.3

Top: cover=20.0mm, bar diameter in x =12.0mm, bar diameterin y =12.0mm
Bottom: cover=20.0mm, bar diameter in x=12.0mm, bar diameteriny =12.0mm

Note. The crack checking calculations are based on strains calculated from an
interpolated effective area of steel. However the actual crack width is calculated taking
the bar spacing and bar diameter of the layer orientated closest to the principal moment
in question. Contour plots for crack widths “controlled” by each reinforcement layer are
provided to identify exactly which bars are controlling the cracks. By default the
maximum crack width is displayed.

e To determine the extent of any excessive cracking press the Pass/Fail button on the
RC Slab Design Control to show a two-tone contour plot of crack width below and
above the acceptable limit.

Combining on: MMin
SLS (Min)

Entity: RG Slab Design

Component: Max botiom face crack widths (Units: mm)
Contours indicate passifail for allowable crack width

03

Maximum 0 457 529 at node 78 of element 7
Minimum 0.0 at node 18 of element 6

RC Siab Design to BS EN 1992-1-1:2004/NA:2005
Calculation based on principal moments, rebar skew angle=90"
Slab depth from geometry

cf cylinder streng

Charactenstic steel strength =460.0N/mm?*

Effective conerete modulus=11.3789N/mm*

Top: cover=20.0mm, bar diameter in x =12.0mm, bar diameterin y =12.0mm
Boltom: cover=20.0mm, bar diameter in x =12.0mm, bar diameteriny =12.0mm

In this instance excessive cracking in the bottom face of the slab is localised and local
increases in reinforcement may be sufficient to prevent the cracks. In this example the
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| File

Save

Simple Building Slab Design

reinforcement density will be increased in the bottom only initially to prevent any
excessive cracking.

o First, press the RC Slab Design button on the RC Slab Design Control.
e On the Design Code Settings dialog, press the Next button

e On the Reinforcement Details page increase the bottom reinforcement to be 16mm
in both X and Y directions. Click Next

e On the Crack Width Settings page click Finish to view the updated results.

e Click OK to ignore the message relating to “Maximum steel stress exceeded”. This
steel stress has not changed because it relates to top steel in hogging over the central
support.

The extent of the cracking in the bottom face is now within acceptable limits.
Investigation of cracking in the top face would be carried out in a similar manner with
the combination set for MMax to maximise hogging moments.

Note. The crack checks are based on an interpolated concrete modulus allowing for
time-dependant effects. The interpolated value is displayed in the on screen output. For
complicated models featuring multiple materials, it may therefore be necessary to
reanalyse the model with the interpolated concrete stiffness to more precisely calculate
the loading effects.

e Click Close in the RC Slab Designer Control dialog to remove all Slab Designer
results.

Note. The Contour layer entity setting is reset to None whenever the RC Slab
Designer is closed.

Save the model

El Save the model file.

Note. All the Slab Designer inputs are saved to the model and will be saved when the
model is saved. All load combinations, envelopes, and graph datasets, if defined when
processing results, are also saved and therefore do not have to be re-created if the
model is amended and a re-analysis is done at a later date.

This completes the example.
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Discussion

Discussion

Element types and orientation of results

This example demonstrates the use of the RC Slab designer for a model that uses an
irregular mesh of thick plate elements. Within the slab the reinforcement will generally
be orthogonal for the layout demonstrated and for thick plate elements the results are
output in global directions, so there is no conflict. If, in a real-life example, shell
elements were inadvertently used for a model such as this, the use of an irregular mesh
would mean that the results used for the Wood-Armer / slab calculations would have
different orientations over the whole slab and hence be incorrect. In this circumstance a
local coordinate set would need to be used to orientate the shell element results to be
consistent with the global axes in order to obtain sensible components for use in the
calculations.

The following result contours shows the difference between results from global (left)
and local (right) axes for the ULS(Max) MX(B) plot.

Global Axes Local Axes

e The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

e Results transformations can be applied using the Transformed... button on a results
layer’s Properties dialog. Selecting Global axes will transform local element results
into the global axes system. Other options are available..

e Global results are indicated by the uppercase X, Y and Z in the component names,
whereas lowercase X, y and z (when seen) are used to denote local results or
transformed results.
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default mesh density of 4 divisions per line a reduced accuracy of results will have been
obtained. The following graph for ULS(Min) shows how Bending Moment (MX) along
a horizontal 2D slice section through the central three columns typically varies with the

If the Evaluation Version of LUSAS was used to carry out this example with a reduced
number of line mesh divisions used.

Element density and results obtained

Simple Building Slab Design
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M /8 Divisions -8
In general, more accurate results are obtained when using more line mesh divisions and

hence more elements when modelling slabs of this type. Care should always be taken to
use an appropriate number of elements together with a possible refinement of the mesh

in areas of interest in order to obtain the best results.




Description

Linear Analysis of a
Post Tensioned
Bridge

For software product(s):

LUSAS Civil & Structural or LUSAS Bridge

With product option(s): | None.

Description
A 3-span concrete y y =0.2 - 0.163(x-19) + 0.0136(x-1%)
post ) tensioned T y = 0.2 +0.163(x-13) - 0.02717(x-1F |
bridge is to be
analysed. The

bridge is idealised
as a 1 metre deep
beam with a tendon
profile as shown in
the half model of the
bridge.

The initial  post
tensioning force of
5000 kN is to be

by
y =-0.1322x + 0.01135x m \
\ X el X

W tangent points

6.5

y

AN
s

6.5 2 4 6

A

15 10

Abutment

Column

Half-model of bridge

(Notto scale)

applied from both ends. Tendons with a cross section area of 3.5e3mm? are located
every 2 metres across the section allowing the analysis to model a 2 metres effective

width.

Three loadcases are to be considered; self-weight, short term losses, and long term

losses.

Units of kN, m, t, s, C are used throughout the analysis. Note that tendon cross-sectional

area is specified in mm?.
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A

Modelling

Linear Analysis of a Post Tensioned Bridge

Objectives

The required output from the analysis consists of:

U The maximum and minimum long and short term stress in the concrete due to
post tensioning.

Keywords
2D, Beam, Prestress, Post tensioning, Beam Stress recovery.

Associated Files

U post_ten_modelling.vbs carries out the modelling of the example up
until the point of defining the prestress. carries out the modelling of the structure
up to the section titled Defining Prestress with Short Term Losses. After
running the script continue from that point in the example.

O post_ten_profile.csv carries out the definition of the tendon.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as post_ten

e Use the Default working folder.

e Enter the title as Post-tensioning of a bridge
e Select model units of kN,m,t,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the startup template Standard
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| Geometry
Line >
| Coordinates...

| Geometry

Group >

[ New Group...

Model Properties. ..

Modelling

e Select the Vertical Y axis option.

e Click the OK button.

Note. Save the model regularly as the example progresses. This allows a previously
saved model to be re-loaded if a mistake is made that cannot be corrected easily.

llt] .
Note also that the Undo button ﬂ may also be used to correct a mistake. The undo
button allows any number of actions since the last save to be undone

Feature Geometry
il Enter coordinates of (0, 0), (15, 0) and (25, 0) to define two Lines representing

half the bridge. Use the Tab key to move to the next entry field on the dialog. Click the
OK button

Y
Ibt‘: *

o Select all the visible Points and Lines using the Ctrl and A keys together.

-

To make the manipulation of the model easier create a group of the bridge
e Enter the group name as Bridge

e Inthe Treeview select the group Bridge with the right-hand mouse button and
select the Invisible option to hide these features from the display.

Defining the tendon profile

When using the Prestress utility the tendon geometry is determined from a Line
definition which, in practice, is usually a spline curve. The geometry of the tendon may
be input into the model directly by manually entering the coordinates, or, as in this
example, by copying values from a comma separated file (.csv) which has been opened
in a spreadsheet application and pasting these values into the Point coordinates dialog
in Modeller. This is done using standard Ctrl + C and Ctrl + V keys.

Note. To prevent the point representing the left-hand end of the bridge and the end
point of the tendon profile from becoming stored as just a single point in the model the
geometry should be made unmergable.

e On the Geometry tab select the New geometry unmergable option and click OK
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| Geometry >

Linear Analysis of a Post Tensioned Bridge

[Paint >
| Coordinates. ..

| File
| Model Properties...

| Geometry
| Line >

Spline >

| By Points...

e Read the file
\<LUSAS Installation Folder>\Examples\Modeller\post_ten_profile.csv into a
spreadsheet.

¢ In the spreadsheet, select the top left-hand corner of the spreadsheet grid to select all
the cells and press the Ctrl + C keys together to copy the data.

e Select the 3 Columns option to show X, Y

and Z columns. |

Grid style
| v

e Select the top left-hand corner of the Enter
Coordinates dialog and press the Ctrl + V X ¥ £
keys together to paste the coordinates
defining the tendon profile into the table.
Note that the use of ‘Paste’ using a mouse
button is not enabled. Click OK.

Click here to select the table

 Local coordinate set

I Global coordinate set j

= | Keepas referenoeiset

The points defining the tendon profile should oK | Cancel | Help |
appear as shown.

On the Geometry tab de-select the New geometry unmergable option and click OK
e Use Ctrl and A keys together to select all the visible Points.

¢ Click OK to define a spline that is defined in point selection order.

S

e Use Ctrl and A keys together to select the spline line and points.
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Modelling

Geomet _— . . .
| fé’{‘;jp'y ~ Make the model definition easier by placing the prestress tendon into a group.
| New Group .
~ e Enterthe group name as Tendon and click OK
Note. As well as defining the tendon manually using coordinates the Prestress Wizard
/ (accessed using Bridge (or Civil) > Prestress Wizard > Tendon Profile) allows you
to define the profile of the tendon in 2D or 3D space as a series of straight lines, arcs,
splines and parabola. The Tendon Profile dialog is used in the Segmental Construction
of a Post Tensioned Bridge example.
Defining the Mesh
The concrete bridge is represented by 2D beam elements.
e In the Treeview select Bridge and pick the Set As Only Visible option. This
turns off the display of the tendon to make bridge assignments easier.
| Attributes e Select Thick Beam, 2 dimensional, Linear elements, enter the dataset name as 2D
I% Beam and click OK to add the mesh dataset to the &b Treeview.
e Use Ctrl + A to select all the features.
o Drag and drop the mesh dataset 2D Beam onto the selection.
Defining the Geometric Properties
The beam idealisation represents a two metre width of the bridge which is one metre
deep. A section of this size will be created and added to the local library for subsequent
assigning to the model.
| Utilities e Select the Rectangular
Section Propel'[y SO|Id SeCthn (RSS) ~ Dimensional data — Calculated properties ——
Calculator > D |17 It A |2n—
Rectangul ;
S:gﬂor;%ufrs i e Enter a depth (D) of 1 a_nd s F | T o T
- a breadth (B) of 2 and click R —
OK to add the section to | l |
the local library. w [0
—pB—l N
e IW
Name [RS5 D=1 B=2 f W
gi:::zf;jz::ﬁzw Load sections. .. | Cleatageometw..l Wisualise... |
ak, I Cancel | Apply | Help |
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| Attributes

Geometric
Section Library..

>

Linear Analysis of a Post Tensioned Bridge

To add this section to the & Treeview:

From the Usage section select 3D Thick Beam (Any beam)

Select User Sections from the top-most drop-down list, select Local library, then
select RSS D=1 B=2. Since the initial section was defined simply in an xy plane, a
rotation about the centroid will be required. As a result:

Select a Rotation about centroid of 90
Enter the attribute name as Beam Properties and click OK

With the whole model selected drag and drop the geometric dataset RSS D=1 B=2

Beam Properties (RSS D=1 B=2 major z) from the & Treeview onto the selected
features.

@l Select the Isometric button to view the visualised beam.

ll Select the fleshing on/off button to turn-off the geometric visualisation.

@l Select the Home button to return the model to the default view.
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| Attributes

Modelling

| Material >
| Material Library. ..

Defining the Material

Select material Concrete of grade Ungraded from the drop down list and click OK
to add the material dataset to the &% Treeview.

With the whole model selected (Ctrl and A keys together) drag and drop the

material dataset I1sol (Concrete Ungraded) from the & Treeview onto the selected
features and assign to the selected Lines by clicking the OK button.

Defining the Supports

LUSAS provides the more common types of support by default. These can be seen in
the & Treeview.

The bridge is supported with rollers at each of the abutments.

Select the point at the left-hand abutment and the point at the column. (Hold the
Shift key to add to the initial selection)

Drag the support dataset Fixed in Y from the &b Treeview and drop it onto the
selected Points in the graphics window. Choose options to Assign to points for All
analysis loadcases and click OK

Select the right-hand point on the centre line of the bridge.

Drag the support dataset Symmetry YZ from the & Treeview and drop it onto the
selected Point in the graphics window. Choose options to Assign to points for All
analysis loadcases and click OK

T
T
4

Loading

Three loadcases are to be applied. The first represents self-weight of the structure. The
second represents the prestress with short term losses only. The third represents the
prestress with short and long term losses.

Defining the Self-weight

Gravity can be applied to any loadcase from the () Treeview.
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| Analyses

| Loadcase...

Linear Analysis of a Post Tensioned Bridge

e Select Loadcase 1 from the ‘= Treeview with the right-hand mouse button and
select Gravity.

Note. When gravity is applied to a loadcase as an option, load arrows representing
self-weight are not shown in the View window.

e Select Loadcase 1 from the ©=! Treeview with the right-hand mouse button and pick
the Rename option and change the loadcase name to Self Weight

Turn-on the display of the tendon

Now that the bridge assignments have been made the tendon can be re-displayed.

e Inthe Treeview select Tendon with the right-hand mouse button and select the
Visible option.

If rebuilding a model, or creating a model using the
supplied file.

If a previous analysis of this example has failed you need to return to this point to
continue after having run the supplied file stated.

If you created the model using the supplied associated file you need to continue from
this point to complete the modelling required.

Defining Prestress with Short Term Losses

¢ Ensure that the ‘Automatically add gravity to this loadcase’ option is not selected.
e Change the loadcase name to Short Term Loss and click OK

o Select Short Term Loss from the ‘X! Treeview with the right-hand mouse button
and pick the Set Active option.

Caution. Prior to running the Prestress Wizard to calculate short term and long term
tendon losses the correct Short Term or Long Term loadcase must be set active to
ensure that the values are written into the correct Tendon Load assignment attributes as
held in the &% Treeview. In addition, prior to running the Prestress Wizard, the spline
line representing the tendon, then any lines representing the concrete bridge, must be
selected in that order. So, with the Short Term Loss loadcase set active:
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| Bridge
| Prestress Wizard >

Single Tendon >

| BS5400-4:1990

Modelling

In the Treeview, select the spline Line representing the tendon with the right-
hand mouse button and click the Select Members option.

In the View window, select the 2 beams representing the concrete bridge. (Hold the
Shift key to add the other 2 lines to the initial selection)

1. Select this tendon line first

2. Select this bridge line 3. Select this bridge line

Select the Defaults button.  EEREClITIZ)
[Shorttermlosses ————
Ensure the Analysis type is | *=* = 3] B et (g
set to Beam Wabbie factor [3E: |/
i ~Tendon detasls — I Long term losses ———————————————
In the Tendon dEtalls Prestress force lW kN Relaxation loss
section enter the Prestress | o aes [555  mmt | | shirkage coeticent
force as 5000 Modulus of elasticity 200.0E6 khjfm2 Creep coefficient
Enter the Tendon area as | Teensmeiosons [ = Stress at ransfer

1 1 Jacking details
3.5E3 .(nOte that thls 1S Jacking end End 1 slip IW m Jacking angle IUU— =
entered in mm2) [ 1oy =]
End 2 slip I 0.0 m Jacking angle 0.0 =

Leave the Modulus of the
elasticity of the tendon as
200E6

V¥ Generate report
¥ Generate araphs:

Defaults I oK I Cancel I Help |

Set the number of Tendon sampling points to 25
In the Short term losses section set the duct friction coefficient to 0.3
Ensure the Long term losses option is deselected.

In the Jacking details section ensure the jacking is defined for End 1 only with an
End 1 (anchorage) slippage of 0.005

Click the Generate report option. When the wizard is run this will generate a
report in HTML format in the \<Lusas Installation Folder>/Projects directory
summarising the prestress tendon forces.
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Linear Analysis of a Post Tensioned Bridge

e Click the Generate graphs option. When the wizard is run this will generate graph

datasets in the &7 Treeview for subsequent graphing of tendon losses to be carried
out.

e Click OK

Equivalent nodal loading is then calculated from the values entered on the Prestress
Definition dialog.

On completion, an HTML report will be opened automatically in the default web
browser. This report is also saved into the specified folder. The report is a complete
summary of the tendon profile, properties and loading assignments made. On closing
the report the tendon loading assignments on the model can be seen for the active
loadcase.

Caution. Subsequent modification of the current tendon profile or beam lines will
4 s not update the calculated loading until the prestress wizard is run again with the same
analysis loadcase set active.

e Click OK to dismiss the warning message displayed

Modeller will assign the datasets to the selected Lines representing the concrete beams
for the current loadcase and will also add two load datasets to the &b Treeview.

e Inthe Treeview double-click the Utilities entry and on the Tendon profile tab
click the None button to stop the display of the tendon profile setting-out details.

Note. Tendon sampling points determine the number of points used when graphing
/ and creating reports on short and long term losses.
Defining Prestress with Short and Long Term Losses

| Analysis e Change the loadcase name to Long Term Loss and click OK
| Loadcase...

e Select Long Term Loss from the (&) Treeview with the right-hand mouse button
and pick the Set Active option.

I Caution. Forgetting to set the correct loadcase active prior to running the Prestress
4 e Wizard will write values to an incorrect loadcase.
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| Bridgel BS5400-4:1990

Modelling

| Prestress Wizard >
|Single Tendon >

| utilities

| Graph Wizard...

| utilities

| Graph Wizard...

e Re-select the tendon profile and the two lines representing the bridge, making sure
that the tendon profile is selected first.

With the Long Term Loss loadcase active:

The values previously entered on the dialog will be retained. Select the Long term
losses option. Leave all other values as they were set for the short term loss loadcase.

e Click the Generate report and the Generate graphs options. This generates a

report in HTML format and graph datasets in the " Treeview for subsequent
graphing to be carried out.

e Click OK to apply the prestress force to the current loadcase.

Equivalent nodal loading is calculated from the values entered on the Prestress
Definition dialog.

e Click OK to dismiss the warning message about subsequent modification of the
current tendon profile or beam lines not updating the calculated loading until the
prestress wizard is run again.

Graphing of Prestress Force in the Tendon

When the Generate graphs option is selected on the Prestress dialog two graph datasets
are created. One contains the distance along the beam and the other contains the force
in the tendon at each point. To graph these:

e Select the Specified datasets option and click Next

e From the first drop down list select Tendon Assignment Line 3 Distance and from
the second select Tendon Assignment Line 3 - Short Term Losses and click Next

e Click Finish to display the graph
Now add a graph of the Force after long term losses:
o Select the Specified datasets option and click Next

e From the first drop down list select Tendon Assignment Line 3 Distance and from
the second select Tendon Assignment Line 3 - Long Term Losses and click Next

e In the Include existing graphs panel ensure that Graph 1 is selected, then click
Finish to update the graph.
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Linear Analysis of a Post Tensioned Bridge

Post-tensioning of a bridge

4700
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—®— Tendon Assignment Line 3 - Short Term Losses / Tendon Assignment Line 3 - Distance
—8—Tendon Assignment Line 3 - Long Term Losses f Tendon Assighment Line 3 - Distance

E Close the graph window.

Saving the Model

e ——— & s the mode fite

Running the Analysis

;l Press the Solve Now button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

LUSAS loadcase results will be added to ‘&' Treeview.

In addition, 2 files will be created in the Additional Model Data folder, where the
model file resides:

U post_ten.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.
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| File

Viewing the Results

[New...

| File
| Script

|Run Script...

O post_ten.mys this is the LUSAS results file which is loaded automatically
into the *= Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

0 post_ten_modelling.vbs carries out the modelling of the example up to
the point of defining the prestress.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as post_ten

e To recreate the model up until the point of defining the prestress, select the file
post_ten_modelling.vbs located in the \<LUSAS Installation
Folder>\Examples\Modeller directory.

Now return to the section entitled Defining Prestess With Short Term Losses earlier
in this example and re-define the tendon properties.

Viewing the Results

Selecting the Results to be Viewed

The results will be loaded on top of the current model and the loadcase results for the
last solved loadcase (Long term loss) will be set to be active by default.

o Inthe "= Treeview right-click on Self Weight and select the Set Active option.
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Deformed Mesh Plots

A deformed mesh plot helps highlight any obvious errors with an analysis before
progressing to detailed results processing. The deformed shape will usually show up
errors in loading or supports and may also indicate incorrect material property
assignments (e.g. where the results show excessive displacements).

Deformed Mesh Plot for Self Weight

o If present, turn off the display of the Geometry, Attributes and Mesh layers from
the =¥ Treeview.

The Deformed mesh layer should be already present in the Treeview, and the View
window will be showing the deformed mesh for the self-weight alone.

e With no model features selected, click the right-hand mouse button in the graphics
window and select VValues

e Select entity Displacement and component DY

e Select the Values Display tab.

e Select the Show values of selection option.

e Change the number of significant figures to 4 and click OK

e Select the node on the centre line to add the value of vertical displacement at mid-
span to the display.

-4 87E-3

Deformed Mesh Plot for Short Term Loss

o In the 2 Treeview right-click on Short Term Loss and select the Set Active
option.

i
Y— .~ —3B856E3

Defining a Basic Combination

Combinations can be created to view the combined effects of the self weight and short
term loss loadcases on the structure.
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Viewing the Results

Basic

Combination...

The combination properties dialog will appear.

e Select the Self Weight and Short Term Loss loadcases from those available and

click the il button to add them to the load combination. Change the combination
name to Self Weight and Short Term and click the OK button to finish.

Deformed Mesh Plot for Combination

o Inthe (& Treeview right-click on Self Weight and Short Term and select the Set
Active option.

The deformed mesh plot will show the effect of the combined loading on the structure.

i

b T T -1.014E-3

Fibre Locations

Force/moment and stress diagrams can be plotted for pre-defined fibre locations on
members. All sections created by the Section Property Calculator will have extreme
fibre locations pre-defined. These fibre locations can be seen by expanding the

Geometric Line entry Beam properties (RSS D=1 B=2 major y) in the & Treeview,
and they can be visualised by double-clicking the Geometric Line attribute name and
then selecting the Visualise button on the dialog. In doing so, it can be seen that, by
default, Fibre S1 is the active fibre and Fibre S1 and Fibre S4 are the upper and lower
extreme fibres for which diagram and stress results plots should be created.
Diagram Stress Results at Fibre Locations

e Turn off the display of the Values layer from the [=- Treeview.

o In the ™ Treeview right-click on Short Term Loss and select the Set Active
option.

e With no features selected right-click in a blank part of the graphics window and
select Diagrams to add the diagrams layer to the = Treeview.

The diagram properties will be displayed.
e  Select Stress - Thick 2D Beam results of stress Sx(Fx, Mz) in the beam.

e Select the Diagram Display tab and ensure that Peaks only is selected.
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e Change the angle of the text to 45, set the number of significant figures to 4 and
click OK to display the stress diagram at Fibre location S1 for the Short Term Loss
loadcase

Diagram Results for Short Term Loss

&
;—-.:x/_/_\ —_— & =

Diagram Results for Combination

e Inthe @ Treeview right-click on the combination Self Weight and Short Term
and select the Set Active option to display the stress diagram at Fibre location S1
for the Self Weight and Short Term combination

Diagram Results for Combination at Fibre 4

Once a loadcase has been set results can be plotted for any defined fibre location. In
this example, because of their location and because of the applied loading, Fibre S1 and
Fibre S2 will give the same results at the top of the beam. Fibre S3 and Fibre S4 will
both also give the same results at the bottom of the beam — so only a diagram for Fibre
S4 needs to be plotted.

With the combination Self Weight and Short Term still set active in the (5 Treeview:

o Inthe b Treeview expand Geometric Line entry Beam Properties (RSS D=1 B=2
major z) and right-click on Fibre S4 and select Set Fibre Active.

The diagram display will update to show the stresses at Fibre S4:
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Viewing Results on Fleshed Members

e Asan alternative to plotting diagram results, stresses in beams can also be plotted
on fleshed members.

e Turn off the display of the Diagrams layer from the = Treeview.

Contour Results for Short Term Loss

o In the & Treeview right-click on Short Term Loss and select the Set Active
option.

e Click in a blank part of the Graphics Window to deselect the members.

e With no features selected right-click in a blank part of the graphics window and
select Contours to add the contours layer to the = Treeview.

e Select Stress — Thick 2D Beam results of axial and moment results in the members
Sx(Fx, Mz) and click OK

Initially the contour properties will be displayed for the fibre location (Fibre S4) that is
currently set active.

o

To see the stresses on the fleshed beam member:
ek | . .
Select the isometric button.

ll Select the fleshing on/off button to visualise the stress results for the fully fleshed
cross-section.
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Analysis: Analysis 1

Loadcase: 2:Short Term loss

Results file: post_ten~Analysis 1.mys
Entity: Stress - Thick 20 Beam
Component: Sx(Fx, Mz} {Units: kN/m?)

-T.2314E3
-6.02617E3
-4.82094E3

-3.615TE3

- -2 41047E3
-1.20523E3
0.0

1.20523E3
. 2 41D47E3
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Contour Results for Combination

o In the ‘X! Treeview right-click on the combination Self Weight And Short Term
and select the Set Active option.

Combination 1
Entity: Stress - Thick 2D Beam
Compeonent: Sx(Fx, Mz) (Units: kN/m?)

-5.25472E3
-4, 37893E3
-3.50315E3
-2.62T36E3
- -1.7515TE3

-875.786
0.0
B75.788

. 1.75157E3

Note. Diagrams and contours may be displayed at the same time to show results for
selected fibre locations.

This completes the example.

Discussion

This example illustrates the use of the single tendon prestress wizard, which does not
take into account any stressing or unstressing of any other tendons, should they also be
present in the model, which in this example they are not.

The Multiple tendon prestress wizard should generally be used instead of the single
tendon wizard since it takes into account elastic shortening due to stressing of other
tendons according to the selected design code or user-defined percentage losses, and is
more suited to staged construction analysis. If the option to ignore effects due to elastic
shortening is chosen the loading computed will be the same as that calculated by the
single tendon wizard.
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Description

Simple Grillage

For software product(s): | LUSAS Bridge.
With product option(s): None.

Description

A bridge deck is to be analysed using the grillage method. The geometry is as shown
below. All members are made of C50 concrete to BS5400. Section properties of the

longitudinal beams and diaphragms are to be calculated using the Section Property
Calculator facility.

Footw ay 0.25m Concrete Surfacing 0.1m Tarmac
Density 2.4t/m3 Density 2.0t/m3
L—Z.Sm—*—B.Sm Lane—»‘d—S‘Sm Lane =1< 2.5m—>‘

12 m

Y6 beam with insitu
concrete top slab
} : : Vo25m | SPan=20m
P P P P P N Width =12m
Skew = 0°
| 6@2m ‘

Cross-section through deck

[« 20m >
n (] o
Longitudinal section along deck T

0.5m
The structure is subjected to four loadcases: Dead load, Superimposed dead load, Lane
loads in both lanes (UDL and KEL), and an abnormal load (HB) in the lower notional
lane with a lane load (UDL and KEL) in the upper lane.

Units of N, mm, t, s, C are used in calculating the section properties of selected
components.

Units of kN, m, t, s, C are used throughout when modelling the grillage.
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Modelling

| File

New...

Simple Grillage

Objectives

The required output from the analysis consists of:

O A deformed shape plot showing displacements caused by the imposed loading

O A diagram showing bending moments in the longitudinal members for the design
load combination

Keywords

2D, Y6 Precast Section, Section Property Calculation, Local Library, Grillage,
Basic Load Combination, Smart Load Combination, Enveloping, Deformed Mesh,
Bending Moment Diagram, Print Results Wizard

Associated Files

U grillage_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Before creating the grillage model the section properties of the longitudinal beams and
end diaphragms are to be computed using the section property calculator and stored for
future use. Calculation of section properties requires section geometry to be
drawn/defined in the XY plane.

Creating the Longitudinal Beam Model
Ql Create a new model.

e Enter the file name as Y6
e Use the Default working folder.

e Enter the title as Y6 Precast Beam
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| utilities

Section Property

Calculator >
| Precast Section...

| utilities

Section Property
Calculator >
Arbitrary
Section...

Modelling

Select model units of N,mm,t,s,C from the drop down list provided.

Ensure the timescale units are Seconds

Ensure the analysis type is Structural

Ensure the startup template is set as None

Ensure the Vertical Z Axis option is selected, and click the OK button.

Defining Longitudinal Beam Geometry

From the Y Beams section
series select a Y6 section.

Specify a slab depth of 250
Enter a slab width of 2000
Click the OK button.

The section will now be drawn.

Calculating Longitudinal Beam Section Properties

Press Ctrl and A to select the
two surfaces defining the Y6
section

Select the option Add to local
library so the calculated
properties will be available
from the local library when
required.

Name the section Y6 Precast
Beam.

Click the Apply button to
compute the section
properties. These will be
displayed in the greyed text
boxes on the right hand side

—Precast beam

Precast section | vy geamg vl

Precast Beam Section Generator

Section no. 6 -
—Conerete slab
B
¥ Symmetric about beam centre line A E—

D
oot o 5 tetrramaney [ || [ ]
Width (B8) [ 2pog Right hand width {Br)

OK | Cancel | Help

Arbitrary Section Property Calculator
—Calculated Properties
Area A 0.0
Second moment of area about x axis bec 00
Second moment of area about y axis Iy 00
Product moment of area by 0.0
Torsional constant J 0o
Efective shear area in x direction Asx 0o
Effective shear area in y direction Asy 0.0
Radius of gyration about x axis L3 0.0
Radius of gyration about y axis ¥ 00
Shear centre, distance from centroid along x axis x0 0.0
Shear centre, distance from centroid along y axis yo 00
Warping torsional constant Cw 0.0
Plastic neutral axis. distance from centroid along x adis xp 0.0
Plastic neutral axis, distance from centroid along y axis P 0.0
Plastic section modulus about x s Zpx 0.0
Plastic section modulus about y axdis Zoy 0.0
Plastic torsional section modulus Zpt 00
Angle to principal axis (anticlockwise +ve) Theta |00
[V Annotate properties ¥ Automatic meshing Maximum elementsfiine [15 =]

¥ Recompute section properties V| Add to local library

™ Add to server library

Cancel

Apply Help

of the dialog and written to the local library.
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e Click the Cancel button to close the dialog.

Creating the End Diaphragm Model

| File
[New...

Ql Create a new model and discard the changes to the previous model.
e Enter the file name as diaphragm

e Use the default working folder.

e Enter the title as End diaphragm

e Ensure units of N,m,kg, s,C are selected.

e Ensure the Structural user interface is selected

e Ensure the startup template is set as None

e Ensure the Vertical Z Axis option is selected

e Click the OK button.

Defining Diaphragm Geometry

| Geometry

[Surface S _I Enter coordinates of (0,0), (0.5,0),
~ [Coordinates... (0.5,0.5), (1,0.5), (1,0.75), (0,0.75) to define
a surface representing the end diaphragm

and slab (which is to be represented by the
end beam on the grillage model) and click
OK

W
W
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| utilities

Section Property
Calculator >
Arbitrary
Section...

| File

New...

Modelling

Calculation of End Diaphragm Section Properties

Select the option Add local
library and name the section
End Diaphragm.

Click the Apply button to
compute the section
properties. These will be
displayed in the greyed text
boxes on the right hand side
of the dialog and written to
the local library file for future
use.

Click the Cancel
close the dialog.

button to

[ Calculated Properties

Area

Second moment of area about x axs

Second moment of area about y axds

Product moment of area

Torsional constant

Effective shear area in x direction

Effsctive shear area iny direction

Radius of gyration about x axis

Radius of gyration about y axis

Shear centre, distance from centroid along x axdis

Shear centre. distance from centroid along y ads

Warping torsional constart

Plastic neutral axis, distance from centroid along x ads

Plastic neutral axis, distance from centroid along y axis

Plastic section modulus about x axis

Plastic section modulus about y axis

Plastic torsional section modulus

EEyEE2EER R g |T=E >

Angle to principal axs (ar ise +ve)

Theta |0.0

¥ Annctate properties ¥ Automatic meshing

¥ Recompute section properties ¥ | Add to local library

Maximum elementsfine [15 =]

™ Add to server library

Name [ang diaphragm

Cancel Apply Help

Creating the Grillage Model

Now that the beam and diaphragm properties have been calculated the grillage model
can be created.

gl Create a new model and discard the changes to the previous model.

Enter the file name as grillage

Enter the title as Simple grillage analysis

Set the units as kN,m,t,s,C

Ensure the Structural user interface is selected

Ensure the startup template is set as None

Ensure the Vertical Z Axis option is selected.

Click the OK button.

Note. Save the model regularly as the example progresses. Use the undo button to
correct any mistakes made since the last save.
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Grillage Wizard...

Simple Grillage

Using the Grillage Wizard

In this example the grillage wizard is used to generate a model of the bridge deck. The
grillage wizard defines the grillage geometry, assigns grillage elements to each of the
lines, and assigns supports to the end beams. It also creates Groups to ease member
identification and the application of section properties.

Note. It is difficult to make absolute recommendations as to how individual structures
should be modelled using a grillage. A few basic recommendations are however valid
for most models:

a) Longitudinal beams within the grillage should be coincident with the actual
beams within the structure.

b) Transverse beams should have a spacing which is similar or greater than that of
the longitudinal beams and the total number of transverse beams should be odd
to ensure a line of nodes occur at mid span.

e Select the Set defaults button
e Ensure Slab deck is selected and click Next
e The grillage is Straight with 0 degrees skew so click Next again

e Select evenly spaced longitudinal beams, and enter the grillage width as 10 and the
number of internal longitudinal beams as 6. Click Next

e Leave the number of spans set as 1
o Enter the length of span as 20 and the number of internal transverse beams as 9

e Click Finish to generate the grillage model.

92



| Utilities

Section Property
Calculator

>

Rectangular

Sections > Solid

Modelling

Calculation of Transverse Beam Section Properties

The internal transverse beams each represent a 2m width of slab so the section
properties are computed for an equivalent solid rectangular section, and the section is
added to the local library for assignment to the model later in the example.

End Diaphragm ‘ ‘ Slab ‘ ‘ Transverse Grillage beams ‘
o | o | ) | -
ﬁlm#iZm;LingJ
Longitudinal Section
PY Enter a depth Of D = 0.25 Rectangular Solid Section Property Calculator
i~ Dimensional data i~ Calculated properties
e Enter awidthof B=2 I T iy s 5
B ! o [T
e  The section properties will : T e PO
be displayed in the greyed R W [T
text boxes on the right hand i by [0
side of the dialog. h—B— [
e Note the torsion constant B |
) is calcul_atfad to be Mane [FES D0 ps [DATEGE7
0.0096. This is based on
beam theory and is not G kel Lostsecion. | Crstegeomety. | Vi, |
appropriate to represent a o | cect | s | [ ]
slab in a grillage analysis. It

will be adjusted later in the example.

e A section name of RSS D=0.25 B=2 is automatically created from the entered
dimensions.

Ensure the Add to local library option is selected and click OK to add the
properties to the local section library.

Modifying Section Properties for Grillage Analysis

e When representing an isotropic slab using a grillage model, the effective torsion
constant (per unit width) can be shown to be ¢ = d*/6 (per unit width). It is
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| Geometric >
| Section Library...

| Attributes
| Geometric >
| Section Library...

Simple Grillage

therefore common practice to assume 50% of the value calculated using beam
theory for a wide slab-like beam. In this example therefore:

e The transverse members represent only the slab and therefore their torsion
constant can be entered as ¢ = bd*/6 (i.e. 50% of the section library value).

e The longitudinal members represent the precast beam and associated width of
slab, and therefore this reduction is only applied to the proportion of the torsion
constant exhibited by the slab.

When the transverse 0.25m deep 2m wide slab and the Y6 precast (longitudinal)
beams are selected from the local section library their section properties will be
adjusted accordingly.

Adding Section Library Items to the Treeview

First, add the transverse slab section geometric attribute:

Select the User Sections library from the upper-right drop-down list.
Select the Local library type.
Select the RSS D=0.25 B=2 entry from the drop down list.

Select the Enter Properties option and reduce the torsion constant to 0.005 (as
discussed: ¢ = hd%e6).

Enter an Attribute name of Transverse Slab major y and click OK to add the
section properties to the &b Treeview.

Next, add the Y6 beam geometric attribute:

Select the User Sections library from the upper drop-down list.
Select the Local library type.

Select Y6 Precast Beam from the name in the drop-down list.

Select the Enter Properties option and modify the torsion constant to be 0.020
(The computed value of the precast beam alone, 0.0143, plus the reduced
contribution from the slab; ¢ = bd3/12 = 0.005).

Enter an Attribute name of Y6 Precast Beam and click OK to add the section
properties to the &b Treeview.

Note. Even though the Y6 beam was defined in millimetres the units can be extracted
from the library in metres. The units will be set to metres automatically as these were
the units selected on the New Model dialog.
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Modelling

e Lastly, define the end diaphragm geometric attribute:

e Select the User Sections library from the upper drop-down list.
e Select the Local library type.

e Select End diaphragm from the drop down list.

e Click OK to add the section properties to the & Treeview.

Note. When a section is used from a library without amending its section properties or
the section’s orientation (as just done for the End diaphragm) the library name is
appended automatically to the automatic identifying name given in the dialog. This will
be of the type LGeol, LGeo? etc, signifying Line Geometric properties.

Assigning Geometric Properties to the Grillage Members

El Use the Isometric View button to rotate the model so that the following assignment
of the geometric properties can be seen.

I? Ensure the fleshing button is depressed in the toolbar menu.

Longitudinal members

The Y6 beam section properties are to be assigned to all the longitudinal members.

e Inthe &b Treeview select the Y6 Precast Beam major z entry and click on the
copy button.

e Inthe Treeview select the Edge Beams group and click the El paste button to
assign the Y6 beam section properties to the edge beams.

Confirmation of the assignment will appear in the text window.

e Select the Longitudinal Beams group and click the EI paste button again to
assign the Y6 beam section properties.

Transverse slab members

The slab section properties are assigned to the transverse members in a similar fashion.

o In the &b Treeview select the Transverse Slab major y entry and click on the
copy button.
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Reverse...

Simple Grillage

e In the Treeview select the Transverse Beams group and click the El paste
button to assign the slab section properties.

To clarify the display prior to assigning the diaphragm members the extent of the
fleshing of each grillage member can be modified as follows:

e Inthe Treeview, double click on the Attributes name, click the Geometric tab
and press the Settings button. For cross-section end shrinkage select the Automatic
option, and click OK to update the display.

Diaphragm members

The diaphragm section properties are assigned to the end diaphragms in a similar
fashion.

e Inthe 63; Treeview select the End diaphragm (m) major z entry and click on the

copy button.

e In the Treeview select the End Diaphragms group and click the El paste
button to assign the slab section properties.

From the fleshed image it can be seen that the end diaphragm members for the far end
are incorrectly displayed, and as a result the line directions of the lines to which they
have been assigned need to be reversed.

e Select the 5 lines at the far end of the grillage

This reverses the line directions of the selected lines to give the following image.
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| Material Library. ..

| Bridge
Bridge Loading >
Gravity

Modelling

Note. You can also check assignments by right-clicking on a group name in the
Treeview and selecting Select Members.

Defining the Material

Note. In this example a single material property will be used. If deflections and
rotations are of interest then separate analysis runs with short and long term properties
may be appropriate.

e Select material Concrete BS5400 from the drop down list, and Short Term C50
from the grade drop down list.

e Click OK to add the material dataset to the & Treeview.

e With the whole model selected (Ctrl and A keys together) drag and drop the

material dataset Isol (Concrete BS5400 Short Term C50) from the & Treeview
onto the selected features and assign to the selected Lines by clicking the OK
button.

Loading

In this example seven loadcases will be applied to the grillage. These will be enveloped
and combined together to form the design combination.

Renaming the Loadcases

o In the & Treeview expand Analysis 1 and right click on Loadcase 1 and select the
Rename option.

e Rename the loadcase to Dead Load by over-typing the previous name.

Dead Load

Dead load is made up of the self-weight of the structure, which is defined as
acceleration due to gravity.

Note. When a bridge deck is modelled by a grillage the plan area of slab is
represented by the longitudinal and transverse members. As a result, the self-weight
should only be applied to the longitudinal members.

ﬂ Turn off the display of the fleshed members

e A load dataset named BFP1 (Gravity -ve Z) will be added to the & Treeview.
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| Bridge Loading
| Surfacing...

>

e Inthe & Treeview select the BFP1 Gravity -ve Z entry and click on the copy
button.

e Inthe L=l Treeview select the Edge Beams group and click the El paste button.

o With the Assign to lines and Single Loadcase options selected click the OK button
to assign the gravity loading to the Dead Load loadcase.

Loading arrows confirming the assignment of the self-weight dead load on the edge
beams will be displayed.

e Inthe Treeview select the Longitudinal Beams group and click the EI paste
button to gravity loading.

o With the Assign to lines and Single Loadcase options selected click the OK button
to assign the gravity loading to the Dead Load loadcase.

Loading arrows confirming the assignment of the self-weight dead load on the internal
longitudinal beams will be added to the display.

Superimposed Dead Load

Superimposed dead load consists of the surfacing loads. These represent the self-
weight of the footways and the surfacing on the road.

Specify the surfacing loading for the footway:

e Leave the density as 2.4

e Change the thickness to 0.25

e Set the length to 20 and set the width to 2.5

e Leave the skew angle as 0 and the origin as Centre

e Click the Apply button to add a Pch2 (Surfacing 20.0m x 2.5m Skew=0.0deg
Thickness=0.25m Density=2.4 t/m”3) loading attribute to the & Treeview.

Now specify the tarmac highway surfacing load:
¢ Change the density to 2.0
e Change the thickness to 0.1

e Leave the length as 20 but change the width to 3.5
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Modelling

| Point

| Coordinates...

>

e Click the OK button to add a Pch3 (Surfacing 20.0m x 3.5m Skew=0.0deg

Thickness=0.1 Density=2.0t/m”3) loadin

Discrete point and patch loads are positioned
have to form part of the model.

El Enter the coordinates of the mid point

g attribute to the & Treeview.

by assigning them to points which do not

of each footway and each notional lane

(10,0.25), (10,3.25), (10,6.75), (10,9.75) and click OK

£ NIA On the status bar at the bottom
return to a global Z direction view.

of the display, click the Z axis button to

e Select the points at the
centre of each footway

2

by holding the Shift  ggjact these

key down to select points to assign
points after the initial footwav. surface
selection. loading

e Drag and drop the |

N

discrete loading dataset

Pch2 (Surfacing
20.0m X 2.5m
Skew=0.0deg Thickness=0.25m Density=2.4 t/m”3) onto the selected points.
e Select Include Full Load RESEEESEIGELLNEESIITES <]
from the dI’Op dOWh ||St ~Patch transformation
ThIS W| I I ensure the IND Attribute Selected j
portion Of the pavement "~ Load transformation
Ioad WhICh is OVerhal:lging IND Attribute Selected j
the edg_e of the grillage | __.
model is applied to the fihol moc ]
edge beams.
" Project onta line (2D line beam and frame models)
b Enter Superi mposed - Ignore projection direction moments
Dead Load as the & Project over area (grilages, slabs and 30 space frames)

Loadcase and click OK to
assign the loading.

The loading will be visualised.

Patch load divisions

The Patch divisions object

" Project into volume {salid models)

Options for loads outside search area IIncIude Full Load j
[ |

Analysis IP.naIysis 1

Loadcase

¥ et as active loadcase

Load Fackor I 1.0

a4 I Cancel | Help |

seen in the & Treeview

controls the number of discrete point loads used to represent a patch load. By default a
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specified number of 10 divisions is used. However, for this example, and for most real
life uses a greater number of divisions is required to accurately reflect the surfacing
loading.

o Inthe &b Treeview double-click the Patch divisions object

e Select the Distance between loads option and specify 0.5. Click OK to update the
patch divisions and see the updated loading visualisation.

Now the road surfacing is to be assigned:

e Select the two points at the

centre of each notional lane. D P Bt
e Drag and drop the discrete <:;‘ ?Slict+tfese
load dataset Pch3 %;f;;“;g e
(Surfacing 20.0m x 3.5m s:rfa?ce
Skew=0.0deg Inlinie
Thickness=0.1 PSR P PR R N RN F e ot 1 N A
Densityeo.0tm~3)  from  Liiiiiii i

the & Treeview onto the
selected points.

o Leave the loading option for loads outside the search area set as Exclude All Load
because for this load type it is irrelevant whether include or exclude is used since
the load length, which is positioned centrally, is the same length as the span length

e Select Superimposed Dead Load from the Loadcase drop down list.

e Click OK to assign the road surfacing load. The loading will be visualised.

Vehicle Load Definition

HA loading is to be applied to each notional lane in loadcases 3 and 4. These loads are
defined using the UK vehicle loading definitions supplied with LUSAS Bridge.

Lane load
e Select the Lane load (HA load) button.

e Select loading code BD 37/88, change the length to 20 and select the OK button to
add the load dataset Pch4 (HA BD37/88 20.0m x 3.5m Skew=0.0deg (Centre)) to

the & Treeview.

Knife edge load
e On the same dialog, select the Knife edge load (KEL load) button.
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Leave the notional width as 3.5 and the intensity as 120 and click the OK button to
add the load dataset Pch5 (KEL 120kN Width=3.5m Offset=0.0m Skew=0.0deg

(Centre)) to the & Treeview.

Abnormal load

On the same dialog, select the Abnormal load (HB vehicle) button.

With the axle spacing set to 6 and 45 units of HB load select the OK button to add
the load dataset Pnt6 (HB 6.0m spacing 45.0 units) to the & Treeview.

Click the Close button to close the UK bridge loading dialog.

Assigning HA Loading

Assigning KEL Loading

Select the point defined at the [
centre of the upper notional lane.

R
R
I
e
e
DR
ey

e
+ s

Drag and drop the dataset Pch4 [

(HA BD37/88 200m X 35m o nloanufesvufesscloses|sevnfsennnnne

Skew=0.0deg (Centre)) from the
Treeview.

R
R

Enter HA upper as the Loadcase,
leave other values as their
defaults, and click OK. The loading will be visualised.

Select the point defined at the centre of the lower notional lane.

Drag and drop the dataset Pch4 (HA BD37/88 20m x 3.5m Skew=0 (Centre)) from
the &b Treeview.

Enter HA lower as the Loadcase, leave other values as their defaults, and click OK

Select the point defined at the
centre of the upper notional lane.

LSS TS

Drag and drop the dataset Pch5
(KEL  120kN  Width=3.5m
Offset=0.0m Skew=0.0deg |

(Centre)) from the &b Treeview.

Enter KEL upper as the Loadcase and click OK

Select the point defined at the centre of the lower notional lane.
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e Drag and drop the dataset Pch5 KEL 120kN Width=3.5m Offset=0 Skew=0
(Centre) from the & Treeview.

e Enter KEL lower as the Loadcase, leave other values as their defaults, and click
OK

Assigning Abnormal HB Loading

For this example, abnormal HB loading is only assigned to the lower lane.

e Select the point defined at the
centre of the lower notional lane.

e Drag and drop the dataset Pnt6
(HB 6.0m spacing 45.0 units) .
from the Treeview onto the ’
selected point.

o o+ | e

i

e Enter HB lower as the Loadcase,
leave other values as their defaults, and click OK

Note. Loading assignments can be checked in a number of ways. This can be done by
either selecting a point and accessing its context menu to view its Properties (which will
include Loading), or a loading attribute in the Attributes treeview can be interrogated
by accessing its context menu and choosing View Assignments, or a Loadcase and
loading folder can be expanded in the Analyses treeview.

Save the model

El Save the model file.

Running the Analysis

With the model loaded:

El Open the Solve Now dialog, ensure Analysis 1 is selected and press OK to solve.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.
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Viewing the Results

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.

In addition, 2 files will be created in the directory where the model file resides:

U grillage.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U grillage.mys this is the LUSAS results file which is loaded automatically
into the ‘X! Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

U grillage_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as grillage and click OK

To recreate the model, select the file grillage_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the (L) Treeview, and results for the last solved
load case will be set to be active by default.
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Deformed Mesh and Summary Plot

A deformed mesh plot helps highlight any obvious errors with an analysis before
progressing to detailed results processing. The deformed shape will usually show up
errors in loading or supports and may also indicate incorrect material property
assignments (e.g. where the results show excessive displacements).

o Inthe (X! Treeview right-click on Dead load and select the Set Active option.

o If present, turn off the display of the Geometry, Attributes and Mesh layers in the
Treeview.

e The Deformed mesh
layer should be turned on
by default in the
Treeview.. Double click
its name and select the
Specify factor option and
enter 300 Click the OK
button to display the
deformed mesh for
loadcase 1.

El If necessary use the

Isometric View button to rotate the model.

e Step through each of the loadcases in the G Treeview using the Set Active option
and check each deformed shape looks correct for the supposed loading.

£ 1 Return to the view from the global Z direction.

Defining Envelopes and Combinations

The design combination will consist of all dead loads and an envelope of all live loads
factored by the appropriate adverse or relieving factor.
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Adverse Factor
Loadcase hame Relieving Factor
Y1 V3
Dead Load 1.15 1.10 1.0
Super Dead Load 1.75 1.10 1.0
HA alone 15 (% 1.10 0
HA with HB 1.3 (% 1.10 0
Table 1

Note. According to BS5400 part 1 two safety factors should be applied to adverse

loading. yriaccounts for the uncertainty in the applied loading and 7yss is a safety factor
to allow for modelling inconsistencies / inaccuracies.

Note. (*) When designing to BD 37/88 the HA lane loading factors also include
additional lane factors. For a two lane structure these are noted in the tables which
follow.

Defining a Basic Load Combination 1

A basic load combination to investigate HA and Knife Edge loads will be defined.

On the Basic Combination dialog:

LI Add loadcases (3) HA upper, (4) HA lower, (5) KEL upper, (6) KEL lower

Note. To add a number of loadcases all together select the first loadcase in the list,
hold down the Shift key and select the last loadcase in the list (scrolling down the list if

necessary) and click the LI button.
Each loadcase selected then needs a corresponding lane factor to be specified.

e Select the Grid button and update the factors as shown in Factor column of the
following loadcase combination table.
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Load Factor

Combination...

Defining a Basic Load Combination 2

Lane Lane Factor to
Loadcase name
Factor be used
Y1 Y3
HA upper 1.5 1.10 0.956 1.6
HA lower 1.5 1.10 0.956 1.6
KEL upper 15 1.10 0.956 1.6
KEL lower 15 1.10 0.956 1.6
Table 2

Click OK to return to the combination properties dialog.
Change the combination name to HA + KEL both lanes

Click OK to save the combination definition.

A basic load combination to investigate HA, HB and Knife Edge loads will also be
defined.

On the Basic Combination dialog:

LI Add result loadcases (3) HA upper, (5) KEL upper, (7) HB lower

Each loadcase selected needs the factor to be specified.

Select the Grid button and update the factors as shown in Factor column of the
following loadcase combination table.
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Load Factor L Fact
Loadcase name Lane Factor ane Factor
to be used

Yir | V3

HA upper 1.3 1.10 0.956 14

KEL upper 1.3 1.10 0.956 1.4

HB lower 1.3 1.10 0.956 1.4
Table 3

e Click OK to return to the combination properties dialog.
e Change the combination name to HA + KEL upper, HB lower

e Click OK to save the combination definition.

Enveloping the Basic Live Load Combinations
On the Properties dialog:

LI Add combinations (8)HA+KEL both lanes and (9) HA+KEL upper, HB lower
e Change the envelope name to Live Load Envelope

e Click OK to save the envelope definition.

Note. When either a Max or Min smart combination or envelope is modified the

corresponding Max and Min dataset will be updated automatically.

Defining a Smart Combination

Smart load combinations take account of adverse and relieving effects for the loadcase
being considered. The Self-weight, Superimposed Dead Load, and the Live Load
Envelope will all be combined using the Smart Load Combination facility to give the
design combination.

On the Smart Combination dialog:
il Add loadcase (1)Dead load and (2)Superimposed DL to the Included panel.

il Add (10)Live Load Envelope (Max) and (11)Live Load Envelope (Min) to the
Included panel.
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Each loadcase/envelope selected needs the permanent and variable factors to be
specified.

e Select the Grid button and update the Permanent Factor for the Live Load
Envelopes to 0 and ensure the Variable Factor for all loadcases are as shown in the
table.

Permanent Variable
Loadcase name Variable Factor (relieving) Factor to be
Factor used
Y1 V3
(1)Dead Load 0.15 0.10 1.0 0.265
(2)Superimposed DL 0.75 0.10 1.0 0.925
(10)Live Load ) _
Envelope (Max) 0 1.0
(11)Live Load ) _
Envelope (Min) 0 1.0
Table 4

Note. In this table the permanent factor is based upon the relieving factor from Table
1. The variable factor for Dead Load and for Superimposed Dead Load is based upon
the product of the adverse factors for both from Table 1 minus the permanent
(relieving) factor. The live load envelopes have already been factored in previous load
combinations (Tables 2 and 3) and, as a result, only a unity factor is applied as a
variable factor.

e Click OK to return to the combination properties dialog.
e Change the envelope title to Design Combination

e Click OK to save the smart combination.

Selecting Loadcase results

o In the & Treeview right-click on Design Combination (Max) and select the Set
Active option.

e Select entity Force/Moment — Thick Grillage results of component My from the
drop down lists to combine and apply the variable factors based on the moments
about the Y axis and click the OK button.
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Note. When activating a smart combination the selected component is used to decide
if the variable factor should be applied. (The variable component is only applied if the
resulting effect is more adverse) Viewing results for a component other than the
selected component will result in display of the associated values (coincident effects).
When the results of an envelope or smart combination are printed the column used to
compute the combination or envelope is denoted with an asterisk in the column header.

Selecting Members for Results Processing

Results are to be plotted for selected longitudinal members of the grillage only. The
grillage wizard automatically creates groups which are useful in the results processing.

e In the Treeview select the Longitudinal Beams with the right hand mouse
button and pick Set as Only Visible

e Inthe Treeview select Edge Beams with the right hand mouse button and pick
Visible

e Turn off the display of the Deformed mesh layer in the [=F Treeview.
e Add the Mesh layer to the Treeview and click OK to accept the default

properties.

Bending Moment Diagram

A plot showing the bending moment from the design combination is to be displayed for
the selected members of the grillage.

e With no features selected, click the right-hand mouse button in a blank part of the

graphics window and select the Diagrams option to add the diagram layer to the
Treeview.

The diagram properties will be displayed.

e Select entity Force/Moment — Thick Grillage results of component bending
moment My

e Select the Diagram Display tab

e Select the Label values option.

e Select the Orientate flat to screen/page option.

e Deselect the Use for labels too option, so that labels are drawn in black.

e Set the Label font to size 12
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e Enter an Angle of 45 degrees

e Set the Number of significant figures to 4

e Set % of element length to 60

e Click the OK button to display the bending moment diagram.
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Note. Results plots which are to be printed are best created in the page layout view.
This provides a view that will appear similar to the printed output. Labels however may
however be difficult to read in the page layout view since they reflect the size of the
labels on the final printout. When this situation arises the zoom facility may be used to
examine labels of interest more closely.

e Switch to page layout view.

e Add a border to the page which contains the title, date and version of the LUSAS

software in use.

e Ensure the orientation is set to Landscape. Change the page margins to enable the
annotation to be added without obscuring the display. Set the left margin to 50, the

right margin to 15 and the top and bottom margins to 10. Click OK

A summary of results will be added to the graphics window showing the loadcase name,
diagram component, maximum and minimum diagram values, and element numbers in

which the maximum and minimum moments occurs.
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e Select the annotation by clicking over any piece of text and then drag it the
summary text to an appropriate location on the plot.

Note. The location of any model feature, element or node can be found by using the
Advanced Selection facility. This can be used to find the location of the maximum and
minimum results values as the element number is output in the window summary text.

As well as creating a results plot, results can be printed for saving or copying to a
spreadsheet using standard Windows copy and paste.

Printing results for the active loadcase

| Utilities Results values may be output to the screen in a tabular listing format for the active
Print Results loadcase or for any selected loadcase. With Design Combination (Max) currently set
Wizard... active:

e On the Results Wizard dialog ensure Loadcases Active is selected and click Next.

e On the Results Entity dialog, select entity Force/Moment — Thick Grillage, for
location Gauss Point and of type Component.

¢ In the Primary Components panel ensure that My is the only one selected.

e Set the number of decimal places to 1 and click the Finish button to display the
results.

BB LUSAS Yiew: Forces and Moments in Local Axes Loadcase = 12ResultsFile = 0  [E= E3

=] E el

Element 4 | Gauss point Fz [ My(*) ﬂ
Element Gauss point Fz 1153 M)

1 1 -391.3 208 220
-309.1 0 108 -50.8
-304.5 108 © -1122
-2899 108 | -1726
-285.3 108 | -2321
-280.7 0 10 © -2907
-266.1 108 @ -348.4
-261.5 0 -10 | -403.2
-276.49 108 | -461.0
-2723 108 | 3159
-267.7 108 | -369.9
-2471° 104 -367.4
-2425 104 -G16.4

15 3 -23749 104 -GG64.4 LI
M 4 » M \ Model infa }\ 12:Design Combination (Max) (My)

Note. When the active loadcase is an envelope or smart combination the results
/ printed will show the primary component (My in this case) marked with an asterisk.

Wioi~imithi &k

—=io

[0 UT OSSRV DU UG BV DU U P P Y Y

[~

Note. Hovering over the contents of a cell will display a datatip showing location
/ information and an associated value.
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Note. Table data can be sorted by selecting a column and choosing a sort option from
the context menu for the selection.

Saving printed results to a spreadsheet

When the Printed Results window is shown a context menu can be displayed allowing
the printed results to have their number of significant figures or decimal places
changed, be sorted in ascending or descending order, be saved to a spreadsheet or
copied for pasting elsewhere.

e Right-click inside the Printed Results window and select Save as Microsoft
Excel...

e Enter a file name of grillage_results
e Ensure the save option All tabs is selected and click Save.

Note that Microsoft Excel may impose limitations on the length of tab name permitted.

Printing results for selected loadcases

Results values may be printed for selected loadcases. To illustrate usage:

e On the Results Wizard dialog ensure Rdiass
Loadcases Selected is chosen and I allloadcases
click Next. Fiter
’VStart ID Step |1 Filter
e On the Loadcases dialog select el Tt
results files or load combinations = ™ ™ =l éi?ﬁiﬁ?ﬁsem
12:Design Combination i
from the model and results panels — fhre = o = k=l i
= I £D)9:HE lower, HA + KELupper 0 ﬂ
and press the Add to button to %1210&5@1 Combination (M) 0
. :Design Combination (Min
add them into the Included panel and @igﬁvefofdsmlﬁpe(m ; =
C|iCk NeXt @ll:Live Load Envelope {Min) 0

T | I
e On the Results Entity dialog, select
entity Force/Moment - Thick
Grillage, type Component and
location Gauss Point. Ensure Primary component My is selected.

« Back | Mext = | FEiriish | Cancel | Apnly | Help |

e Set the number of decimal places to 1 and click the Finish button to display the
results.
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Save the model

|Fi|k;ave— & e the modet fite.

Note. If the model file is saved after results processing, all load combinations,
/ envelopes, and graph datasets, if defined, are also saved and therefore do not have to be
re-created if the model is amended and a re-analysis is done at a later date.

This completes the example.
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Description

Simple Slab Deck

For software product(s): | LUSAS Bridge.
With product option(s): | None.

Description

A simply supported bridge structure consisting of an in-situ slab deck is to be analysed.
The geometry of the deck is as shown. The slab has 0.5m thick carriageways and 0.4m
thick footways.

>

1.5m—

Fl.BmH?mHl.Sm#
C - )

0.5m

Slle

o
~

m

The structure is subjected to loading defined in the Departmental Standard BD 37/88
Loads for Highway Bridges.

The units of the analysis are kN, m, t, s, C throughout.
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Modelling

Simple Slab Deck

Objectives

The required output from the analysis consists of:

O A deformed shape plot showing displacements caused by the imposed loading
O A diagram showing the bending moments in the slab

Keywords

2D, Shell, Bridge Loading, Moving Load, Eccentricity, Basic Load Combination,
Load Envelope, Peak Values, Deformed Mesh, Contours, Graphing, Wood Armer

Associated Files

U bridge_slab_modelling.vbs carries out the most of the modelling of the
example. After running the script go to the heading entitled Assigning the
Moving HB Vehicle Load and continue from this point.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file. Modeller will prompt for any unsaved data and display
the New Model dialog.

Creating a new model

e Enter the file name as bridge_slab

e Use the Default working folder.

e Enter the title as Simple Bridge Slab Analysis
e Change the model units to kN,m,t,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the Startup template Standard.
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Modelling

e Select the Vertical Z axis option and click OK

Note. It is useful to save the model regularly as the example progresses. Use the undo
button to correct a mistake. The undo button allows any number of actions since the last
save to be undone.

Defining the Material

o Select material Concrete grade Ungraded from the drop down list and click OK to
add the material attribute to the &% Treeview.

e Select the Isol (Concrete Ungraded) attribute from the & Treeview with the
right-hand mouse button and select Set Default to make concrete the default
material for all newly created features.

Feature Geometry

il Enter coordinates of (0, 0), (10.5, 0) to define the lower Line. Use the Tab key to
move to the next entry field on the dialog. With all the coordinates entered click the
OK button.

e Select the line.

él Sweep the line through a translation of X=-1.5, Y= 1.5, Z = 0 and click OK to
create a Surface which defines the lower footway.

o Select the Line at the top of the footway.

él Sweep the Line through a translation of X= -7, Y= 7, Z= 0 and click OK to create
a Surface which defines the carriageway.

e Select the Line at the top of the carriageway.

él Sweep the Line through a translation of X= -1.5, Y= 1.5, Z= 0 and click OK to
create a Surface which defines the upper footway.

Meshing

The slab deck will be meshed using a Surface mesh. The number of elements in the
mesh can be controlled, by defining Line meshes, on the Lines defining the Surface
boundary. Other methods of controlling mesh density are also available.
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Defining a Surface Mesh

e Select a Thick shell element type which is Quadrilateral in shape with a Linear
interpolation order.

e Ensure a Regular Mesh that will allow Transition, Irregular and Automatic
meshing if possible.

e Enter the mesh attribute name as Thick Shell

o Click the OK button to add the mesh attribute name to the &b Treeview.
To assign the mesh to the model all features must be selected:

e Select all the features of the model, (the shortcut is to press the Ctrl and A keys at
the same time).

e Drag and drop the Surface mesh attribute Thick Shell from the & Treeview onto
the selected features.

The mesh will be displayed with each Line being split according to a default number of
divisions.

Note. One way of controlling the mesh density is by specifying the number of mesh
divisions along each Line. Since Modeller is fully associative, this will control Surface
mesh density.

Using Line Mesh Divisions

In this example 8 divisions per Line are required for the longitudinal Lines and
transverse Line representing the carriageway. A number of Line mesh divisions are

defined by default. These can be seen in the &b Treeview.

e Select the 4 Select these 6
longitudinal Lines as Lines for

shown. Hold the Shift 'Divisions=8'
key down after @ ;

selecting the first Line
to add the other Lines I .

to the selection. \‘K\ @

e Still holding the Shift
key select the 2
transverse Lines of the ! >)\A\
surface representing the b
carriageways.

ki
ey
v
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Modelling

e Drag and drop the Line mesh attribute Divisions=8 from the & Treeview onto the
selected features.

The mesh will be re-displayed to show 8 mesh divisions along each selected line.

Note. Holding down the L key while selecting ensures that only lines will be
selected. Similarly the P key limits the selection to Points, the S key; Surfaces, the V
key; Volumes and the G key; Geometry. Similar shortcuts exist for elements, nodes,
etc., which can be found in Modeller Manual.

Defining the Thickness and Eccentricity

The slab is 0.5 m thick in the carriageway region and 0.4 m thick beneath the footways.
o Enter a thickness of 0.5 and leave the eccentricity field empty.
e Enter the attribute name as Thickness 0.5

e Click the Apply button to define the first geometry attribute and allow another
dataset to be defined.

e Change the thickness to 0.4

Eccentricity measured Element local z axis
from mid surface of
0.4m thick slab to nodal
line in element local z
direction.

Nodal line at
Mid surface of slab cgntre of 0.5m
in footw ay region thick slab

Note. The direction of the eccentricity is measured from the mid-surface of the slab to
the nodal line in the local element direction which follows the local surface direction.
Since in this example the mid-surface of the slab representing the footway is above the
nodal line, and the element local Z axis direction is vertically up, the eccentricity is
input as negative.

e Enter the eccentricity as -0.05
e Change the attribute name to Thickness 0.4

e Click the OK button to finish.
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| Local Coordinate. ..

The thickness is now assigned to each Surface.

e Select the Surface representing the carriageway.

e Drag and drop the geometry attribute Thickness 0.5 from the &b Treeview onto the
selected surface.

Geometric assignments are visualised by default.

e Select the two footway Surfaces, (hold down the Shift key to add the second
Surface to the selection).

e Drag and drop the geometry attribute Thickness 0.4 from the &b Treeview onto the
selected surfaces.

El Select the isometric

button to see the geometric
visualisation on the
members.

El The Zoom in button

can be used to check the eccentricity has been assigned correctly.

@l Select the Home button to return the model to the default view.

ll Select the fleshing on/off button to turn-off the geometric visualisation

Supports

The more common types of support are provided in the &b Treeview by default. In this
example the slab deck is to be restrained in the vertical and lateral direction at the
abutment edges, Additionally, a single pinned support will be assigned to one point on
the deck to prevent rigid body motion.

Before the supports can be assigned a local coordinate system needs to be defined so
the lateral displacement can be restrained in the skew direction along the length of the
abutment edges.

e Enter an angle of 45 for the rotation about the Z-axis.

e Enter the dataset name as Skew and click OK to add the Local coordinate attribute
to the c&: Treeview.

e By default the new Skew local coordinate system, is visualised within the view
global axes.
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To assign the abutment supports:

e Select the Six Select these 6 Lines
transverse Lines

representing the end L ™,
diaphragms  (ensure N Y

the Shift key is used ™~ AN
L Y ™,
to add to the initial \q{\
selection) ™.
e Drag and drop the hN

‘\\
local coordinate % '\@

attribute Skew onto o S Y *
the selected Lines.

o Drag and drop the support attribute Fixed in YZ onto the selected Lines.
The Assign Support dialog will be displayed.

e Ensure that the attribute is assigned to All analysis loadcases

e Click the OK button to finish.

To assign the pinned

support: N v
. _ N N

e Select the single Point ‘\_\ ‘\\

at the origin
J N \

e Drag and drop the \\\ \\\
support attribute . ! ™.
Pinned onto the 2 M
selected Point. Select this Point [ ) ¥—&E ™

The Assign Support dialog
will be displayed.

e Ensure that the attribute is assigned to All analysis loadcases

e Click the OK button to finish.

Note. Since the slab is flat the in-plane rotation degrees of freedom for the thick shell
elements can be eliminated from the element formulation by deselecting the following
element option. This will remove ill-conditioning of the equations and reduce the
problem size. It should however be noted that if moment supports are to be applied with
this option deselected, rotation about the Z axis must be restrained to eliminate
mechanisms in the solution.
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|Bridge Loading >
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| Bridge

|Bridge Loading >
United
Kingdom. ..

Simple Slab Deck

e Select the Solution tab and select the Element Options button. Deselect the option
to Assign 6 DOF to all thick shell element nodes and click the OK button to
return to the Model Properties, Click OK to return to the display.

Defining the Loads

Four loadcases will be defined:

U The self-weight of the slab (ignoring any surfacing loads).

O A patch load equivalent to a traffic load over the full length and width of the
upper traffic lane.

U A knife edge load acting at mid-span of the upper lane.
O An HB vehicle in the lower lane.

Self-weight

The self-weight is defined using an acceleration due to gravity in the negative Z
direction. The correct units are automatically calculated when the gravity loading is
selected from the Bridge menu.

Lane Load

The second load will represent a lane load along the upper traffic lane.
e From the Vehicle Loading dialog select the Lane load (HA Load) button.
e Select loading code BD37/88 from the pull-down list.

e Enter the loaded length as 10.5, leave the notional width set as 3.5, set the skew
angle as -45 and the origin as Centre, then click OK to add the lane load patch

loading to the &b Treeview.

Note. Setting a skew angle on this patch load does not skew the whole load — it only
skews the ends of the patch load to match the angle of the skewed deck.

Knife Edge Load
e From the Vehicle Loading dialog select the Knife edge load (KEL load) button.

e Leave the skew angle as 0 and click OK to add the lane load patch loading to the
& Treeview.
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Modelling

Abnormal Loading

e From the
Vehicle Loading | ehicle details

dialog select the D L
Abnormal _ P B
Load (HB Inner axle spacing [m) Iﬁ o -BIE—-—EE _____ E};-._EI;_
Vehicle) button. Nurber of HE Lrite (25 - A — B
(25 - 45) |45— Tm 'Eia"'aﬁ'___'%' 'Eia'
e Leave the Axle 18m|£11,16,21.26 m18m
spacing as 6

and the Number

of HB units as ok | cancel sooh | Heb |

45 and click OK
to add the HB

vehicle point load to the FoTreeview.

e Select Close to close the Vehicle Loading dialog.

Assigning the Self-weight Load

e To assign the gravity loading select all active features using the Ctrl + A keys
together and drag and drop the loading attribute BFP1 (Gravity -ve Z) from the
& Treeview onto the selected features.

The Loading  Assignment [EEXTrl e i
dialog will be displayed.
[ Assign to points [V Assign to surfaces
° EnSUre that the Assign to [ Assign to lines [T &ssign bo valumes
Surfaces button is selected :
. " allloadcases Analysis | Analysis 1 j
and click the OK button to I
aSSign the |Oad to AnalySiS ¥ single loadcase  Loadcase I 1:loadcase 1 j
1 Loadcase 1. More =3 | ¥ | 5et a5 active [nadcase
The load visualisation for ok | cancel | b |
Loadcase 1 will be displayed.

e To rename Loadcase 1 in the (X! Treeview expand Analysis 1 and select Loadcase
1 with the right-hand mouse button, then choose the Rename option. Overtype the
loadcase name with the name Self Weight

Assigning the Lane Load and Knife Edge Loads

Vehicle and lane loads are represented by patch loads that are assigned to Points which
may form part of the model, or may be defined specifically to locate the bridge loads as
in this case:
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Point >
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El Enter coordinates as (-1.5, 6.75) and click the OK button to create a new Point in
the middle of the upper lane.

e In the Treeview move the Geometry layer name down to sit beneath the
Attributes layer so that the point defined can be seen.

The patch and knife edge loads can now be assigned to the Point that has just been
defined.

e Select the Point defined at the centre of the upper traffic lane.

e Drag and drop the loading attribute Pchl (HA BD37/88 10.5m x 3.5m Skew= -
45.0deg (Centre)) from the & Treeview onto the selected Point.

The Loading Assignment dialog will
Patch transformation
appear' Mo Attribute Selected = |

The loading option to Project over area LINd:mh“’ES‘:Ed 5
will have been automatically selected.

Search area

IWhu\e model j

e Overtype the name of the loadcase to
be HA & KEL upper  Project onto line (2D line beam and frame madels)

™ Ignere projection direction moments

& Project over area (grilages, slabs and 3D space frames)

e Click on the OK to complete the W T )

H Options for loads outside search area | Excude All Load -
assignment. 5
The patch load will be visualised on the C -
model. Lomd Facter [10

l—
oK I Cancel | Help |

Note. The number of patch load

divisions in the patch is set in the ¥ Patch divisions object. By default ten patch
divisions are used in the long direction of the patch. For more detailed information on
discrete point and patch loads refer to the on-line help.

e Drag and drop the loading = .
attribute Pch2 (KEL 120kN =5 & oo s ™0
Width=3.5m Offset=0 NS TR AT
Skew=0.0deg (Centre)) from S \Q\i\\'\}\ \
the & Treeview onto the \\ \\\
selected Point. X .
\\ - \"\.
e  Select the loadcase name HA & S .
KEL upper from the loadcase N o

drop down list and click the
OK button to assign the load.

The assigned patch loading for the upper lane should be as shown.
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| Line

| Coordinates...

| Bridge

>

|Moving Load...

Note. In this example the patch loading has been shaped to match the skew of the
deck but it could have alternatively been defined oversize in length and when assigned
to the model any loading outside of the model could have been excluded as necessary.

If rebuilding a model, or creating a model using the
supplied file.

If a previous analysis of this example has failed you need to return to this point to
continue after having run the supplied file stated.

If you created the model using the supplied associated file you need to continue from
this point to complete the modelling required..

Assigning the Moving HB Vehicle Load

The HB vehicle will be assigned to the points using the moving load generator. To use
this facility a line defining the path of the vehicle must be created.

e Click on a blank area of the model window to clear the current selection.

il Enter coordinates of (-3.25, 3.25) and (7.25, 3.25) to define a Line describing the
path of the HB vehicle and click OK

e  Select the Line just defined.
e  Ensure the Moving vehicle load is set to Pnt3: (HB 6m spacing 45 units)

e Set the option Move the vehicle along path in equal number of divisions to 10
and click OK to generate loadcases 3 to 13 representing the HB load moving
forward across the bridge.

@l The isometric view button can be used to rotate the model so the load directions
can be visualised.

Checking loading s &N

Loads on the model may be visually \\ \\

checked at any time by changing the N AN

. N N
active loadcase. S TR
LN Y

e From the 2 Treeview select o i
Load ID=3 Line=17 Pos=6, Nl EN
click the right-hand mouse AN
button and select the Set Active option to see the mid-span position of the moving
load.
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| Save

This process may be repeated for any loadcase.

Saving the Model

The model is now complete and the model data should be saved before running
analysis.

El Save the model file.

Running the Analysis

A

With the model loaded:

El Press the Solve Now button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful
Analysis loadcase results are added to the @ Treeview.

In addition, 2 files will be created in the Associated Model Data directory:
U bridge_slab.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U bridge_slab.mys this is the LUSAS results file which is loaded
automatically into the (&) Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O bridge_slab_modelling.vbs carries out the modelling of the example.
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Viewing the Results

[New...

| File

|Script

| Run Script...

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as bridge_slab and click OK

To recreate the model up to the point of defining the moving load, select the file
bridge_slab_modelling.vbs located in the \<LUSAS Installation
Folder>\Examples\Modeller directory.

Now return to the section entitled Assigning the Moving HB Vehicle Load earlier in
this example and continue from this point.

Viewing the Results

[ View

| Page Layout Mode

[ File

| Page Setup...

Loadcase results can be seen in the @ Treeview, and the loadcase results for the last
solved loadcase (HA + KEL upper) is set active by default.

The results will be examined. For this problem the following are required:

U A plot of the deformed mesh.

O A colour-filled contour plot of bending moments in the X direction due to a load
combination.

U A graph showing the variation of bending moment along a section of the slab.
O A contour plot of Wood-Armer reinforcement moments in the slab.

Using Page Layout Mode

The model was created using a Working Mode view which allows a model of any size
to be created. Results could be viewed using this mode of operation, but in order to
allow additional information to be added without obscuring the model, Page Layout
Mode can be used instead.

The graphics window will resize to show the model on an A4 size piece of paper in
landscape orientation.

e Ensure that left, right top and bottom margins are set to 60, 10, 10 and 10
respectively and click OK

To plot a deformed mesh the Attributes and Mesh layers will be hidden.

e Click the right-hand mouse button on the Attributes entry in the 5 Treeview and
select the On/Off option. The geometry will be hidden from the display.

127



| Window
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e Repeat to turn off the Mesh layer.

@I If necessary, use the Isometric view button to rotate the model to the view
shown.

Note. When required, the local coordinate system axes can be turned off by
deselecting the Show Definition option for the Skew entry in the &b Treeview.

This page layout view can be saved for subsequent re-use with other models.

Enter the view name as Landscape Page Layout and click OK

Displaying the deformed shape
o Inthe "= Treeview right-click on Self Weight and select the Set Active option.

e Inthe =" Treeview turn-off the display of the Geometry layer.

e With no features selected
click the right-hand mouse
button in a blank part of the
Graphics Window and select
the Deformed mesh option

to add the deformed mesh layer to the [=¥ Treeview.

e Click the OK button to accept the default deformed mesh properties values.

The deformed mesh plot for the first loadcase will be displayed.

Contour Plots
Results can be plotted as colour line or filled contour plots. Here, longitudinal bending
moments will be plotted as colour filled contours.

£ 1 Return the model to the default starting view by pressing the Z axis field
on the status bar at the bottom of the graphics window.
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Viewing the Results

e With no features selected click the right-hand mouse button in a blank part of the
graphics window and select the Contours option to add the contours layer to the

Treeview.
The contours properties dialog will be displayed.

e Select Entity Force/Moment -
Thick Shell Component
moments in the X direction Mx

e Click the OK button to display
contours of moments in the X
direction.

Re-ordering the display of the layers

Note. The order of the layers in the Treeview governs the order in which the
layers are displayed in the graphics window with layer names at the top of the list drawn
to the screen first. To see the mesh layer on top of the contours layer the mesh layer
needs to be moved down the [ Treeview to a position after the contours layer.

o Inthe G Treeview select the [
Deformed mesh layer, click =
the right-hand mouse button
and select the Move Down
option. (This can also be
done by dragging and
dropping a layer name on top
of another layer name).

Note. Contours of results may be displayed which are either averaged at the nodes, to
give a smoothed contour display, or unaveraged to contour on an element by element
basis. Unaveraged nodal results are useful for checking for sufficient mesh refinement
(since they will display inter-element discontinuities in the solution). They are also used
to prevent the averaging of stresses across elements with dissimilar material or
geometric properties. By default contours are smoothed.

Moving information on the annotation layer

Text and other objects such as the contour key may be moved after their initial
placement.
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Envelope
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e Click on one of the items of text on the contour key. (This will select the key and
enable it to be moved).

e Click and drag the object to a new position on the left-hand margin of the page.

Marking Peak Values

e  With nothing selected click the right-hand mouse button in a blank part of the

graphics window and select the Values option to add the values layer to the
Treeview.

The values properties dialog will be displayed.
e Select Force/Moment - Thick Shell contour results of bending moment Mx

e On the same dialog, select the Values Display tab and ensure the Maxima and
Minima check boxes are selected to display the top 1% of results.

e  Set the number of significant figures to 4
e Change the angle to 45 degrees
e Select the Choose Font button and set the text size to 16 and click OK

e Click the OK button to add
the peak values to the
display. Note that on the
diagram shown right the
mid-span values have been
artificially coloured white in
order to be visible when
printed.

The contour layer could have
been be turned-off to view the
values.

Defining an Envelope

Envelopes are used to automatically assemble the worst effect from a selection of
loadcases, combinations, or other envelopes. In this example an envelope is to be
assembled to show the worst effect from the moving HB vehicle.

To include just the moving load loadcases in the envelope:

e With Analysis 1 selected from the drop-down list select (3) Load ID=3 Line 17
Pos=1 Dir=Fwd from the loadcase panel. To select all HB moving loadcases hold
down the Shift key, scroll down the list and select (13) Load ID=3 Line 17
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Basic Combination

Viewing the Results

Pos=11 Dir=Fwd and click on the il button to add all the selected datasets to
the Included panel.

e Change the name to Moving load lower and click OK

e Two envelope attributes representing the maximum and minimum results will be
created in the ©= Treeview.

Note. Changing the properties of the max or min envelope will change the definition
of both envelopes.

Defining a Combination
Combinations can be used to view the combined effects of several results loadcases,
combinations or envelopes.

The combination properties dialog will appear. Loadcases Self Weight, HA & KEL

upper and the moving load envelope are to be included in the combination.

e With the model file selected from the drop-down list select both Self Weight and
HA & KEL upper from the Name panel and click the il button to add the
loadcases to the combination dataset with a factor of 1

e From the bottom of the loadcase name panel select the envelope Moving load

lower (Max) and click the LI button to add the loadcase to the combination
dataset

Note. By default loadcases are added to the combination with a factor of 1. This
factor may be changed by selecting the loadcase in the Included panel and changing the
load factor in the text box provided. Alternatively the factors may be changed in a grid
by selecting the Grid button.

e Change the combination name to Max Design Combination and click the OK
button to finish.

Note. To obtain the correct effect from the combined loads the combination should
only include one occurrence of each loadcase. Envelope and Combination definitions
are held and saved within the model file.

Selecting and Viewing the Combination Results

o In the & Treeview right-click on Max Designh Combination and select the Set
Active option.

e Select Force/Moment - Thick Shell results of component Mx and click OK
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The contour plot for Mx from the
load combination will be
displayed.

Note. The values layer is still

listed in the Treeview so the
maximum and minimum values of
Mx for the load combination will
also be shown.

Graphing the Results of a Slice

A graph is to be plotted showing the variation in bending moment through a specified
section of the slab.

If the model is in the XY plane the By Cursor dialog will appear.
e Ensure that Snap to grid is selected with a grid size of 1
e Click the OK button.

e Click and drag the cursor along the centre of the lower lane (Y=3) to define the
location of a section slice through the slab.

Note. The Y ordinate of the slice can be seen in the status bar I'1:3 . The X
and Y scales on the sides of the window will also help this selection.

The graph X axis values of distance through the deck are defined by the slice section.
The graph Y axis results now need to be specified on the slice data dialog.

e Select Force/Moment - Thick Shell results for Bending Moment in the X
direction Mx and click the Next button.

The graph Y axis results have now been defined and title information for the graph can
be added.
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Enter the graph title as
Bending Moment Mx
along lower lane

Leave the graph X and Y
axis names blank.

Click the Finish button to
display the graph.

Bending moment M along lower lane

Mtz - 16:Max Design Combination(2)

[y BTy I Ne N T e B S Tw Rt R We R w Ty N ST R ¥ R
[=} — [ o -+ i} [t} [ o

Coordinates (-6,3,0) to (8,3.09(1)
—8— My - 16:Max Design Combination() / Coordinates (-6,3 0) to (3,3,0)(1)

Note. If the graph axes labels are left unspecified default names will be used.

Note. The graph properties can be modified by clicking the right hand mouse button
/ in the graph window and selecting the Edit Graph Properties option.

E Close the graph window.

il Click on the selection mode button to return to normal cursor mode.

Wood Armer Reinforcement Plots

In the = Treeview double-click on the Contours layer.

The contour properties dialog will be displayed.

With the Force/Moment - Thick Shell entity selected, select Component My(B)
to display results of Wood Armer moments in the Y direction in the bottom of the

slab.

Click the Wood Armer button.
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e On the Wood Armer Options dialog Transverse
enter a Reinforcement skew angle of Reinforcement
135 degrees. Direction

e Click the OK button to return to the 1350 Longitudinal
contour properties dialog. Reinforcement
Direction

e Click the OK button to display a plot of
Wood Armer contours of My(B) for the +ve
active combination.

Note. Specifying the distance from top or bottom surface to centre of top or bottom
reinforcement is only used when plotting contours of M[UtilB] or M[UtilT]

Caution. The selected results component (My(B)) is different to that being used to
compute smart combinations and/or envelopes (Mx) and therefore the results displayed
will be coincident effects.

e Click the OK button to accept this.

Caution. The contour plot will show bending moment contours My(B) but the

Values layer will currently show values of bending moments in the X direction. i.e. Mx

since these were specified previously.

e Click Yes to change the éf,\ AV

k)

values layer to show >

maxima and minima

values of My(B).

Save the model

El Save the model file.

Note. When the model file

is saved after results processing, all load combinations, envelopes, and graph datasets, if
defined, are also saved and therefore do not have to be re-created if the model is
amended and a re-analysis is done at a later date.

This completes the example.

A separate example covers Wood Armer slab assessment in more detail.
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Use of an irregular mesh and transformation of resulits

In this example the geometry and mesh attributes result in a regular mesh aligned to the
global axis.

The use of an irregular mesh would mean that the results used for the Wood-Armer
plots will have different orientations over the whole slab and hence be incorrect. In this
circumstance a local coordinate set would need to be used to orientate the shell element
results to be consistent with the global axes in order to obtain sensible components for
use in the calculations.

e The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

e Results transformations can be applied from the Treeview. Press
Transformed... and select Global axes to transform local element results into the
global axes.
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Description

Wood-Armer Bridge
Slab Assessment

For software product(s):

LUSAS Bridge.

With product option(s):

None.

Description

A Wood Armer slab

11.3 degree skew angle

assessment is to be v
carried out on a 15m 1.25
long, 9.8m wide single | ¢—— 7 e

span, reinforced f I Upper lane

concrete bridge deck. < Boundaries of Palltch loads ————»/ 3.65

The deck has a skew
angle of 11.3 degrees
and is 0.9m deep.

v

I Positions of Knife

A load combination Lower lane " edge loads

comprising self [ """ 71.25
weight, upper and

lower lane loads, and ‘L 15.0 >}

upper and lower knife
edge is to be created
from  the  results

All dimensions in metres

obtained. Slab reinforcement is to be arranged orthogonally and has capacities of 1700
and 300 kNm in the chosen Mx and My directions.

Units of kN, m, t, s, C are used throughout.

Note. In order to create a generic example, no reference is made to any particular
design code or loadcase type.
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Modelling

Wood-Armer Bridge Slab Assessment

Keywords

2D, Simple Slab, Skew Angle, Wood-Armer Reinforcement, Wood-Armer
Assessment, Safety Factors, Self Weight, General Loading, Knife Edge Loading,
General Patch Loading, Combination, Contour Plotting, Display Peak Values.

Associated Files

O wood_armer_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as wood_armer

e Use the Default working folder.

e Enter the title as Wood Armer Slab Example

e Select model units of kN,m,t,s,C from the drop-down list provided.
e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Ensure the Standard startup template is selected

e Select the Vertical Z axis option

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.
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| Geometry
[Surface >
Coordinates...
| Geometry
Line >
Copy...
| Geometry
Line >
Copy...

Modelling

Feature Geometry

_I Enter coordinates of (0, 0), (15, 0), (16.96, 9.8) and (1.96, 9.8) and click OK to
define the slab as a single Surface.

Next, the edge of carriageway and - .
lane widths will be defined by

copying the lower Line of the main

span.

e Select the lower horizontal Line Select this Line

of the model.
M Enter the X translation as 0.25 ﬂ

[derived from 1.25*tan(11.3°] .

e Enter the Y translation as 1.25 metres, and click the OK button.
The edge of the lower carriageway will be drawn.
To define 2 notional lane widths of 3.65 metres.

e Select the Line just drawn.

[Tl Enter the X translation as 0.73
[derived from 3.65*tan{11.3°}]

e Enter the Y translation as 3.65

metres. @ Select this Line
e Enter the number of copies as 2

|2
==

e Click the OK button to finish.
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| Attributes
Mesh >
Surface...
| Attributes
Geometric >
Surface...

Wood-Armer Bridge Slab Assessment

Meshing

e Select Thick plate, *
Quadrilateral, elements with JF
Linear interpolation. ;’ }( }[ ,{ ){ ,'[ f ,{ ){ }( [r
/

o Deselect the automatic
divisions option and enter 10 A R R i

divisions in the local X jf ,/ ,r' )‘r f f f )‘fj ,‘rf f }"r
[ ] /

direction and 7 divisions in the sf J{ }( jlr
local Y direction. S .

. IR EED,
e Enter the attribute name as i
Thick Plate and click the OK button to finish.

LUSAS will add the Surface mesh attribute to the & Treeview.

e Select the whole model using the Ctrl and A keys together.

e Drag and drop the Surface mesh attribute Thick Plate from the & Treeview onto
the selected features.

Note. At any time the mesh (and other features) displayed in the Graphics area may

be turned on or off by right-clicking on the layer name in the l=* Treeview and selecting
the On/Off option.

e Turn off the display of the Mesh as just described.

Geometric Properties

o M Open the Units Convertor and Variation
Utility from the Thickness textbox.  [uit convertor

Convert from

e Convert from 900, selecting mm to convert [rm |
900mm to model units. Press OK to return.

To model units
|n.9 |m

e Enter the attribute name as Thickness 0.9.
Click OK to add surface geometry attribute to ~~ _+f ="t
the &b Treeview. ok | concdl | hep

e Select the whole model.

e Drag and drop the geometry attribute Thickness 0.9 from the & Treeview onto the
selected features.
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| Attributes

Modelling

| Material >
| Material Library. ..

!l Select the fleshing on/off button to turn-off the geometric visualisation. If at any
time during the example you wish to visualise the geometry select this button.

Material Properties

e Select material Concrete from the drop down list, leave grade as Ungraded and
click OK to add the material attribute to the &% Treeview.

e With the whole model selected, drag and drop the material attribute 1sol (Concrete

Ungraded) from the & Treeview onto the selected features, ensuring that Assign
to surfaces is selected click OK

Supports

LUSAS provides the more common types of support by default. These can be seen in

the &b Treeview. Both inclined edges of the slab are to be simply supported in the Z
direction.

Assigning the Supports

e Select the 2 inclined Lines at
either end of the slab. (hold the
Shift key down to add to the first
selection).

&

Select these
Lines

e Drag and drop the support
attribute Fixed in Z from the
Treeview onto the selected
features.

[, |
e Ensure Assign to lines and All
analysis loadcases are selected and click OK

The supports will be visualised.

Loading

Five loadcases will be considered, with an additional two combinations of these loads
created at the results processing stage.
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Modifying the Geometry to assign loading

To position knife edge loads additional Points are required at mid-span positions.

e Select the 3 horizontal Lines that
define the traffic lane
boundaries. (Hold the Shift key

Select these 3 Lines

down to add to the selection) |
| Geometry e Select Use same divisions for
IM all lines and enter the number of
[By Spieing__ > divisions required for all as 2
In Equal
Divisions... - .
SVSRSs—— o Ensure the Delete original lines @
after splitting option is selected
and click OK e |
Additional Points will be created at
mid-span and existing Lines will be broken into 2 new Lines. The new Points will be
used later to define the position of the mid-span knife edge loads for each traffic lane.
Loadcase 1 - Self weight
| Attributes e Select the Body Force option and click Next
| Loading....

* Define the linear acceleration due to gravity in the Z direction as -9.81
e Enter the attribute name as Self Weight and click Finish

e With the whole model selected, drag and drop the loading attribute Self Weight

from the &% Treeview onto the selected features ensuring the loading is assigned to
Surfaces as Loadcase 1 and click OK

The self weight loading will .
be displayed.

L‘—‘—“

e In the ™ Loadcases
Treeview expand Analysis
1 then right-click on .
Loadcase 1 and select the
Rename option.

e Rename Loadcase 1 to i@
Self Weight i

W
o
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| Attributes

Loading...

Modelling

Loadcase 2 - Lane load (lower lane)

The coordinates of the
Points selected will be °

inserted into the coordinate

Select the first point, » -
hold down the Shift key f . JT
anq select point 2, 3 and 3. Select this Point
4 in the order shown to _ _

define the patch area. @4. Select this Point

In the Discrete panel
select the Patch option
and click Next

MJ

fields. 1. Select this Point 2. Select this Point

Enter a load value of -15 (kN/m?) for each coordinate.

De-select the Use default button in the Patch load divisions panel and enter 15 in the
x direction and 0 in the y direction so that the number of loading points in the patch
y direction will be computed automatically from the aspect ratio of the patch.

Enter the attribute name as Lane load (lower) and click Finish

Note. The order in which the Points are selected determines the local x and y
directions of the patch load. The local x direction is from the first Point to the second
Point selected. The local y direction is from the second to the third Point.

Select the Point shown at
the origin of the

structure.
Drag and drop the

loading attribute Lane _

l9ad (lower) from the Select this P'oint to

& Treewgw onto  the assign Patch Loading

selected Point.

Ensure  Options for oo ) I

loads outside search
area is set to Exclude all
load

[
p—

Enter the loadcase as Lane load (lower) with a load factor of 1 and click OK

The loading will be displayed.
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| Loading...

Wood-Armer Bridge Slab Assessment

Note. Because the coordinates of the patch load were taken from the coordinates of
the Points, the patch load must be assigned to the Point at the origin of the structure.

Loadcase 3 - Lane load (upper lane)

e Select the Points in the
order shown to define the
patch area for the upper
lane.

3. Select this Point d

i
e In the Discrete panel / 4. Select this Point

select the Patch option -

and click Next 2. Select this Point
The coordinates of the 1. Select this Pomt
Points selected will be % I
inserted in the coordinate
fields. Assign patch load to this Point

e Enter a load value of -15
(kN/m?) for each coordinate.

o De-select the Use default button in the Patch load divisions panel and enter 15 in the
x direction and 0 in the y direction.

e Enter the attribute name as Lane load (upper) and click Finish

e With the Point at the origin of the structure selected, drag and drop the loading
attribute Lane load (upper) from the &% Treeview onto the selected Point.

e Ensure Options for loads outside search area is set to Exclude all load

e Enter the loadcase as Lane load (upper) with a load factor of 1 and click OK
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Modelling

Loadcase 4 - Knife edge load (lower lane)

e Select the Points in the
order shown to define the

knife edge load position )
for the lower lane. 2. Select this Point

1. Select this Point

e In the Discrete panel
select the Patch option
and click Next

e Select the Straight Line @

option. [@ Assign Knife load to this Point. I

The coordinates of the
Points selected will be inserted in the coordinate fields.

e Enter a load value of -32.24 (kN/m) for each coordinate.

o De-select the Use default button in the Patch load divisions panel and enter 15 in the
x direction.

o Enter the attribute name as Knife edge load (lower) and click Finish

Note. The order in which the Points are selected determines the local X direction of
the knife edge load. The Local X direction is from the first Point to the second Point
selected.

¢ With the Point at the origin selected, drag and drop the loading attribute Knife edge
load (lower) from the & Treeview onto the selected Point.

o Enter the loadcase as Knife edge load (lower) with a load factor of 1 and click OK

Load case 5 - Knife edge load (upper lane)

e Select the Points in the order shown 2 Select this Point

to define the knife edge load I J
position for the upper lane. .
i . 1. Select this Point
e Select the Discrete Patch option / @ /
and click Next

e Select the Straight Line option. _ _ o j
Assign Knife load to this Point.

)y

The coordinates of the Points selected
will be inserted in the coordinate fields. ke

e Enter a load value of -32.24 (kN/m) for each coordinate.
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Save

Wood-Armer Bridge Slab Assessment

e De-select the Use default button in the Patch load divisions panel and enter 15 in the
x direction.

e Enter the attribute name as Knife edge load (upper) and click Finish

e With the Point at the origin selected, drag and drop the loading attribute Knife edge
loading (upper) from the & Treeview onto the selected Point.

e Enter the loadcase as Knife edge load (upper) with a load factor of 1 and click OK

Visualising Loadcases

Loadcases can be visualised at any j f

time by activating each loadcase in the A

(& Treeview.

o From the ‘E Treeview select the .

- LR B B B B A R

Lane_ load (lower) loadcase, click 4 3 5 b s 5 b s s b e s s s s
the right-hand mouse button and b e b b e b b s e s s oa
select the Set Active option. Mo b 6 4 4 4 4 5 4 6 4 0 b b 9

Saving the model

El Save the model file.

Running the Analysis

A

With the model loaded:

El Press the Solve Now button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (5 Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U wood_armer.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.
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[New...
| File
| Script >
| Run Script...

Running the Analysis

0 wood_armer.mys this is the LUSAS results file which is loaded
automatically into the () Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

0 wood_armer_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as wood_armer and click OK

e To recreate the model, select the file wood_armer_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results.
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Viewing the Results

Combinations

A combination will be created to apply the ultimate limit state (ULS) factors and lane
factors to loadcases 1 to 5. Typical ULS and lane factors can be found in relevant
design codes.

Dead load factor ULS
combination Loadcase Factor Factor
Calculation
U Dead load factor yp = 1.15 Self weight Yo X Vs 1.265
U Additional factor v = 1.1 Lane load By X Y1 X Vs 165
(lower)
Lane load Bo X va X Vi3 1.65
Live load factors for ULS (upper)
combination Knife edge load | B1 X va X i3 1.65
O Lane factors ;=10 and [(1OWeD
B, =1.0 Knife edge load | B2 X ya X Ys3 1.65
U Live load factor yq = 1.5 (upper)

U Additional factor v = 1.1

Defining a Combination

Combinations can be created to view the combined effects of multiple loadcases on the
structure. A combination dataset Combination 1 is to be created in the .= Treeview

| Analyses The combination properties dialog will appear. All 5 loadcases should be included in
|Basic Combination  the load combination panel.

e Select loadcase Self Weight hold the Shift key down, scroll down, and select Knife
edge load (upper).

e Click the LI button to add the loadcases to the combination dataset.

Note. To obtain the correct effect from the combined loads in this example the
/ Combination should only include one occurrence of each loadcase.
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Assigning load factors

¢ In the Included panel on the Combination dialog, select the Self Weight loadcase
and enter load factor of 1.265 in the load factor text box.

e For each of the other 4 loadcases, select each loadcase in turn and enter a factor of
1.65

o Select the Grid button to check all the factors are entered correctly and click OK to
return to the combination dialog.

¢ Click OK to create the combination dataset.

Selecting Loadcase results
o Inthe ‘= Treeview right-click on Combination 1 and select the Set Active option.
o If present in the =¥ Treeview turn off the Geometry and Attributes layers.

e Turn on the display of the Mesh layer in the [ Treeview.

Contour Plots

e With no features selected click the right-hand mouse button in a blank part of the

graphics window and select the Contours option to add the contours layer to the
Treeview.

The contour properties dialog will be displayed.

Moments in the X direction

e Select Force/Moment - Thick Plate contour results.
e Select the MX component.
e Click the OK button to display contours of MX for Combination 1.

e To display the mesh on top of the contours, select the Mesh entry in the
Treeview and drag on drop it on top of the Contours entry in the 5 Treeview.

149



Wood-Armer Bridge Slab Assessment

Marking Peak Values

e With nothing selected click the
right-hand mouse button in a
blank part of the graphics
window and select the Values
option to add the values layer to

the Treeview.

The properties dialog of the values
layer will be displayed.

e Select the Force/Moment — Thick Plate entity.
e Select the MX component.

e Select the Values Display tab and set Maxima and Minima values to display the
moments for the top 0.1% of results.

e Click the OK button to redisplay the contours with peak values marked.

Moments in the Y direction

e In the Treeview double-click
on the Contours layer.

e Select the Force/Moment -
Thick Plate entity.

e Select the MY component.

e Click the OK button to display
contours of MY for Combination
1.

Note. The values layer is currently displaying results for MX.

e Select Yes to change the values layer results to match those of the contours layer.
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Moments in XY direction

e Inthe Treeview double-
click on the Contours layer.

e Select the Force/Moment -
Thick Plate entity.

e Select the MXY
component. Click the OK
button.

e Select Yes to change the
values layer results to match
those of the contours layer.

Wood-Armer Reinforcement Moments

Note. For the following section, it is assumed that you are familiar with the theory of
Wood-Armer as an explanation is beyond the scope of this example. If additional
information is required consult the LUSAS Theory Manual. Initially, Wood-Armer
reinforcement moments Mx(B) in the bottom surface of the slab will be calculated.

Wood-Armer Moments in X direction of the bottom of the slab

¢ Inthe =" Treeview double-click on the Contours layer.

e Select the Force/Moment - Thick Plate entity.

e Select the MX(B) component to view contour of Wood Armer moments in the X
direction for the bottom of the slab. Click the OK button.

e Select Yes to change the values layer results to match those of the contours layer.

From the resulting Wood-Armer
plot it can be seen that the
maximum value of Mx(B) is
1545 KkNm. This value is
compared with the maximum
slab capacity (1700 kNm) to
determine the safe load carrying
capacity. In this case the slab
passes the assessment.
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Wood Armer Moments in Y direction of the bottom of the slab

The Wood Armer moments in the direction of the reinforcement on the bottom Surface
My(B), are now to be examined.

¢ Inthe = Treeview double-click on the Contours layer.

e Select the Force/Moment - Thick Plate entity.

e Select the MY(B) component to view contours of Wood Armer moments in the Y
direction for the bottom of the slab.

e Click the OK button.
e Select Yes to change the values layer results to match those of the contours layer.

The plot indicates a maximum
applied sagging Wood Armer
moment My(B) of 389 kNm
This exceeds the slab capacity of
300 kNm and therefore this slab
fails assessment.

Note. Normally the analysis
would be continued to calculate
the reduction in live load that
would be necessary to obtain a
situation where the applied moment My(B) equals the capacity of the slab My*(B). This
would result in a restriction in the load carrying capacity of the slab.

Wood-Armer - Discussion

It is generally accepted that the Wood-Armer equations when used in the assessment of
the load carrying capacity of slabs provide a safe but conservative estimate of the
structural capacity. It is possible to obtain significant improvements using alternative
equations based on the fundamental principles of Wood-Armer.

Note. A detailed explanation of the modified equations is beyond the scope of this
example, however the user may find it beneficial to consult the following references:

U Concrete Bridge Design to BS5400. L.A Clark. Published by Construction
Press. Appendix A. Equations For Plate Design.

U The Assessment of Reinforced Concrete Slabs. S.R Denton, C.J Burgoyne.
The Structural Engineer. Vol. 74. No. 9. May 7.

In outline, the method adopts a safety factor approach, where the user inputs the slab
capacity of the reinforcement and the reinforcement skew angle. Since the slab can
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Viewing the Results

potentially fail in flexure about any axis in the plane of the slab, the method examines
the applied moment field (Mx, My, Mxy) against the moment capacity field (Mx*,
My*, Mxy*) for all possible reinforcement skew angles.

The method returns minimum safety factors for top (hogging) and bottom (sagging)
reinforcement for each nodal position.

Note. Top and bottom safety factors are possible at any single position due to the
application of mixed moment fields.
Wood-Armer Assessment

o Inthe =" Treeview turn-off the Values layer.

e In the Treeview double-click on the Contours layer and select the
Force/Moment — Thick Plate entity.

e Select the MULil(B) component to select contours of Utility factors in the bottom of
the slab.

e Click the Wood-Armer button. oA Ot

& Wood-Armer (bending only)

Formulation
(] Oﬂ the WOOd'Armer OpthﬂS dla|Og ensure ’Vr' Clark-Hielsen (axial farce included)

the Reinforcement skew angle is set to 90 Renforcement skew angle [0
and the Distances to the centre of the Distance from top surface to center of top reinforcement | 0.0
rei nforcement are Set to 0l Distance from bottom surface to center of bottom reinforcement | 9.0

K Factor
K factor for non-minimised area of reinforcement | 1.0 ‘

W Assessment

The moment capacity of the slab in the

sagging and hogging zones needs to be Resstive momentfforce n the x-direction (top) | 1700
entered. Resistive momentfforce in the y- or alpha-direction (top) | 300

Resistive moment/force in the x-direction (bottom) | 1700
[ ] Enter the Resistive moment in the X Resistive moment/force in the y- or alpha-direction (bottom) | 300
direction (top) as 1700

Cancel | Hep |

e Enter the Resistive moment in the y direction (top) as 300

e Enter the Resistive moment in the x direction (bottom) as 1700

e Enter the Resistive moment in the y direction (bottom) as 300

e Click the OK button to return to the contour dialog.

¢ Click the OK button to display contours of safety for the moment capacities entered.

Note. Specifying the Distance from top or bottom surface to centre of top or bottom
reinforcement is not applicable for Thick Plate elements. It is only used with Shell and
Ribbed Plate Elements.
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Note. Wood Armer skew angles are measured anticlockwise from the x-axis towards
the y-axis.

Note. In the Wood e
Armer dialog, hogging  &otu: Forceomen: - Tniok rate
moment capacity .

values are entered as _gjiii;:
0.55553

+ve (positive) values 0 se8ss

0.777742

0.111106
0222212

and the  sagging 0959954

moment CapaCity Maximum 1.00257 at node 39
Minimum 2.61289E-3 at node 12

values are entered as v

-ve (negative) values.

Changing the Contour range

If a utility factor plot shows values of less than 1.0, the slab is deemed to satisfy the
reinforcement criteria and no live load reduction is necessary.

To help clarify whether any regions of the slab have failed the assessment the contour
range will be modified.

e In the Treeview double-click on the Contours layer and select the Contour
Range tab.

e Set the contour Interval as 0.2 and the Value to pass through as 1
e Click the OK button to finish.

Contours of utility

factors from 0 to 1 giﬁg::i.‘:ﬁifmg.m Pate
will  be displayed B

showing a  small 05
region in the centre of i '°
the slab that has failed  Mrmn 612055 o noas 12
the assessment

according to the

moment capacities

used.

This completes the example.
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Description

Grillage Load
Optimisation

For software product(s): | LUSAS Bridge and LUSAS Bridge Plus

With product option(s): | Autoloader.
Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

This example illustrates how the vehicle load optimisation facility is applied to grillage
models. Autoloader vehicle load optimisation is used using the reciprocal influence

method.
2
-
500 g:
—» < chl
OI

[

750, [
7_14;0: I I I : I I I — ?250
T

F1450»%2400%2400%24500%2400%2400—»%1450{

Cross Section

L 30400 0 30400 N

7300

Road carriageway as Central Radius 500m
defined by kerb lines W us

Carriageway Definition
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Grillage Load Optimisation

The structure to be analysed consists of steel plate girders supporting an in-situ
reinforced concrete deck slab. Two spans of 30.4m each (skew span measurement) span
between the centreline of the support bearings.

The parapet beams are cast onto the structure after the deck slab has cured. This will
make the edge beam properties different from the internal beams however for simplicity
this will be ignored in this example. This assumption makes both the internal and edge
beam properties the same. The properties are computed assuming 6 transverse beams in
each span.

Note. The section properties stated are for the composite sections ignoring shear lag
effects, i.e. taking into account the full width of the slab. The composite sections have
been transformed using short term concrete modulii and are stated in “steel” units in the
table below.

Section Property Table ,(A\Arsfnrg (:32/32/ m:) Jm!
Edge Beam/Internal Beams (Uncracked) 0.12359 | 0.03777 0.697E-3
Edge Beam/Internal Beams (Cracked) 0.04151 | 0.01387 5.366E-6
Transverse Beams 0.1188 0.5012E-3 | 0.997E-3
Skew Beam 0.0684 0.2886E-3 | 0.575E-3
Diaphragms 0.05775 | 0.029E-3 0.107E-3

The structure will be designed to carry full HA loading and 30 units of HB loading as
derived from BD37/88.

Units of KN, m, t, s, C are used throughout.
Objectives
The required output from the analysis consists of:
O ULS and SLS values for selected locations on the structure.

Keywords

2D, Grillage, Autoloader, Load optimisation, Load visualisation, Influence

surface, Basic Load Combination, Smart Load Combination, Envelope

Associated Files

U spaced_beam_geometry.vbs carries out the definition of the section
properties.
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Modelling

Modelling

0 spaced_beam_modelling.vbs carries out the modelling of the example
without the loading applied.

Vehicle load optimisation in LUSAS

e Vehicle load optimisation (VLO) makes use of influence surfaces and influence
analysis to identify the most onerous vehicle loading patterns on bridges for a
chosen design code and to apply these loading patterns to LUSAS models. A
vehicle load optimisation wizard provides the means of defining parameters, for a
particular design code, to generate the most critical traffic loading pattern for each
influence shape under consideration. The actual vehicle load optimisation software
that is used to generate this loading depends upon the design code chosen.

e For traffic loading assessment to Australia AS5100-2: 2004, Canada CAN/CSA-
S6-06 (Design), Eurocode EN-1991-2, New Zealand (Transit New Zealand Bridge
Manual), and United States of America AASHTO LRFD 6th Edition LUSAS
Traffic Load Optimisation (LUSAS TLO) software is used.

e For vehicle loading assessment to other supported design codes, Autoloader Vehicle
Load Optimisation software is used.

¢ Inthis example, the grillage is loaded according to design code BD37/88, so
Autoloader is used. After completing the example as written it could be run-
through again (using the similar steps as described) for a different design code.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as spaced_beam
e Use the Default working folder.

e Enter the title as Two span grillage analysis with load optimisation
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| Bridge

Grillage Wizard...

Grillage Load Optimisation

Select model units of kN,m,t,s,C

Ensure the timescale units are Seconds

Ensure the analysis type is Structural

Ensure the startup model template is set to None
Select the Vertical Z axis option.

Click the OK button.

Note. It is useful to save the model regularly as the example progresses. This allows a
previously saved model to be re-loaded if a mistake is made that cannot be corrected
easily by a new user.

Feature Geometry

The grillage geometry will be created using the Grillage Wizard.

Select the Set Default button

Select Spaced beam and slab deck and ensure the cracked section is 15%. Click
Next

The grillage is Straight with 40 degrees skew. Click Next
Select an Orthogonal grillage arrangement and click Next

Ensure Evenly spaced beams are being defined and enter the width of grillage as 12
and the number of longitudinal beams including edge beams as 6. Click Next

Change the number of spans to 2

For each span enter the length of span as 30.4 and change the number of internal
transverse beams to 6

7

—u
.

f S UL

Click Finish to generate the grillage model.
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| File

Modelling

| Script

| Run Script...

Defining the Geometric Properties

The geometric properties for this model are listed in the section property table at the
beginning of this example. However, for ease of use they will be read in using a file that
is supplied.

Open the file spaced beam geometry.vbs which is located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

Assigning Geometric Properties

This is best done by using copy and paste in the &b and [Z] Treeview panes.

Select the Edge Beam/Internal Beams (Uncracked) properties from the &
Treeview and click on the Copy button.

In the L=] Treeview select the Longitudinal Uncracked Section group and click on

the Paste El button.

Confirmation of the assignment will appear in the text window.

Select the Edge Beam/Internal Beams (Cracked) properties from the & Treeview
and click on the Copy button.

In the Treeview select the Longitudinal Cracked Section group and click on

the Paste El button.

Select the Transverse Beams properties from the & Treeview and click on the

Copy button.

In the L=l Treeview select the Transverse Intermediate Beams group and click on

the Paste El button.

In the Treeview select the Transverse Central Beams group and click on the

Paste El button.

Select the Skew Beams properties from the & Treeview and click on the Copy
button.

In the Treeview select the Transverse Skew Beams group and click on the

Paste El button.

159



Grillage Load Optimisation

e Select the Diaphragms properties from the & Treeview and click on the Copy
button.

e Inthe Treeview select the Internal Diaphragms group and click on the Paste

EI button.

e Inthe Treeview select the End Diaphragms group and click on the Paste EI
button.

Checking for correct geometric assignment
e Turn off the display of the Mesh layer from the [ Treeview.

e Double click on the Geometry layer in the Treeview and select Assignment
from the Colour by drop down list.

e Click the Set button and select Geometric from the Attribute Type drop down list.

e With the Generate key option selected click the OK button to return to the
Geometry properties dialog and OK again to display the geometry coloured by
geometric assignment with the key annotated.

Geometric Key
Analysis: Analysis 1
I cdge Beamiinternal Beams (Uncracked)
Edge Beam/Internal Beams (Cracked)
Il Transverse Beams
Skew Beam

I Diaphragms

A

i
<

e To remove the ‘Colour by Attribute’ assignment double click on Geometry in the

Treeview, select Own Colour from the Colour by drop down list and click OK
to update the display.

Defining the Material

| Attributes e Select material Mild Steel of type Ungraded from the drop-down list and click OK
[Material _ - to add the material dataset to the &% Treeview.
Material Library...
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| Bridge

Bridge Loading >
Gravity

Modelling

e With the whole model selected (Ctrl and A keys together) drag and drop the

material dataset Isol (Mild Steel Ungraded) from the & Treeview onto the
selected features.

Note. Because the geometric properties provided are transformed section properties
(as mentioned in the example’s description) Mild Steel properties are assigned to the
complete model.

Supports

The deck is supported in the vertical direction at each of the diaphragms. Since there
are no in-plane degrees of freedom no in-plane supports are required. The grillage
wizard automatically restrains the grillage from vertical displacement at each
diaphragm.

Note. If in-plane effects such as braking forces are to be considered the grillage
elements should be replaced by 3D beam elements and the appropriate properties and
supports should be assigned.

Self-Weight
Selecting this menu item adds Gravity -ve Z to the &b Treeview.

¢ With the whole model selected, drag and drop the loading dataset BFP1 (Gravity -

ve Z) from the &b Treeview onto the selected features. Ensure the Assign to lines
option is selected and click OK to assign to Loadcase 1.

The gravity loading will be visualised on the model.

3

|l

*a

o From the &' Treeview expand Analysis 1 and then, using the right-hand mouse
button, select Loadcase 1 and select the Rename option. Change the loadcase name
to Self Weight
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| Attributes

| Influence
Reciprocal

| Attributes

Theorem...

| Influence
Reciprocal

| Attributes

Theorem...

| Influence
Reciprocal

Theorem...

Grillage Load Optimisation

Defining Influence Attributes

In order to use the vehicle load optimisation facility the locations at which the
optimised load combinations are to be calculated and the parameter to be computed
must be chosen. To do this, influence attributes are defined and assigned to the model.
LUSAS then calculates the influence surfaces for any specified position in the structure
using the Muller-Breslau principle whereby the mesh is automatically “broken” at each
specified node and automatically constrained to act in the required manner. An
influence surface is generated for each of the chosen locations and parameters.

For this example three influence surfaces will be defined using Reciprocal Method
influence attributes.

Influence Point 1

The first influence attribute will be used to investigate the reaction at the left hand
abutment.

e Select a Reaction influence type for a Vertical axis influence direction for a
Positive displacement direction. Enter the influence attribute name as Reaction
Support 1 and click OK.

The influence attribute will be added to the & Treeview.

Influence Point 2

The second influence attribute will be used to investigate mid span bending in the first
span.

e Select a Moment influence type About Transverse axis direction for a Negative
displacement direction (because we are interested in the maximum sagging
moment). Enter the influence attribute name as Bending Span 1 and click OK.

Influence Point 3

The third influence surface attribute will be used to investigate the hogging moments at
the central pier.

e Select a Moment influence type About Transverse axis direction for a Positive
displacement direction (because we are interested in the maximum hogging
moment). Enter the influence attribute name as Bending Internal Support and
click OK.

Note. Longitudinal and Transverse directions are specified using the ® Direction

definition object in the & Treeview. In this example the longitudinal direction is
defined to be the Global X direction, and the transverse direction is always assumed to
be orthogonal to the longitudinal direction.
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Modelling

Turning loading visualisation on and off

|i| At any time during this example any applied loading can, for reasons of clarity, be
turned on and off by selecting the Loading on /off button.

Assigning Influence Attributes

Influence attributes can be assigned to nodes or points. When modelling grillages
created by the grillage wizard there will always be a node at a point on the model, so
influence attributes could be assigned to points. But, in general usage, and for slab
analysis especially, influence attributes are better assigned to nodes.

Caution. Reciprocal influence attributes can be assigned to as many nodes or points
on the model as necessary, but should only be assigned to those nodes or points for
which they are applicable. For example, the Bending span 1 influence attribute (defined
for a negative displacement direction) should only be assigned to those nodes in the
first span of the bridge for which a negative influence shape applies. For nodes where a
positive influence shape exists a Reciprocal influence attribute with a positive
displacement direction should be assigned. In general, when using Reciprocal influence
attributes the influence shapes for nodes of interest should be viewed prior to any
influence attribute assignments being made. Note that Direct Method influence
attributes can be assigned to the whole model regardless of whether nodes lie in a
positive or negative region of an influence shape.

For this example, and for speed and clarity reasons, only one node will be selected for
each influence attribute.

e  Turn off the display of the Geometry layer in the =" Treeview.
e Turn on the display of the Mesh layer in the [=* Treeview
e If necessary turn off any loading visualisation.

1. Select this node

ANNEY
‘* ﬁ 5 Select this node

2. Select this node

The first influence attribute will investigate the reaction near the centre of the left hand
abutment.
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e Select the node on the end diaphragm as shown.

e Drag and drop the influence attribute Reaction Support 1 from the & Treeview
onto the selected feature.

Note. Where a node coincides with its parent geometry the geometry name (in this
case a Point) will appear as part of the influence assignment name in the (2 Treeview.

The second influence attribute will investigate edge mid-span bending in span 1.

e  Select the mid-span node at the edge of span 1 as shown.

e Drag and drop the influence attribute Bending Span 1 from the & Treeview onto
the selected feature

The third influence attribute will investigate hogging near the centre of the internal
support.

e  Select the node at the internal support as shown.

e Drag and drop the influence attribute Bending Internal Support from the &
Treeview onto the selected feature

Visualising the Defined Influence Points

Influence attribute assignments
are visualised as they are assigned
to the model. To check that the
influence attribute orientations are
correct (meaning that the correct
influence directions have been
defined) an isometric view of the
model should be used.

El Select the isometric button.

e Ensure that the influence
visualisations are as shown

Using the Vehicle Load Optimisation facility to calculate
the worst case loading patterns.

The vehicle load optimiser automates the creation of load datasets in accordance with
the chosen loading code for the locations and effects specified.
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| Geometry
Line >
|ArciCircle >
From
Coords/Points

| Geometry
Line >
| ArciCircle >
From
Coords/Points

| File

Save

Modelling

Before invoking the Vehicle Load Optimisation Wizard the Kkerb lines need to be
defined. This can be done by specifying coordinates for the kerbs via the Carriagewway
Definition dialog of the Wizard, but is best done by defining kerb lines on the model.

@l Select the Home button to return the model to the default view.

o InthelY Treeview turn on the display of the Geometry layer.

Defining Kerb Lines

e Specify the first point as (-5, 1) the second point as (75, 1). Define the third point
as (35, 20) and select the Direction option for the third point.

Enter the radius as 500 and ensure that Minor Arc is selected.
e Click OK to define the first kerb line.

e  Specify the first point as (-5.584, 8.2766) and the second point as (75.584, 8.2766).
Define the third point as (35, 20) and set the Direction option for the third point.

Enter a radius of 507.3 and ensure that Minor Arc is selected
e Click the OK button to define the second kerb line.

e Select the first and second kerb line. (Use Shift to add to the initial selection)

L ]

w

*a

Note. It is also possible to generate the upper kerb line by offsetting a line from the
lower one by first selecting the lower line and choosing the Geometry > Line > By
Offsetting menu item, and the specifying an offset distance equivalent to the width of
the carriageway to be generated (7.3m in this case), and generating it away from the
reference position (or from 0,0).

Save the model

El Save the model file.
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Optimisation...
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Rebuilding a model after a previous failed analysis

If a previous analysis of this example has failed you need to return to this point to
continue after having run the supplied file stated.

Carrying out Vehicle Load Optimisation

Ensure the two kerb lines are selected before choosing the next menu item.

With the kerbs selected the vehicle load optimisation can begin.

Select the Defaults
button to reset any
settings from any
previous vehicle load
optimisation runs.

Select United
Kingdom from the
Country drop down
list.

Select BD37/01 from
the Design code drop-
down lists.

VLO Analysis 2 will

xl

be automatically entered for the Analysis entry in the E;Treeview. (Note that an
alternative name can be entered by selecting the New option from the drop-down

list).

Enter the VLO run Name as VLO Run 1

Select the Optional code settings button.

The BD37/88 optional code settings will appear.
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Ensure the options Use
HA Loading, Use HB
Loading and Use KEL
Loading are selected.

Set the number of HB
units to 30

Deselect the option to
Use cusping

Click OK to set the
selected options and
return to the main
vehicle load optimisation
dialog.

Select the Optional loading parameters button to display the optional loading

parameters dialog.

Ensure the vehicle library is set as \<Lusas Installation
Folder>\Programs\Scripts\ati\VehicleFiles\autoload.vec

Select HB from the drop down Vehicles list.

Set Longitudinal increment to 0.25 and Transverse increment to 0.25

Ensure vehicle direction is set to Both and click OK to set the options and return

to the main vehicle load optimisation dialog.

Note. By seclecting ‘Edit Advanced Code Options’ on the Optional code settings
dialog and clicking the Advanced button some of the lesser used loading options may

be modified. This is also available for the loading options.

Having specified the loading options the carriageway positions need to be defined. In
this example the carriageway positions are defined from the selected kerb Lines.

Finally the influence surfaces to be utilised must be defined.

Select the Define carriageways button.

Select the Kerbs from selection option and click Apply to define the carriageways

and return to the main dialog.

Select the Set influence surfaces button.

Ensure Include all influence surfaces is selected.
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e Ensure that each loaded influence area is set to Positive in the grid. This will
instruct Autoloader to solve for the worst positive effects on each of the specified
influence surfaces.

e  Ensure the increment for influence surfaces is set to 0.25

e Click OK to set the influence data and return to the main dialog.

The optimisation parameters are now set-up.

e Click OK on the main VLO dialog to carry out the load optimisation.

LUSAS Modeller will run an analysis using the Solver to generate each of the three
influence surfaces and then run the appropriate Vehicle Load Optimisation software for
the design code chosen (in this case Autoloader) to compute the worst position of
vehicles for each influence surface, and generate the corresponding loadcases in

LUSAS Modeller. These can be seen in the @ Treeview.

Running the analysis

Finally, the model needs to be solved using those critical loadcases:

e Press the Solve Now El button and on the dialog ensure every analysis is selected
and click the OK button to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (X Treeview.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding the Model

If errors have been made in defining the model that for some reason you cannot correct,
a file is provided to re-create the model information correctly.

U spaced beam_modelling.vbs carries out the modelling of the example
up to the point of using the vehicle load optimisation facility.
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| File
[New...
| File
| Script >
Run Script...

Viewing the Results

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as spaced_beam and click OK

To recreate the model up to the point of using the vehicle load optimisation facility,
select the file spaced_beam_modelling.vbs located in the \<LUSAS Installation
Folder>\Examples\Modeller directory.

Now return to the section entitled Vehicle Load Optimisation earlier in this example
and continue from that point.

Viewing the Results

Analysis loadcase results for VLO Run 1 are present in the (5] Treeview.

Load Visualisation

If it is required to visualise the load pattern for a particular loadcase, this can be done
by setting the results loadcase to be active.

If the Attributes layer is present and the |i| Loading on/off button is depressed
(signifying it is ‘on’) the loading patterns for the various results loadcases can be
displayed:

o In the & Treeview expand both the VLO Analysis and Vehicle Load
Optimisation Run 1 branches, then right-click on the model loadcase Bending
Span 1 - (Point...) - ULS1/Positive (4) and select the Set Active option to display
the load pattern.

2
i 1]
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Reactions at Influence Point 1

A plot showing the reactions is to be displayed.

e Turn off the display of the Geometry and Attributes layers in the =¥ Treeview.

o In the ‘B Treeview right-click on the results loadcase Reaction Support 1 —
(Point...) - ULS1/Positive (2) and select the Set Active option.
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e With no features selected, click the right-hand mouse button in a blank part of the

graphics window and select the Values option to add the values layer to the
Treeview.

The values properties will be displayed.

e Select entity Reaction results for the component vertical reaction FZ
e Select the Values Display tab

e Plot the top 10% of the maxima values

e  Set the Number of significant figures to 4

e  Select the Choose Font button

e Select a font Arial style Bold size of 12

e Click OK to return to the values properties dialog and OK again.

The design reaction at the fixed bearing (previously selected for influence surface
analysis) for the current loadcase Reaction Support 1 — (Point...) - ULS1/Positive (2)
will be displayed.

I bad .4
o In the (& Treeview, right-click on the Reaction Support 1- (Point..) -

ULS2/Positive (8) loadcase and select the Set Active option to display the design
reaction value.

P
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Viewing the Results

Select the remaining Reaction Support 1 results loadcases in turn and choose Set
Active to display the other corresponding SLS reaction values which are shown in
the following table:

Location Quantit ULS1 ULS2 SLS1 SLS2
(Group name) y (LC:2) | (Lc:8) | (Lc:14) | (LC:20)
Reaction Support 1 Vertical reaction
(End diaphragms) (F2) 654.4 553.7 553.7 503.4

Moments at Influence Point 2
To view the bending moments in an edge beam the groups facility will be used in
conjunction with the Diagrams layer.

In the Treeview right-click on Edge Beams group and select the Set as Only
Visible option.

Turn off the display of the Values layer in the = Treeview

In the (2! Treeview, right-click on the Bending Span 1 - (Point...) - ULS1/Positive
(4) loadcase and select the Set Active option

Add the Diagrams layer to the Treeview
Select entity Force/Moment — Thick Grillage results for the bending moment My
Select the Diagram Display tab

Select the Label values option, Label only if selected option, Orientate flat to
screen/page option. Deselect the Peaks Only option, set the label font to be size
20, the font Angle to 45 and the significant figures to 4

Click OK to finish.

The window summary shows the maximum and minimum values.

Use the Zoom in button to enlarge the left-hand end of the lower-beam.

Drag a box around the beams of interest to view moment values on the beam.
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Scale: 1: 275.156
Zoom: 100.0

Eye: (0.0, 0.0, 1.0)

Linear/dynamic analysis
Analysis: VLO Analysis 2
Loadcase: 4:Bending span 1 - Point 433 - ULS1/Positive (4)

Results file: grillage_v151_check~VLO Analysis 2.mys
Maximum displacement 0.0172527 at node &

Deformation exaggeration: 95.6913

Diagram entity: Force/Moment - Thick Grillage

Diagram component: My (Units: kN.m)
Diagram maximum 58&1.796 at Gauss point 1 of element 18

Diagram minimum -1.5326BE3 at Gauss point 1 of element 7
Diagram scale: 1: 6.52451E-3

Note. Summary information (as shown in the image above) can be added by ensuring
the Window Summary check box is ticked. This is found in the panel beneath the

Treeview.

By changing the active results loadcase this table of results for the design of the edge
beam can be generated.

Location Quantit ULSL | ULS2 | SLS1 | SLS2
(Group name) Y (LC:4) | (LC:10) | (LC:16) | (LC:22)
Lower edge beam | g i moment (My) | -1533 | -1297 | -1207 | -1179

(Edge Beams)

Note. By selecting Peaks Only in the Diagram Display tab the labels can be limited
only to the maximum and minimum in the selection.

Note. If the values layer was used to investigate bending moments at points in the
grillage, care must be taken to ensure that unaveraged values are displayed for any
number of grillage elements coming together at a node rather than averaged values. If
so done, end shrinkage settings will allow the separate values to be seen in isolation.
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Moments at Influence Point 3

e In the L=l Treeview right-click on Longitudinal Cracked Section group and select
the Set as Only Visible option.

o In the (B Treeview, right-click on the Bending Internal Support - (X)) -
UL S1/Positive (7) loadcase and select the Set Active option.

e Drag a box around the beams of interest to view hogging moment values on the
beam.

Scale: 1: 275.156
Zoom: 188.697

Eye (0.0, 0.0, 1.0)
Linear/dynamic analysis

Analysis: VLO Analysis 2 . ,\(:’

Loadcase: 7:Bending internal support - Point 29 - ULS1/Positive (7) <,§</ &

Results file: spaced_beam~VLO Analysis 2.mys ‘ig‘." & N Q}f>

Maximum displacement 9.39604E-3 at node 98 A L a
Deformation exaggeration: 175.708 '\;,P

Diagram entity: Force/Moment - Thick Grillage

Diagram component: My (Units: kN.m)

Diagram maximum 1.60122E3 at Gauss point 1 of element 173
Diagram minimum -522.973 at Gauss point 11 of element 175
Diagram scale: 1: 6.24524E-3

By changing the active loadcase the remaining ULS and SLS results for the design of
the longitudinal beam over the support can be generated.

Location Quantit ULS1 ULS2 SLS1 SLS2
(Group name) y (LC:7) | (LC:13) | (LC:19) | (LC:25)

Central pier Bending moment
(Longitudinal (,?A \ 1601 1355 1355 1232
Cracked Beams) y

This completes the example.
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Additional Notes

When modelling grillages either Reciprocal Method influence attributes (as used in this
example) or Direct Method attributes may be used.

For the Reciprocal Method, the influence type may be a Shear force, a Reaction, a
Moment or a Displacement only. For each influence type the influence direction and
either a positive or negative displacement direction needs to be specified.

For the Direct Method, the influence type may be set by defining any Entity of interest
(such as a Reaction, or a Force/Moment, or a Stress), an influence direction (such as an
axis of a member, or a path along a structure, or a material direction) and a Component
of interest (such as My).
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Description

Description

Bridge Slab Traffic
Load Optimisation

For software product(s): | LUSAS Bridge and LUSAS Bridge Plus

With product option(s): | LUSAS Traffic Load Optimisation (TLO).

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

This example uses the LUSAS TLO software option with the reciprocal influence
method to aid in the linear static analysis of a 3-span curved concrete bridge deck
subject to Eurocode traffic loading.

N

Points of interest for influence surface generation

The structure is modelled using thick plate elements, representing a deck of inner radius
75m, outer radius 86m and thickness 0.7m. The deck has a width of 11m consisting of a
10m wide carriageway region and two 0.5m wide verges. The live loading is to be
calculated for three defined influence surfaces using the LUSAS TLO software option.

Units used are kN, m, t, s, C throughout.

Note. LUSAS TLO is a software option for LUSAS Bridge. It extends the vehicle
loading capabilities in LUSAS Bridge and produces worst-case traffic load effects more
easily and much faster than by manual methods. LUSAS TLO generates the most
onerous traffic load patterns according to a selected code of practice, based upon
influence surfaces for specified load effects (moments, shears, reactions, stresses etc) at
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selected locations in the structure. A number of Eurocode National Annexes and other
codes are supported. This example analyses a bridge deck using EN1991-2
Recommended Values. Subsequent analysis for comparison purposes is carried out
using the UK and Swedish National Annex options.

Modelling Objectives
The operations in the creation of the model are as follows:

Sweep a curved deck from a line.

Mesh the Surfaces with thick plate elements (regular mesh).

Define and assign geometric properties to describe the slab thickness.
Define and assign material properties.

Define and assign bearing supports.

Define and assign dead loading.

Define three influence surfaces which will allow calculation of the most onerous
traffic load pattern for:

1. Mid-span bending, inner curve, first span.
2. Mid-span bending, mid-node, second span.
3. Reaction at the first internal support.

U Use LUSAS TLO to calculate the most onerous traffic load pattern for the three
influence surfaces.

(I W W Wy Wy Wy

Keywords

2D, Slab, Modelling, Eurocode, Element Axes, Influence Surface, LUSAS TLO,
Vehicle Load Optimisation, Load Combination, Bending Moments, Reactions,
Transformed Results, Peak Values

Associated Files

U deck_modelling.vbs carries out the modelling of the slab deck for
subsequent use with the LUSAS TLO software option.

Vehicle load optimisation in LUSAS

e Vehicle load optimisation (VLO) makes use of influence surfaces and influence
analysis to identify the most onerous vehicle loading patterns on bridges for a
chosen design code and to apply these loading patterns to LUSAS models. A
vehicle load optimisation wizard provides the means of defining parameters, for a
particular design code, to generate the most critical traffic loading pattern for each
influence shape under consideration. The actual vehicle load optimisation software
that is used to generate this loading depends upon the design code chosen.
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Modelling

e For traffic loading assessment to Australia AS5100-2: 2004, Canada CAN/CSA-
S6-06 (Design), Eurocode EN-1991-2, New Zealand (Transit New Zealand Bridge
Manual), and United States of America AASHTO LRFD 6th Edition LUSAS
Traffic Load Optimisation (LUSAS TLO) software is used.

e For vehicle loading assessment to other supported design codes, Autoloader Vehicle
Load Optimisation software is used.

e Inthis example, the bridge deck is loaded according to EN1991-2 Recommended
Values, so LUSAS Traffic Load Optimisation is used.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as deck

Note. When saving a model for use with Autoloader a filename of 8 or less characters
must be specified.

e Enter the title as Deck analysis using traffic load optimisation
e Use the Default working folder.

e Set model units of kN,m,t,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the model template Standard

e Select the Vertical Z axis option.

e Click OK
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| Geometry
[ Line >
Coordinates...
| Geometry
| Surface >
By Sweeping. ..
| Attributes
Mesh >
Surface...

Bridge Slab Traffic Load Optimisation

Note. Save the model regularly as the example progresses. This allows a previously
saved model to be re-loaded if a mistake is made that cannot be corrected easily.

llt] .
The Undo button ﬂ may also be used to correct a mistake. The undo button allows
any number of actions since the last save to be undone.

Geometry

In this model, one span of the complete bridge deck is modelled in its entirety
(including specifying geometric properties, material, supports, etc.) before it is then
copied to form the complete 3-span structural model.

il Enter coordinates of (0,75) and (0,86) to define a Line representing the end of the
deck.

¢ Click the OK button to finish.
e Select the Line just drawn.

él Select the Rotate option and enter an angle of -7.5 1
degrees to rotate about the Z-axis about the origin 0,0

e Click OK to sweep the Line to create a surface

Meshing

This analysis will consider only out-of-plane bending effects, and no in-plane behaviour
therefore plate elements will be used. Note that when thick plates are used care must be
taken to ensure that results are transformed correctly when plotting contours and values
of bending moments.

e Select Thick plate, Quadrilateral, Linear elements.
Do not specify any mesh discretisation parameters,
this will be controlled by the mesh divisions on the
lines.

e Enter the dataset name as Thick plates and click OK

e With the whole model selected, drag and drop the

surface mesh dataset Thick plates from the
Treeview onto the selected features.
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| File

Model Properties...

| Attributes

Geometric >
Surface...

| Attributes

Material >
Material Library...

Modelling

The default number of line mesh divisions of 4 divisions
per line will be drawn. This gives a somewhat coarse
mesh so the default number of line mesh divisions will
now be changed.

e With the Meshing tab selected, set the default number
of mesh divisions to 6 and click OK

The new mesh divisions will be displayed.

Geometric Properties

e Enter a thickness of 0.7

The eccentricity box should, in this case, be left blank. Using an eccentricity would
infer some in-plane effects, when, as described above, this analysis is intended to
consider only out-of-plane effects. In 3D structures where behaviour is dependent upon
both flexural and membrane effects, shell elements may be used.

e Enter the dataset name as Slab thickness and click OK

e With the whole model selected, drag and drop the

geometric dataset Slab thickness from the
Treeview onto the selected features.

Geometric property assignments are visualised by default.

e In the Treeview re-order the layers so that the
Attributes layer is at the top, the Mesh layer is in the
middle, and the Geometry layer is at the bottom.

Material Properties

e Select material Concrete of type Ungraded and click OK to add the material
dataset to the &% Treeview.

e With the whole model selected (Ctrl and A keys together) drag and drop the

material dataset Isol (Concrete Ungraded) from the & Treeview onto the selected
features and assign to the selected surfaces by clicking the OK button.

Supports

LUSAS provides the more common types of support by default. These can be seen in

the &b Treeview. In this example the deck is to be simply supported so the Fixed in Z
support will be used.
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Surface
Copy...

e Select the 2 support Lines shown.

e Drag and drop the support dataset Fixed in

Z from the & Treeview onto the selected ﬁ

Lines.
e Ensure the Assign to lines and All analysis Select
i : these 2
loadcases options are selected and click OK Lines

The supports will be visualised on the model.

To check the location and direction of the
supports:

El Use the isometric view button to rotate the
model.

e To complete the full model of the bridge deck
select the whole model using the Ctrl and A
keys together.

M Select the Rotate option and copy the features
selected through an angle of -7.5 degrees about the Z-axis and about the origin 0,0

o Enter the number of copies as 2 and click the OK button.

The full 3-span model of the bridge deck will be created.
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| Bridge

Bridge Loadin >
Gravity

| Attributes

Local Coordinate. ..

Modelling

Note. Many of the more common tasks are provided in a context menu for the View
window. With the model geometry selected clicking the right-hand mouse button within
the view will display a context menu with Copy, Delete, Move and Sweep.

Self-Weight
This command adds BFP1 (Gravity -ve Z) to the & Treeview.

e With the whole model selected, drag and drop the loading dataset BFP1 Gravity -

ve Z from the &b Treeview onto the selected features. Ensure the Assign to
surfaces option is selected and click OK to assign to Analysis 1, Loadcase 1.

The gravity loading will be visualised on the model.

o Inthe'Z Treeview, using the right-hand mouse button, select Loadcase 1 and select
the Rename option. Change the loadcase name to Self Weight

Defining a local coordinate system

Since this model is a curved deck a cylindrical local coordinate system will be used for
the direction definition. Specifying a direction definition sets the vertical, longitudinal
and transverse axes for a model to assist with model orientation and the calculation of
particular effects. A local direction definition is used for aligning influence attributes
along a singly curved bridge deck.

e Select the Cylindrical option and ensure that the Z-axis option is set. Enter a
dataset name of Cylindrical about Z-axis and click OK

To use this local coordinate system:
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| Direction definition...

| Attributes

| Influence >

Reciprocal
Theorem...

¢ In the Longitudinal section of the dialog set the Local axis to be Cylindrical about
Z-axis for Theta and click OK.

Influence Attributes

In order to use the vehicle load optimisation facility, it is necessary to identify what
guantity is to be optimised and at what location in the structure. This is achieved by
specifying appropriate influence surfaces, which is done by defining and assigning
influence attributes to the model. LUSAS generates influence surfaces for each of the
chosen locations and load effects, and in this case, by using the Muller-Breslau
(reciprocal) theorem. Note that Direct Method influence attributes are also available
and provide different capabilities.

To make it easier to select the nodes required to define the influence parameters the
geometric and load visualisation will be removed from the display.

ll Select the fleshing on/off button to turn-off the geometric visualisation.

Iil Select the loading on/off button to turn-off the loading visualisation

e Turn off the display of the Geometry layer in the = Treeview.

For this example three influence surfaces will be defined.

Influence Surface Definition - Edge Mid-span Bending

The first influence attribute to be defined will be used to investigate mid span edge
bending in the first span.

e Select a Moment influence type nfluence
About transverse influence Infencetype [Mament 7]
d | rectl on fOr a N egatl\/e Influence direction | About transverse Vl
displacement direction (because we Displacement direction | Negative -]
are interested in the maximum
sagging moment). Attibute [Bending span 1 =] = ew

e Enter the influence attribute name as
Bending span 1 and click OK. ok | comel | ey | Heb |
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| Attributes
| Influence >
Reciprocal
Theorem...

Modelling

e Select the mid-span node at the
inside edge of the first span.

e Drag and drop the influence
attribute Bending span 1 from
the & Treeview onto the
selected node.

This adds an influence assignment
(with a corresponding coordinate)

to the @ Treeview.

Caution. Reciprocal influence attributes can be assigned to as many nodes or points
on the model as necessary, but should only be assigned to those nodes or points for
which they are applicable. For example, the Bending span 1 influence attribute (defined
for a negative displacement direction) should only be assigned to those nodes in the
first span of the bridge for which a negative influence shape applies. For nodes where a
positive influence shape exists a Reciprocal influence attribute with a positive
displacement direction should be assigned. In general, when using Reciprocal influence
attributes the influence shapes for nodes of interest should be viewed prior to any
influence attribute assignments being made. Note that Direct Method influence
attributes can be assigned to the whole model regardless of whether nodes lie in a
positive or negative region of an influence shape.

For this example, and for speed and clarity reasons, only one node will be selected for
each influence attribute.

Influence Surface Definition — Mid-span Bending Span 2

The second influence attribute to be defined will be used to investigate mid-span
bending in the middle of the slab in the second span.

e Select a Moment influence type About transverse influence direction for a
Negative displacement direction (because we are interested in the maximum
sagging moment).

e Enter the influence attribute name
as Bending span 2 and click
OK.

e Select the node at mid-span of the
second span.

e Drag and drop the influence
attribute Bending span 2 from

the c&: Treeview onto the
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Theorem...
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selected node.
This adds the influence assignment to the (2 Treeview.

Tip. For this example, giving influence attribute names that relate to each span and
support (rather than just defining one influence attribute called ‘Bending’ or ‘Reaction’
enables easier identification of the influence results in the 5! Treeview.

Influence Surface Definition - Maximum Reaction

The third influence attribute to be defined will be used to investigate the maximum
reaction at the inner edge of the second line of supports.

Select a Reaction influence type in the Vertical axis influence direction for a Positive
displacement direction.

e Enter the influence attribute
name as Reaction support 2
and click OK.

e Select the node at the edge of
the first support as shown.

e Drag and drop the influence
attribute Reaction support 2
from the &b Treeview onto the
selected node.

Visualising the Defined Influence Points

Influence attribute assignments are visualised as they are assigned to the model. To
check that the influence attribute orientations are correct (meaning that the correct
influence directions have been defined) a plan view of the model should be used in this
case

@l Select the Home to return the
model view to a plan view.

e Ensure that the influence
visualisations are in the
orientations shown.
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| Point >

Copy...

| Geometry
| Paint >

Copy...

| Geometry
[ Line >

' By Sweeping...

| File
| Save

| File
[New...

Modelling

Define the Kerb Lines

Kerb lines are used to define the extent of a loadable carriageway.
e Turn on the display of the Geometry layer in the [= Treeview.

e Select the Point at the left-bottom corner of the deck

Sarm

LI Enter a translation of 0.5 in the Y direction. Click OK.

e Select the Point just created

ﬂ Enter a translation of 10 in the Y direction. Click OK.

e Select the two Points that have been created

él Select the Rotate option and enter an angle of -22.5 degrees to rotate about the Z-
axis about the origin 0,0

e Click OK to sweep the
Points to create a two lines
representing the kerbs

Save the model

El Save the model file.

This completes the preparation of the model for influence analysis.

Rebuilding the Model

If errors have been made in the modelling of this example that for some reason you
cannot correct, a file is provided to re-create the model information correctly, allowing
a subsequent analysis to be run successfully.

0 deck_modelling.vbs carries out the modelling of the example including
the loading.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as deck
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| Script

| Run Script...

e To recreate the model, select the file deck_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

Running a Reciprocal Influence Analysis

If it is required to visualise influence surfaces and confirm they are correct before they
are used to generate optimised loading patterns, this can be optionally done by solving a
Reciprocal Influence Analysis in isolation from any other analyses.

e Press the Solve Now El button and deselect the Analysis 1 option to leave just the
Reciprocal Influence Analysis check box ticked. Click the OK button.

e When solved, the @ Treeview will contain one results file for each influence
surface.

Visualising Influence Surfaces

El Rotate the model to an isometric view.

o From the ‘&' Treeview right-click on the Reciprocal Influence Analysis results
loadcase Bending span 1 and select the Set Active option.

¢ Right-click on the model view window and add an Influence Shape entry to the
Treeview

o If present, turn-off the display of the Mesh and Geometry layers from the
Treeview.

e In the Treeview double-click on the Attributes entry, click the Supports tab,
and select the All button. Select the option From results file and click OK.

Bending span 1 (moment) influence
surface
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e From the 'E Treeview right-click on the Reciprocal Influence Analysis results
loadcase Bending span 2 and select the Set Active option.

Bending span 2 (moment) influence
surface

o From the 'E Treeview right-click on the Reciprocal Influence Analysis results
loadcase Reaction support 2 (reaction) and select the Set Active option.

Reaction support 2 (reaction) influence
surface

o After checking the influence shapes, turn-off the display of the Influence shape

layer, and turn back on the display of the Mesh and Geometry layers from the
Treeview.

Using the Vehicle Load Optimisation facility to calculate
the most critical loading patterns

The vehicle load optimisation software option automates the creation of traffic load
patterns in accordance with a selected design code for locations specified on the model.
The example as written uses EN1991-2 Recommended Values, which is supported by
the LUSAS TLO software option. Other EN1991-2 National Annexes may be chosen.
Results for selected other National Annexes are shown at the end of the example.

187



| Bridge

Bridge Slab Traffic Load Optimisation

Vehicle Load

Optimisation. ..

Select the kerb lines

Prior to running the vehicle load
optimisation the kerb positions
defining the extent of the
loadable area of carriageway
must be selected. Ensure that the
Geometry layer is turned-on,
then:

e Select the two lines
representing the kerb
positions / extent of the traffic lane.

Define Vehicle Load Optimisation parameters
e First select the Defaults

button to reset any VLO [+ Loading options _
Settlngs from any prev'ous Cauntry IEWDDE j Optional code settings.
use Design code | EN1391-2 Recommended Values 2009 7] | Oplional loading parameters...
r— Salution process
o Se I eCt EU ro pe fI’O m the I “iew onerous effects table Define camageways. .
Country drop down list. [ A — R ————
& Al chosen influences  © Most onerous

e Select EN1991-2
Recommended Values from
the Design code drop down
list.

Analysis [0 Analysis 2 =l

Name  [VLO Run 1

Mote that the madel will be saved when OK. is pressed

Defaults oK Cancel Help |

e Ensure the View onerous
effects table is not selected

e Select Create loading patterns for All chosen loadcases

e VLO Analysis 2 will be automatically entered for the Analysis entry in the C.
Treeview. (Note that an alternative name can be entered by selecting the New option
from the drop-down list).

e Ensure the Name is set as VLO Run 1
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Browse the optional code settings

° Select the Optional COde EN1991-2 Recommended Yalues
. . Representative values required load goups toinclude |
settings button and the optional | gasceo [ C i)
loading parameters dialog will | |* comsnstonissio ¥ Growp 4-LMa
appear for the design code Pl ¥ Bt L3
selected el () Vehiclels] [SV160020000vy -
' ¥ Include associated L1
On this dialog any representative - [ edusion ostoren .—ES{H;SE",E?HED sdvanced,
values that are required and load s efesons il ‘
groups that are to be included can be
specified. Special vehicle types can
be specified and advanced settings [ ok | oc | concu ke

can be defined. No changes are
required for this example.

Note that a single special vehicle (SVV1800200Iow) is specified as a default in these
recommended values and that a vehicle(s) appropriate to the structure being designed
should be specified in practice.

For this example, un-check the Infrequent option, then click the OK button to
accept the remaining default values and return to the main VLO dialog.

Browse the optional loading parameters

¢ Onthe main VLO dialog, select the Optional loading parameters button
e On this Options dialog ensure the
Longitudinal increment is set to 0.25, [ =<e@e Ea
the Transverse increment is set to 0.25 R r —
and the Vehicle direction is set to Both. Vaficl dractan T
e Click OK to return to the main Vehicle Detauts [[ OK | Concdl | e
Load Optimisation dialog.
Define the carriageways
e On the main VLO dialog, select the Define Sdolod
carriageways... button. f“”'a::w“‘a:dﬂsil—j
Because the kerb lines have been selected the carriageway ::"I'b:m_mawm I_Lm E
shape and angle of carriageway are known. Kerbs from 7K:hmmg -
selection will be automatically selected (© et bt e
& Kerbs from selection
e Click Apply to return to the main Vehicle Load
Optimisation dialog. 2o | P || e
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Define the influence surfaces

e On the main Vehicle Load Tk S
Optimisation dialog, select | o e
the Set influence surfaces o
button.

e Ensure the Include all
influence surfaces option

is selected.

° Ensure the POSitive Search area to be used for reciprocal influences  [Defaut =
checkbox option is selected
for each influence. =T N

Note. For an influence analysis carried out using Reciprocal Method attributes the
influence shape for a chosen influence location will determine whether Positive or
Negative should be chosen. For this example vehicle loading placed onto the positive
areas will create the maximum negative moment required.

e Click OK to return to the main load optimisation dialog.

e Press the OK button on the main VLO dialog to run the vehicle load optimisation
analysis.

This loading optimisation will take just a few seconds on modern computers, and when
successfully completed, Characteristic, Combination and Frequent results table entries
and results loadcases and Loading folders will appear in the () Treeview for each
influence as shown in the following image.

=2 Y10 Analysis 1
- YLD Run 1
El Bending span 1 - Positive - Charackeristic
- B-[Y 2:Bending span 1 - (4,90523, 74,5394, 0,0) - Positive - Charackeristic
Ela Loading
: SZLML od (20 0 100
S ELML od (30 0 100

LML Es (4 (1.0
............ S b odl (BN e 1M

Note. If ‘Create loading patterns’ was not selected on the main VLO dialog the most
onerous loading effects can be created individually for selected VLO results table
entries by using a ‘Create Loading” button that appears instead of the ‘Loading
Created’ one.
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So, as can be seen, the VLO run includes loading arrangements but no results. Whilst
loading patterns can be visualised, results are available only after the VLO analysis has
been solved.

Visualising Load Definitions

e Inthe Treeview ensure the Influence shape layer is turned-off, and the Mesh
layer is turned on.

o Inthe =" Treeview turn-off the display of the Geometry layer.
Iil Select the loading on/off button to turn-on the loading visualisation

= =
I_I If necessary, select the supports on/off button to turn-on the support visualisation

The load definition may be visualised for each loadcase as follows:

Viewing Characteristic Loading for Edge Mid-span 1

e Inthe G Treeview right-click
on the loadcase Bending span
1 - (xy) - Positive -
Characteristic and pick the
Set Active option.

Here, it can be seen that Group la
dominates and the load pattern is
made up of LM1 tandem systems
and LM1 udl patches. The 10m
carriageway width accommodates three 3m wide lanes. With reference to EN1991-
2:2003 table 4.2 and clause 4.2.4 (4), Lane Number 1, with the heaviest tandem and udl
loads, is positioned adjacent to the influence definition on one side of the deck. Moving
away from the location of interest, lanes 2 and 3 appear in order. The remaining area
(1m wide) appears on the far side of the bridge deck. Spans 1 and 3 only are loaded
(span 2 is not part of the adverse area).
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Viewing Characteristic Loading for Mid-span Bending Span 2

o In the ' Treeview right-
click on the loadcase
Bending span 2 - (X\y) -
Positive - Characteristic
and pick the Set Active
option.

Here, again, Group la dominates
and the load pattern is made up
of LM1 tandem systems and
LM1 udl patches. Lane Number 1, with the heaviest tandem and udl loads, is positioned
adjacent to the influence definition, near the middle of the deck. Lanes 2 and 3 appear
each side of Lane 1 and the 1m wide remaining area appears on the opposite side of the
bridge deck compared to that when considering the previous loadcase. This illustrates
how the ranking and location of lanes is modified as appropriate (EN1991-2:2003
clause 4.2.4(2)). Span 2 only is loaded (spans 1 & 3 are not part of the adverse area).

Viewing Characteristic Loading for Reaction at Support 2

o In the & Treeview right-
click on the loadcase
Reaction support 2 - (X,y) —
Positive - Characteristic
and pick the Set Active
option.

In this last example, giving
maximum reaction at the inner
support, Group 5 dominates and
the load pattern is made up of LM3 with associated LM1 tandems and udl patches. The
SV1800/200 is positioned adjacent to the influence definition, near the edge of the deck
over spans 1 and 2. This is considered to be Lane Number 1 (EN1991-2:2003 Annex A
clause A.3). Lanes 2 and 3 appear on the far side of the deck and are loaded only in the
adverse area which happens to be in span 3. The 1m wide remaining area appears
between lanes 1 and 3, illustrating yet another arrangement of lane rank and location,
used to generate the most onerous traffic load pattern.

Note. The VLO run creates loading arrangements but no results. Results are available
only after the VLO analysis has been solved.

Running a VLO Analysis

Only the VLO analysis has to be solved in order to produce the results for the optimised
loading arrangements for each influence assignment.
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e Press the Solve Now El button.

The Solve Now dialog indicates that the VLO analysis results are not up to date and
that they need to be solved.

e Analysis 1 (the self weight analysis) does not need to be solved yet, so should be de-
selected.

e Press OK to solve the VLO run.

Viewing Load Combinations

The LUSAS TLO facility outputs a design value — Characteristic, Combination or
Frequent, with the meaning of each given in the TLO Help. In this example the vehicle
loading is assumed to be the dominant effect and all other variable actions (wind, snow,
temperature etc.) are being ignored. For this case, and in accordance with EN1990
6.4.3.2(3) equation 6.10, the loads can be combined as yg*[dead loads] + yq*[traffic
loads]. According to clause A2.3.1(4), for the design of structural members not
involving geotechnical actions, the y factors can be found in Table A2.4(B) as yg = 1.35
and yq4= 1.5 for traffic. So, to define a basic combination:

On the Combination Properties dialog:
e From the model listing add Self Weight to the included panel.
e Add Bending span 1 - (x,y) - Characteristic to the included panel.

e Click the Grid button and enter factors of 1.35 for self weight loadcase and 1.5 for
the Bending span 1 loadcase

e Change the combination name to Combination Bending Span 1 and click the OK
button to update the combination in the (X Treeview.

Plotting Contours of Moment and Peak Values

o In the {2 Treeview right-click on the loadcase Combination Bending span 1 and
pick the Set Active option.

The Solve Now dialog will be displayed showing the status of the analyses that have
been defined. This shows that Analysis 1 — the self weight loadcase analysis will need
to be solved, since for the purposes of this worked example, analyses have been
deliberately solved in isolation, to show how this could be done, if desired.

e Click OK to resolve the analyses indicated as needing to be solved.

e With no features selected click the right-hand mouse button in a blank part of the
graphics window and select the Contours option to add the contours layer to the
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Treeview. Note that by default, and in accordance with established theory, thick
plate element results are given along a chosen global axis. Because we wish to look
at radial results along the deck the cylindrical local coordinate system must be
selected in order to make the appropriate results components available for selection.

Select Entity Force/Moment - Thick Plate and then select the Transformed button
and select the Specified local coordinate option. Ensure Cylindrical about Z-axis
is selected in the drop down list. Leave the Shell plane for resultants as theta/z
and click OK.

Now, as a result of transforming the results, a new component is available in the
Component drop down list. Selected moments in the theta direction Mt

Click the OK button to display contours of moments in the longitudinal direction.

To display the mesh on
top of the contours, select
the Mesh entry in the
Treeview and drag and
drop it onto/below the
Contours entry in the
Treeview.

With no features selected
click the right-hand mouse
button in a blank part of the graphics window and select the Values option to add

the values layer to the = Treeview.

The values properties dialog will be displayed.

Select Entity Force/Moment - Thick Plate and Component moments in the theta
direction Mt, and select Averaged nodal.

Select the Values Display tab.
Deselect the Symbols display option.

Deselect the Maxima option and select the Minima option since the sagging
moment is negative. Change the percentage of values to display to 1

Set the number of significant figures to 4
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e Click the OK bhutton to display contours of moments in the longitudinal direction
with the bending moment value displayed.

Plotting stress contours and peak values for other load combinations and for other
influence points of interest may be obtained in a similar manner to that described above.

Save the model

El Save the model file.

Note. When the model file is saved after results processing, all load combinations,
envelopes, and graph datasets, if defined, are also saved and therefore do not have to be
re-created if the model is amended and a re-analysis is done at a later date.

This completes the example.
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Discussion

Traffic Load Optimisation for EN1991-2 design codes

To illustrate general usage this example analysed traffic load optimisation to EN1991-2
using the Recommended Values design code option.

By re-selecting the lines representing the kerbs on the Geometry layer and selecting an
appropriate design code on the main Vehicle Load Optimisation dialog and re-running
the traffic load optimisation analysis, the results for other supported EN1991-2 Design
Code and National Annexes values can be similarly obtained. When re-running the
LUSAS TLO facility on the existing model care should be taken to ensure that the
correct loadcase is included in the load combination and that the correct load factor has
been specified.

Traffic Load Optimisation for EN1991-2 UK

By following a similar procedure to that previously described the optimised load
definitions for EN1991-2 UK (using a single SV80 special vehicle) can be obtained
along with a contour plot for a basic combination of self weight and combination results
for bending in span 1, as shown in the following images.

Optimised Characteristic Loading for Optimised Characteristic Loading for
Influence Point at Edge Mid-span 1 Influence Point at Mid-span Bending Span 2

Optimised Characteristic Loading for the Combination results for Influence Point
Influence Point at Reaction at Support 2 at Edge Mid-span 1
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Here, the two bending influences show Group 1A loading to be dominant. The LM1
tandem and LM1 udl are however different in value to those in the earlier example due
to the use of the appropriate adjustment factors from NA to BS EN1991-2 Table NA.1.
The reaction influence shows the Group 5 to be dominant. The UK SV80 appears in
Lane Number 1, with associated LM1 also appearing in Lane Number 1,with a
minimum 5m distance from the SV to the first axle of the LM1 TS. Lane rank and
location are similar to those described in the earlier example.

Traffic Load Optimisation for EN1991-2 Sweden

By following a similar procedure to that previously described the optimised load
definitions for EN1991-2 Sweden (using all Complementary load model loads from ‘a’
to ‘I’) can be obtained along with a contour plot for a basic combination of self weight
and combination results for bending in span 1, as shown in the following images.

Optimised Characteristic Loading for the Optimised Characteristic Loading for the
Influence Point at Edge Mid-span 1 Influence Point at Mid-span Bending Span 2

Optimised Characteristic Loading for the Combination results for the Influence Point at
Influence Point at Reaction at Support 2 Edge Mid-span 1

Here, the two bending influences show Group 1A loading to be dominant. In
accordance with SIS/PAS NA to EN 1991-2:2003 clause 4.3.2(3) and VVFS 2009:19
Chapter 6, clause 4, Table 7.1, adjustment factors for the LM1 tandem and LM1 udl are
applied — hence there is no LM1 tandem in Lane Number 3 (factor a43=0). Other
comments on the EN1991-2 load patterns above also apply here. The reaction influence
shows the Swedish Complementary Load Model to be dominant. Type L vehicles
appear in Lanes 1 & 2, with udl q appearing in Lane 3 and no loading in the “remaining
area”. Lane rank and location are similar to those described in the earlier example.
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Description

Vehicle Load
Optimisation of a
Box Beam Bridge

For software product(s): | Bridge and Bridge Plus

With product option(s):

Description

A 5-span concrete box curved bridge with end spans of 45m and three internal spans of
50m is modelled with beams to illustrate the use of the Direct Method Influence (DMI)
attributes and Vehicle Load Optimization (VLO) facilities in LUSAS.

Span §

North
Abutment

South
Pier 1 Abutment

A pre-defined base model with assigned mesh, material and support attributes is
supplied for use with this example.

Units used are kN, m, kg, s, C throughout.
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Vehicle Load Optimisation of a Box Beam Bridge

Objectives

The required steps in the analysis consist of;

O Run a Direct Influence Method Analysis to calculate the effects of a unit load
O Define influence attributes and assign them onto the model

O Create influence surfaces

O Create optimised vehicle loading results with VLO

Keywords

Bridge, Concrete, Box Girder, Direct Method Influence, Vehicle Load
Optimisation

Associated Files

U curved_bridge_preliminary.mdl Basic beam model of the bridge.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Loading the model

To start this example, open the read-only file curved_bridge_preliminary.mdl located
in the \<LUSAS Installation Folder>\Examples\Modeller directory.

The basic bridge geometry will be displayed.
e Save the file as \<LUSAS Installation Folder>\Projects\curved_bridge
e Save the model into this new folder as curved_bridge

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.
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Model Description

The 5-span, box girder bridge has spans of 45m, 50m, 50m, 50m and 45m, all set-out to
a horizontal curvature of 510m radius. For simplicity the cross section of the bridge is
considered constant across its length, and the deck is supported on 5.5m high abutments
and 12.5m high circular pier columns, which are considered fully integral with it. The
box girder of the deck, including cantilever outstands, is 11.5 m wide. The carriageway
itself is 7.7m wide, with space for a footway on the inside and hard standing margin on
the outside.

The deck is modelled as a series of beams along the centreline of the carriageway at a
radius of 510m. The kerb lines defining the extent of the loadable carriageway are
defined at the deck level, above the nodal line, using lines of 506.55m radius and
514.25m radius — a difference of 7.7m, which relates to the width of the carriageway.

For the purposes of this example the geometric lines of this model have been assigned a
line mesh of thick beam elements with a specified element length of 5m. A cylindrical
coordinate system has been used to orientate the abutments and piers supports.
Concrete EU f,,=50MPa has been assigned to all members. Pin supports restrain the
base of the piers and other pin supports, having the additional fixity, THY, are used at
the abutments. A local cylindrical coordinate system has been assigned to the end points
to orientate the supports as needed.

The Direct Method Influence method is to be used for vehicle load optimisation
analysis instead of the Reciprocal Theorem because it allows the structure to be
analysed as a simple line-beam model.
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|Reference Path. ..

| Attributes

| Search Area. .

Defining a reference path

A reference path is to be created for use as a centreline for the bridge and also to define
a grid which will be used for the loading locations required to create influence shapes in
Direct Method Influence Analysis. The use of a reference path is recommended for
most vehicle loading and load optimisation situations.

e From the L=l Treeview right-click on Deck and click Select Members to select the
lines representing the bridge centreline.

e Change the name to be Bridge Centreline and click OK. A corresponding path
definition entry will be created in the N Treeview.

Note that the direction of the reference path will control the order of any created
influence entries (when created) in the (X Treeview.

Defining a search area

A search area is to be used to limit the area or features over which loads are applied, so
that the effect of the load on certain features may be removed from the analysis. It is
strongly recommended to define a search area for VLO analyses.

e Change the name to Deck and click OK.

o From the &b Treeview, drag and drop the newly defined Deck search area on to the
model to assign the attribute to the already selected bridge centrelines.

Direct Method influence analysis

Direct Method influence analysis is a means of creating an influence where the effect of
a specified point load is assessed at each node or grid location on a loadable area of a
structure. The value of the load effect of interest at each specified location is then used
to construct an influence line or surface for that location. The direct method influence
enables the construction of influence surfaces for any results component at any node in
the structure.

Direct Method influence analysis can be carried out either by defining and assigning
influence attributes to the model before carrying out an influence analysis (as has to be
done for the Reciprocal Theorum Method), or by pre-solving for the nodes in a search
area, or for the points on a loading grid, (without having any influence attributes
assigned to the model) to evaluate the effect of a unit load up front. This optional
approach caches the results for each node or loading point on the grid so that they are
available when an influence attribute is assigned to the model at a later stage, allowing
influence shapes to be generated for chosen locations on-the-fly. Note that for a line
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beam analysis, as used in this worked example, Direct Method influence attributes must
be used.

Defining a Direct Method influence analysis

e Choose Deck as the Search area in order to apply a prescribed unit load only on
the deck beams.

For a line beam model, where the geometric section represents a beam with a loadable
top slab, a loading grid of points should be defined to represent the slab. This virtual
grid is equivalent to the nodes or points present in a shell or plate model and is used to
create an influence surface for each location of interest.

e Ensure that Grid is selected.

e Ensure that the chosen Centreline is the previously defined Bridge Centreline
reference path.

e Set a Transverse width of 11.5. This is the width of the grid to be loaded for
influence analysis.

e Press the Grid Settings button and make sure that Match nodes in search area
(line beam models only) is selected.

e Change the name to DMI My and press OK as necessary to exit the dialogs.

Note. The Grid Settings advanced dialog controls the spacing and number of load
locations within the defined width and search area length. For line beam models the
most accurate results are obtained when the grid spacing along the centreline of the
loading grid is set to match the longitudinal spacing (and hence number of nodes) of the
underlying beam mesh.

Note. When the ‘Match nodes in search area option’ is used for line beams models,
only 1 transverse point is used to define the extent of the loading grid to each side of the
line beam. Using a larger number of transverse points across a single beam will not
make the analysis more accurate, and is not required because results are only calculated
for the two extreme fibres. If a very fine grid was defined the solution stage may take
some time, as the solution time is proportional to the mesh and grid density.
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Vehicle Load Optimisation of a Box Beam Bridge

The defined grid that is now shown on the model will be used
by an influence analysis to apply a unit load at each grid point.

The grid can be displayed or hidden on the screen.

From the ‘) Treeview right-click on DMI My and select
Show Grid to un-tick the entry and make the grid invisible.

Note. A Direct Method Influence analysis can include any s
number of influence types, or can include only particular '
influence assignments for a particular span or section of a

model of the model. Here, an analysis for just one influence

(My) is being used for all spans.

Solving for a Unit loadcase Lo

Press the Solve Now ;l button. On the Solve Now dialog

ensure that both Analysis 1 (which includes the self-weight loadcase that assumes
the bridge is wished-in-place for the purposes of this example) and also DMI My
are checked and press OK to run the analysis.

This applies a unit load to each loading point on the grid and caches the results for each
point so that they are available when an influence shape is required to be generated.

If the analysis is successful...

A results loadcase for Analysis 1 and a DMI My analysis entry are added to the @
Treeview.

Defining Direct Method influence attributes

Now that the influence analysis has been solved the definition of influence attributes
can be done prior to assigning to nodes in the structure..

Select Entity as Force/Moment-Thick 3D Beam
Ensure the Direction is Local
Select My as the Component of interest.

Choose Automatically choose elements for averaging to create an individual
influence based on the average of all element values at the node of interest.

Enter My Influence as the name and press OK to close the dialog
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Once created, an influence attribute is held in the & Treeview for assignment to
selected nodes or points. Note that subsequent assignment of the same attribute to other
nodes or points of interest on a model will use the same influence type settings that
were initially made.

Assigning Direct Method influence attributes to the deck

Influence assignments will be made to all nodes along lines representing the deck.

e From the Treeview turn Utilities off. This turns-off the display of the reference
path.

e From the Treeview right-click on Deck and click Set as only visible to display
only the lines representing the bridge centreline.

e Hold-down the N key (to select just the Nodes) and make a box-selection with the
cursor to enclose the five lines representing the deck. 49 nodes will be selected.

e Drag and drop the My Influence attribute from the 63; Treeview onto the view
window to assign it to the selected nodes.

Influence loadcases (as yet unsolved) will be added to the DMI My analysis in the (L)
Treeview, indicating the name and position of the influence attribute assigned. Note that
where a node coincides with its parent geometry the geometry name will appear as part
of the influence assignment name.

e With no features selected right-click the view window and select All visible.

SHEEEE DFinding assigned influence locations

In models with lots of elements, nodes and attributes you can quickly locate an assigned
influence location in the view window by selecting this context menu item for an
influence attribute:

o From the & Treeview right-click on My Influence (My) — (x,y,z) — (Element 87,
Element 90) and choose Find.

A temporary indicator will appear, highlighting the node with the assigned influence
attribute.

Visualising influence shapes

o From the (X! Treeview right-click My Influence (My) - (x,y,z) — (Element 87,
Element 90) and now choose Set Active to view the influence shape for My at the
centre of span 3, noting that the next step must be completed before the influence
shape will be drawn.
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e With no features selected right-click in a blank part of the view window and select
the Influence shape option.

e From the Treeview turn the Geometry off, to leave a view of the chosen
influence shape.

(WContouring influence results

After the influence attributes have been defined and assigned, contours can be added to
the view to indicate just what effect the degree and direction of influence loading
applied along the surface will have on the assigned node.

o Elwith no features selected right-click in a blank part of the Graphics window and
select the Contours option to add the Contours layer to the = Treeview.

e Select the Entity Influence result. Note that the Component Inf and Display of
Nodal will be automatically selected.
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e To plot the contour on the influence shape, select the Contour Display tab and tick
Deform

e Press OK to exit the dialog.

Analysis: DMI My ~
Loadcase: 1:My Influence (My) - (495.947, 118.896, 0.0) - (Element 87, Element 90)

Entity: Influence result
Component: My

-8.36305E3
-7.16833E3
-5.97361E3

-4.77889E3
8 3 ssa16e3
-2.38944E3
-1.19472E3

0.0
- 1.19472E3

Maximum 1.85586E3 at node 55
Minimum -8.89663E3 at node 176

The contours can be simplified to indicate which areas of the structure, when loaded,
will have a positive, or negative influence for the selected influence assignment.

Double-click the Contours layer to the = Treeview to open the properties dialog

Select the Contour Range tab.

Ensure Number is selected and change the value to 1

Press OK to exit the dialog.
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Analysis: DMI My
Loadcase: 1:My Influence (My) - (495.947, 118.896, 0.0) - (Element 87, Element 90)
Entity: Influence result

Component: My

-

Maximum 1.85586E3 at node 55
Minimum -8.89663E3 at node 176

Note. For this influence analysis, carried out using Direct Method Influence attributes,
vehicle loading placed onto the negative areas (blue) will create the maximum negative
moment for the influence shape for this chosen influence location. Vehicle loading
placed onto the positive areas (red) will create the maximum positive moment for the
influence shape for this chosen influence location.

Vehicle Load Optimisation (VLO)

Now that influence attributes have been defined and assigned, the VLO facility can be
used to define optimised traffic loading for the bridge for these influence assignments,
based on a chosen code of practice. In this example EN1991-2 UK will be used. Note
that unlike Reciprocal Theorum influence attributes, Direct Method influence attributes
can be assigned to the whole model regardless of whether nodes lie in a positive or
negative region of an influence shape.

e From the = Treeview turn off Contours and Influence shape and Annotation

e Turn on Geometry
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Selecting kerb lines

Note. In this model, the lines defining the extent of the loadable carriageway have
been defined as Combined Lines which cannot be directly used by the VLO facility.
But, and as a general rule, any lines representing kerbs should always be saved as a
Group to aid easy selection. This has been done for this example and the points and
lines representing the kerbs can then be selected indirectly by selecting the Group in
which they are members.

e In the Groups Treeview, right-click on the Kerblines group, and then select
Select Members to select the lines representing the extent of the carriageway

o [ZlFirst select the Defaults button to reset any VLO settings from any previous use.

e Select United Kingdom from the Country drop down list and choose EN1991-2
UK 2009 as the Design code.

For simplicity only the effects of a characteristic LM1 load will be considered in this
example.

e Press Optional Code settings and ensure that Characteristic is the only one of the
representative values required, and Group la —LM1 is the only one of the load
groups to be included. Press OK to exit the dialog.

e Press Define carriageways. Ensure Kerbs from selection is selected and press
Apply to exit the dialog.

e Press Set influence surfaces and on the next dialog select Include all influence
surfaces.

e Ensure that the Positive and Negative checkboxes are selected for all the My
Influences included (see note below). This means that the VLO analysis will
produce loading patterns for positive and negative effects of My.

Note. Clicking in the header cell of a column will select the whole column so that
checking (ticking) one entry will check (tick) all in that column.

e Press OK to return to the main VLO dialog.
e Ensure the option to View onerous effect table is selected.

e Ensure the option to Create loading patterns for All chosen influences is not
selected.

e To specify a non-default analysis name choose New from the drop-down list, and
enter the analysis name to be VLO DMI My

e Change the VLO run Name to be LM1 All
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| Tile Horizontally

e Press OK to exit the dialog and generate optimised loading.

After a short time, and at the bottom of the (X Treeview the new VLO DMI My
analysis will be created. This contains the LM1 All ®8VLO run, as denoted by this

icon ¥ which includes Characteristic results table entries for the negative and positive
My Influence assignments as shown in the following image.

B2 YLO DMI My
- L1 Al
My Influence (My) - Negative - Characteristic
My Influence (My) - Positive - Characteristic

A VLO results table will also appear in a window showing tabbed results pages for the
negative and positive influence assignments that have been made, and with the most
onerous influence assignment in each set of tabbed results shown highlighted in red.

Note. Because the option to ‘Create loading patterns’ was not chosen on the main

VLO dialog, no loading folders will initially appear for an influence in the C
Treeview, but the VLO results table will show ‘Create Loading’ alongside all influence
assignment entries, loading patterns to be created, as necessary, one at a time.

Filtering influence results

e First, in the VLO results table ensure that the My Influence (My) — Negative —
Characteristic tab is selected

By default, results in tables are listed for all visible nodes in order of descending effect
showing the most onerous value at the top of the listing in red. If desired, and by
selecting a feature on the model, only those results applicable for a particular feature
may be shown. One way of seeing this is to tile the View and Results Table windows
and to select the individual lines representing each span of the model in turn.

e From the L2l Treeview right-click on Kerblines and click Set invisible to hide the
the lines representing the kerbs.

This arranges the windows as shown in the following image.
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e In the model view window, select each of the lines representing the spans in turn to
filter the results in the table and see that the most onerous effect occurs in span 5.

EE LUSAS View: LM1 All My Influence (My) - Negative - Characteristic =] =lol|
FIERE FIEE
T (463.28,213.24,0.0) - (Element 149, Elemert 152) | 195 -16.7462E3; GRIA-CHAR | Creste loading 1§ (46328,21324,00) - (Element 149, Elemert 152) | 196 -16.7482E3. GR1A-CHAR | Creste loading
3 | (495947,118.896, 0.0) - (Elemert 57, Elemert 90) 116 -161673E3 GRIA-CHAR  Creste loading 9 (465349, 208 688, 0.0) - (Elemert 145, Elemert 140) 194 15747863 GRIA-CHAR  Creste loading
4 (505,204, 69.7804, 0.0) - (Elemert 26, Element 59) 74 -15.9346E3  GRIA-CHAR  Create loading 16 |(467.372,204.116, 000) - (Elemert 142, Elemert 1481 190 -12.9892E3 GRIA-CHAR  Create loading
5 [(481 928,166 863, 0.0) - (Elemert 118, Elemert 1213 157 -159219E3 GRIA-CHAR  Create loading B 19 | (433.01, 222283, 0.0) - (Element 155, Element 158) 206 12718263 GRIA-CHAR = Createloading
B | (509.779,14.9978, 0.0) - (Element 23, Element 25) 30 -ISTTT3ES GRIACHAR  Creste loading 26 [(469.351,199.524,00) - (Elemert 139, Elemert 142) 186 -B60726E3 GRIA-CHAR  Creste loading
E] (509.387,24 .99, 0.0) - (Element 29, Elemert 32) 38 -157620E3 GRIA-CHAR  Creste loading 40 [(471.284,194 913,00) - (Element 136, Elemert 130). 182 41228683 GRIA-CHAR = Creste loading
9 |(485:349,205 688, 0.0) - (Elemert 146 Elemert 143). 194 157478E3 GRIA-CHAR | Create loading 50 Poirt & - (Line 5) 178 -239159E3 GRIA-CHAR  Create loading
100 | (497 089,114 028, 0.0) - (Element 84, Element 87) m -52644E3 GRIA-CHAR | Create loading 52 Pairt & - (Line 6) 178 -226702E3 GRIA-CHAR  Createloading
11 | (494.758,123752, 0.0) - (Elemert 90, Element 93) 120 -15.2602E3 GRIA-CHAR  Creste loading 53 Poirt 2 - (Line £) 214 17B565E3 GRIA-CHAR  Cresteloading
13 |(483.541,162:137,0.0) - (Element 115, Elemert 118) 152 1515383 GRIA-CHAR __ Create loading 56 Poirt 6 - (Line 7) 178 -167951E3 CGRIACHAR | Creats loading
14 | (505863, 84,5242, 0.0) - (Element 53, Element 56) 70 -14.88E3  GRIA-CHAR  Create loading
15 [(480268,171 586, 0.0) - (Elemert 121, Elemert 124) 161 14859863 GRIA-CHAR  Create loading
16_|(467.372,204.116,0.0) - (Element 142, Element 145) 190 1298923 GRIA-CHAR Creatsloading | -
4 4+ #l )My Influence (My) - Negative - Characteristic My Irflusnce (My) - Poshive - Characleristic /. 4 4 b H 5_}My Influence (My) - Negative - My Influence (My) - Postive - Characterisic ]
=lol x| £ Lusas view: curved_bridge_preliminary_PB.mdl Window 1
Unfiltered influence results show results for all Influence results filtered to show only those results
features (all spans) for a selected feature (span 1)

Creating loading patterns

For this worked example, the most onerous loading effect for the influence assignment
of interest will be created individually by pressing the ‘Create Loading’ button
alongside the appropriate entry in the onerous results table.

With the line representing span 5 still selected:

e In the VLO results table ensure that the My Influence (My) — Negative —
Characteristic tab is selected and press the Create loading button for the most
onerous negative result entry (shown in red at the top of the right-hand table above).

A loadcase entry and a Loading folder will appear for the VLO results table entry in the
(&) Treeview for that influence as shown in the following image.
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El-2 YLD DMI My
El-g LML Al

|_—‘_| My Influence (My) - Megative - Characteriskic
El@ 208:My Influence (My) - (463.28, 213.24, 0.0) - (Element 149, Element 152} - Megative - Characteristic
=123 Loading

e 2ILMT udl (23 (0,61
o LM udl {30 (x 0.61)
o LM udl {43 (% 0,613
- GiLML ks (S) (x 1.0)
-~ BiLM1 udl {E) (% 2.2)
o FiLML udl (T (x 2,20
- BiLML ks (8 (x 1.0)
o QLML ral {90 (x 2.2)
e 100LMYL ral (100 (x 2.2)

e Leave the results table open to create additional loading patterns.

Check the loading visualisation settings
Before visualising the loading it is prudent to check or correct the settings required.

e From the = Treeview double-click Attributes
e Select the Loading tab and press Settings... button

e Ensure Show discrete loading by definition is selected and press OK to exit the
dialog.

e Press OK to return to the model.

Negative effects

e From the @ Treeview, and from within the VLO DMI analysis section, select the
My Influence (My) — (X,y,2) — (Element 149, Element 152) - Negative —
Characteristic loadcase and choose Set Active.

e Press Iil to visualise loading.

The optimised loading for the characteristic case of EN1991-2 UK that gives the
maximum My effect in the mid-span of span 5 for negative influence will be displayed.
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Positive effects
With the line representing span 5 still selected:

e Go back to the VLO results table and select the My Influence (My) — Positive —
Characteristic tab and press the Create loading button for the most onerous
positive result entry for the line selected. Note that this entry is not the most onerous
value for the bridge as a whole because it is not shown in red.

A loadcase entry and a Loading folder will appear for the VLO results table entry in the
G Treeview for that influence.

o From the /&) Treeview, and from within the VLO DMI analysis section, select the
My Influence (My) — (Point 6 — (Line 6) — Positive - Characteristic and choose
Set Active.

The optimised loading for the characteristic case of EN1991-2 UK that gives the
maximum My effect positive influence for the selected span will be displayed.

213



Vehicle Load Optimisation of a Box Beam Bridge

After further inspection (by selecting the line of each span and looking at the filtered
results in the onerous results table) it can be seen that the most onerous results for
hogging are actually obtained for span 3 at pier 3.

o First press |£| to turn-off the display of the loading patterns.

Solving optimised loading arrangements

So, as seen, the VLO run includes loading arrangements that can be optionally
visualised but produces no structural results. Results are available only after the VLO
analysis has been solved. So:

e With the model view window active, press the Solve Now El button.

Only the VLO analysis has to be solved in order to produce the results for the optimised
loading arrangements for each influence assignment. The Solve Now dialog indicates
that the VLO DMI My analysis results are not up to date and that they need to be
solved. The other two analyses are unselected by default, as their results are up to date.

e Press OK to solve the VLO run.

The results will be loaded on top of the current model, with the last viewed VLO DMI
My analysis loadcase set active by default.

Plotting bending moments

o From the (&) Treeview, and from within the VLO DMI My analysis section, select
the My Influence (My) - (x,y,z) — (Element 149, Element 152) - Negative -
Characteristic results loadcase and choose Set Active.

e From the = Treeview turn off the Geometry and Attributes layers.
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e With no features selected right-click in a blank part of the Graphics window and
select the Diagrams option to add the Diagrams layer to the = Treeview

e From the diagram properties drop-down menu, pick Force/Moment — Thick 3D
Beam from the entity and My from the component drop down list.

e From the Diagram Display tab deselect the Use for labels too option, select
Decimal places and change the value to 1

e Press the Label font... button and change the style to Bold

e Press OK to return to the properties dialog, and then press OK exit.

10011,
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The diagram shows the worst-case sagging moment, My, for span 5, due to
characteristic LM1 loading.

o From the &) Treeview, and from within the VLO DMI analysis section, select the

My Influence (My) — (x,y,z) — (Point 5 — (Line 4) — Positive - Characteristic and
choose Set Active.
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513.8
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The diagram shows the worst-case hogging moment, My, for span 5, which occurs at
pier 4, due to characteristic LM1 loading.

Using the procedures described in this example, lines representing each span can be
selected, onerous loading patterns can be created, all loadcases solved, and the
corresponding results for each span can be inspected.

This completes the example.

Discussion

This example just shows how a single influence component (My) can be defined and
assigned as an attribute to nodes within the lines representing the deck. Other influence
attributes such Mx, for investigating torsional effects, could be assigned to nodes in the
deck also, with loading and results effects being obtained in exactly the same way.
Investigation of axial forces at pier heads can also achieved in a similar fashion, but by
making assignments only to the points at those locations.

VLO analysis nhaming conventions

One Direct Method Analysis entry could contain a single Vehicle Load Optimisation
run, for all assigned influence components of interest, but for large models this could
result in a great deal of unstructured data within the Analyses (X treeview that is not
easily viewable.

It is often better to have a single Direct Method Analysis entry containing multiple
VLO run entries of suitable names such as Deck, or Pier, even including additional
references to load types, since this will simplify the viewing and provide a ‘structure’ to
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the data in the Analyses (L) treeview and also make the identification of results
loadcases easier when results processing.

The use of appending an influence component name to a Direct Method Analysis entry
or a VLO Run name (if they only contain assignments for a single influence type) may
also be useful if many entries are present in the Analyses (L) treeview, and some of
these entries are contracted when other entries are being viewed.
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Description

BRO Slab Analysis

For software product(s): | LUSAS Bridge.

With product option(s): None

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

&

Modelling

This example uses a previously created LUSAS bridge model that contains Swedish
BRO loadings and loadcases. The BRO load combination wizard is used to investigate
worst case positive and negative effects.

The structure is modelled using thick plate
elements, representing a deck of inner
radius 75m, outer radius 86m and
thickness 0.7m. The deck has a width of
11m consisting of a 10m wide carriageway
region and two 0.5m wide verges.

Objectives

U Generation of load combination in accordance with Swedish bridge code BRO

Keywords

2D, Slab, BRO Load Combinations, BRO Wizard, Positive Effects, Negative
Effects

Associated Files

0 deck_comb_loaded.mdl Model file of the structure.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.
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| File

BRO Slab Analysis

| Open...

| File

|Save As...

Creating a new Model

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File>
New to start a new model file. Modeller will prompt for any unsaved data and display
the New Model dialog. Select the Cancel button. Select the menu command File>Open
and then browse to the \<Lusas Installation Folder> \Examples\Modeller directory
and select the deck_comb_loaded.mdl file.

Open the read-only file deck_comb_loaded.mdl located in the \<LUSAS Installation
Folder>\Examples\Modeller directory.

Loadcases considered

The model in use was created using the Swedish BRO startup template. When using a
country-code specific template such as this, a number of blank loadcases are created in

the ‘& Treeview. These are the characteristic loadcases that are considered possible
within the Swedish code of practice BRO. Individual vehicle and lane loadings have

also been created in the ¢ Treeview and assigned to these loadcases. The BRO load
combination wizard will combine them in accordance with the Swedish code.

The following characteristic loadcases have been assigned to the model:
e Dead Load
e Surfacing
e Support yielding 1
e Support yielding 2
e Support yielding 3
e Support yielding 4
e Temperature 3
e Equivalent load 1 to Equivalent load 10
¢ View the BRO loadings and loadcases in the & and (2 Treeviews.

e In the \<LUSAS Installation Folder>\Projects\ folder create a new directory
called deck_comb_loaded

e Save the model into this new folder as deck_comb_loaded This helps keep all
relevant files separate from other analyses and is good practice.
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normally be defined using the || - sweden Options

Note. Loadcases  would

of this example is to concentrate
on showing the use of the BRO
Combination ~ Wizard  these Vehicle B load...
loadcases have already been
defined and assigned to the
model that is in use.

Brldge > Bl’ldge Loadlng_ > Wehicle A load... Heawy vehicle loading.. |
Sweden  menu entry which

would dlsplay the dlalog shown Sinale wheel load... Fatique wehicle loading... |
HOWGVGr, because the purpose Special vehicle loading... Classification Yehicle... |

Lare loading... Train Loading...

Help |

Running the Analysis
With the model loaded:

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to begin
the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.

In addition, two files will be created in the Associated Model Data directory where the
model file resides:

T U0 deck_comb_loaded.out this output file contains details of model data,
H assigned attributes and selected statistics of the analysis.

U deck_comb_loaded.mys this is the LUSAS results file which is loaded
automatically into the (X Treeview to allow results processing to take place.

Viewing the Results

BRO Combinations

The BRO combination wizard allows you to choose which loads to combine into
combinations. By selecting the combination type i.e. Comb4A (Combination 4A), the
wizard defaults the load coefficients to the correct values as stated in table 22-1 of
BRO. Once all the required permanent, variable and live loads have been selected the
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resultant combination can be produced. The resultant combination will be formed by
combining a combination of permanent loads, support yielding combination or
envelope, a combination of variable loads and envelopes of live loading.

Note. The BRO combination wizard can only be used if the BRO loadcase template
/ has been specified to define the characteristic loadcases at the Model Startup stage.

| Bridge The BRO Combination Wizard dialog will appear.
Loading

Combinatins >« Select the Set

[BRO...
defaUItS bUtton' Welcome to the BRO combination wizard
4 SeIeCt To begin to generate a BRO combination, choose which combination you require and click
combination Mext to continue.
Comb 4A
— BRO Combination options
» Ensure the Fleaze zelect type of combination required.
Number of
variable  Combl € Comb2 ¢ Comb3 & Comb4d ¢ Comb4B ¢ Comb 52
loadcases is set O Comb58 C CombEC € Comb6 C Comb? © Comb® € Combd
to4
i Murnber of wariable loads to be included in the combination [ 4
e Click Next
Set defaults | Mext > | Cancel | Help |
. For the
permanent load — Permanent load twpe zelection
type selection
ensure the Dead
load and Dead Load: v Overburden I
Superimposed
dead: Deck Superimpozed Deck Sutfacing [V Earth pressure Active [
Ssu rfaCing el Passive [~
options are ‘ w =1 r 0 -
ater pressure | restress force t=|
selected =
. ClICk the Next ‘ Shrinkage During erection [~ | ke
button to
continue.
< Back | Mext > | Cancel Help
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e In the Support

ylE‘Idlng section — Load type selection
select the
Combine
enve I 0 pe of Support yielding: " Combine loadcases selectively
IOadcases Option. +  Combine ervelope of lbadcases
e Click the Next Suppart yieldhg case 1 & Support yielding case 6 7
bUttOﬂ to Suppart yieldng case 2 [ Suppart pielding case 7 [
. Support yieldngcase 3 & Support yielding case 8 7
continue. Support yieldng case 4 [F Support yieldng case 9 7
Support yieldngcase 5 7 Support yielding caze 10 7
< Back Next > Cancel Help

e No user defined

permanent loads — Load type selection
have been User: Permanent load1 [ Permarent factar i Yariable factor [
defme(_j for this User: Pemanent load 2 [~ Permanent factar i Yariable factor [
anaIySIS B &Y Uzer: Permanent load3 [~ Permanent factor [ Wariable factar [
(_ansure the dlalog User. Permanent load 4 [~ Permarent factar [ Yariable factor [
is left blank and L ,
R User: Pemanent load5 [~ Permanent factar | ‘Warable factar i
click Next to S . —
. User. Permanent loadE [~ Permarent factar i Wariable factor [
continue. | |
User: Pemanent load 7 [~ Permanent factar 1 Yariable factar [
Uzer: Permanent load® [ Permarent factar q Wariable factor [
User. Permanent loadd [~ Permarent factar [ Yariable factor [
User: Pemanent load 10 [~ Permanent factar | Wariable factar [
< Back Mewt > Cancel Help
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e For the variable

|Oad type — Yariable load type zelection
selection pick
Temperature ‘ Surface load r | ‘ Fatique load = ‘
type Temp 3
i ‘ Braking force r | ‘ Lateral farce | ‘
e Click Next to
continue. lze and curent r | ‘ Sric Il ‘
‘Wind loading o | Temperaturs Temp1 [
Temp2 [
‘ \Water pressure r | Temp3

‘ Surcharge o | ‘ Accident loads ol ‘

< Back | Mest > | Cancel Help |

e No user defined

variable loads — Load type zelection
have been User: Wanable load 1 I Permanent Factar U— ‘ariable Factar -|—
defl ne(_j for thlS User: Wariable load 2 r Permarnent factor D_ Warigble Factor 1_
anaIySIS A SO User: Wariable load 2 I Pemanent factar [ Yariable Factar 1—
_ensure the dlal_og Uszer: Wariable load 4 r Permanent factor [ ‘ariable factor -|—
15 blank and CIICk Uszer: Yariable load & I Permatent factor ] ariable factor ‘I_
Next continue. : : L
User: Wariable load & I Permanent factor [ Yariable factor [
User: Wariable load 7 r Permarnent factor D_ Wariable Factor 1_
User: Wariable load 8 I Pemanent factar [ Yariable Factar 1—
User: Wariable load 9 r Permanent factor [ ‘Yariable Factar 1—
User Yariable load 10 [ Pemanent factar [ Variable Factar [
< Back Mewt > Catcel Help
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e Finally,  with
reference to the — Yanable load type zelection
QTreeVIeW’ Combine the following equivalent load cases with the loadings selected previously to produce
enter the the BRO factared load combinatians.

Equivalent
loads as Equivalent loads I 1-54-64
attributes  1:54-
64 Maintenance and emergency vehicles I
Live load cazes selection (0:50,1:51,0:53,1:56-60)

e |eave the Format - File ID : Loadease Number...
Maintenance [Firgt file loaded iz Mo.0]
and emergency Has the live loading been produced uzing the vehicle load optimizer. o
vehicles blank.

e Select Finish to — _— e "
generate the < Bacl inis| ancel elp
BRO Resultant
combinations.

Displaying contours for BRO Max and Min Effects

o If present, turn-off the display of the Geometry and Attributes layers in the
Treeview.

e With no features selected, click the right-hand mouse button in a blank part of the

graphics area and select the Contours option to add the contours layer to the
Treeview.

The contours properties dialog will be displayed.

e Select Entity Force/Moment - Thick Plate component moments in the X direction
MX and click OK

The Contour results for Loadcase 1 - Dead Load will be displayed.
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Loadcase: 1:Dead Load
Ertity: ForceMdoment - Thick Plate
Component: hix

AS6 618
17 463
78.309 J
391545
o
391545
78309 -
117 463 -
. 156 B8

Mzximum 195 326 st node 19
Minirmum -157 085 st node 21

o In the ‘& Treeview right-click on BRO Combination 4A:Resultant(Max) and
select the Set Active option to view the worst positive effects (i.e. hogging moments
and reactions). Select entity Force/Moment - Thick Plate and component MX to
be used to assess the relieving or adverse affects when processing the combinations
and click OK. To continue with partial results click OK

Caombining on: X

BROCombination 4.4 Resultant (730 (s L ' F
Ertity: ForceMoment - Thick Plate
Component: hix e
-95.3841
oo
95.3541
- 196765
295152
393.536 - 0

491 .92
590,505
Gt 655

Mgximum 774 934 ot node &
Minirmum -110.523 &t node 21

e Set combination the BRO Combination 4A:Resultant(Min) active to view worst
negative effects (i.e. sagging moments and vertical displacements). Select entity
Force/Moment - Thick Plate and component MX to be used to assess the relieving
or adverse affects when processing the combinations and click OK. To continue
with partial results click OK
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Save

Viewing the Results

Combining on: i

BROCombinstion 44 Resutart (73) (Min)
Ertity: Forceoment - Thick Plate
Component: hX

-9559
-B62 663
-739.423

-B16.188

- -492.95
-363.713
-246 473
-123.238
on

Maximum 32 3628 at node 36
Mirirmum -1 OFE7EES at node 52

Additional results processing can be carried out in a similar manner to that described in
the Simple Slab example.

Save the model

El Save the model file.

Note. When the model file is saved after results processing, all load combinations,
envelopes, and graph datasets, if defined, are also saved and therefore do not have to be
re-created if the model is amended and a re-analysis is done at a later date.

This completes the example.
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Description

Section Slicing of a
3D Shell Structure

For software product(s): | Any Plus version.

With product option(s): None

Description

This example uses the
Slice Resultants
Beams/Shells facility to
investigate the behaviour
of a bridge deck
modelled using thick
shell  elements. The
results are converted into
forces and moments of
an equivalent beam
using this facility.

Units used are N, m, kg,
s, C throughout.

Objectives
The output requirements of the analysis are:

U Forces and bending moments along length for whole structure
O Forces and bending moments associated with central girder effective width

Keywords
Force, Bending moments, Slicing, Shells.
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Section Slicing of a 3D Shell Structure

Associated Files

H U shell_slicing.mdl Model file of the structure.
i

Modelling

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Creating a new Model

| File e To create the model, open the file shell_slicing.mdl located in the \<LUSAS
Open.. Installation Folder>\Examples\Modeller directory.

El If necessary, click the isometric button to view the model in 3D
|i| If necessary, turn-on the display of the supports.

Iil If necessary, turn-on the display of the loading.
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Modelling

| File e Save the model to your local projects folder to prevent overwriting the model in the
|SaveAs.. examples directory.

In the ‘X! Treeview two loadcases can be seen. One corresponds to the self-weight of
the structure and the other to an applied load of a United Kingdom HB vehicle. For the
post-processing, a combination has also been defined which combines these two load
cases.

Turning off all layers other than the mesh allows visualisation of the general layout of
the model. The deck is 4.21m wide and consists of a concrete slab and three steel
girders as indicated in the following figures. The mesh discretisation of the model is
extremely coarse for the purpose of this example.

Note. When carrying out this type of slicing on realistic models it is recommended
/ that a much finer mesh discretisation is used to accurately capture the response of the
structure, particularly if 3- and 4-noded shell elements are being used for the modelling.

Idealisation of the Bridge Structure

For this example the idealisation of the bridge structure into the analysis model has
been done using only shell elements.

Top flange and
slab connected

Shell element modelling of the whole structure

Shell elements have been used for the girder components and also the concrete slab as
illustrated. For the modelling, discrete features have been defined for the top flange and
the slab since their materials are not identical. The slab has an eccentricity to define a
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Section Slicing of a 3D Shell Structure

bending plane that is not coincident with the top flange and these two components are
combined using an equivalence attribute. This is just one of many ways that the
idealisation for this type of bridge structure can be undertaken.

Based upon this idealisation method the whole model showing element discretisation is
as shown:

Alternative idealisations

The following figure shows the same structure but this time the shell elements
representing the top and bottom flanges of the girder have been replaced by beam
elements running along the top and bottom of the girder with the appropriate properties
for the flange members.
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Modelling

7/ 7 7 7 7 7/
// /// /// / /// /// ///
7
e /7 7 / e 7 7
7/ 7 7 7 7 7
s 7 ’ / 7 7 7
/v
Beams for top
and bottom
flanges

Shells for web

Beam element modelling of flanges

In the last figure the whole girder has been replaced by beam elements with appropriate
geometric properties and an eccentricity to offset the bending plane of the beams.

Actual modelling
location of beam

_—
l
!

\ Beam representing

complete girder with
eccentricity

Beam element modelling of the whole girder
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Section Slicing of a 3D Shell Structure

The choice of which analysis idealisation should be used depends upon what is required
from the results of the analysis. For instance, if a curved girder analysis is being
performed and the lateral forces in the top and bottom flanges are required then Shell
element modelling of the whole structure or beam element modelling of the flanges (as
shown in the first two figures) are suitable but beam element modelling of the whole
girder (as shown in the last figure) is not.

Running the Analysis
With the model loaded:

El Open the Solve Now dialog, ensure Analysis 1 is selected and press OK.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

Viewing the Results

Analysis loadcase results are present in the (5} Treeview, and the loadcase results for
the self-weight loadcase will be set to be active by default.

| utilities

| Annotation
Window

Summary

Plotting Deformed Shapes

Ensure the Mesh, Geometry and Attributes layers are present and turned off in
the = Treeview.

With no features selected click the right-hand mouse button in a blank part of the
Graphics area and select the Deformed mesh option to add the deformed mesh

layer to the = Treeview.

Show the Window Summary for an overview of the results.
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Viewing the Results

Seale=1:26.4404

Zoom: 100.0

Eye: (057735, -0.67735, 0.67735)
Linearvvnamic Analysis

Loadcase: 1

Self nieight

Results File: 0

Maximum Displacement 0.12041E-01 at Hode 16

Computing Forces And Bending Moments For
Combination

e  Turn off the Deformed Mesh and Annotation layers in the = Treeview.

e With no features selected click the right-hand mouse button in a blank part of the

Graphics area and select the Mesh option to add the mesh layer to the
Treeview. In the mesh dialog box click the OK button to accept the default values.

e With no features selected click the right-hand mouse button in a blank part of the
Graphics area and select the Geometry option to add the geometry layer to the

Treeview. In the geometry dialog box click the OK button to accept the default
values.

o Inthe "= Treeview expand Analysis 1 then right-click on Combination and select
the Set Active option. The results for the combined effects of the factored self
weight and HB vehicle load will now be available.

e Select the centre line of the model (Line 11). This line will be used to define the
path along which the slicing will take place.
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Section Slicing of a 3D Shell Structure

Straight line 11

Points: 1, 25
Surfaces: 3. 4.5
Msh:Mull_4_1

There are 8 itemz at thiz position
Press Tab to cpele through them

o B Set the view axis to be along the global Z-axis by pressing the Z-axis
button at the bottom of the graphics area.

The current Modeller window should look as follows:

definition of the slice cutting planes must, for this example at least, always be done with

Note. Whilst visualisation of the model can be done using an isometric view the
the model viewed along the global Z-axis.

With the centre line of the model (Line 11) still selected:

| utilities
Slice Resultants
Beams/Shells
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Viewing the Results

The slicing dialog will be displayed.

—Slice locations

(] Select the Incremental " From points or hodes in selection
d |5Fance from start Of path % Incremental distances from start of path e.g. 1(@10,2@5
option. | 0151

7 Ahsolute distances from start of path e.g. 10,15.20

e Enter 0;15@1 into the |
associated box which will cut
. . Diztance from reference arigin to
slices at the start of the line || stataof path(chainage) KE
(Om) and every 1m up to and || —Siice aptions
inClUding 15m. Moments sbout * Nedtral axiz © Path intersection

. E ffect idth Ihelvde wholeel i [
e  Set the Distance from reference I~ Efecivevidh | IRlloeleeintileetanent et

Origin to Start of path |+ Smooth corners on path
(Chainage) to 0 Slicenamne prefiz I Slice

—Loadcase

e Select the Neutral axis option _
®dctive O Ml O Sekctedegl248|
to calculate the forces and

moments about the sliced
section neutral axis.

Defaults | Ok | Cancel | Help |

e Ensure that the Effective width option is not selected.

e  Ensure the slice option Smooth corners on path is selected.

e Set the Slicename prefix to Slice . This will be the prefix for the name of the sliced
sections created.

e Click the OK button to start the automated slicing the model.

Note. Three methods are available for the definition of the slice locations:

U From points or nodes in selection allows the definition of the slicing locations
by projection of the points/nodes onto the slicing path.

U Incremental distances from start of path allows the definition of progressive
slice distances governed by the supplied increments. These increments can be
positive or negative so long as the accumulated distance is within the path
length.

U The Absolute distances from start of path allows the definition of known
distances along the slicing path for slices to be taken.

The slice option Smooth corners on path is used to traverse sharp corners in the
defined slicing path. If smoothing is selected then the orientation of the slice plane is set
to be at an angle of half the path angle change at the connection if this location
coincides with a slice. If smoothing is not selected, two slices will be taken at a sharp
corner with angles taken from both lines/arcs at the connection.
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Section Slicing of a 3D Shell Structure

The tabulated data

The forces and moments for the slices are output in a grid as indicated in the following
figure. The output is relative to the slice axes and consists of the following information:
Slice title, distance associated with slice location, the global coordinates of the sliced
section neutral axis, shear forces (Px and Py), axial force (Pz), bending moments (Mx
and My) and torsion (Mz). If moments are calculated about the path intersection then
the coordinates will be equal to the location on the path associated with the distances

selected.
Slice Results

Slice & 0

Slice 2 1.0 1.0 ili] 0.0413928 97918466 (0.0 228707EE |00 0o 01281 7EE-3

Slice 3 20 20 no 0.0413928 |9.77547E6 (0.0 229457EE |00 no 0.12116EE-3

Slice 4 a0 a0 0o 0.0413928 |9.75911E-6 (0.0 230264E6 |00 0o 01141553 ||

Slice 5 40 40 nn 00413926 |10 038266 (0.0 1745EE |00 nn 74 FER4EE

Slice § 50 50 ili] 0.0413928 100026 0.0 17.328%E6 |00 0o £2.0895E -5

Slice 7 ED ED no 0.0413928 |9.90E58E € (0.0 17.1888E 6 |00 no E1.3907E &

Slice 8 7.0 70 0o 0.0413926 9810796 [B7.9102E3  |17.0523E6 |00 0o 54ET0EE |
IV Thieshold value  [1e-6 Clase |

Values that could conceivably be considered to be zero can be tabulated as such (for

viewing purpose only) by setting an appropriate Threshold value.

The grid data can be copied and pasted using the Ctrl + C and Ctrl + V keys into an
application such as Microsoft Excel to generate force and bending moment diagrams as

illustrated.
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Viewing the Results

Forces and bending moments

3.00E+06
2.00E+06
£ 1.00E+06
% 0.00E+00 e
E -1.00E+06 =i=Fy
& -2.00E+06 =Pz
= -3.00E+06 M
E’ -4 D0E+06 My
P -5.00E+06 s
-5.00E+06

-7 .00E+06
Distance (m)

e If necessary, turn-on the Annotation layer in the = Treeview.

The locations of the slices are indicated on the model as illustrated below. These
annotations include the physical location of the slice, its title and a local coordinate set
indicating the axes of the slice. If the option to calculate the forces and moments about
the neutral axis has been selected this local coordinate set will be defined at the neutral
axis location. If however the option to calculate the forces and moments about the slice
path has been selected, the local coordinate set will be defined at the intersection
between the slice path and the slice plane.

.
i
Fplme
=
Fplme
=
==
o
==

e Click on the EI isometric button to view the model in 3D to view the extents of
the slices.
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| utilities
Slice Resultants
Beams/Shells

Section Slicing of a 3D Shell Structure

Note. Whilst visualisation of the slices generated is possible in an isometric view the
definition of the slice cutting plane must, for this example at least, always be done with
the model viewed along the global Z-axis.

e Press the Close button to close the Slice results table and remove the display of slice
locations from the Annotation layer of the model.

Computing Forces and Bending Moments for Girder
Effective Width

o I NA Set the view axis to be along the global Z-axis

With the centre line of the model still selected:
The slicing dialog will be displayed. T

- Slice locations

" From points o nodes in selection

[ ] Select the Absolute distances from start of £ Incremental distances ffom start of path e.q. 1@10,285
path option. [ e

v Absolute distances from start of path e.g. 1015.20
I 0255751012515

Note. List separators vary according to your PC’s || Ditesfomelenceoiinte 5|

start of path (chainage)

regional locale settings. For example, English (UK) e
- - - loments about * Neutral axis "ath intersection

and EngIISh (US) Settlng§ use a Comma as a IISt I¥ Effective width | 2.0 I Inchude whole elements only

separator. French, Swedish and other language

¥ Smooth comers on path

settings use a semi-colon. Seeronepen [ Gl |

Loadcase

Please enter whatever is appropriate to your region. [ potve CAl O soeciedeg 24 |
In this example an English (UK) separator is shown. | | e [
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Viewing the Results

e Enter 0,2.5,5,7.5,10,12.5,15 (using an appropriate list separator for your regional
settings) into the associated box. This will cut slices at the start of the line (Om) and
every 2.5m up to and including 15m.

e Set the Distance from reference origin to start of path (chainage) to 100 . The
start of the slicing path will therefore have a distance/chainage of 100m and the end
of the slicing path will have a distance/chainage of 115m.

e Select the Effective width option and enter 2.0 in the associated box. This will set
the effective width to be 2.0m centred on the slicing path (i.e. 1.0m either side)

e Set the Slicename prefix to Girder2 (Eff) . This will be the prefix for the naming
of the sliced sections.

e Click the OK button to start slicing the model.
The forces and moments for the slices are output in a grid as shown:

Slice Results [ %]

Girder [Eff] 1 100.0 0.0 7 4E3 B ]
Girder [Eff) 2 025 |25 7H.855E-18 | 0.0622785 | -10.3833E-6 | -44290M1E3 | -E16876E3  |-1.45731E6 |-31.9670E6 | 24.09553E-E
Girder [Eff) 3 1050 |50 79.855E-18 | 0.0622785 | -1.77568E-6 | -75.0993E3  |-1.19305E6  |-219555E6  |-56.9B62E-6 | 11.6428E-6
Girder [Ef)4[-2) |107.5 |75 70.855E-18 | 0.0622785 | 412138E-6 | 96.495E3 -1.38373E6 | -230862E6 | -FESI01EE | B.92151E-E
Girder [Ef1 4 [+Z] | 107.5 |75 78.855E-18 | 0.0622785 | 11.681E-6 -1021E3 13934386 | -230187EE | -T44632E6 | -O.6205EE-E
Girder [Eff) 5 1100|100 7H.855E-18 | 00622785 | 121926E-6 | 71.0146E3 | -1.17338E6 | -22040BE6 | -60.2157E6 | -10.9251E-B
Girder [Ef B 125|128 7H.8E5E-18 | 0.06227385 | 18.1336E-6 | 416.520E3 | -GOBG7IEZ | -1.40065E6 |-27.3141E6 | -238413EE
Girder [Eff) 7 1150|180 79.855E-18 | 0.0622785 | 14.1946E-6 | B94.615E3  [12001E3 -187.693E3 | 1.67157E-6 | -19.5059E-6

™ Threshold valus IWE-B Close I

Copying these results into a spreadsheet application and generating the graphs gives the
force and bending moment diagrams as shown:

Forces and Moments

-1.00E+06

\ O~/ .
-1.50E+06 \ / =y
-2.00E+06 \Nx-—"( ——Mz

-2 50E+06

1.00E+06
. 5.00E+05 -

E

£ 0.00E+00 - P
=

H a5 10 05 110 J..fs 120 =Py
£ -5.00E+05 -

g / =Pz
z

£

Chainage (m)
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| utilities

Section Slicing of a 3D Shell Structure

Remove
Beam/Shell Slice
Annotations

e Press the Close button to close the Slice results table and remove the display of slice
locations from the Annotation layer of the model.

The locations and extents of the slices through the bridge are indicated on the model as
illustrated below. These annotations include the physical location, title and local axes as
before.

AGirder2 (Eff) 1 irder2 (Eff) 2 irder2 (Eff) 3 AGirder2 (Eff) 4 irder2 (Eff) 5 AGirder2 (Ef) 6 AGirder2 (Eff) 7
kS A A A

===

e Click on the El isometric button to view the model in 3D to view the extents of
the slices.

e Delete the current slice annotations.

This completes the example.

Notes

Curved structures can also be sliced using this facility.
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Description

Seismic Response
of a 2D Frame
(Frequency Domain)

For software product(s): | All (except LT versions)
With product option(s): | None.

Description

This example examines the Spectral

Response analysis of a 2D braced tower

frame. The geometry is simplified to a  Diagonal
wire-frame or stick representation, with  bracing
each of the structural members being

represented by Point and Line features

only.

9 x 4.5m
The model is comprised of thick beam high storeys
elements for the concrete column, beam

members, and steel diagonal bracing

members  which have pinned end L
connections. The structure is fully

restrained against displacement and 17272714
rotation at ground level. U &

7 X 4.0m wide bays |

Since the global response of the structure
is required, the model of the tower is
further simplified by meshing each Line with a single element. This will effectively
avoid the extraction of local panel modes for individual beams and columns. These
local modes could be investigated independently in a more detailed analysis.

y

The spectral response analysis is performed in three distinct stages. Firstly a natural
frequency analysis is performed. This is used here to calculate the first 10 natural
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A

Modelling

Seismic Response of a 2D Frame (Frequency Domain)

modes of vibration of the structure. The eigenvalues, frequencies and eigenvectors
(mode shapes) are stored and used in the subsequent spectral response analysis.
Although the natural frequencies are obtained from an eigenvalue analysis any
information regarding the magnitudes of deformations or moments is non-quantitative.

The second phase of the analysis is the spectral response calculation, in which the
spectral response computation is performed interactively as a results processing
operation using the Interactive Modal Dynamics (IMD) facility. This is an alternative to
performing a non-interactive spectral response analysis in LUSAS.

In a spectral response analysis, the structure is subjected to a support condition
excitation. In this example this is assumed to be the effect of Seismic/Earthquake
motion although any support motion could be envisaged. The excitation is specified as
a spectral curve, in terms of displacement, velocity or acceleration and represents an
envelope of these effects over a measured frequency range. Damping may also be
specified at this stage.

From the spectral analysis participation factors are obtained which indicate, for each
mode, the degree of structural response associated with this applied excitation.

The last phase of the analysis considers self weight in conjunction with the spectral
response and to this end two load combinations are defined from which worst case
force/moment envelopes may be obtained.

Units used are N, m, kg, s, C throughout.

Keywords

2D, Plane Frame, Beam, End Releases, Fleshing, Natural Frequency, Eigenvalue,
Spectral Response, Seismic, Axial Force, Shear Force, Bending Moment
Diagrams, Participation Factors, Modal Dynamics, Interactive Modal Dynamics
(IMD), Modal Response, Global Response, Graphing, Animation, Load
Combination.

Associated Files

U tower_modelling.vbs carries out the example modelling.
U tower_spectrum.vbs defines a typical spectral curve excitation.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.
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| Geometry >
Line >
Coordinates...

Modelling

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as tower

e Use the Default working folder.

e Enter the title as Tower

e Set model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the Standard startup template.

e Select the Vertical Y Axis option.

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to

correct any mistakes made since the last save was done.

Defining the Column and Beam Members

il Enter coordinates of (0, 0), (0, 4.5), (4, 4.5) and (4, 0) and click OK to define the
first bay of the ground level storey.

Note. Sets of coordinates must be separated by commas or spaces unless the ‘Grid
Style” method is chosen. The Tab key is used to create new entry fields. The arrow
keys are used to move between entries.
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| Attributes

|Mesh
|Line...

| Attributes

| Geometric
|Line...

>

Seismic Response of a 2D Frame (Frequency Domain)

Meshing - Columns and Beams

As the global response of the structure is required only
one beam element need be used along each Line. This
will prevent LUSAS from picking up any panel modes
caused by local vibration of the columns and beams.

Select Thick Beam, 2 dimensional, Linear

elements.

Enter the number of divisions as 1

Enter the attribute name as Thick Beam and click

OK

With the whole model selected, drag and drop the Line mesh attribute Thick Beam
from the &% Treeview onto the selected features.

Geometric Properties - Columns and Beams

From the Usage section
select 2D Thick Beam from
the drop down list and
change the values on the
dialog to match those shown
in the table for a column
member.

Enter the attribute name as
Concrete  Column  and
select the Apply button to
create the attribute and re-
use the dialog.

Change the values on the
dialog to match those shown
in the table for a beam
member.

Change the attribute name to Concrete Beam and click OK

Column Beam

Member Member
Cross-sectional area 0.1 0.08
Second moment of area 0.8336-3 0.5336.3
about z axis 1zz) 033€ 2396
Effective Shear Area in 01 0.08
Y Direction (Asy) : '
Offset in y direction

0 0

(Ry)

Note. Whilst in practice column sizes would vary with height and beam sizes may
vary throughout the structure, in this example, for simplicity, all of the concrete
columns and beam sections are of the same size and assumed to be of solid square
section.
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| Attributes
| Material >
Material Library...
| Geometry
| Line >
Copy...

Modelling

e Select the 2 vertical Lines representing the column
members. (Hold the Shift key down to add to the
initial selection).

e Drag and drop the geometry attribute Concrete

Column from the & Treeview onto the selected
features.

e Select the horizontal Line representing the Beam. &

e Drag and drop the geometry attribute Concrete — #—f=f= .
Beam from the &b Treeview onto the selected Line.

Geometric property assignments are visualised by default. In general the diagrams in
this example will not show geometric visualisations.

Material Properties - Columns and Beams

e Select material Concrete from the drop down list, leave the grade Ungraded and
click OK to add the material attribute to the & Treeview.

The columns and beams are made of concrete.

o Select the whole model by either using the Ctrl and A keys to select all features or
by dragging a box around the model.

e Drag and drop the material attribute Isol (Concrete Ungraded) from the &
Treeview onto the selected features.

Copying the Column and Beam Members

Now that one bay has been fully defined it will be copied to form the other 6 bays of the
ground storey of the tower. With the whole model selected:

“arm

II1] Enter a translation in the X direction of 4 metres.

e Enter the number of . - . . - -
copies required as 6 M

e Click the OK button
to create 6 additional
bays.

g5
W

Bay 6 of the structure requires diagonal bracing to be added with the ends of both
members being free to rotate about the Z direction in order to model a pinned
connection.

247



| Geometry
[ Line >
| Points. ..
| Attributes
| Geometric >
| Section Library...

Seismic Response of a 2D Frame (Frequency Domain)

Defining the Bracing Members

e Select 2 diagonally opposite Points in bay 6. (Hold the Shift key down to add to the
selection).

ilThe line will be drawn.

o Repeat for the other pair of diagonally opposite Points.

Meshing - Bracing Members

Only one beam element is to be used along each bracing member. However, the ends
of the bracing members must be free to rotate about the Z direction in order to model a
pinned connection, therefore the existing mesh dataset (as used for the beam and
column members) cannot be used. A new mesh dataset must now be created from the
existing one.

e Inthe c&n Treeview double-click the Thick Beam attribute name.

e Click the End releases button and set the First node end releases and Last node
end releases to allow Rotation about Z by selecting the option.

e Click the OK button to return to the Line mesh dialog.
e Change the dataset name to Thick Beam (Pinned Ends) and click the OK button.

e With the 2 Lines representing the bracing members selected. Drag and drop the Line

mesh attribute Thick Beam (Pinned Ends) from the &b Treeview onto the selected
features.

Note. The visualisation of . ' ' ' » .
the beam end releases is J J I NHE J
shown by default. If it is

required to turn-off their fe THZ WHZ
visualisation select the

Treeview and double click on Mesh, select the Visualise tab and deselect the Beam
end releases option.

Geometric Properties - Bracing members

For the purposes of this example the bracing members are to be defined as Universal
Beams.

The standard sections dialog will appear.

¢ Inthe Usage section ensure that 2D Thick Beam is selected
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| Attributes
| Material >
Material Library...
| Geometry
| Line >
Copy...

Modelling

e From the UK Sections library select the Universal Beams (BS4) section type and
select the 254x146x43kg UB section.

e Enter an attribute name of Bracing Member and click the OK button to add the
Universal Beam attribute to the & Treeview.

o Select the 2 diagonal Lines representing the bracing members.

o Drag and drop the geometry attribute Bracing member (254x146x43kg UB major
z) from the &b Treeview onto the selected features.

ﬂ Select the fleshing on/off button to turn-off the geometric visualisation. If at any
time during the example you wish to visualise the geometry select this button.

Material Properties - Bracing Members

e Select material Mild Steel from the drop down list, leave the grade Ungraded and
click OK to add the material attribute to the &% Treeview.

e With the 2 bracing members selected, drag and drop the Material attribute 1s02
(Mild Steel Ungraded) from the &b Treeview onto the selected features.

The first bay of the ground storey of the tower is nhow completely defined. The support
conditions are not defined or assigned yet because this bay will be copied upwards to
create other storeys where supports will not be required.

Copying the Model Features

The other storeys of the tower can now be generated by copying selected features
through specified distances in the Y direction.

e Select the whole model using the Ctrl and A keys together.

Sarm

LI Enter a translation in the Y direction of 4.5 metres. Enter the attribute name as
Y=4.5. Click the Save button to save the attribute for re-use. Enter the number of
copies required as 2 and click the OK button to finish to generate two additional
storeys.

Note. All attributes assigned to the features on the ground level storey, for example,
line mesh, geometric and material properties, will be duplicated on the other storeys
automatically when the new features are created by copying.
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Seismic Response of a 2D Frame (Frequency Domain)

e Drag a box around the Drag a box to select only these bays
bays shown to create r- T T T T T T T T T T T T T T 1
the next level of the : :
structure. | |

| |
|GeL?r:';e"y S Il Select the atiribute - ]
Copy... Y=4.5 from the drop T T T T T T T T N k
down list and click the

OK button to create 1

copy of the features &

selected.

fese e L - L L ]

e Drag a box around the bays shown Drag a box to select
to create the next level of the only these bays
structure. ;‘ ________ ]

o I |

|GeL?:;e"y S Il setect the attribute Y=45 from | |
Copy... the drop down list and click the OK :_ :
button to create 1 copy of the features e k

selected.

e Drag a box around the bay shown Drag a box to select
whlch _W|II be used to create the only this bay
remaining levels of the structure. -

—% I

[ [

1 -

L L]
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| Geometry

Line
Copy...

Modelling

ﬂ Select the attributeY=4.5 !
e Change the number of copies to 4

e Click the OK button to create the remaining levels. !

Supports

LUSAS provides the more common types of support by

default. These can be seen in the & Treeview. The
tower must be fully restrained at the base, therefore 3
degrees of freedom (U, V and rotation about the Z axis)
must be restrained. A fully fixed support type is &—4=f= & &
therefore required.

Assigning the Supports

e Drag a box around the 8 Points along the
base of the structure.

e From the & Treeview drag and drop the
support attribute Fully Fixed onto the
selected features, ensure the All analysis
loadcases option is selected and click OK

The model geometry is now complete.

o)

Loading

Note. No static structural loading is required for the first part of this analysis because
the spectral combination is carried out during results processing using the results from
the natural frequency analysis which is independent of applied loading. The modelling
will now be completed by defining the controls necessary to extract the natural
frequencies.
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Eigenvalue Analysis Control

Since the first stage of a spectral response analysis involves a computation of the
natural modes of vibration an initial eigenvalue extraction analysis must be carried out.
The solution parameters for eigenvalue analysis are specified using an eigenvalue
control dataset. In this example the first 10 natural modes of vibration of the tower are
computed.

Eigenvalue analysis control properties are defined as properties of the loadcase.

e Inthe @ Treeview, expand Analysis 1 then right-click on Loadcase 1 and select
Eigenvalue from the Controls menu.

The Eigenvalue dialog will appear.

Eigenvalue Eq
Solution IFrequenc_l,J j Value
Mumber of eigenvalues 10
™ Include modal damping Sieh danmpitg .. | Shift to be applied 0|
Eigervealues required IMinimum j
— Range specified az

% Frequency = Eigenvalue

Type of eigensalver | Default j

- Bigerivector normalisation ¥ Stum sequence check for missing eigenvaluss

" Unity ' Mass = Stiffress N 4
vanced... |
0k I Cancel | Help |

The following parameters need to be specified:

e Set the Number of eigenvalues as 10

e Ensure the Shift to be applied is set as 0

e Ensure the Type of eigensolver is set as Default

Note. Eigenvalue normalisation is set to Mass by default. This is essential if the
eigenvectors are to be used for subsequent IMD analysis when results processing.

e Click the OK button to finish.
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| File

Running the Analysis

| Save

Saving the model

El Save the model file.

Running the Analysis

A

With the model loaded:

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to run
the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (5] Treeview

In addition, 2 files will be created in the new Associated Model Data directory where
the model file resides:

U tower.out this output file contains details of model data, assigned attributes
and selected statistics of the analysis.

U tower.mys this is the LUSAS results file which is loaded automatically into
the /= Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

0 tower_modelling.vbs carries out the modelling of the example.
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| File

New...

| File

[ Script

>

Run Script...

Seismic Response of a 2D Frame (Frequency Domain)

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as tower

e To recreate the model, select the file tower_modelling.vbs located in the \SLUSAS
Installation Folder>\Examples\Modeller directory.

;l Rerun the analysis to generate the results.

Viewing the Results

| utilities

Print Results
Wizard...

Eigenvalue loadcase results are present in the C! Treeview, with Eigenvalue 1 set to be
active by default.

Plotting Mode Shapes

e Turn off the display of the Mesh, Geometry and Attributes layers in the
Treeview.

e By default the Deformed mesh layer is visible.
To see other mode shapes:

o In the & Treeview right-click on Eigenvalue 2
and select the Set Active option. The deformed
mesh plot for Eigenvalue 2 will be displayed.

e By setting each Eigenvalue to be active the
deformed mesh can be seen for all mode shapes.

Note. The mode shape for eigenvalue 1 may be
inverted. This is because the sense is arbitrary since
during vibration deformed shape will appear in both
directions.

Printing Eigenvalue Results

Eigenvalue results for the whole structure can be displayed in the Text Output window.
Ensue Active is selected and press Next. Then select None from the Entity drop down

list. Ensure Eigenvalues is displayed in the Type drop down list and click Finish. The
Eigenvalue results will be printed to the Text Output window. Error norms may vary.
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Viewing the Results

MODE EIGENVALUE FREQUENCY ERROR NORM
1 147.296 1.93160 0.945062E-12
2 1527.44 6.22017 0.252379E-12
3 7481.98 13.7667 0.992755E-13
4 12463.9 17.7683 0.261939E-12
5 16464.9 20.4221 0.968822E-13
6 26008.4 25.6671 0.346929E-12
7 31861.1 28.4087 0.455993E-10
8 33854.1 29.2837 0.157390E-07
9 34920.0 29.7411 0.110320E-06

10 35963.4 30.1822 0.499202E-06

Note. The frequency in Hertz can be obtained by dividing the square root of the
eigenvalue by 2=. The period of vibration in seconds is obtained using the reciprocal of
frequency (1/frequency). Values of error norm may vary from those shown.

Caution. The system eigenvectors have been normalised (in this case with respect to
mass) therefore any derived quantities such as displacement and moment are also
normalised and are not true design values.

o E] Close the text window by selecting the close button in the top right hand corner
of the window.

e Use the maximise button to increase the size of the graphics window.

Spectral Response Analysis

Spectral response calculations are performed using the IMD (Interactive Modal
Dynamics) facility. Setting up the spectral response results involves the following steps:

O Define the Spectral Excitation curve.

U Define the dynamic excitation type (support motion acceleration in this
example), direction, and specify the type of results required using a CQC
(Combined Quadratic Combination) for spectral response.

O Set the IMD loadcase to be active.

The spectral combination results can be displayed using a deformed shape plot or force
and moment diagrams.

Note. Additional damping information may also be set. Unlike results from a natural
frequency analysis, the output values obtained from a spectral combination are design
values.
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| Script
| Run Script....

| Analyses
[IMD Loadcase. ..
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Stage 1 - Defining a Spectral Excitation Curve

Values for the spectral excitation
curve need to be specified. For this
analysis Acceleration versus Period
values are to be used with a damping
value of 5%.

Note. The Utilities > Response
Spectra menu item would normally
be used to define response spectra
data. However, to simplify entering
the required data, the full response
spectrum definition for this example
is contained in a command file.

Acceleration

Tower Response Spectra

L D I I I R B
T
4f- e
354 IR RO U U U [
ke I T I
1 1 1 1 1
25 L i I e e
1 1 1 1 1 1
2""l"'T"'I""I"'l'"'l"'T
154 -to-
[ R SRR REEEEE EEEREEE SR
05 i t t t t t t
o] Lyl = Lo = L ] L
— — [} [} Loy} o

Fariad

Acceleration £ Period

e In the \<LusaslnstallationFolder>\Examples\Modeller directory select the file

tower_spectrum.vbs and click OK

e A response spectra dataset TOWER and corresponding graph datasets containing
the spectral data for period and acceleration will be created in the " Treeview.

Stage 2 - Defining the Dynamic Excitation

e Select Support Motion from the
Excitation drop down list and
Spectral from the Results drop

down list. Ensure the Use all modes

option is selected.

e Change the IMD loadcase name to
be IMD Spectral Response

e Click the Excitation Set button.

IMD Loadcase [ %]

Damping

Type

Excitation | Support Motion hd Set...
Results Spectral - Set...

Mad
INDne 2

Set damping... |

¥ Use all modes

Selectmodes,

Marmn

] IIMD Spectral Response

[Earce] Aepl Help

Cloze I
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Viewing the Results

€ Displacement © Velocity @ Acceleration

Support Motion [1x]

e On the Support Motion dialog select
Acceleration support motion option in the X
direction which is Relative -

o

Click the OK button to return to the IMD
loadcase dialog.

€ User specified

b |1.D

Yy 2z

Fregency domain

v I—D.D Iespohze motion type
= IDD— Relative hi
QK I Cancel I Help |
e On the IMD loadcase dialog EEMELIEIIES
CIle the RESU|tS Set button Type of spectral respanse mbinatiol
Eo rapones gt fhere 7|
e On the Spectral Response
. [~ Response speckrumm
dlalog set the type Of S_pec!:ral " Frequency  { Displacement Spectral curve ID.D—%
response to CQC Combination  period (" velocity G
with the damping variation ) Accpkraiion 55
. " Accelerationfgravity
correction set as None. The Ao Bas
response  spectrum TOWER Period lAcce'era'-onl:I a6
. R i 02 [i=E] 828
read in from the command file T s fee i
will already be selected in the S 12 £
H ] 1.0 252
dl’Op down list. ] 133 363 4 37 15z B2 wz
) 7 20 5.0 -| Period
e Click the OK button to return to o
. [T2pECctral response
the IMD loadcase dialog. vame [ToWER EEr
e Click the OK button to finish.
oK I Cancel | Help

Selecting the IMD Results Loadcase

o In the & Treeview right-click on the IMD Spectral Response loadcase name and

select the Set Active option.

The spectral combination results are now activated. Any subsequent results plots, such
as deformed shapes or moments, will be for the spectral combination results only.

Using Page Layout Mode

The model was created using a Working Mode view which allows a model of any size
to be created. Whilst previous results have been viewed using this mode of operation,
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in order to allow additional information to be added without obscuring the model, Page
Layout Mode will be used instead.

| View The graphics window will resize to show the mesh layer on an A4 size piece of paper.
[Page Layout Mode

| File Set the page layout to Portrait and click OK
[Page Setup...

Displaying Results for Spectral Combination

A plot showing the tower deformed shape, bending moment and axial force for the
spectral combination is to be displayed.

e Turn-off the Deformed Mesh layer from the [=* Treeview.

e Add the Mesh layer to the [=* Treeview.

Axial Force Diagram

e With no features selected, click the right-
hand mouse button in a blank part of the
Graphics area and select the Diagrams
option to add the Diagrams layer to the

Treeview.

e Select Force/Moment - Thick 2D Beam
results of axial force Fx in the members.

e Select the Diagram Display tab, select
the Label values option and choose the
Label only if selected option

e Click the OK button to finish.

Results will be calculated for the active IMD
spectral response loadcase and an axial force
diagram of stresses in each member will be J

displayed.
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Displaying results on selected members

e Hovering over a member with the cursor will display previously chosen results
information for gauss points along that member.

e Selecting a member will display results for that member. Remember more than one
member can be selected by holding down the Shift key, or by dragging a box
around the members of interest with the cursor.

El If necessary, use the Zoom in button to view results information.

These types of element results can also be plotted in isolation on selected model

features. This is covered later in the example.

Shear Force Diagram

e In the Treeview double-click on the
Diagrams layer. The diagram properties
will be displayed.

e Select Force/Moment - Thick 2D Beam
results of shear force Fy in the members.

e Click the OK button to finish.

e A shear force diagram of stresses in each
member will be displayed.
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| utilities

Annotation >
Window border

| File

Print Preview...

| utilities
Annotation >
Window border

[ View

Working Mode

Seismic Response of a 2D Frame (Frequency Domain)

Bending Moment Diagram

e In the Treeview double-click on the
Diagrams layer. The diagram properties
will be displayed.

e Select Force/Moment - Thick 2D Beam
results of bending moment Mz in the

members.
e Click the OK button to finish.
A bending moment diagram of stresses in - (_\
each member will be displayed.
I A L_x L
L b .
L
e |

Printing Results

Note. Text and border annotation may be added to the display from the Utilities>
Annotation menu.

This adds a border to the display.
Now view how the results would print.

This shows how the bending moment results for the whole model will appear on printed
output.

o Click the Close button to exit the print preview window.

Removes the border from the display.

Plotting Results for a Selected Part of the Model
The graphics window will resize to show the model in normal working mode.
Note. Changing from Page Layout to Working Mode will resize and reposition any

displayed annotation. Page layout mode should be used when preparing a view for
printing. Working Mode should be used when viewing on the screen.
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| Geometry

Group >
New Group

Viewing the Results

If results are to be plotted for a selected part of the structure only, a Group may be
created of the area of interest. For example, to plot results of just the top 4 storeys of
the tower:

e Inthe Treeview double-click the Mesh layer, select Visualise tab and de-select
the option to visualise Beam end releases. Click the OK button.

e Drag a box around the upper 4 storeys of Dragabox 7.7~ 71
the tower as shown. around these : :
features | |
Enter Upper 4 storeys for the group I I
name. Click the OK button to complete : :
creation of the group. | |
| |
o Click the right-hand mouse button on the | |
Upper 4 storeys group in the | |
Treeview, and select the Set as Only lL !
Visible option to turn on the display of (\ bFd Jk
this group only. .
i o L_F# L
b .
L
L |

The results for just the upper 4 storeys will be displayed.
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e To add values to selected members double click on the

Diagrams layer in the Treeview and select the Diagram
Display tab.

e Ensure that the options to Label values and Label only if
selected are chosen.

e Set the number of significant figures to 4

e Choose the Label Font button and change the size to 11 and
click OK

e Change the Angle to 25
e Select the Scale tab and set the magnitude to 2

e Click OK and the diagram will be displayed without any
values because no elements have been selected.

e Select the horizontal elements and the labels of My (as
previously selected) will appear.

Note. Holding down the Shift key after the first selection will enable labels on more
than one element to be visualised.

Re-display the Whole Model

To re-display the whole model in working mode:

e Select the Treeview and click the right-hand mouse button on tower.mdl, and
select the Visible option to turn on the display of all groups. Select Yes to act on
subgroups as well.

Frequency Versus Participation Factor Graphs

A graph of Participation factors (for the X and Y directions) versus Frequency is to be
plotted. For the current spectral combination, where the applied ground motion is in the
X direction, the graph will show to what extent each structural mode is excited in the X
and Y directions. A large modal participation factor indicates a significant response in
that direction.

Using the Graph Wizard

The graph wizard provides a step-by-step means of selecting which results are to be
plotted on the X and Y axes of the graph. The X axis is always defined first.
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| utilities e Ensure the Time history option is selected and click the Next button.

Graph Wizard...

e Select the Named option and click the Next button.

e Select Natural Frequency from the drop down list and click the Next button.
The Y axis results to be graphed are now defined.

e Select Named results and click the Next button.

e Select Participation Factor X and click the Next button.

Additional information for the graph may now to be added.

e Enter the Y axis title as Participation Factor in X

e Ensure that the Show symbols button is selected.

e Click the Finish button to display the graph.

Note. If no graph or axis titles are entered default names will be used.

Note. The sign of the participation factor displayed on the graph is arbitrary as the
/ mode shape from which it is derived can have a positive or negative amplitude.
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A graph will be created in a new window and the values used will be displayed in an
adjacent table. To see the graph at the best resolution enlarge the window to a full size
view.
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| Graph Wizard...

From the graph it can be seen that the first 3 modes are dominated by the motion in the
X direction.

A graph of Participation factor in the Y direction will now be plotted on top of the
existing graph.

e Ensure the Time history option is selected and click the Next button.
o Select the Previously Defined option. Click the Next button.

e Select Natural Frequency results. Click the Next button.

The Y axis results to be graphed are now defined.

e Select Named results and click the Next button.

e Select Participation Factor in Y. Click the Next button.

The results are to be plotted on top of the existing graph so no additional title
information is to be added.

e Select the Include existing graph option and include Graph 1 by ticking the check
box inside the Include existing graphs panel of the dialog.

e Click the Finish button.

tower

Graph 1
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-#-Participation Factor ¥ axis(10) f Matural Frequency(3)
Faricipation Factor ¥ axis{12) / Natural Frequency(11)

The Participation factors for the Y axis are superimposed on the graph.
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| Edit

Edit Graph
Properties...

Viewing the Results

From the graph it can be seen that the fourth mode shape is dominated by motion in the
Y direction.

Note. The graph properties may be modified by clicking the right-hand mouse button
in the graph display area and selecting the Edit Graph Properties option.

To change the symbols on the second graph dataset:

Select the Curves tab and the second dataset Participation Factor Y / Natural
Frequency from the dropdown list.

Change the symbol to Square

Select the Symbol Start Colour and select dark blue
Select the Line Colour and select the same dark blue
Click OK to action the change.
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Creating Animations of Mode Shapes

The dominant mode shapes (Eigenvalue results 1, 2, 3 and 4) caused by the applied
response spectra will now be animated. To see the deformations in the structure the
deformed mesh layer must be displayed.

Re-select the window containing the model data and use the maximise button

to increase the size to fill the graphic area.

265



Seismic Response of a 2D Frame (Frequency Domain)

e Turn off the display of the Mesh, Diagram and Annotation layers in the
Treeview.

e Add or turn-on the Deformed mesh layer and OK the dialog properties.

o In the ‘5 Treeview right-click on Results File Eigenvalue 1 and select the Set
Active option.

The deformed shape for Eigenvalue 1 will now be displayed.

| utilities e Ensure the Active loadcase button is selected and select the Next button.

Animation Wizard...

e Use a Sine deformation with 14 frames. Set the deformation magnitude of 6 mm for
therange O to 1

o Click Finish to build and display the animation.

|
*Animation: LUSAS2 M= 3

o
LT EC .

e To see the animation at the best resolution enlarge the window to a full size view.

The buttons at the bottom of the window may be used to slow-down, speed-up, pause,
step through frame by frame, or stop the animation.

Saving Animations

Animations may be saved for replay in LUSAS at any time or saved for display in other
windows animation players.
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| File

Running the Analysis

| Save As AVI...

| File

|save

| Analyses

Generate Structural
Analysis...

e Ensure the animation window is the active window.

e Save the animation to your projects folder and enter tower_1 for the animation file
name. An .avi file extension is automatically appended to the file name.

e Animations can be compressed to save disk space by altering the Compress Video
slider.

El Save the model file.

Viewing the effects of self weight and spectral response

Spectral loadcases can be combined with other loadcases to provide results which
include dead and live loads but since spectral loadcases are computed from an
eigenvalue analysis the sign of the spectral displacements is always positive. The most
adverse results can, however, be obtained using load combinations.

This adds a new structural analysis to
the model General | Initial Deformations |
Set thi lysi: th - .
e Ensure Set this analysis as the | base sucural s Ig‘f”tﬁ"_r_"_"a“ a=hes R
base structural analysis is not Material

selected, and that Inherit from
base analysis is selected.

e Name the analysis Analysis 2 and
pl’eSS OK Mame | Analysis 2

OK | Cancel | Apply | Help |

Loading from self weight can be automatically added to any loadcase by enabling
gravity in the (5 Treeview:

o In the & Treeview expand Analysis 2 and then right-click on Loadcase 2 and
rename it to be Self Weight

o Inthe ! Treeview right-click on Self Weight and select Gravity

Running the Analysis

El Open the Solve Now dialog. Ensure that Analysis 2 is selected and press OK.
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Viewing the Results
After a successful analysis the Self Weight results file will be added to the (2 Treeview.

| Analyses

Basic Combination...

| Analyses

Basic Combination...

Defining Self weight and Spectral load combinations

Two basic load combinations will now be created to view the combined effects of the
self weight and spectral results; one for self weight plus the spectral results and one for
self weight minus the spectral results.

The combination properties dialog will appear.

Basic Combination
Available Induded Load factor | 1.0 Grid...
File [modsl =l {BFie 0: 3: Self Weight

QFHE 0: 2: IMD Spectral Response
Name Type \ Res file
(D 1:Loadcase 1 0
) 3:5elf Weight 0
(B 2:IMD Spectral Respo... 0
3>
5
| | i
MName I Self weight + Spectral Response
TpE: |Hc-ne ﬂ
OK | Cancel | Apply I Help

Ensure results file model is selected from the drop down list.

Select Self Weight and click the il button to add the loadcase to the load
combination. Leave the load factor set as 1.0

Select IMD Spectral Results and click the LI button to add the Spectral results
loadcase to the load combination. Leave the load factor set as 1.0

Enter Self Weight + Spectral Response for the combination name

Click the OK button to finish.

Note. The IMD Spectral Results loadcase references the eigenvalues held in the
Analysis 1 results file.

The previous procedure is repeated to create a second basic load combination.

Ensure the file model is selected from the drop down list.
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| File

Save

Viewing the Results

Include the Self Weight loadcase with a load factor set to 1.0

From the model file include the IMD Spectral Results loadcase and set the load
factor for as -1.0

Enter Self Weight - Spectral Response for the combination name

Click the OK button to finish.

El Save the model file. This also saves any created load combinations with the model.

By setting a Self Weight and Spectral Response load combination active, shear force
and bending moments can be viewed for each combination. Use or modify the
Diagrams layer to view values on the frame.
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Mz for Self Weight + Spectral Response Mz for Self Weight - Spectral Response

This completes the example.
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Description

Seismic Response
of a 3D Frame
(Frequency Domain)

For software product(s): | All (except LT versions)
With product option(s): | None.
Note: This example exceeds the limits of the LUSAS Teaching and Training version.

Description

This example examines the spectral
response of a 2-storey 3D frame.
The geometry of the structure has
been simplified to a wire-frame or
stick representation with each of the
members of the structure being
represented by a line feature only. A
fleshed view of the model is shown
to the right.

Units used are N, m, kg, s, C
throughout.

Objectives
The required output from the analysis consists of:
O Axial force and bending diagram from a CQC combination.

Keywords

Seismic, Spectral, Response, Mass Participation, Interactive Modal Dynamics,
Excitation, Eigenvalue, CQC Combination.
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Associated Files

0 3D_frame.mdl Model of the structure.

U 3D_frame_spectrum_EC8.vbs defines a typical spectral curve to
Eurocode 8

Discussion

The mesh definition used on a dynamic analysis is somewhat different from that used
on a static stress analysis. In a static analysis, and with experience, it is usually not too
difficult to estimate where the high stresses are likely to occur. These estimates can then
be used to develop a meshing strategy with a fine mesh in high stress locations and a
coarse mesh in less critical locations. For a dynamic analysis the interaction between
the stiffness and inertia forces will lead to deflected shapes which can be very different
from those expected in a static analysis.

In a dynamic analysis both stiffness and mass distribution has to be considered.
Generally, the best strategy for a dynamic analysis is to have a uniform mesh over the
entire structure but in stiff regions a more coarse mesh can be used. In regions that are
more flexible, or where heavy masses are located, the mesh can be more refined.

In this example the global behaviour of the building is being considered for earthquake
response. The lower frequencies will be dominant in this analysis and a relatively
coarse mesh will suffice. If the higher frequencies are important, or if a local response
due to panel modes for individual beams and columns is to be considered, a revised
mesh with more elements would need to be considered.

The spectral response analysis is performed in two distinct stages:

1. A natural frequency analysis is performed. This is used here to calculate the first 30
natural modes of vibration of the structure. The eigenvalues, frequencies and
eigenvectors (mode shapes) are stored and used in the subsequent spectral response
analysis. In order to carry out a spectral analysis the modes must be normalised with
respect to the mass. Although natural frequencies are obtained from an eigenvalue
analysis any information regarding the magnitudes of deformations or moments is
non-quantitative.

2. A spectral response calculation is performed interactively as a results processing
operation using the Interactive Modal Dynamics (IMD) facility. This is an
alternative to performing a non-interactive spectral response analysis in LUSAS
Solver.

In a spectral response analysis, the structure is subjected to support excitation. In this
example this is assumed to be the effect of seismic motion although any support motion
could be envisaged. The excitation is specified as a spectral curve, in terms of period
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Modelling

| File

Open...

Modelling

versus acceleration. Damping, implicitly included in the spectral curve, may also be
specified at this stage.

From the eigen analysis, participation factors indicate, for each mode, the degree of
structural response associated with an applied excitation. In the spectral analysis a mode
combination is calculated from which a worst-case displacement/moment envelope may
be obtained.

Running LUSAS Modeller
For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Building and loading the model

For this example a model file is provided:

To create the model, open the read only file 3d_frame.mdl located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

El If necessary, select the isometric button to view the frame in 3D.
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Save As

| File

Save
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!l Toggling the Fleshing button on and off will show the steelwork arrangement.

Save the model

El Save the model file to the \<Lusas Installation Folder> \Projects directory.

Note. No static structural loading is required for this analysis because a spectral
combination is carried out during results processing using the results from the natural
frequency analysis which is independent of applied loading.

The modelling will now be completed by defining the controls necessary to extract the
natural frequencies.

Defining Eigenvalue controls

Eigenvalue controls are defined as properties of the loadcase.

o In the ' Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Eigenvalue from the Controls menu.

The Eigenvalue dialog will appear.

The following parameters need to be specified:

e Set the Number of eigenvalues as 30

e Ensure the Shift to be applied is set as 0

e Ensure the Type of eigensolver is set as Default

Note. Eigenvector normalisation is set to Mass by default. This is essential if the
eigenvectors are to be used for subsequent IMD analysis in results processing as they
are in this case.

e Click the OK button to finish.

El Save the model file.

Running the Analysis

With the model loaded:

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK.
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Viewing the Results

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

Viewing the Results

| utilities

[ Annotation
Window

Summary

Analysis loadcase results for each eigenvalue can be seen in the (5 Treeview.
Eigenvalue 1 is set to be active by default.

Plotting Mode Shapes

Turn off the display of the Mesh, Geometry and Attributes layers in the
Treeview.

With no features selected click the right-hand mouse button in a blank part of the
Graphics area and select the Deformed mesh option to add the deformed mesh
layer to the Treeview. Select the Visualise tab and, if selected, de-select the
Beam end release option. Click the OK button to accept the remaining default
values and display the deformed mesh for Eigenvalue 1.

Show the Window Summary for an overview of the results.

Scale=1:131.208
Zoom: 4000
Eve: (057738, -0.57735, 0.57739)
Eigenvalue Analysis

Cump: 1

Eiganwactar 1

Results File: O

Eigenvalue: 3820

Natural Frequeney 3.114

Emar Norm: 0.1226E-11

Maximum Cisplacement0.9649E-02 at Node 79
Entity: $trass
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Print Results Wizard

Seismic Response of a 3D Frame (Frequency Domain)

Note. The window summary displays the values of the eigenvalue and the natural
frequency and also a value for displacement at a node. It should be noted that the
displacement value is non-quantitative and is related to the amount of mass in a
particular mode using the mass normalisation technique. Therefore the only items that
can be found using a basic eigenvalue analysis are the frequency and the mode shape.

Note. The mode shape may be inverted from that shown above. This is because the
sense is arbitrary since during vibration deformed shape will appear in both directions.

o In the & Treeview right-click on Eigenvalue 2 and select the Set Active option.
The deformed mesh plot for Eigenvalue 2 will be displayed.

By setting each Eigenvalue to be active the deformed mesh can be seen for all mode
shapes.

Printing Eigenvalue Results

Eigenvalue results for the whole structure can be displayed in the Text Output window.
e Choose Active loadcases and click Next.

e Select None from the Entity drop down list. Ensure Eigenvalues is displayed in the
Type drop down list and click Finish.

The Eigenvalue results will be printed to the Text Output window. For inspection only
the first 10 modes will be printed here.

MODE EIGENVALUE FREQUENCY ERROR NORM

1 382.904 3.11433 0.168140E-11
2 1011.29 5.06126 0.774353E-12
3 1599.54 6.36527 0.431202E-12
4 1891.32 6.92154 0.236809E-12
5 2336.34 7.69287 0.571844E-12
6 2525.21 7.99777 0.384185E-12
7 3924.31 9.97015 0.421926E-12
4153.57 10.2572 0.260236E-12

9 4183.07 10.2936 0.248550E-12
10 6658.98 12.9874 0.380041E-12
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| Utilities

Print Results
Wizard...

Viewing the Results

Note. The frequency in Hertz can be obtained by dividing the square root of the
eigenvalue by 27, and the period of vibration in seconds is obtained using the reciprocal
of frequency (1/frequency). Values of error norm may vary from those shown.

Caution. The system eigenvectors have been normalised (in this case with respect to
mass) therefore any derived quantities such as displacement and moment are also
normalised and are not true design values.

o Close the text window by selecting the close button in the top right hand corner of
the window.

Checking the Mass Participation Factor

Note. In order to carry out a successful response analysis you should ensure that a
significant proportion of the total mass has been accounted for in the analysis. This
requires checking that around 90% of the total mass is in the global x and y directions.
Failure to check that a significant proportion of the total mass has been accounted may
lead to important modes being missed and subsequent errors in the resulting response
analysis results.

e Ensure Active loadcases is chosen and click Next.

e Select None from the Entity drop down list. Ensure Sum Mass Participation
Factors is displayed in the Type combo box and click Finish. The Sum Mass
Participation Factors results will be printed to the Text Output window.

For inspection only modes 20 to 25 will be printed here. It can be seen that a 90%
participation value has been achieved in mode 22.

MODE SUM MASS X SUM MASS Y SUM MASS 7
20 0.861201 0.933385 0.122995E-01
21 0.870885 0.937375 0.123688E-01
22 0.945303 0.937380 0.123710E-01
23 0.945422 0.937388 0.130555E-01
24 0.945428 0.937470 0.304988
25 0.945451 0.937589 0.308786

e Close the text window by selecting the close button in the top right hand corner of
the window.

e Use the maximise button to increase the size of the graphics window.
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| Script

| Run Script....

| Analyses

[IMD Loadcase. ..

Spectral Response Analysis

Spectral response calculations are performed using the IMD (Interactive Modal
Dynamics) facility. This involves defining the spectral curve and excitation and
specifying the results required in an IMD loadcase. The spectral results can then be
interrogated by setting the IMD loadcase active.

With spectral response analysis additional damping information may also be set. Unlike
results from a natural frequency analysis, the output values obtained from a spectral
combination are design values.

Stage 1 : Defining a Spectral Excitation Curve

Values for the spectral excitation curve need to be specified. For this analysis
Acceleration versus Period values are to be used.

3d_frame_spectrum_ec8.vbs defines response spectrum to Eurocode EC8.

o Select the file 3d_frame_spectrum_ec8.vbs, which is located in the \<LUSAS
Installation Folder>\Examples\Modeller directory. Click OK

e A response spectra dataset 3D_frame_spectrum containing the spectral data for
period and acceleration will be created in the " Treeview.

Stage 2 : Defining the Dynamic Excitation

An Interactive Modal Dynamics loadcase IMD 1 will be added to the Treeview.

e Select Support Motion from the Excitation drop down list. Press the Set button
alongside and ensure the Acceleration support motion option is set to a User
specified direction which is Relative. In the box next to the X direction enter the
value of 1.0 and in the box next to the Y direction enter the value of 0.6. Click the
OK button to return to the IMD loadcase dialog.

e Select Spectral from the Results drop down list. Press the Set button alongside and
ensure the type of spectral response is CQC Combination with the damping
variation correction set as None. The response spectrum 3D_frame_spectrum read
in from the supplied VBS file will already be selected in the drop down list. Click
the OK button to return to the IMD loadcase dialog.

¢ Inthe Modes section, ensure the Use all modes option is selected.

e Click the OK button to finish.
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Viewing the Results

Note. Using the user-specified support motion option a single earthquake response
can be applied in multiple directions at the same time. In this case 100% of the
earthquake response is being applied in the X direction at the same time as 60% of the
earthquake response is being applied in the Y direction. In real-life situations, in the
absence of additional data, and depending upon the design code being used, a
percentage of the horizontal earthquake response could also be applied in the vertical Z-
direction.

Note. There are a number of different methods of carrying out modal combinations:

1. If the natural frequencies are well separated the square root of the sum of the
squares (SRSS) has been shown to produce acceptable results.

2. For asituation where the modes have close separation of natural frequencies then an
absolute sum (AbsSum) is taken on the assumption that they can peak in phase with
each other.

3. Alternatively a complete quadratic combination (CQC) method can be used (as in
this example) which effectively combines both the SRSS and AbsSum methods as it
accounts for the separation between modes.

Note. If the defined damping differs from that inherent in the spectral curve a
correction may be applied. There are a number of damping variation correction options
available for use. For more details on these see the Theory Manual.

Stage 3: Selecting the IMD Results Loadcase

o In the & Treeview right-click on the IMD Loadcase 1 loadcase name and select
the Set Active option.
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Secale=1:130.82
Zoom: 100.0
Eve: (-0.57735, -0.57735, 057735
Spectral Responze Analysis

CQC Combination

Spectrum: 1

Maximum Displacement0.7797E-02 at Hode 142

Stage 4 : Displaying the Spectral Combination Results

Plots showing the axial force and bending moments in the members for the spectral
combination is to be displayed.

e In the L2l Treeview right-click the group named Columns and Set as Only Visible
to only view the column members.

e Turn off the display of the Deformed Mesh layer in the = Treeview .

e With no features selected, click the right-hand mouse button in a blank part of the

Graphics area and select the Diagrams option to add the Diagrams layer to the
Treeview.

e Select Force/Moment - Thick 3D Beam results of axial force Fx in the members.
Select the Diagram display tab and select the Label values option. Plot values on
80% of the element length. Click the OK button to finish.

Note that the Orientate by element axes and Orientate flat to screen/page option are
greyed-out because they have no relevance for axial stress diagrams. A ‘flat to
screen/page’ plot is obtained by default.
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Viewing the Results

Scale=1:122.407

Zoam: 1000

Ewe: (0577325, -0.57735, 0.67739)
Spectral Response Analysis

COQC Combination

Spectrum: 1 | | |
taximum Displacement 0.7359E-02 at Node 79 |

Entity: Force/mMoment |

Diagram Component: Fx

hACAG625. at EIWGR 1401

MIN 1249 at EIWGP 2701 | I

DIAGRAM Scale: 10 1667 1 |

! kJ__.zﬂ "

Results will be calculated for the active IMD load case and an axial force diagram of
force in each member will be displayed. If necessary, use the Zoom in button to view
results information. These type of results can also be plotted in isolation on selected
model features.

e Inthe =" Treeview double-click the Diagram layer to view its properties.

e Select Force/Moment - Thick 3D Beam results of axial force My in the members.
Click the OK button to finish.
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Scale: 10 144649

Zaom: 100.0
Eve: (-0.57735, -0.57735, 0.57735) R
Spectral response analysis
CQC combination 49803 ITHTES
Spectrum: 30_frame_spectrum 39857
Losdcase: ZIMD 1 s BE14E3
1849883 3
Diagram entity: ForceMoment - Thick 30 Beam \E -é%%aE
{25104E3 054E4E3
Diagram component: Wy 409399
Ba0 859 1930
Diagram maximum 13.3543E3 at Gauss point 1 of element 12
330563 BE2TYES
Dizgram minimum 3. 29566 at Gauss point 6 of glemert 9 7 459963
; fL7R4BES BASESES
Diagram scale: 1; 0.448294E-.
35705E3 3834E3 47031
466,164
242E3 O4ERIES
issasaEa anssr
33543E3 9.21516E3 25 575
3 PaRES
g 17039E3 96043
7
S i
91016E3 05.644
06,624
45353 9755E3 24 056
60.02
W4TI4ES
12366663 ! PEATSES 1E558E3
90,155
2108263 54 885
B7ES
. 74494E3
v X
07.536

Note that Orientate by element axes is the default diagram display option for all
components other than Fx. This can be changed by selecting the Diagram display tab
and selecting Orientate flat to screen / page as necessary.

. _
® ;a\,e El Save the model file.

This completes the example.
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Description

Buckling Analysis of
a Plate Girder

For software product(s): | Any Plus version.
With product option(s): | None.
Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

The buckling behaviour 16000 |
of a steel plate girder
with web stiffeners is to | | | | | | | | | | | | |

be eXamined. }-—»}—SOO bearing F—»}istiﬁeners at 1500 centres +—-‘ 500 bearing—H
The girder is supported -+ N :

at both ends by fixed

and  roller  bearing ——
supports. A cross-slab b Lo sifonrs

connection to the girder
provides a partial lateral
restraint. A distributed Modeling
load representing Helght
transverse steel decking

is applied to a selected
part of the web of the |/4ldgan
girder. The steel plates

30mm flanges

Lateral

Modelling units used support

are modelled using thin | aemetes T
shell (QSL8) elements. j’i

Units of kN, m, t, s, C
are used throughout the
example.
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A

Modelling

Buckling Analysis of a Plate Girder

Objectives

The required output from the analysis consists of:

U A deformed shape plot showing displacements caused by the imposed loading.
O Calculation of the critical buckling load

Keywords

Simple Geometry, Plate Buckling, Linear Buckling, Eigenvalue Buckling, Deformed Mesh
Plot, Printing Eigenvalues.

Associated Files

U plate_girder_modelling.vbs carries out the modelling of the example. After
creating a new model and running this file, the example can be continued from
the section titled Running the Analysis.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller in
the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating the Longitudinal Beam Model

e Enter the file name as plate_girder

e Use the Default working folder.

e Enter the title as Buckling analysis of a plate girder

e Select model units of kN,m,t,s,C from the drop down list provided.
e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the Standard startup template.

e Select the Vertical Y axis option and click OK.
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| Geometry

| Line

>

Coordinates...

| Geometry

Modelling

| Surface

By Sweeping...

| Geometry

>

| Surface

| By Sweeping...

>

Feature Geometry

A cross-section of the girder is created initially and swept and copied into a half-model
before mirroring to create the full plate girder model.

il Enter coordinates of : :
(-0.1,0), (0,00 and (0.1,0) to | |
define Lines representing the | T . |
bottom flange of the girder. ! = '
Click the OK button.

e Drag a box around all the
features just drawn.

él Enter translation value of 0.1 in the Y direction to create surfaces that will define
part of the end stiffener. Click the OK button to finish.

e Drag a box around the 2 line i i
features shown. '

él Enter a translation value of 0.8 Select these featlres
in the Y direction and click OK to
create surfaces that will define part A
of the end stiffener.
The girder has a 500mm long bearing region at the end which
will be created first. J
e Select the 6 Lines representing the cross-section of the
girder as shown.
Select
t_hese 6 A
lines
[
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| Geometry

Surface >
By Sweeping...

N

| Geometry

Surface
Copy...

Buckling Analysis of a Plate Girder

Geometry

ﬂl Enter a translation value of 0.5 in the Z direction. Click the OK button to finish.

Note. Save the model regularly as the example progresses. The Undo button may be
used to correct any mistakes made since the last save.

Note. Holding down the L key while selecting ensures that only lines will be selected.
Similarly the P key limits the selection to Points, the S key; Surfaces, the V key;
Volumes and the G key; Geometry. Similar shortcuts exist for elements, nodes, etc.,
which can be found in Modeller Manual.

El Use the Isometric button to view the model to a similar
view to that shown
The bearing region has a stiffener either side of it.

I |

|

[

|

i

|

o Select the 4 surfaces representing the 2 end stiffeners. :
[

|

M Enter a value of 0.5 in the Z direction to copy the surfaces
to define the web stiffeners. Click OK to finish.

Select these 4
surfaces

Note. Many of the more common tasks are provided in the context menu. With the
model geometry selected right-hand within the view to make the context menu appear.
From this menu you can Copy, Delete, Move and Sweep.

The girder has 1500mm long internal panel sections along its length.
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| Geometry
Surface >
By Sweeping...
| Geometry
Surface >
Copy...

Modelling

e Select the 6 Lines representing the cross-section of
the girder. If necessary use the Zoom facility to
simplify the selection.

él Enter a translation value of 1.5 in the Z direction.
Click the OK button to finish. Select
these 6
lines

N

¢ Right-click on the o b X coordinates readout display on the Status bar
and select Rotate +Z +Y.

e Hold down the Shift key on the U '
keyboard and select the X
coordinate readout panel again
to obtain the reverse view
looking along the X-axis.

{

=

e Drag a box around all the
features shown to select the first
panel section and web stiffener. ® L __ k

Select these features

MEnteravalue of 1.5 in the z
direction to copy the surfaces used to define the web and

15150 S50 0 0 S 0 B 0 e

_k Select these features

e Enter the number of copies as 9 and click the OK button.
Finally, the other bearing end to the girder has to be created.

e Drag a box around all the features shown to select the bearing end of the girder and
web stiffener.
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| Geometry

Surface
Copy...

Buckling Analysis of a Plate Girder

ﬂ Enter a value of 15.5 in the Z direction to copy the surfaces used to define the web
and stiffener. Click OK to finish.

D S D B D B A

Meshing the web stiffeners

Line mesh divisions will be used to control the surface mesh density for the plates. All
Lines defined so far have 4 Line mesh divisions by default. Certain Lines require
different divisions to be specified.

@l Select the home button to view the girder end on.

Line mesh

The Lines representing the top flange, lower flange, and part of the web and web
stiffeners require 1 mesh division to be assigned to them. These could be selected
individually in order to assign the line mesh division to them but LUSAS provides some
advanced selection / deselection tools for this type of work.

e Hold down the L key on the keyboard and draga
box around the area shown to only select the

|
I 2
. e | e
Lines within the box. :_ YN %
e Then, with the lines still selected, hold down the k
Control key and drag separate boxes around
each of the 3 points shown. 1. Hold down
the L key and
Note. Using the Control key in the manner box select
described deselects the lines going into the screen these features
from the previous box-selection. These lines will
therefore remain meshed with 4 line divisions. 2. Hold down
the Control key
and select the 3
inner features
as shown
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Modelling

@l Selection of lines

can be checked by using
the Isometric button.

Only the lines shown in
the  diagram  should
appear highlighted to
show that they have been
selected.

@l After checking, select the Home button to return the model to its initial view.

e With the lines selected drag and drop the Line mesh attribute Divisions=1 from the
& Treeview onto the selected features.

e In a similar fashion to that done for the top flange,

hold down the L key and drag a box around the 1. Hold down the
area shown to select all the Lines within. L key and box
select all
e Then, with the lines still selected, hold down the features shown

Control key, and drag separate boxes around each

of the 6 points shown to deselect the lines goin 2. Hold down

. P s . going Control key and
into the screen from the initial selection. select inner

. . L features shown
o Drag and drop the Line mesh attribute Divisions=1

from the e?b Treeview onto the selected features.

N \
Surface mesh
| Attributes e Select Thin shell, Quadrilateral elements with Quadratic interpolation. LUSAS will
l% select QSL8 elements.
urface...

e Enter the attribute name as Thin Shells (QSL8) and click OK to finish.
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| Attributes

Geometric >
Surface...

Buckling Analysis of a Plate Girder

e Select the whole model (Control + A keys)

e Drag and drop the surface mesh attribute Thin

Shells (QSL8) from the & Treeview onto the
selected features.

The mesh will be drawn. Note that, by default, the
mesh nodes as shown on these accompanying
diagrams are not displayed.

El Use the Isometric button to view the mesh on
the model.

El Use the Zoom in button to check the mesh
definition.

o
il Use the resize button to show the whole model
il Use the Cursor button switch back to the normal cursor tool.

Geometric Properties

Three steel thicknesses are required to model the web, flanges and web stiffeners.

e Enter a value of 0.01 for the thickness. The eccentricity can be left blank. Enter the
attribute name as Thickness=0.01m. Click the Apply button to create the attribute.

e Amend the thickness to 0.015. Change the attribute name to Thickness=0.015m. Click
the Apply button to create the attribute.

e Amend the thickness to 0.03. Change the attribute name to Thickness=0.03m. Click
the OK button to finish.

@l Select the home button to view the beam end on.
e Select the whole model (Control + A keys)

e Drag and drop the geometry attribute Thickness=0.015m from the & Treeview
onto the selected features.

!l Select the fleshing on/off button to turn-off the geometric visualisation.
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Modelling

e Select the Surfaces representing the topand T~ -~~~ "7~ !
bottom flanges. '

e Drag and drop the geometry attribute |
Thickness=0.03m from the & Treeview P I
onto the selected features. 1. Box select

the top flange

2. Hold down
] 1 Shift key and
add bottom
flange to
] 1 selection

o Select the Surfaces representing the web.

e Drag and drop the geometry  attribute

Thickness=0.01m from the c&n Treeview onto the )
selected features.

I
I
I
I
I
|
e Once done, click on a blank part of the graphics :
window to deselect the web surfaces. 11 1
I
I
I
I
I
I
I
I

1. Box
select the
surfaces

|
!Ap—T—q—" of the web
1 [

|
I
T
Checking attribute assignments
Note. Once assigned to the model, attributes such as geometry may be visualised.
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| Attributes

| Material >

Material
Library...

| Attributes

Support...

Buckling Analysis of a Plate Girder

e In the Treeview click the right-hand  ceometri ey
mouse button on the Geometry layer .mg:::;;g;gf
and select Properties.

Thickness 0.015

e On the Colour by drop-down menu
select Assignment then select the Set
button. Change the attribute type to
show Geometric attributes and click
OK. Finally, select Solid on the
geometry properties box and click OK

El Use the Isometric button to view the
model to a similar view to that shown.

e Check that the geometry assignments
have been correctly assigned and then
switch off the visualisation. In the Treeview click the right-hand mouse button
on the Geometry layer and select Properties.

e On the Colour by drop-down menu select Own colour then Finally, de-select Solid
on the geometry properties box and click OK

Material Properties

Select material Mild Steel from the drop-down list, leave the grade as Ungraded and
click OK to add the material attribute to the &b Treeview.

e With the whole model selected, drag and drop the material attribute Isol (Mild

Steel Ungraded) from the & Treeview onto the selected features. Click OK
ensuring it is assigned to all surfaces.

Supports

Three support conditions are required. A fixed bearing, a rolling bearing, and a lateral
restraint to the flange of the girder.

Set the translation in the X and Z directions to Fixed. Set the spring stiffness in the Y
direction to 200e8 and specify that the Spring stiffness distribution is stiffness/unit area.
Enter the attribute name as Fixed Bearing. Click the Apply button to reuse the dialog for
the other support conditions.

e Set the translation in the Z direction to Free and leave all other translations as
specified previously. Enter the attribute name as Rolling Bearing. Click the Apply
button to reuse the dialog for the next support condition.
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Modelling

e Set the spring stiffness in the X direction to 100e8. Set the translation in the Y and z
directions to Free. Ensure that the Spring stiffness distribution is stiffness/unit length.
Enter the attribute name as Lateral Support. Click the OK button to finish.

El Use the Zoom in button to enlarge the view of the
left-hand end support.

il Use the Cursor button switch back to the normal
cursor tool.

e Select the 2 flange Surfaces shown. Take care to
not select the lowest web surface by mistake.

Note. For features lying underneath others in the
Graphics Window, continually clicking on a feature
will cycle through selecting different features in turn.

e Drag and drop the support attribute Fixed Bearing

from the & Treeview onto the selected features.
Click OK ensuring that it is assigned to Surfaces.

AV

- Select
_|* Use the resize button to show the whole model. these 2 surfaces

El Use the Zoom in button to enlarge the view of the
right-hand end support.

il Use the Cursor button switch back to the normal cursor tool.
o Select the equivalent 2 lower Surfaces for the right-hand support.

o Drag and drop the support attribute Rolling Bearing from the &b Treeview onto the
selected features. Click OK ensuring that it is assigned to Surfaces.

293



| Attributes

Buckling Analysis of a Plate Girder

| Loading. ..

@l To help assign the lateral supports return the model to
the default home view.

Drag a box around the Point shown (All Lines in the same
plane will be selected).

Drag and drop the support attribute Lateral Support from

the &b Treeview onto the selected features, Click OK
ensuring that the support attribute is assigned to Lines.

Loading

Self-weight will be applied to the model as a property of the
analysis.

In the (2 Treeview, expand Analysis 1 then right-click on
Loadcase 1 and select Gravity to apply self-weight to the
model

In addition to the self-weight, a uniformly distributed load is
to be applied to the flange of the beam.

Select the Global Distributed option and click Next

Select this Point

Enter a load of -10 in the Y direction and specify that the load distribution be Per
Unit Area. Enter the attribute name as Imposed Loading and click the Finish

button.

Fbselect the Surfaces of the top flange as shown

Drag and drop the loading attribute Imposed Loading
from the &b Treeview onto the selected features. Click OK
assigning it to Surfaces as Loadcase 1

Click in a blank area of the view window to deselect any
currently selected features

This completes the modelling of the girder.

Box select the top

flange
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| File

Save

Running the Analysis

Eigenvalue Analysis Control

By default an eigenvalue analysis extracts the natural modes of vibration of a structure.
It can also be used to solve buckling load analysis problems. The solution parameters
for buckling analysis are specified using an eigenvalue control attribute. In this example
only the 1st natural mode of buckling of the girder is to be investigated.

Eigenvalue analysis control is defined as a property of a loadcase.

e In the (5 Treeview right-click on Loadcase 1 and select Eigenvalue from the
Controls menu.

e Select a Buckling Load solution for the Minimum number of eigenvalues.
¢ Change the type of eigensolver to be used to Subspace Jacobi

e Enter the Number of eigenvalues to be calculated as 1

e Enter the Number of starting iteration vectors as 2

e Enter the Shift to be applied as -10

e Click the OK button.

Note. The use of a shift and the Subspace Jacobi solver is required when applying
uniformly distributed spring supports to quadratic elements in an eigenvalue analysis.
This is due to the theoretical negative stiffnesses required by the shape functions to
evenly distribute the support stiffness. During the analysis a number of negative pivot
warnings will be shown, due to these theoretical values, which can be ignored.

Saving the model

El To save the model file.

Running the Analysis

With the model loaded:
El Open the Solve Now dialog, ensure Analysis 1 is selected and press OK to run the
analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.
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| File
[New...
| File
| Script >
| Run Script...

Buckling Analysis of a Plate Girder

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.

In addition will be created in the Associated Model Data directory where the model file
resides, including:

U plate_girder.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U plate_girder.mys this is the LUSAS results file which is loaded automatically
into the & Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O plate_girder_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as plate_girder

To recreate the model, select the file plate_girder_modelling.vbs which is located in
the \<LUSAS Installation Folder>\Examples\Modeller directory.

;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the () Treeview.

El Select an isometric view of the model.
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Print Results
Wizard...

Viewing the Results

e Turn off the display of the Attributes, Geometry and Mesh layers in the = Treeview.

Deformed Mesh Plot

e Turn on, and then double-click the Deformed mesh layer to the [& Treeview.
e From the Deformations tab, select Specify factor and enter a factor of 2.5

¢ Click the OK button to display the first eigenmode shape.

Printing the Buckling Load Factors

In an eigenvalue buckling analysis, the load factors are equivalent to the eigenvalues.
Load factors are the values by which the applied load is factored to cause buckling in
the respective modes. Eigenvalue results for the whole model can be displayed in the
text window.

e For the Active loadcase, press Next and ensure the entity type is set to None, ensure
that results type Eigenvalues is selected and click the Finish button.

The Eigenvalue results will be printed to the text window with the Load factors being
given in the eigenvalue results column. Error norms may vary.

MODE EIGENVALUE LOAD FACTOR ERROR NORM

1 9.87597 9.87597 0.262586E-06
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Calculating the Critical Buckling Load

The applied load of -10 must be multiplied by the first load factor (9.87597) to give the
value of loading which causes buckling in the first mode shape. The initial buckling
load is therefore 9.87 x the applied dead and live load.

Note. An applied load of unity could be used in an eigenvalue analysis - in which case
the eigenvalues produced would also represent the critical loads at which the structure
would buckle. However, to prevent potential convergence problems with the analysis it
is more usual to apply actual in-service loading and multiply the applied load by the
eigenvalue to give the critical buckling load for each eigenvalue.

This completes the example.

Important Notes Relating to Buckling Analysis

This example has taken you through the process of carrying out a linear buckling
analysis on a plate girder. Linear buckling analysis is a technique that can be used to
estimate the load that can be supported by a structure prior to structural instability or
collapse. However a number of points should be considered when carrying out this type
of analysis:

e Buckling analysis is dependent on applied loading. All the loads on the structure
must be applied in a single loadcase, this being loadcase 1. In addition, load factors
appropriate to the analysis should be included when the loads are assigned.

e Buckling analysis is dependent on the initial model geometry being considered. A
perfectly straight (and undeformed) model will provide different answers from a
model with imperfect geometry. See Generating a model with imperfect geometry
below.

e An eigenvalue buckling analysis actually requires the use of elements with
geometrically nonlinear capabilities in order to create additional stress terms in the
stiffness matrix. Some elements do not have a nonlinear capability. Refer to the
Element Reference Manual before such an analysis is commenced.

e The eigenvalue buckling analysis of the structure can only be used to provide the
mode shape of the structure and the critical buckling load. The stresses and
displacements that are obtained are relative to the unit normalised eigenvector and
are generally of no practical use. To obtain member forces for the girder it is
necessary to perform a further linear static analysis with the same combination of
loading on the structure. The stresses and displacements in the structure when the
critical load is applied may be obtained simply by performing a linear static analysis
with the loads factored to the buckling load previously derived. These may be
compared to other limit state criterion to determine the load carrying capacity of the
structure. The critical buckling stress for the mode under consideration will be
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obtained from the same analysis. If required this can then be used with reference to
design codes to calculate the value of the slenderness parameter for lateral torsional

buckling At and the limiting compressive stress G

e This analysis type will provide both local and global buckling modes. However,
engineering judgement is necessary to determine which buckling mode is critical in
order to select the appropriate buckling load factor.

o If a load factor very close to unity is derived, it would normally be prudent to carry
out further investigation, removing some of the assumptions in the initial analysis
and perhaps carrying out a nonlinear analysis.

Generating a model with imperfect geometry

If required, an imperfection can be built into the initial model either by manually
defining the appropriate geometry or by using the deformed mesh from one analysis (or
load incrernent / time step / eigenvalue) as the starting point for a further analysis.

To do this:

e Turn on the display of the Attributes, Geometry and Mesh layers in the = Treeview.

e Setup a new analysis by selecting the Analyses > Generate Structural Analysis
menu item.

e On the Analysis dialog, with the General tab active, ensure that Inherit from base
analysis is specified to use properties defined for the first ‘base’ analysis.

e Select the Initial deformations tab and choose the option to Start with deformed
mesh from Analysis 1 and Loadcase 1

e Enter a suitable scale factor for the load incrernent / time step / eigenvalue of
interest, and click OK to save the settings made.

e Modify existing loading, supports, or assign any new material properties (if a
nonlinear analysis were to be carried out) as necessary and solve the model.
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Description

Nonlinear Analysis
of a Concrete Beam

For software product: Any Plus version. Bridge Plus version for the discussion.

With product options: Nonlinear.

Description

A nonlinear plane stress analysis  All dimensions in millimetres ~ Point Load C-L

is to be carried out on a model of a 200 0
reinforced concrete beam. ! ,f“s 7
The reinforcement is provided in

the lower face of the beam and has 10N

a total cross-sectional area of ”

400 mm2. The superposition  of BAR3 Elements QPMS8 Elements

nodal degrees of freedom assumes 150

that the concrete and ! ‘ ! F—'{

reinforcement  are perfectly | |
bonded. It is assumed that the self- & 1
weight of the beam is negligible . .
compared with the applied load F1650—+—1650—>{

and that the effects of any shear

reinforcement can be ignored.

T
300
A

Due to the symmetrical nature of the problem, only the left-hand span of the beam is
modelled. The beam is simply supported at the left-hand end with a symmetry support
at the right-hand axis of symmetry. A concentrated vertical load is applied to the top of
the beam 1200mm from the left-hand end. The concrete section is represented by plane
stress (QPM8) elements, and the reinforcement bars are represented by bar (BAR3)
elements. A nonlinear concrete cracking material model will be applied to the plane
stress elements and a von Mises plastic material will be applied to the reinforcement
bars.

Units of N, mm, t, s, C are used throughout.
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Modelling

Nonlinear Analysis of a Concrete Beam

Objectives
The behaviour of the beam under cracking/yielding is to be examined by producing the
following:

O A Deformed Mesh Plot showing the final deformed shape.

O A Load Displacement Graph for the top node on the axis of symmetry
of the beam.

0 Stress contour plot showing the stress distribution in the beam.
O Crack pattern plot showing the crack patterns produced.

O Animation of stresses and crack patterns for selected load
increments.

O A graph of variation in stress through selected slice sections through
the beam.

Keywords

2D, Plane Stress, Bar Elements, Nonlinear Concrete Model, Element Selection,
Concrete Cracking, Steel Reinforcement, Groups, Crack Patterns, Animation,
Graphing, Load Displacement Curve, Slice Sections

Associated Files

U beam_nl_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as beam_nl

e Use the Default working folder.
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Modelling

e Enter the title as Nonlinear Concrete Beam
e SettheunitsasN, mm,t, s, C

e Leave the timescale units as Seconds

e Ensure an analysis type of Structural is set.
e Select the model startup template Standard
e Select the Vertical Y Axis option.

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to
/ correct any mistakes made since the last save was done.

Defining the Geometry

|Gﬁ_?rr:3e"y S il Enter coordinates of (0, 0),

Coordinates... (1200, 0) and (1650, 0) to define two
Lines representing the bottom of the
left hand span of the beam. Clickthe L ——————————————————

OK button to finish. Drag a box to select these 2 Lines k

e Select both Lines just drawn by
dragging a selection box around them.

|G|eso$fzz S L5 Enter a transtation value of 25 in the Y direction to create the Surface which

[By Sweeping... represents the concrete cover from the face of the beam to the centreline of the
reinforcement.

e Click the OK button.

e Select the upper Lines of both of
the Surfaces just drawn as shown.

Select these 2 Lines

ERVARN:

|G|e;5':f§tcz = 4l Enter a translation value of 275 in the Y direction to create the Surface which
“[Bysweeping..  represents the extent of the concrete above the centreline of the reinforcement.

e Click the OK button.
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| Geometry

| Group

| New Group

| Geometry

| Group

| New Group

| Attributes

|Mesh
|Line...

>

Nonlinear Analysis of a Concrete Beam

The model should appear as shown.

—

Defining Groups

To simplify the assignment of model attributes certain model features will be grouped

together to allow selection by name in the Treeview as opposed to selection by
cursor in the graphics window. The 2 Lines representing the reinforcement bars are to
be grouped together:

e Ensure the 2 Lines are still selected Select these 2 Lines

as shown.
/> N\

I i / \ E
Enter Bars for the group name. s

e Click the OK button to complete
creation of the group.

The Surfaces representing the concrete are to be grouped together.

e Holding-down the S key, (and 7~~~ """ TTTTTTTTT T
noting that the cursor changes to | I
show the type of feature that will be : :
selected) drag a box around the |
whole model to select only the L ___ _ _ _ __ _ _________ _k
Surfaces defining the concrete. Drag a box to select only Surfaces

Enter Concrete for the group
name. Click the OK button to complete creation of the group.

Note. In this example, model attributes will be defined but not assigned to the model
straight away. They will be assigned to the model later by making use of the Groups
facility.

Defining the Mesh Reinforcement Bars

Separate mesh datasets need to be defined for the reinforcement bars and the concrete.
For the reinforcement bars a uniform mesh is to be used to the right of the applied load
and a graded mesh is to be used on the horizontal lines to the left of the applied load.

The reinforcement bars will be modelled using Line meshes.

e Set Generic element type to Bar, Number of dimensions to 2 dimensional and
Interpolation order to Quadratic

304
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Modelling

|Mesh
|Surface...

| Attributes

| Geometric
|Line...

>

Ensure the Number of divisions is set to 4

Enter the attribute name as Bar Elements - Divs=4

Click the Apply button to create the attribute in the & Treeview and leave the
dialog visible to allow additional datasets to be defined.

Change the Number of divisions to 6 and click the Spacing button.
Select a Uniform transition ratio of first to last element of 2 and click OK
Change the attribute name to Bar Elements - Divs=6 graded

Click the OK button to finish to add the attribute to the & Treeview.

Defining the Mesh Concrete

The concrete will be modelled using a Surface mesh with Line mesh divisions to
control the mesh density..

Select Plane stress, Quadrilateral, Quadratic elements.
Enter the attribute name as Plane Stress - Concrete
Click the OK button to add the attribute to the & Treeview.

The default mesh density of 4 divisions per line is sufficient for the Surface to the
right of the applied load. A graded line mesh will be created for use on the Surface
to the left of the applied load

In the & Treeview double click the Line mesh attribute name Bar Elements -
Divs=6 graded

The Line mesh properties dialog will appear.

Change the attribute type to None

Change the attribute name to Divisions=6 graded

Click the OK button to add the attribute to the & Treeview.

Defining the Geometric Properties

Select Bar/Link from the drop down list and enter a value of 400 for the total cross
sectional area of the reinforcement.

Enter the attribute name as Steel Area and click the OK button to add the attribute
to the & Treeview.
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Nonlinear Analysis of a Concrete Beam

| Geometric
| Surface...

| Attributes

| Material

| Isotropic...

| Attributes

| Material
|Isotropic. ..

e Enter a value of 150 for the thickness. Leave the eccentricity blank.
e Enter the attribute name as Beam Thickness and click the OK button to add the
attribute to the & Treeview.

Defining the Material Properties

Nonlinear steel properties will be defined for the reinforcing bar elements.

e Enter Young's modulus as 210e3 and Poisson's ratio as 0.3 and leave the mass
density field blank.

o Click the Plastic option and enter an Initial uniaxial yield stress of 300

e Select the Hardening option, click the Hardening gradient button and enter a
hardening Slope value of 2121 with a Plastic strain of 1

e Enter the attribute name as Nonlinear Steel
e Click the OK button to add the attribute to the & Treeview.

Nonlinear concrete material properties will be defined for the Surface elements
representing the concrete.

e Enter a Young's modulus of 42000, a Poisson's ratio of 0.2 and leave the mass
density field blank.

o Click the Plastic option and from the drop-down list select Concrete

e For the plastic model Type choose Smoothed Multi Crack (model 102)
e Enter a Uniaxial compressive strength value of 31.58

e Enter a Uniaxial tensile strength value of 3.158

e Press the Advanced... button

¢ In the Advanced Concrete Properties dialog change the Strain at end of softening
curve to be 0.003 and press OK to return.

e Enter the attribute name as Nonlinear Concrete

e Click the OK button to add the attribute to the c&n Treeview.

Assigning Attributes to the Bars

The various Line and Surface mesh, geometric and material attributes defined
previously will now be assigned to the model using the groups that have been defined.
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Modelling

In the L=] Treeview right-click the group name Bars. Select the Set as Only Visible
option. The features in the group will be displayed.

Select the left hand Line of the two Select this Line for

Lines representing the bars. ﬂBar Elements - Divs=6 graded
i

Drag and drop the Line mesh

attrioute Bar Elements - Divs=6 ﬁ
graded from the & Treeview onto Select this Line for
the selected Line. Bar Elements - Divs=4

Select the right hand Line of the two Lines representing the bars.

Drag and drop the Line mesh attribute Bar Elements - Divs=4 from the 63;
Treeview onto the selected Line.

In the Treeview double-click on
the Mesh entry and select Show
nodes.

-

The Line mesh divisions will be seen defined with the spacing as shown.

Select both Lines.

Drag and drop the geometric attribute Steel Area from the &b Treeview onto the
selected features.

Drag and drop the material attribute Nonlinear Steel from the & Treeview onto
the selected features.

Note. The diagrams in this example show element nodes. To see these at any time you

can go to the Treeview and double-click the Mesh layer. On the Mesh tab select
Show nodes and click the Close button.

Assigning Attributes to the Concrete

In the Treeview right-click the group name Concrete. Select the Set as Only
Visible option.

The Lines in the Bars group will be removed from the display and the Concrete group
will be displayed.
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e Select the left-top and left- Select this Line
bottom Lines as shown. &

o From the &b Treeview drag and
drop the Line mesh attribute

Divisions=6 graded onto the *=*
selected features. @
... and this Line

e Select the whole model using the
Ctrl and A keys together.

-—

e Drag and drop the Surface mesh attribute Plane Stress - Concrete from the 63;
Treeview onto the selected features.

A graded mesh will be drawn on the
left-hand Surface and a uniform
mesh will be drawn on the right-
hand Surface. =

e Drag and drop the geometry attribute Beam Thickness from the & Treeview onto
the selected features.

ﬂ Select the fleshing on/off button to turn-off the geometric visualisation. If at any
time during the example you wish to visualise the geometry select this button.

o With the whole model still selected, drag and drop the material attribute Nonlinear

Concrete from the b Treeview onto the selected features. Ensure the Assign to
surfaces option is selected and click OK

The mesh on the Lines representing the cover to the centreline of the reinforcement
needs to be altered. This is because they currently have a default Line mesh of 4
divisions per line when only 1 division per line is required.

e Drag boxes to select the 3
Lines as shown. (Remember [ T 7 i
to hold the Shift key down I [
after the first line is selected :_ o

=
}
1
. _ L _—
so the other lines are added to ‘k Jk
the selection)

T

A\

T

Drag 3 boxes to select these 3 Lines
e Drag and drop the Line mesh

attribute Divisions=1 from the & Treeview onto the selected Lines.

The mesh will be redisplayed with the revised mesh pattern.
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Modelling

[ Loading...

Making all groups visible

e From the L] Treeview right-click the group heading name beam_nl.mdl. Select the
Set as Only Visible option. Click Yes to act on sub groups as well.

All features in the model will now be
displayed as shown.

Supports

When using the Standard template, LUSAS provides the more common types of
support by default. These can be seen in the & Treeview. The beam is to be simply
supported in the Y direction at the left-hand end and a horizontal restraint in the X
direction is required to satisfy the symmetry requirements at mid-span.

e Select the lowest Select these 2 Lines
Point at the left hand for support 'Fixed in
end of the model as X A
shown. e

F

e Drag and drop the

L

support attribute = i
Fixed in Y from the T . L
& Treeview onto the Select lower Point for

selected Point. Ensure support ‘Fixed in ¥

the Assign to points
and All analysis loadcases options are selected and click OK

e Drag a box around the 2 Lines at the right hand end of the model as shown.

e Drag and drop the support attribute Fixed in X from the & Treeview onto the
selected Lines. Ensure the Assign to lines and All analysis loadcases options are
selected and click OK

Loading

A single concentrated load is to be applied to the Point at the top of the beam. A unit
load will be applied and the load factor in the nonlinear control will be used to control
the magnitude of loading.

e With the Concentrated option selected click Next
e Enter a loading value of -1 in the component Concentrated load in Y Dir

e Enter the attribute name as Point Load and click Finish
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e Select the Point on the Select this Point
top of the beam as %
shown.

e Drag and drop the
loading dataset Point %
Load from the
Treeview onto  the
selected Point.

R

4
L 2

e Ensure the Assign to points option is set and click OK to assign the load to
Analysis 1, Loadcase 1.

Nonlinear Control

Nonlinear analysis control properties are defined as properties of a loadcase. The
nonlinear analysis is to be terminated when the beam deflection at mid span reaches a
limiting value.

e Select the point shown. Select this Point

e In the @ Treeview %
expand Analysis 1 —
then right-click on —
Loadcase 1 and select 4 —™
Nonlinear & — =
Transient from the

Controls menu.
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The Nonlinear & Transient dialog will appear:

Monlinear & Transient

~ Incrementation
[v Monlinear

Incrementation Im
Starting load factor IEDEIEI—
Max change in load factor I 2000

Max total load factor ID—

v Adjust load based on convergence

Iterations per increment I 10

[ Geostatic step

Solution strategy
[" | Same as previous loadcase

o

Max number of iterations

Residual force norm

ury

Incremental displacement norm 0

Advanced...

r Incremental LUSAS file output
™| 5ame as previous loadzase

Output file

—I'!‘d"a”md' = Flat file

- — Restart file
I\_c-nsc-lll:latlc-n "'I
Initial time step III'E'— Max number of saved restarts |0

Log file

™| Tire domain

Total response time 100.0EG

T

™| Butamatic tme sEepping History file

Advanced. |
~Common to all

Max time steps or increments I a
0K I Cancel Help

Select the Nonlinear option and set Incrementation to Automatic

e The initial load to be applied is the actual load applied to the model multiplied by
the starting load factor. Set the Starting load factor to 5000

e Enter the Max change in load factor as 2000 to restrict the second and subsequent
load increment sizes to ensure sufficient points are obtained to observe the load
deflection behaviour of the beam.

e Change the Max total load factor to 0 as the solution is to be terminated on the
limiting displacement at mid span.

e Change the number of desired Iterations per increment to 10

Note. If the number of iterations on the previous increment is less than the desired
/ number the next load increment will be increased (up to the maximum change in load
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increment) while if the number of iterations is less than the desired number the next
load increment will be reduced.

In the Solution strategy section of the dialog, ensure the Maximum number of
iterations is set to 25

Leave the Residual force norm as 0.1 and the Incremental displacement norm to
1 so convergence of the solution at each load increment will be achieved when the
out of balance forces are as less than 0.1% of the reactions and the iterative change
in displacements is less than 1% of the displacements for that load increment.

Select the Advanced button in the Incrementation section of the dialog.

Advanced Nonlinear Incrementation Parameters I

— Automatic incremention — Termination criteria
. ) : ¥ Teminate on value of limiting «ariable
Stiffriezs ratio to gwitch to arc-length IUU =
Fuaint rurmber 13

[ Use arc length contral \Variable type

Arc-length calculation ICrisfieId "I
W alue

™| Belative displacement arc [Ength procedine

: . . . — Step reduction
7| Guide are lenath solition with curent stiffress 2

¥ &llow step reduction
I | s ront with brestresidual e : .
b awimum step reductions 5

Arc-length restart load factar 0.a Load reduction factar 05

11

|

Arc-length restart load change 0o Load increase factor 20

0k, I Cancel | Help |

Ensure that the Stiffness ratio to switch to arc length value is set to 0.0
Select the Terminate on value of limiting variable option.

The selected point number (this may differ depending on how the model was
created) will appear in the Point number drop down list.

Set the Variable type to V to monitor the deflection at the selected point in the Y
direction.

Enter a value of -3 so the analysis is terminated when the central deflection reaches
this value.

In the Step reduction section ensure the Allow step reduction option is selected.

Click OK to return to the Nonlinear & Transient dialog.
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| File

Model Properties. ..

| File
| Save

Running the Analysis

e Click OK again to set the loadcase properties.

One additional setting is required for this analysis to ensure no element mechanisms are
induced as the material yields.

e Select the Solution tab.

e Click on the Element Options button and select the Fine integration for stiffness
and mass option.

e Click the OK button to return the Model Properties dialog.
¢ Click the OK button to finish.

Save the model

The model is now complete and the model data is to be saved before an analysis is run
using the LUSAS Solver.

El Save the model file.

Running the Analysis

El Open the Solve Now dialog, and press OK to run the analysis.
During the analysis 2 files will be created:

U beam_nl.out this contains the statistics of the analysis, for example how
much disk space was used, how much CPU time was used, and any errors or
warning messages from LUSAS, and so on. Always check the LUSAS output
file for error messages.

U beam_nl.mys this is the LUSAS results database which will be used for
results processing.

Note. Warnings will be written to the text output window during this analysis.
Warnings are not to be confused with errors which normally stop an analysis from
being run. The warnings are written to advise you of modelling-related issues that are
found during the analysis and of the steps LUSAS has taken (if any) to allow the
analysis to continue.

If the analysis is successful...

Analysis loadcase results are added to the (2 Treeview.
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| File
[New...
| File
| Script >
| Run Script...

Nonlinear Analysis of a Concrete Beam

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Select No to not view
the output file. Any errors listed in the text output window should be corrected in
LUSAS Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

U0 beam_nl_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as beam_nl

To recreate the model, select the file beam_nl_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the G Treeview, and the loadcase results for
load increment 1 are set to be active by default.

Changing the Active Results Loadcase

o Inthe ™= Treeview right-click on the last load increment Increment 6 Load Factor
= 15000 and select the Set Active option.

Deformed Shape

e In the Treeview turn off
the Geometry, Attributes
and Mesh layers by right
clicking on each entry and ' _—
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Viewing the Results

| Graph Wizard...

selecting the On/Off option.

Creating a Load versus Displacement Graph

A graph of displacement at mid- Select this Node
span is to be plotted against the

applied load. To do this a node on

the line of symmetry is selected:

e With the Deformed mesh layer
visible, select the top node on —
the axis of symmetry as shown.

Using the Graph Wizard

The graph wizard provides a step-by-step means of selecting which results are to be
plotted on the X and Y axes of the graph. The X axis is always defined first.

Ensure the Time history option is selected and click the Next button.

Ensure the Nodal results is selected and click Next

Select entity Displacement for component resultant displacement RSLT

The node number selected earlier will be displayed in the drop-down list.

Click the Next button.

The Y axis results to be graphed are now defined.
e Select the Named option and click Next
e Select Total load factor from the drop down list.

e Click the Next button.
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e Leave all title information blank ., G
and click the Finish button to | . .
display the load deformation 0o
graph_ 13000 -

12000 -----

11000 ----

Note. Graphs can be modified .|
using the right hand mouse button in =~ am|
the graph window and selecting the &
Edit Graph Properties option. e

6000 |-
5000

-

E Close the graph window.

—®—Total load factor(2) / Resultant Displacement Node 181(1)

Use the maximise button to increase the size of the graphics window.

e Inthe = Treeview turn off the Deformed mesh layer.

Maximum Principal Stress Contour Plots

e With no features selected, click the right-hand mouse button in a blank part of the

graphics window and select the Contours option to add the contours layer to the
Treeview.

The properties dialog will be displayed.

e Select entity Stress - |

Plane Stress for
the x direction, SX

¢ In the Contour Display tab ensure Deform is not selected.

e Click the OK button to display contours of stresses for the final load increment.

Viewing Crack Patterns

e With no features selected, click the right-hand mouse button in a blank part of the

graphics window and select the Values option to add the values layer to the
Treeview.

The properties dialog will be displayed.
e Select Stress - Plane Stress contour results of type Crack/crush

e Select Values Display tab and press the Failure details... button to change the pen
colour that is used to plot negative yield to Black.
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Animation Wizard...

Viewing the Results

e Click the OK button to T ——
display the cracking
pattern for final load
increment superimposed
onto the stress contours.

Animating the Results

As an alternative to viewing results individually for each loadcase, the change of stress
due to the increasing load increments can be animated instead. To ensure consistent
contour values throughout the animation the interval of the range of contours is to be
specified.

¢ Inthe = Treeview double-click on the Contours layer.
The contour properties will be displayed.

e Select the Contour Range tab and click the Interval option and set the contour
interval as 1

e Click the Maximum button and set the maximum value as 3
e Click the Minimum button and set the minimum value as -16
e Click the Set as global range and Use global range options.

e Click the OK button to redisplay the stress contours using the new contour range.

Using the Animation Wizard

e Select the Load History
option and click the Next
button.

e Select the All loadcases

TeEE——
option and select the
Finish button to create the

animation sequence.

Note. The buttons at the
bottom of the window may be
used to slow-down, speed-up,
pause, step through frame by
frame, or stop the animation.

i = xf4| aln|[= 8] ¢ ENNNNENENENENNNNNNNNNNENANRNRNENNNEN
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| File

Save As AVI...

| utilities

Graph Through 2D

Nonlinear Analysis of a Concrete Beam

Saving Animations

Animations may be saved for replay in Windows animation players.
e Ensure the animation window is the active window.

e Browse to your projects folder and enter beam_nl for the animation file name. An
.avi file extension is automatically appended to the file name. Click Save

Note. Animations can be compressed to save disk space by changing the
Compression Quality. Reducing the quality will, however, result in a lower definition
image. It is also possible to reduce file size by setting smaller dimensions on the first
page of the Animation Wizard.

E Close the animation window, choosing not to save changes.

M [=]ES Enlarge the model window to a full size view.

Creating a slice section of results

In this example a graph is to be plotted of the variation in stress through the specified
section of the beam. The X axis values of distance are defined by the section slice. The
Y axis results are specified from the graph wizard dialog.

e Ensure the Snap to grid option is selected and a grid size of 100 is specified.
e Click the OK button.

Note. The snap to grid dialog will only appear if the model is viewed in the XY plane.

If necessary, return the model to the default starting view by clicking <. N/A, on

the status bar at the bottom of the graphics window.

e Using the screen ruler as a
guide, click and drag the
cursor as shown to define the
location of a section slice
through the beam at a distance
of 1600 from the left-hand
end.

e Select Stress - Plane Stress results for Stress SX and click the Next button.

e Leave all title information blank.
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| Window

1 LUSAS View
beam_nl.mdl
Window 1

|Window

2 Graph2:Graph 3

Viewing the Results

e Click the Finish button to
create the graph of stress
through the section of
beam.

Graph2

Stress SX{4)
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Coordinates [1600 400 0) ta (1500,-100 M3
—#— Strags SX(4) / Coordinates (1600,400,01 to (1600 ,-100,0)(3)

Adding Additional Results to a Graph

e Re-select the window containing the results contours. The cursor will still be in

section slice mode.

e Using the screen rulers as a |
guide, click and drag the : : | ——
cursor as shown to define the
location of a section slice
through the beam at a distance |
of 1000 from the left-hand

end.

e Select Stress - Plane Stress results for Stress SX and click the Next button.

e In the ‘Include existing graph’ panel select the check box for Graph 2.

e Click the Finish button to
see the results for the
second slice section
alongside the results for
Graph 2.

e Re-select the existing graph
to see the overlaid data

Graph3

Stress SX(4)
o

A e bsmsdesendenond

240 |-~
320 -
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—®—Stress SX(E) / Coordinates (1000,600,0 to (1000 -100,03(5)
—#—Stress SX(4) / Coordinates [1600,400,01 to (1600 -100,03(3)
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Nonlinear Analysis of a Concrete Beam

E Close the graph window.

Plotting Crack Width Contours and Values

Crack width values as calculated by the use of the Smoothed Multi Crack Concrete
Model can be plotted in contour and value form:

e Double-click the Contours layer name in the Treeview.
The properties dialog will be displayed.

e Select entity Plastic strain - Plane Stress for component of stress in the x direction,
CWMax

e Select the Contour Range tab and deselect Use global range

e Deselect the Maximum button

e Deselect the Minimum button

e Set the contour Interval to be 0.005

e Click the OK button to redisplay the stress contours using the new contour range.
e Press Yes to confirm the Values layer will be adjusted to match.

Note. Contouring of crack width values effectively shows the elements affected by
cracking and identifies those elements where the maximum crack widths occur. This is
done using unaveraged, or unsmoothed values at nodes. To see the actual values of
crack width within elements (at the locations where the Crack/crush patterns were
plotted earlier in the example), values for gauss points need to be plotted.

To see the crack width values:
e Double click the Values layer name in the ['=F Treeview.

e With the Values Results tab active, ensure the following are selected: Plastic
strain — Plane Stress of Component CWMax at Location Gauss Point.

e Select the Values Display tab and ensure the Symbols and Values are checked, and
change the Font angle to 45 degrees.

e Click OK to update
the display and show
the actual crack width
value calculated at
gauss points within the
element.
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Discussion

Discussion

This completes the example

Plotting Crack Widths to EN1992-1-1

In this example nonlinear steel properties were defined for the reinforcing bar elements.
Reinforcement bar attributes (accessed from the Attributes > Geometric > Bar
reinforcement menu item) may alternatively be used to model the steel reinforcement
in reinforced concrete, but only if a linear steel material model is used to represent the
steel reinforcement and the Crack Widths calculation utility (accessed from the Bridge
> Crack Widths to EN1992-1-1 menu item) is employed.

When this is done, contours and values of crack widths can be plotted in accordance
with EN 1992-1-1:2004 Eurocode 2 by selecting the Entity Crack Widths EN 1992-1-
1 and the Component Maximum Crack Width on the Contour Properties dialog. Note
that a linear steel material model (rather than a nonlinear one) is required for the steel
reinforcement because of the steel strains used in the calculations.

Reinforcement bar attributes are similar to geometric line attributes but need to be
assigned to lines meshed with bar elements for a chosen analysis to enable a crack
width calculation to be carried out. Bar attributes may be defined for a single
reinforcing bar (a Discrete bar), as would be used in a 3D model, or be defined with
suitable properties to represent a bundle or simplified arrangement of bars (Equivalent
bar) as would be used typically in a 2D plane strain analysis.

When modelled in the way described for two 16mm diameter steel bars, the crack width
contours can be plotted along the bar elements (actually on the surface of the fleshed
bar section) corresponding to the steel strains used in the calculation, and not on any
concrete face or surface in the model. Contours and values are plotted for an active
loadcase (or combination) and are re-computed if a different loadcase is set active. This
visualisation method is used because the approach used in EN 1992-1-1:2004 to
calculate crack widths is generally unclear as to where the crack width calculation
applies.

A typical crack width contour plot for a bar reinforcement attribute defined for the steel
in this example is shown below. Unaveraged or gauss point values of crack widths
could be additionally added using a Values layer.
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Nonlinear Analysis of a Concrete Beam

Analysis: Analysis 1

Load : 6:Load 1,1 it & Load Factor = 15000.0

Results file: nl_beam_102_with_16mm_bar_attributes_linear_steel~Analysis 1.mys
Entity: Crack widths EN1992-1-1

Component: Maximum Crack Width {(Units: mm})

0.0
0.0117178 —*
0.0234355 -
0.0351533 »
[ e —
0.0585889 —»
0.0703066 rer 1 i = -{
0.0820244

. 0.0937422

Maximum 0.10546 at node 2 of element 31 Crack width calculation summary
Minimum 0.0 at node 1 of element 1 Attribute: two 16 dia bars, max crack spacing = 185.3mm, max crack width = 0.10546mm
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Description

Staged
Construction of a
Concrete Tower
with Creep

For software product(s): | Any Plus version.
With product option(s): Nonlinear and Dynamic.

Description

A 20m high concrete tower of varying 4at 10JOO mm
cross-section is to be constructed in four >
stages, each 5 metres high. The formwork

1000 X109

.

is struck 14 days after each stage is cast
and the casting sequence between each
stage is 60 days. 5000 mm

Simplified geometry has been used to
allow the example to concentrate on the
creation of staged construction loadcases,
the definition of the concrete creep
properties, and running a creep analysis.

5000 mm

I

5000 mm

I

Concrete creep is carried out according to 5000 mm
CEB-FIP 1990 code. The modelling units  sogy,, (2 4£
used are N, mm, t, s, C throughout. 00 rnm 4000 mm

Tow er geometry and construction stages
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A

Modelling

Staged Construction of a Concrete Tower with Creep

Objectives
The required output from the analysis consists of:

e A comparison of the moments at the base of the tower after each construction stage.

e Maximum displacement of the tower after each construction stage and the change in
the maximum displacement value due to long-term creep.

Keywords

Birth, Death, Staged Construction, Activate, Deactivate, Long-Term, Creep, CEB-
FIP Concrete Model, Age, Casting, Reference Path

Associated Files

e concrete_tower_modelling.vbs carries out the modelling of the example.

Discussion

Structural concrete is unique among the major construction materials in that it
undergoes time-dependent changes in its properties. Generally, the concrete’s strength
will increase over time, but this increase in strength is accompanied by a certain degree
of shrinkage and creep. Particularly in large structures where several concrete pours
may take place over a period of months or years, the time-dependent nature of
concrete’s behaviour can have a significant effect on the behaviour of the structure and
these effects must be considered in analysis.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file. Modeller will prompt for any unsaved data and display
the New Model dialog.
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| Geometry >
| Line >
| Coordinates...
| Geometry
| Line >
Copy...
| Attributes
[Mesh >
Line...

Modelling

Creating a new model

o Enter the file name as concrete_tower

e Use the Default working folder.

o Enter the title as Concrete creep example to model code CEB-FIP 1990

e Select units of N,mm,t,s,C

e Select timescale units of Days

e Ensure the Structural analysis type is selected.

e Leave the startup template as None

e Select the Vertical Y Axis option.

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to

correct any mistakes made since the last save was done.

Defining the Geometry

il Enter coordinates of (0, 0), and (1000, 5000), to define the first section of the
tower.

e Select the line just drawn.

Sarm

UI1] Enter a translation in the X direction of 1000 and in the Y direction of 5000
e Enter the number of copies required as 3 and click OK to create the next three
sections of the tower.

Defining and Assigning Mesh Attributes

e The tower is to be modelled with Thick Beam 3D Quadratic elements (BMI31
elements) with 6 divisions. These elements can correctly capture the effects of the
variation in section shape.

e Enter the attribute name as BMI31 6Div and click OK.

e Select all lines on the model and drag and drop the BMI131 6Div mesh from the &
Treeview onto the selected features.

e Click OK to assign a default element orientation using a beta angle of 0.
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| utilities

Staged Construction of a Concrete Tower with Creep

Section Property
Calculator

>

Rectangular

Sections > Solid

Caution. If constant cross-section beam elements were to be used to model the
variation in section shape instead of the quadratic elements used, care should be taken
to ensure that the line mesh was sufficiently fine to correctly capture the effects of the
variation in section shape.

Geometric Properties

There are two ways that the tapering shape of the tower could be modelled. The first
option would be to create a tapering beam geometric property for each individual line.
This would require different geometric attributes to be created for each of the four lines.

A more efficient method is to use a multi-varying section geometric attribute which
allows tapering along a reference path rather than along individual lines. By using this
type of geometric attribute, only a single attribute is required to describe the taper of the
tower from its base to tip.

To define the tower cross-section at the base

The basic cross-sectional dimensions of sections at the base and top of the tower will be
defined.

e On the Rectangular Solid Section Property dialog enter D=3000 and B=2000.
A name of RSS D=3000 B=2000 will be automatically created.

e Ensure Add to local library is selected and click Apply to calculate the section
properties, add the section to the local library and define another cross-section.

e Change the values to read D=1000 and B=1000.
A name of RSS D=1000 B=1000 will be automatically created.

e Ensure Add to local library is selected and click OK to calculate the section
properties and add the section to the local library.

All required section properties have now been defined and saved in the local user
library. They will be used to create multiple varying section line attributes which will be

automatically added to the Attributes &b treeview when the attribute is created.
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Modelling

Creating a reference path

e For this example a reference path will be defined along the lines
representing the tower. This will be used when defining and
assigning the varying section properties of the tower.

Box-select all lines representing the tower

| utilities e Leave the name set as Path 1 and click OK.
| Reference Path

e  The direction of the path is shown by arrows now overlaid on each
line.

¢ Note. Model geometry can be used to generate a reference path
/ but no subsequent connection between the initial parent geometry

and reference path data exists.

e The visualisation of a reference path can be controlled via the
Utilities layer. If desired reference path visualisation can be turned | .
off using a context menu option for its entry in the Utilities layer of

the Treeview.

-

Defining the multiple varying section line property

A multiple varying geometric line attribute needs to be defined. This will make use of
the previously defined rectangular solid sections.

Define sections

| Attributes e On the Multiple Varying Section dialog click in the Section cell that currently reads
|§M 914x305x289kg UB and the launch dialog button Hwill appear to allow a different
'\S"e”(':tt'ipo'ﬁ_\_/_ary'”g pre-defined section to be chosen from a different section library.

e On the Enter Section dialog, click on the drop-down list button ﬂ to change the
selection from UK Sections to User Sections

e Ensure a Local library is being accessed.

e Select RSS D=3000 B=2000 from the list of local library items and then click OK
to add the section to the first row of the table on the Multiple Varying Section
dialog.

e On the Multiple Varying Section dialog press the TAB key to move between cells
and create a new row beneath the existing row.

e In the new Section cell (row 2) click on the launch dialog button 3 again. The
drop-down list should still be showing User Sections for a Local library. Browse
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Staged Construction of a Concrete Tower with Creep

and select RSS D=1000 B=1000 from the drop-down list and click OK to add the
section to the table.

Note. Before a visualisation of the longitudinal and horizontal alignment of the cross-
section shapes can be displayed on the dialog, the shape interpolation method and
distance values need to be defined.

Define shape interpolation method

To specify a shape interpolation method for —<SmmEEEs

each defined section: [ =
D Thick Beam ~| | | € Sealedto fit each line individualy
£ Along reference path | Path [~

[ Specily shape interpolation

e The RSS D=3000 B=2000 section as the I syt et

first in the table is set by default to Start
e For the RSS D=1000 B=1000 section

entry click on the drop-down list button e otane 3] A [

*lin the Shape Intel’pola'[ion cell and Hoizortel [Certio tocenie v || Iitepoliion ofpropertes [Ebanced ]

select Linear 1
Define distance values ‘ :l
e Change the distance interpretation to be

Along reference path and ensure Pathl :

is selected. E=raE Secton 22
Lastly a distance value at which the section ‘ dm ‘
will apply should be specified. I = e |

e For the RSS D=1000 B=1000 section click in the Distance cell and enter 20397
(the true length of the tower).

Note. When specifying a distance value at which a defined section will apply it is
important to round-up to the next whole number (20397 in this case). If 20396 has been
specified the final section would not be applied to the topmost line on assignment, and
therefore not shown when fleshed.

Check alignment settings

The vertical and horizontal alignment of a pair or series of sections is controlled by the
Alignment options. All sections are aligned with respect to a chosen section.

e Select Centre to centre for both alignment options and set the section to align to
as 1.
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Modelling

Name the attribute

e Enter a name of Tapering Tower and click OK to add the multiple varying section

line attribute to the & Treeview. Note that “(Varying — 2 sections)” is
automatically appended to the stated name.

Assigning the varying geometric line property

e Box-select all lines representing the tower and drag and drop the Tapering Tower
(Varying — 2 sections) geometric line attribute from the &b Treeview onto it.

Check and correct the orientation of sections used

@I Select the isometric view.

In this example, the 3m x 2m section at
the base of the tower has not been
oriented correctly for the line axes that are
in use. As a results the cross sections at
the bottom and the top of the tower both
need rotating around their centroids. This
is done as follows:

e In the ¢b Treeview double-click on
the Tapering Tower (Varying — 2
sections) attribute name

e On the Multiple Varying Sections
dialog click in the Section cell for
row 1 and click on the launch dialog
button ¥ to access the detail for RSS
D=3000 B=2000 and change the
Rotation about centroid to be 90
degrees and click OK.

e Click in the Section cell for row 2
and click on the launch dialog button
3 to access the detail for RSS : Correct
D=1000 B=1000 and change the Incorrect
Rotation about centroid to be 90 degrees and click OK.
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| Attributes

Staged Construction of a Concrete Tower with Creep

| Material

E

pecialised
Concrete
Creep

CEB/FIP...

Material Properties

In addition to the common linear isotropic material properties (Young’s modulus at 28
days, Poisson’s ratio, mass density, and coefficient of thermal expansion), the mean
compressive strength at 28 days, relative humidity and cement type need to be
specified.

In this example, leave the Include shrinkage box ticked to include the effects of
shrinkage as well as creep in the material behaviour.

The CEB-FIP creep calculations use a parameter called ‘nominal size’. This is
calculated as 2A/U where A is the area of the cross-section and U is the length of the
cross-section perimeter. In LUSAS you have the option of manually inputting the
nominal size by activating the nominal size radio button, or allowing LUSAS to
automatically calculate the nominal size by activating the specify the beam section
internal perimeter factor radio button. The internal perimeter factor is a factor applied
to the perimeter length of any internal voids when calculating the section perimeter U.
In this case the tower cross-section has no voids so the value has no effect.

e Ensure the values shown on the accompanying dialog are entered, enter a material
name of Concrete CEB-FIP Creep and click OK to create the material attribute.

Concrete Creep CEB-FIP (1990)
Component Value

Tangent modulus of elasticity 30.0E3

Poisson's ratio 0.2

Mass density 24E-5

Coefficient of thermal expansion 10.0E-6

Mean compressive strength at 28 days 50.0

Cemert type Mormal or rapid hardening

Relative humidity 70.0

Intemal perimeter factor 05

V¥ Indude shrinkage
* Automatically calculate nominal size from section dimensions
" Use full perimeter

% Spedfy internal perimeter factor

Name | Concrete CEP-FIP Creep j ﬂ W

Close I Cancel | Apply | Help |

e Select the whole model (CTRL + A). From the & trecview drag and drop the
Concrete CEB-FIP Creep attribute onto the model to assign the new creep
material.
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| Attributes
[Support...
| Attributes
Age...

Modelling

Supports

o A fully fixed support is required therefore all degrees of translation and rotation in
the X, Y and Z axes must be set as Fixed. Enter an attribute name of Fully Fixed
and click OK

e Select the point at the base of the tower and from the Fb treeview drag and drop the
support attribute Fully Fixed onto the selected feature, ensure the All analysis
loadcases option is selected and click OK

Loading

Only self weight will be applied in this analysis. The LUSAS auto-gravity facility can
be used to quickly apply gravity loading in all loadcases. This will be done later on
after creation of all the required loadcases.

Age

The age of a section within a creep analysis is important because the material properties
change with time. The age of a section is specified in days between the casting of the
section and when it is first activated in the analysis.

Note. The timescale units of days for the model were set on the New Model dialog at
the beginning of this example. Timescale units are distinct from the fundamental model
units (i.e. N, mm, t, s, C) and are provided as a convenience for long-duration analyses
like creep and consolidation.

Creating and Assigning an Age Attribute

e It is assumed that all sections in the S
tower will be cast and the formwork Aot ctvatontme [[7
struck 14 days after the component was
first activated. (If this was not the case
separate age attributes would be
created and assigned to each section as 0 | cacel | apoh | Hem |
required)

ﬂ [rrew]

e Name the attribute as 14 days to formwork strip and click OK
e Assign the age attribute to all lines in the model.

Note. If a construction includes precast sections, the age of a component might be 80
days, while the component may be activated at day 28 in the analysis for example.
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| Attributes

Birth & Death...

Staged Construction of a Concrete Tower with Creep

Creating Activation and Deactivation datasets

In order to carry out a creep analysis on the model the construction stages are modelled
using the birth and death facility within LUSAS.

e Select the Activate option and click Next

e Enter the attribute name as Activate and click Apply. Then click Back so the dialog
can be reused to define the deactivate attribute.

e Select the Deactivate option and
CIICk NeXt ¥ Percentage to redistribute 100.0
° Se|eCt the Percentage to " Maintain relative position of internal nodes
redistribute option and leave the Constraint equatian type -
value as 100%. Enter the attribute
name as Deactivate, then press Name [Dzactate =1 Heem
Finish
< Back | [ext = | Finish Cancel | Apply | Help

Modelling of Construction Stage 1
@l Select the Home button to return the model to
the default view.

e Inthe Treeview expand Analysis 1 and rename
Loadcase 1 to Stage 1: 0 to 60 Days by right-
clicking its title and selecting Rename

All elements in the model which are not required
for the first stage analysis need to be de-activated.

¢ In the graphics window select the top three lines
of the tower. - Jk

Assign deactivation

dataset to top 3 stages

of construction

o From the ¢b Treeview drag and drop the
deactivation attribute Deactivate to the three
selected lines ensuring that it is assigned to
loadcase Stage 1: 0 to 60 Days
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Modelling

Defining loadcase properties

Note. The total response time of 60 represents the 60-day time interval until the next

In the '= Treeview right-click Stage 1: 0 to 60 Days and, from the Controls menu
item, select the Nonlinear & Transient menu option.

On the Nonlinear & Transient dialog select the Nonlinear option in the top-left
hand corner and leave the incrementation type as Manual.

Enable the Time domain option. Select a Viscous time domain from the drop-down
options. Enter the initial time step as 4, the total response time as 60, ensure the
automatic time stepping option is not selected and set the maximum number of
time steps or increments as 15

In the incremental LUSAS file output section enter a Plot file value of 5 to only
write out the results every 5 time steps. This will simplify the viewing of the results
by only creating a results file for the final time step of each loadcase.

Click OK to return to the Modeller working window.

Nonlinear & Transient

r~ Incrementation

¥ Nonlinear

Incrementation lm
Starting load factor 0.1

Max change in load factor I 0.0

Max total load factor 1.0

¥ adjust [nad based on convergence

Iterations per increment I “

I~ | Genstatic step

Solution strategy
I~ same a5 previous loadcase

Advanced.,., |
¥ Time domain
IViscous 'l
Initial time step |4—
Total response time I &0

[~ Automatic time stepping

Advanced... |

Max number of iterations IIZ—
Residual force norm IDI—
Incremental displacement norm IID—
rIncremental LUSAS file output
I | 5ame a5 previous lnadease
Output file [T
Plot fil [s—
Restart file ID—
Max number of saved restarts IU—
Log file ll—
History file ll—

r~ Common to all

Max time steps or increments I 15

Cancel Help

.

stage of the analysis is activated.

Having set all the Nonlinear & Transient options select OK to return to the
Modeller working window.

333



| Analyses
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| Loadcase. ..

A Nonlinear and Transient object & will be added to the ‘! Treeview. Double-
clicking on this object will allow any changes to be made to the control properties.

Construction Stages 2 to 4

Stages 2 to 4 require loadcases to be generated to specify the duration of the
construction process. Lines on the model must be selected according to the construction
stage being considered and activation datasets must be assigned to these lines as
instructed below.

Stage 2

The elements in the second construction stage must be activated

Enter the Loadcase name as Stage 2: 60 to !
120 Days and select OK

In the ' Treeview select Stage 2: 60 to
120 Days using the right-hand mouse
button select Set Active

In the graphics window select the second | |

line of the tower. : :

With the second stage selected, assign the : :

activation attribute Activate from the éb L _ —

Treeview ensuring that it is assigned to ‘k

loadcase Stage 2: 60 to 120 Days Assign activation

" dataset to the 2nd
stage of construction

Defining loadcase properties

In the &' Treeview right-click Stage 2: 60 to 120 Days and, from the Controls
menu item, select the Nonlinear & Transient menu option.

On the Nonlinear & Transient dialog select the Nonlinear option in the top-left
hand corner and leave the incrementation type as Manual

Select the Time domain option and select a Viscous time domain. Enter the initial
time step as 4, the total response time as 120 and the maximum number of time
steps as 15.

Ensure Same as previous loadcase is selected for the Incremental LUSAS file
output.
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| Analyses

Modelling

| Loadcase...

Select OK to return to the Modeller working window.

Stage 3

The elements in the third construction stage now need to be activated.

Enter the Loadcase name as Stage 3: 120
to 180 Days and select OK

In the "= Treeview right-click Stage 3: [~~~ ~7T 7
120 to 180 Days and select Set Active

In the graphics window select the third
stage of the tower.

L —
With the third stage selected, assign the ‘k
activation attribute Activate from the &%
Treeview, ensuring that it is assigned to
loadcase Stage 3: 120 to 180 Days

Assign activation
dataset to the 3rd
stage of construction

Defining loadcase properties

In the &' Treeview right-click Stage 3: 120 to 180 Days and, from the Controls
menu item, select the Nonlinear & Transient menu option.

On the Nonlinear & Transient dialog select the Nonlinear option in the top-left
hand corner and leave the incrementation type as Manual

Select the Time domain option and select a Viscous time domain. Enter the initial
time step as 4, the total response time as 180 and the maximum number of time
steps as 15.

Ensure Same as previous loadcase is selected for the Incremental LUSAS file
output.

Press OK to return to the Modeller working window.

Verifying self weight and activation assignments

If you need to verify loading assignments such as self weight or to check when
particular lines (and hence elements) become active in an analysis select a line on the
model using the right-hand mouse button and select Properties. Select the Activate
Elements tab. Note that the ‘greyed-out’ loadcase is simply the current loadcase and
may not be the actual loadcase that the properties are assigned to. Selecting the
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Activate entry in the table of Assigned properties will show the loadcase to which the
activation is assigned.

Stage 4

The elements in the fourth construction stage T 1
need to be activated.

| Analyses e Enter the Loadcase name as Stage 4: 180
Loadcase... to 240 Days and select OK
o In the ‘B Treeview right-click Stage 4: T X
180 to 240 Days and select Set Active . -
Assign activation
e In the graphics window select the top line dataset to the 4th
of the tower. stage of construction

e Drag and drop the activation attribute

Activate from the & Treeview ensuring
that it is assigned to loadcase Stage 4:
180 to 240 Days

Defining loadcase properties

o Inthe & Treeview right-click Stage 4: 180 to 240 Days and, from the Controls
menu item, select the Nonlinear & Transient menu option.

e On the Nonlinear & Transient dialog select the Nonlinear option in the top-left
hand corner and leave the incrementation type as Manual

e Select the Time domain option and select a Viscous time domain. Enter the initial
time step as 4, the total response time as 240 and the maximum number of time
steps as 15. Select OK to return to the Modeller working window.

e Click OK to return to the Modeller working window.

Long-term loadcase

This investigates long-term effects on the tower over time.

| Analyses e Enter the Loadcase name as Long-term: 240 to 1000 Days

Loadcase...

o In the = Treeview right-click loadcase Long-term: 240 to 1000 Days and select
the Nonlinear & Transient option from the Controls menu.
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| File

Save

Modelling

e On the Nonlinear & Transient dialog
select the Nonlinear option in the top-left [ . e ety octor s
hand corner and leave the incrementation | icton factor =
type as Manual Minimum time step III-.II-

Maximum time step

e Select the Time domain option and
select a Viscous time domain. Enter the
initial time step as 1, the total response
time as 1000 and the maximum number
of time steps as 20. Integration factor aipha

Integration factor beta

Minimum time step for termination
Termination value

100.0E6
I 0.0
I 0.0
Exponent for increasing time step (CEB-FIP) V. I 20
I 0.5
I L

e Select the Automatic time stepping
option and then select the Advanced

Integration factor gamma

¥ allow step reductions

bUtton Maximum step reductions
e On the Advanced time step parameters ok | concel | neo |

dialog select the Exponent for
increasing time step option and set the value to 2. Press OK to return to the
Nonlinear & Transient dialog.

e Having set all the Nonlinear & Transient options select OK to return to the
Modeller working window.

Note. Specifying an exponent for increasing time step will cause the time step
increments to increase in duration throughout a loadcase. This is particularly useful
with creep analyses where it is often desirable to start a loadcase with short time steps
but progress to larger time steps as the age of the concrete increases to investigate long-
term behaviour without using an excessive number of time steps. The larger the value
specified in the exponent for increasing time step box, the greater the ratio of the final
to first time step size will be. The analysis will always use the number of time steps
specified in the max time steps or increments box.

Note. All lines in the model are now activated so no activation dataset needs to be
assigned to the model for this loadcase.
Applying Gravity as a property of the analysis

Now that all five loadcases have been created, in the (X treeview right-click the heading
Analysis 1 and select Add gravity. This will automatically assign gravity loading to all
loadcases.

El Save the model file.
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Running the Analysis

&

| File
[New...
| File
| Script >
| Run Script...

El Click the solve now button and press OK to run the analysis using LUSAS Solver
and load the results file

If the analysis is successful...

Analysis loadcase results are added to the (2 Treeview.

In addition, 2 files will be created in the Associated Model Data folder in the directory
where the model file resides:

e concrete_tower.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

e concrete_tower.mys this is the LUSAS results file which is loaded
automatically into the @ Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered are
written to the .out file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

U concrete tower modelling.vbs carries out the modelling of the tower.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

Enter the file name as concrete_tower

e To recreate the model, select the file concrete_tower_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results.
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Viewing the Results

Viewing the Results
Analysis loadcase results for each time step are added to the (& Treeview.

Bending moments of Mz at the base of the tower are to be investigated for each stage of
the construction process, that is, after 60 days, 120 days, 180 days, 240 days and for a
long-term loadcase from 240 to 1000 days. A summary of results on each results plot
also allows a comparison of maximum displacements for each stage.

Stage 1 results

e Turn off the Geometry, Mesh, Utilities and Attributes layers in = Treeview.

o Double-click View Properties in the =" Treeview. Select the View tab and ensure
the check box Show only activated elements is ticked. Press Close to apply
changes and return to the model.

o In the 2 Treeview right-click on Time Step 15 Time =
60.000 (days) and select the Set Active option.

e With no features selected click the right-hand mouse
button in a blank part of the Graphics window and select
the Diagrams option. On the dialog, select
Force/Moment - Thick 3D Beam contour results from
the entity drop down list and component Mz.

e Select the Diagram Display tab and ensure Label
values and Peaks only are ticked. Press the Label font...
button to set the diagram font as Arial, Bold, size 14.
Press OK to return and change the angle to -15°.

e Select the Scale tab select Use a local scale and Specify
magnitude with a value of 10mm. Click OK to display
the diagrams layer.

T X

Note. The value for the top of the tower in this plot and also in the following plots
are effectively zero but will display as different values on different PCs due to hardware
specific rounding errors.
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Stage 2 to 4 results

o In the ‘B Treeview right-click on the loadcases noted in the following summary
table, and select the Set Active option to update the diagram results.

4 &
Fy
Time Step 30 Time Step 45 Time Step 60
Time = 120.000 Time = 180.000 Time = 240.000
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| Utilities

Viewing the Results

| Graph Wizard...

Long-term loadcase

o In the X Treeview right-click on Time Step 79 Time
=1000.00 (days) and select the Set Active option.

For the long-term loadcase the bending moment has not
changed from the stage 4 analysis since no additional
loading has been applied to the model. However, a
comparison of maximum displacement between time
steps would show an increase due to the effect of the
creep deformations.

Plotting a Graph of Deflection at Top of Tower
e  The time-dependent creep effects can be plotted using the LUSAS Graph Wizard.

e Ensure that the Mesh and/or Deformed mesh layers are visible,
e Select the node at the top of the tower by holding the N key and clicking the node.
e On the first page of the Graph Wizard, select Time History and click Next.

e For the X-axis entity, select Named and ensure Whole Analysis is selected. Click
Next.

e For the X attribute named data, select Response Time and click Next.
e For the Y-axis entity, select Nodal and click Next.

e Select entity Displacement and component RSLT. The number of the selected node
should automatically be entered in the ‘specify node’ input box. Click Next.

e Enter title Displacement of Tower Tip, X-axis label Time (days) and Y-axis label
Displacement (mm). Click Finish to plot the graph.
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Displacement of Tower Tip

Displacement {m)

o =1 o o o =) o =1 =] =1 o o
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I~} o o = = o i w o [ = @
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220

o o o
= & =
o [} &

1020
1070

Time (days)

e  The graph clearly shows the four construction stages, and that the deflection
increases with time due to creep and shrinkage effects. Note that the tower tip is

not actually activated in the first three construction stages, but deflections of the
deactivated mesh can be plotted.

This completes the example.
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Description

3-Span Concrete

Box Beam Bridge of

Varying Section

For software product(s):

Bridge and Bridge Plus

With product option(s):

None

Description

A 3-span concrete box beam bridge of varying cross-section is to be modelled to
illustrate the use of the box section property calculator and the use of the multiple
varying sections facilities in LUSAS.

Two models are to be created; a preliminary model suitable for prototype / assessment
work and a more detailed model suitable for developing further into a staged
construction model. Simplified geometry is used for both to allow the example to
concentrate on the use of the box section property calculator and the multiple varying

section facilities that are used in modelling the structure.
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3-Span Concrete Box Beam Bridge of Varying Section

Units used are KN, m, kg, s, C throughout
Objectives
The required output from the analysis consists of:

O A comparison of results from the preliminary model and the more detailed
model.

Keywords
Bridge, Concrete, Multiple VVarying Sections, Box

Associated Files

U concrete_box_bridge.mdl Basic beam model.

Discussion

The 3-span structure is comprised of varying hollow cross-sections with solid
diaphragm sections at the four supports. Cross-section properties for three void
locations on the structure (as shown in the image below) will be defined and used in the
creation of multiple varying section geometric line attributes which will then be
assigned to selected lines on the model.

163m overall length

| 39m clear span L 78m clear span L 39m clear span )
0.5m | 24m ) ‘ ‘ 3m 3m 0.5m
; \ i ™
1 2 33 2 1 2 33 2 1
i i
1 2 33 2 1 2 33 2 1
] | |0 -] ] ° 2 psd a3
o v s o [ ~ - 3 & & 3 8 |8
of [© o™~ | (T [t=] @ — —| |~ - - |
T [l T T
'Left Span' '‘Centre Span’ 'Right Span'
Section 1-1 Section 2-2 Section 3-3
'Span Solid' 'Span’ 'Intermediate’ 'Pier' 'Pier Solid'

Schematic elevation showing the locations at which the varying section definitions are based.

Other section properties, for solid diaphragm sections at the supports and at the ends of
the structure (shown on the image above), will also be defined and assigned as required.
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Description

When building a model like this the bridge can either be represented as a ‘flat model’
using lines at a common level with offsets being assigned to the elements to represent to
eccentricity of the section properties about the line, or geometry lines could follow the
centroid of the sections to create a ‘curved’ model. If post tensioning is to be carried out
the model should be based upon a ‘curved” model. Both methods are valid but for this
example the ‘flat model” method will be used.

1§ |

\m/

‘Flat’ modelling method
(where lines following the centroid of one section with other sections offset to align to match)

e

Indicative diagram showing ‘Curved’ modelling method
(where all lines follow the centroid of sections)

Modelling details

The supplied basic beam model is a ‘Flat’ model with clear spans of 39m, 78m and 39m
formed of single straight lines. During the initial part of the example multiple varying
section geometric line attributes are assigned to the single lines along with other section
properties and a simple linear analysis is carried out.

After creating the simple model a more detailed model is formed by splitting the lines
representing each span into shorter 3m long lengths in readiness for a future staged
construction analysis. In doing so 3 mesh divisions will be present on each 3m long
geometric line.

Caution.When modelling varying cross sections with constant section beam
elements, care should be taken to ensure that sufficient elements have been assigned to
the line(s) representing the tapering beam to achieve accuracy of results. If varying
section beam elements are used, only one element per line may be required.
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3-Span Concrete Box Beam Bridge of Varying Section

Modelling : Preliminary Model

| File

Open...

| File

Save As...

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Loading the model

To create the model, open the read-only file Concrete_Box_Bridge.mdl located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

The basic bridge geometry will be displayed.

The geometric lines of this model have been assigned a line mesh of thick beam
elements with an element length of 1m. Concrete (ungraded) material properties, and a
structural gravity load have also been assigned. Fixed supports restrain the piers and
roller supports restrain the ends of the deck.

e In the \<LUSAS Installation Folder>\Projects\ folder create a new directory
called ConcreteBoxBridge

e Save the model into this new folder as concrete_box_bridge_preliminary

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.
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| utilities

Modelling : Preliminary Model

Section Property
Calculator

| Box Section

Defining Cross-sectional properties

To start, cross-section properties for three voided box sections that are used in all three

spans will be defined.

To define the voided span section

e Select the Complex section
option and enter values as
shown on the dialog
opposite.

Box section dimensions are:

e H=22
e Wh=3
e Wt=3

e Hm =0 (or leave blank)
e Th=0.2
e Tt=0.2

Cantilever slab dimensions are:

e Wc=35
e Tcl=04
e Tc2=0.2

Box: Section Property Calculator

Type
’7(‘ Simple section

= Complex section

1
m
2
13
g
7
b
g
&

~Cal details
Humber of cells 1 =
E
© Box section dimensions
H 2.2 Hmo |0
Wh |3 b |u.z
Wt 3 Tt 0.z
) )
| Cantilever slab dimensions —————————| 0
W —— Wt —
we [35 Te1 [0
Exrapointslocations | | Caleulated properties |
1z oz Point | Oftset(D) | Height ] a feae
Fi 25 08
Inx [4.26726
[~ Number of extra points F‘f 12i355 g-;
- 4
Top slab 1 =l Ty [el.6z74
op=s = BT 5 ik
Bottom slab | 1 = ol 1.27 0z Iny [-1,13641E-15
- ] B8.81331
Cantlever siab 1 =
ieb interior Face o = sy |22
— asx [4.916
el exterior o =
vt |0.81026
Mame | Span Load section. .. | Creategeumetry‘..l vb |1.38974
@' add talocal ibrary
€ ek o server bbrary Visualie... | Clearinputs
ok | cancel | wppy | mep |

To allow additional points to be entered in addition to P1 and P2, that are used to define
the internal shape of the cross-section, the following need to be set in the Number of

extra points panel:
e Topslab=1
e Bottomslab=1

e Cantileverslab=1

Web interior face and web exterior face points are not required so are left set to zero.

e Enter the name as Span
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3-Span Concrete Box Beam Bridge of Varying Section

The complete set of values to be entered in the Extra points locations table are:

Point Offset (O) Height (H)
P1 2.5 0.4
P2 2.5 0.4
t1 1.65 0.2
bl 2.0 0.2
cl 1.27 0.2

e To see the section that will be
created by the values entered click
the Visualise button. Click Close

to return to the main dialog.

e Ensure Add to local library is

BZ

B1

selected and click Apply to
calculate the section properties,
add the section to the local library,
and allow you to continue to

define another section.

—*]f'—*@

B2 B4

Tip. Of the section properties calculated one, yt, (0.81026 for this section) should be
noted because it used in subsequent calculations of eccentricity / offset values for other

sections.

To define the voided intermediate section

¢ In the Box section dimensions panel change the value of H to be 3.2

e Change the name to be Intermediate and click Apply to calculate the section
properties, add the section to the local library, and allow you to continue to define

another section.

To define the voided section adjacent to the pier

¢ In the Box section dimensions panel change the value of H to be 5.2

e Change the name to be Pier and click Apply to calculate the section properties, add
the section to the local library, and allow you to continue to define another section.
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| utilities

Modelling : Preliminary Model

Section Property
Calculator

>

Rectangular

Sections > Solid

To define the solid pier section

e Inthe Type panel select Exclude void

e Change the name to be Pier Solid and click Apply to calculate the section
properties, add the section to the local library, and allow you to continue to define
another section.

Tip. The difference between the yt value of the Span section and the Pier Solid section
should be noted because this will be required later in the example to specify an
eccentricity / offset value for other sections. In this case the difference in values of yt is
2.4626 - 0.81026 = 1.65234

To define the solid span section

Existing defined sections such as that of the voided span section can be loaded into the
dialog for subsequent modification to create new or similar sections

e Click the Load section... button. Browse the sections in the local library to find the
Span entry and click OK to load its section details into the dialog.

¢ Inthe Type panel select Exclude void

¢ Change the name to be Span Solid ensure Add to local library is selected and click
OK to calculate the section properties, add the section to the local library, and finish
defining the deck sections.

Tip. The difference between the yt value of the Span section and the Span Solid
section should be noted because this will be required later in the example to specify an
eccentricity / offset value of one from the other. In this case the difference in values of
yt is 0.98225 - 0.81026 = 0.17199

To define the column section

° On the Rectangular Solld SeCtion Rectangular Solid Section Property Calculator
- _ i~ Dimensional data i~ Caleulated properties ——
I;rozperty dialog enter D=6 and 0o " T
= B |2 i ‘ e [0
A name of RSS D=6 B=2 will be -t-- 1D w [T
automatically created. l w [T
f—pB—l
- . J 126435
e Ensure Add to local library is .
- =y
selected and click OK to calculate
the section properties, add the | wam[Fso-ee-: e I
section to the local library, and T —
finish defining section properties. ® Aty

0K | cancel | ey | Hep |
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| Attributes

3-Span Concrete Box Beam Bridge of Varying Section

| Geometric

| Section Library...

>

All required section properties have now been defined and saved in the local user
library. The solid sections must now be added to the & Treeview in order to allow for
them to be assigned to the model. The voided span sections will be used to create
multiple varying section line attributes which will be automatically added to the &
Treeview when the attribute is created.

Adding the geometric properties for the solid sections to
the Treeview

The standard sections dialog will
appear.

For 3D Thick Beam use:

Click on the drop-down list button

ﬂ to change the selection from UK
Sections to User Sections

Ensure a Local
accessed.

library is being

Click on the drop-down list button

ﬂ and select Span Solid from the
list of local library items.

Change the name to be Span Solid

Click the Apply button to add the

Span Solid line attribute to the &
Treeview and allow you to choose
another section.

Click on the drop-down list button

Geometric Line ]

Usag
[30 Thick Beam = || [user Sections =l
Definition [Coca =l
" From Library

Roatation about centraid |0 <] ||[spanseld =l
© Enter Properti

nter Properties 100%

ﬁ

Value

Crozs sectional area (L)

15046

‘Second momert of ares ahout v axis (yy)

683077

‘Second momert of ares ahout 7 axis (1z2)

789895

Product momert of ares (Iyz)

-6 BS2EGE-15

Torsion constant (Jxx)

16 4268

Effective shear area iny direction (asy)

12846

Effective shear area in z direction (43z)

"o

Offsetin y direction (Ry)

oo

Offsetin z direction (Rz)

oo

Tapering »>

Visudise. |

G seviio, | | Plastic propeties.. |

Name ISpan Solid

= m

oK

Cancel | Apply I

Help |

ﬂ and select Pier solid from the list of local library items.

Change the name to be Pier Solid

Click the Apply button to add the Pier Solid line attribute to the & Treeview and

allow you to choose another section.
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| Attributes

Modelling : Preliminary Model

| Geometric

>

Multiple Varying
Section...

¢ Click on the drop-down list button ﬂ and select RSS D=6 B=2 from the list of local
library items

e Change the name to be Column

e Click the OK button to add the Column line attribute to the & Treeview.

Defining the multiple varying section line properties for
the Left Span

A multiple varying geometric line attribute needs to be defined for the left-hand span.
This will make use of the previously defined voided sections named Span, Intermediate
and Pier.

Define sections

e On the Multiple Varying Section dialog click in the Section cell that currently
reads 914x305x289kg UB and the launch dialog button 3 will appear to allow a
different pre-defined section to be chosen from a different section library.

e On the Enter Section dialog, click on the drop-down list button ﬂ to change the
selection from UK Sections to User Sections

e Ensure a Local library is being accessed.

e Click on the drop-down list button ﬂ and select Span from the list of local library
items and then click OK to add the section to the first row of the table on the
Multiple Varying Section dialog.

e On the Multiple Varying Section dialog press the TAB key to move between cells
and create a new row beneath the existing row. (Shape interpolation and distance
values will be entered after all sections have been added to the table)

e In the new Section cell (row 2) click on the launch dialog button 3 again. The
drop-down list should still be showing User Sections for a Local library. Browse
and select Intermediate from the drop-down list and click OK to add the section
to the table.

e Press the TAB key to move between cells and create a new row beneath the
existing row.

e In the new Section cell (row 3) click on the launch dialog button 3 again. The
drop-down list should still be showing User Sections for a Local library. Browse
and select Pier from the drop-down list and click OK to add the section to the
table.
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3-Span Concrete Box Beam Bridge of Varying Section

Note. As the multiple varying section is built-up in the table, a visualisation of the
longitudinal and vertical alignment and of the cross-section shapes used is displayed on
the dialog. Longitudinal section visualisation only takes place once all required data has
been entered and only for sections that are compatible.

Define shape interpolation method

To specify a shape interpolation method — FEESmEE
- - Usage Distance
for each defined section: T — (« e o e e sy

" Along reference path

¥ specify shape interpolation

e The Span section as the first in the W

Edit...
1 Section Shape Interpolation| Distance
table is set by default to Start 1 L -
2| ricmedte sxmhzd 245 Delete
e For the Intermediate section entry [ At & =
click on the drop-down list button _
- . . — ,m Align all sections to section |_1j
in the Shape Interpolation cell borental [come e ]| ntrplaton o proortie [Faned

and select Smoothed

e Repeat for the Pier section in the
cell below selecting Smoothed %

Define distance values C

Lastly we need to specify a distance E=En
value at which each section will apply.

wame [P span )

e For the Span section click in the
Distance cell and enter 0.5 = =l e

e For the Intermediate section enter 24.5

e For the Pier section enter 39.5 and click somewhere else on the dialog to cause the
visualisation to be updated for the last entered distance.

Note. Values entered are treated as proportional distances along a line (for example
entering 0, 10 and 20 would specify a section at either end and at a mid-point of any
line that was selected and assigned the geometric line attribute). Distances are also
mapped to the actual line length so entering 0, 0.5, and 1, in three separate cells would
produce the same result. But note that a section does not necessarily have to be defined
to start at a distance of 0, (as in this example). In this case the use of a non-zero starting
point of 0.5 (a chainage value representing the actual setting-out point of the section on
the model) as well using a corresponding intermediate and an end point appropriate to
the line beam length will help to ensure an easy conversion to a staged construction
model in the second part of this example. This will use the same chainage values in
conjunction with the reference path facility.
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Modelling : Preliminary Model

Check alignment settings

The vertical and horizontal alignment of a series of sections is controlled by the
Alignment options. All sections are aligned with respect to a chosen section.

e Ensure the alignment is Top to top, Centre to centre and with respect to section 1

Name the attribute

o Enter a name of Left Span and click Apply to add the multiple varying section line
attribute to the &% Treeview and allow you to continue to define another one.

Defining the multiple varying section line properties for
the Right Span
This can be done by reversing the order of the sections used for the left span and then

changing the distance values. This time, to prevent inadvertent overwriting of
previously defined line attributes, we will name the attribute first.

Name the attribute

- - . - SEQE\ eam - ?:::\:d to fit each line individuall
e With the Multiple Varying Section %‘j (rmgmmm
dialog for the Left Span currently I~ e secton )
displayed overtype the Left Span Secton Lﬂm*‘m“‘ B —Im;t
. . 1| Pier Start 1235
name with Right Span Blrerci: o 15 beete
Flip
Define sections _ _
Vertical lm Align all sections to section

e Click the Flip button to change the e [ El o S
order of the sections listed. o

1

Check Shape Interpolation type

e The Pier section should be set to :
Start D L =

Section 1-1 Section 2.2 Section 3-3

e The Intermediate section should be
set to Smoothed

Hame [Right Span =] eew

e The Span section should be set to
Smoothed o | el | aoot | neb |

Define Distance values

e For the Pier section click in the Distance cell and enter 123.5
e For the Intermediate section enter 138.5

e Repeat for the Pier section enter 162.5
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3-Span Concrete Box Beam Bridge of Varying Section

Check alignment

e Ensure that all sections are aligned Top to top, Centre to centre and with respect
to section 3 (because this is now the number identifier for the Span section)

Save the changes

e Click Apply to add the multiple varying section line attribute to the & Treeview,
and allow you to continue to define another one.

Defining the multiple varying section line properties for
the Centre Span

This can be done by using the symmetric option to mirror the sections used for the
Right Span and then changing the distance values.

Name the attribute

& Sealed o fit sach fine indivickally

3D Thick Beam 2

e With the Multiple Varying Section dialog
displayed for the Right Span overtype the
Right Span name with Centre Span

Define sections
vetied [fopoop 7]

e Click the Symmetric option to mirror the = e 3

sections listed.

Check Shape Interpolation type

e The Pier section should be set to Start

e The Intermediate section should be set to
Smoothed

e The Span section should be set to Smoothed

Define Distance values

Specify a distance value at which each section will apply:

e For the Pier section click in the Distance cell and enter 42.5
e For the Intermediate section enter 57.5

e Repeat for the Span section enter 81.5

e Click somewhere else on the dialog to cause the visualisation to be updated for the
last entered distance.
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Modelling : Preliminary Model

Check alignment

o Ensure that all sections are aligned Top to top, Centre to centre and with respect
to section 3 (the number identifier for the main setting-out section)

Save the changes

e Click OK to add the multiple varying section line attribute to the &b Treeview and
stop defining any more.

Note. Where all sections have been defined using either a LUSAS supplied standard
library item, or one of the LUSAS standard section generators, an ‘exact’ calculation is
made to arrive at intermediate section properties based upon the user-defined shape
interpolation method.

Assigning the varying geometric line properties
e First, select the 39m long line representing the left-hand clear span of the bridge

and drag and drop the Left Span (Varying — 3 Sections) geometric line attribute
from the &% Treeview onto it.

e Next, select the 39m long line representing the right-hand clear span of the bridge
and drag and drop the Right Span (Varying — 3 Sections) geometric line attribute
onto it.

e Lastly, Select the 78m long line representing the centre clear span of the bridge and
drag and drop the Centre Span (Varying — 5 Sections) geometric line attribute
onto it.

After assignment (and with fleshing turned on) the model will look like this:
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Right Span

N

Centre Span

N

Left Span

N

Assigning the solid geometric deck properties

The solid sections at the ends of the deck and at column locations now need to be
assigned to the model.

TN Select the Y axis button to view the side elevation of the model.

——————n

Drag a box around

Drag a box around
this line

this line

e Box-select the lines at either end of the bridge defining the solid section and drag

and drop the Span Solid (Span Solid major Z) geometric line attribute onto the
selection. This assignment will be adjusted shortly

———————

——————n

Drag a box around
this line

Drag a box around
this line
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Modelling : Preliminary Model

e Box-select the 2 lines at both internal supports defining the solid section of the
deck and drag and drop the Pier Solid (Pier Solid major Z) geometric line
attribute onto the selection. This assignment will be adjusted shortly.

Adjusting the centroid offsets for solid sections

In assigning the geometric line attributes for the solid sections of the deck it can be seen
that differences in centroid values in the y direction cause the solid sections to sit too
high with respect to the varying sections (which were all set-out with a vertical
alignment with respect to the centroid of the section named Span that sits at the left-
hand end of the structure). As a result the offset values for these solid sections need
amending.

e Inthe & Treeview, double-click the Span Solid (Span solid major y) entry. Enter
a value of 0.17199 for the Offset in z direction (ez). This was calculated and noted
with a Tip marker earlier in the example. Click Apply to make the change.

e On the Geometric Line dialog click the ‘spinner’ at the bottom of the dialog until the

Fopier Solid entry appears. For this entry, enter a value of 1.65234 for the Offset in
z direction (ez). This value was calculated and noted with a Tip marker earlier in the
example. Click Close to make the change and close the dialog.

Assigning the main column properties

I

% Select the 2 lines

representing the piers

e Select the lines representing the columns (piers) and drag and drop the Column
(RSS D=6 B=2 major y) geometric line attribute onto the selection.

e Rotate the model to a suitable 3D view
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| File

Save

3-Span Concrete Box Beam Bridge of Varying Section

El Save the model file.

The preliminary model is now complete and ready to be solved.

Running the Analysis : Preliminary Model

A

;l On the Solve Now dialog ensure Analysis 1 is checked and press OK to run the
analysis.

Note. Normally a general warning relating to the use of sufficient constant beam
elements will be displayed whenever a model containing multiple varying geometric
line attributes is solved. However, for this example, it has been turned off.

If the analysis is successful...
Analysis loadcase results are added to the (5 Treeviewt =,

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U concrete_box_bridge_preliminary.out this output file contains
details of model data, assigned attributes and selected analysis statistics.

U concrete_box_bridge_preliminary.mys this is the LUSAS results

file which is loaded automatically into the (5 Treeview to allow results to be
viewed.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered is written
to the output files in addition to the text output window. Any errors listed in the text
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Viewing the Results : Preliminary Model

output window should be corrected in LUSAS Modeller before saving the model and
re-running the analysis.

Viewing the

Results : Preliminary Model

Analysis loadcase results are present in the (5 Treeviewi™.

Add a contour layer

With no features selected click the right-hand mouse button in a blank part of the

Graphics window and select the Contours option to add the contour layer to the
Treeview.

From the drop down menu in the dialog, pick Stress — Thick 3D Beam from the
entity drop down list and pick Sx(Fx,My,Mz) from the component drop down list.

Click OK to display stress contours on the fleshed shape.

Add a diagrams layer

With no features selected click the right-hand mouse button in a blank part of the
Graphics window and select the Diagrams option to add the diagrams layer to the
Treeview.

From the drop down menu in the dialog, pick Force/Moment — Thick 3D Beam
from the entity drop down list and My from the component drop down list.

Select the Diagram Display tab and deselect Label values. Select the Scale tab and
enter a magnitude of 18. Click OK to display a bending moment diagram on the
fleshed shape.

BoX_briage_preuminary-Anaysis 1.mys

D Beam
Fx, My, M2) (Units: kNim?)

This completes the preliminary part of the example.
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Modelling : Detailed Model

| File

| Save As...

| File

| Model Properties. ..

| utilities

| Reference Path

The preliminary model has clear spans of 39m, 78m and 39m formed of single lines. A
more detailed model is to be formed by splitting the lines representing each span into
shorter 3m long lengths in readiness for a future staged construction analysis. To allow
this to happen a reference path is created and the multiple varying section geometric
line attributes are updated to make use of the reference path that is defined prior to the
lines representing the spans being split into the smaller number of line divisions. No re-
assignment of geometric properties need be made to the lines created by splitting the
existing lines. The multiple varying section geometric line attributes will automatically
be applied to the lines using the reference path facility.

e Confirm that all results files will be closed, and the enter the model file name as
concrete_box_bridge_detailed and click the Save button.

Changing the model description

e Change the model title to Concrete Box Beam Bridge Detailed Model and click
OK

Creating a reference path

A reference path defines a route through a model that provides a concept of distance to
each point in the model. Those distances can be used in the definition of a varying
section, such that when the section is assigned to lines, the path is used to interpret
which part of the section is appropriate to each line. Bridge engineers refer to this
reference path concept as chainage.

For this example and for clarity a reference path will be defined above the model using
the path definition dialog.

e Enter coordinates of (0, 0, 10) in the first row of the table. Press the TAB key and
enter coordinates of (163,0,10) in the second row, ensuring the Type remains
Straight, as default.

e Accept all the default values and click OK to define a reference path above and of
the same overall length as lines defining the deck in the model. A corresponding

path definition entry will be created in the & Treeview.
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Modelling : Detailed Model

Note. In its simplest form a reference path can be defined as a line between two points
(quite separate from the model data, as in this case) if a straight path is to be
considered, or be created from the model geometry itself and contain as many defining
points as the lines from which it has been created (by using the Utilities > Reference
Path menu item) in which case the coordinates of all lines selected would be listed in
the Path Definition table. If the latter is done it is important to remember that whilst the
model geometry has been used to arrive at the points required to generate a reference
path, no connection between the model geometry and reference path data exists.

Editing multiple varying section geometric properties

To make use of the reference path all multiple varying section geometric line attributes
need to be edited to refer to it.

o In the &b Treeview, double-click the Left )
Span (Varying - 3 Sections) entry. -

IV Specify shape interpolation
™ Symmetic section

e On the Multiple Varying Section dialog -
change the Distance Interpretation setting to i
Along reference path and ensure that Pathl
is selected. Click OK to update.

e Repeat the above procedure for the Right

Span (Varying - 3 Sections) entry in the &
Treeview.

e Repeat the above procedure for the Centre

Span (Varying - 5 Sections) entry in the &
Treeview.
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Split the lines representing the clear spans

The single lines representing each clear span are to be split into 3m lengths to represent
each proposed construction stage.

e Select the two 39m long lines representing the left and right clear spans of the
bridge

Select this line

Select this line

| Geometry e Select Use same divisions for all lines and enter 13 for the number of divisions.
Line > Ensure that Delete original geometry after splitting is selected and press OK.
By Splitting >
In Equal
Divisions

o Lastly, select the 78m long line representing the centre span of the bridge

Select this line

Enter 26 for the number of divisions and ensure that Delete original lines after

| Geometry .
Line > splitting is selected.
By Splitting >
In Equal
Divisions
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| File

Running the Analysis : Detailed Model

Save

Splitting the lines in this way produces the following model which is now ready for
further manipulation (not covered in this example) to allow a staged construction
analysis to be carried out.

El Save the model file.

The detailed model is now complete and ready to be solved.

Running the Analysis : Detailed Model

A

;l Open the Solve Now dialog. Ensure Analysis 1 is checked and press OK to run
the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (2 TreeviewsS.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U concrete_box_bridge_detailed.out this output file contains details of
model data, assigned attributes and selected analysis statistics.

U concrete_box_bridge_detailed.mys this is the LUSAS results file

which is loaded automatically into the (5 Treeview to allow results to be
viewed.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered is written
to a output files in addition to the text output window. Any errors listed in the text
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output window should be corrected in LUSAS Modeller before saving the model and
re-running the analysis.

Viewing the Results : Detailed Model

(E\hen the detailed model has been built immediately after creating and viewing
results for the preliminary model the Contour and Diagrams layers will already be
present in the Treeview and the stress contours and diagram plot will be as shown
below.

0 1
ete_box_bridge_detailed-Analysis 1.mys

Stress - Thick 3D Beam
Component: Sx(Fx, My, Mz) (Units: KN/m?)

27366563 s
B seevzes o

. 13683263

B 2 73665€3

The results obtained can be seen to be identical to those obtained from the simple
preliminary model.

This completes the detailed modelling part of the example.
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Description

Segmental
Construction of a
Post Tensioned
Bridge

For software product(s): | LUSAS Civil & Structural Plus and LUSAS Bridge Plus
With product option(s): | Nonlinear

Description

The construction of a balanced cantilever segmentally constructed bridge is to be
modelled using a beam analysis.
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Segmental Construction of a Post Tensioned Bridge

A complete analysis of a balanced cantilever segmentally constructed bridge is a
complex and large analysis to undertake. In this example the geometry has been
simplified to concentrate on the definition of the staged construction process and to
illustrate the definition and assignment of tendon properties.

An internal span of the bridge is modelled with segments being placed from adjacent
piers with a final closing segment to join the two constructions together as shown on the
next diagram.

i

e — I.. J|

7 N B \
A N
- T T [ —
T~ —\
A A

Each stage of the construction analysis considers a 6m long section being added to the
construction. These are: Stage 1 (top-left), Stage 2 (top-right), Stage 3 and Stage 4
(middle) and Stage 5 (bottom)

Units used are kN, m, t, s, C throughout.

The example incorporates staged construction and the assignment of multiple tendon
prestress loading.

Objectives
The output requirements of the analysis are:

U Maximum moments during construction
Keywords
Staged Construction, Multiple Tendon Prestress Wizard
Associated Files

U segmental_bridge_modelling.vbs carries out the modelling of the
structure up to the section titled Prestess Loading where tendon properties are
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| Geometry >
| Line >

Coordinates. ..

| Geometry
| Line
Copy...

Description

defined. Modelling. After running the script continue from that point in the
example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

o Enter the file name as Segmental Bridge

e Use the Default working folder.

o Enter the title as Segmental bridge including prestress and creep
e Select model units of kN, m, t, s, C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Ensure the startup template None is selected.

e Ensure the Vertical Y Axis option is selected and click OK.

Defining the Geometry

il Enter coordinates of (0, 0, 0), and (6, 0, 0), to define the first segment of the bridge
and click OK

e Select the line just drawn.

Sarm

LI Enter a translation in the X direction of 6

e  Enter the number of copies required as 4 and click OK
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—pe

¥
¥

Defining and Assigning Mesh Attributes

| Attributes e The bridge is to be modelled with Thick
Mesh > nonlinear beam elements (BTS3 -
tructural
[Line... elements)
& Element description ™ Use default spacing
. - Stiuctural element bype:
e Ensure that 3 dimensional elements of oo o e [ FPPRPRS
1 1 1 Mumber of dimensions
Linear interpolation order are selected. — _ C—
Interpolation order
e Enter 6 for the number of mesh divisions. Liar | SR
. . " Element name " Element length
e Enter the attribute name as Thick . P
Nonlinear Beam and click OK —
e Selectall Iin_es on the_ model and drag and N [Tk it =fw
drop the Thick Nonlinear Beam mesh
from the &% Treeview onto the selected o e o | e |
features.

e Click OK to accept default element orientation.

Note. Forces and moments for a thick nonlinear beam element are constant along each

element’s length. As a result, sufficient elements should be used to get the desired
accuracy. In this example 6 mesh divisions have been chosen for simplicity, more may
be needed in real-life modelling situations.
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| Attributes
| Geometric >
Line...

| Attributes

Material >
Material Library...

| Attributes

Support...

Description

Defining and Assigning Geometric Properties

The bridge is formed from box sections of a
constant width and depth. Five construction
stages are to be modelled. Each of the stages B

rom Library
Rotation about centroid [0 | =

uses the same section properties. o

In this example the geometric properties have
already been calculated and will be defined
manually and then assigned to the model.

e With the 3D Thick Beam option selected
enter the box section properties in the Vales
column as follows:

A =5.36886,

lyy = 17.4844, 1zz = 4.63749, lyz = 0.0,
JIxx = 7.98955,

Asy = 2.55135, Asz = 3.87119,
ey=0.0andez=0.0

e Enter the attribute name as Box Section and click OK.

o Select all the lines on the model (hold down Ctrl + A keys) and drag and drop the
Box Section geometry material from the & Treeview onto the selected features

Note. No cross-sectional details or fibre locations have been defined so no fleshing
of the section or pltting of results at fibre locations will be possible.

Defining the Material

e Select material Concrete of grade Ungraded from the drop down lists, and click
OK to add the material attribute to the &b Treeview.

e Select all lines on the model and drag and drop the Isol (Concrete Ungraded)
material from the &% Treeview onto the selected features.

Note. For this example an allowable tensile stress of 4 N/mm? and an allowable
compressive stress of 20 N/mm? will be considered for the concrete section.

Supports

e A fully fixed support is required so all translations in the X, Y and Z and rotation
about the X, Y and Z axes must be Fixed. Enter a attribute name of Fully Fixed
and click OK
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| Bridge
|Bridge Loading >
| Gravity
| Attributes
| Birth and Death. .

Segmental Construction of a Post Tensioned Bridge

e Select the points at both ends of the bridge model and, from the & Treeview, drag
and drop the support attribute Fully Fixed onto the selected features, ensure the All
analysis loadcases option is selected and click OK

Loading

As well as the self-weight of the structure the effects of the prestress force will also be
considered in this analysis. Firstly, the self-weight will be defined.

A loading attribute named BFP1 (Gravity —ve Y) will be created in the &b Treeview.

Note. If using the Civil version a gravity load may be defined from the Attributes>
Loading> Body Force menu by specifying —9.81 as Linear acceleration in the Y
direction.

Self-weight loading is not to be applied yet. It will be applied during the definition of
the staged construction process.

Creating Activation and Deactivation Datasets

In order to carry out a staged construction analysis the birth and death facility is used.

e Select the Activate option and click Next

o Enter the attribute name as Activate and click Apply

e Click Back so the deactivate attribute can be defined.

e Select the Deactivate option and click Next

e Select Percentage to redistribute and ensure the value is 100%. Enter the attribute
name as Deactivate and click Finish

Modelling of Construction Stage 1

o In the ‘& Treeview expand Analysis 1 then rename Loadcase 1 to be Stage 1 by
selecting Loadcase 1 with the right-hand mouse button and using the Rename
option.

All elements in the model not required for the first stage analysis need to be de-
activated.

e In the graphics window select the three lines defining the segments that are not
required in stage 1.
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~$)

o From the ¢ Treeview and with the three segments selected, assign the deactivation
attribute Deactivate ensuring that it is assigned to loadcase Stage 1 and click OK

Assigning Loading

¢ Now select the two lines representing the active segments at either end. Assign the
BFP1 (Gravity —ve Y) loading to Stage 1 and click OK

Defining Loadcase Properties

o In the & Treeview select Stage 1 using the right-hand mouse button and select
Nonlinear and Transient from the Controls menu.

e On the Nonlinear & Transient dialog select the Nonlinear option in the top-left
hand corner, leave the incrementation type as Manual and click OK to accept all
default entries.

Construction Stages 2 to 3

Stages 2 and 3 require loadcases to be generated to specify the duration of the
construction process. Lines on the model must be selected according to the construction
stage being considered and activation attributes must be assigned to these lines.

Stage 2

The elements in the second construction stage must now be activated

e In the graphics window select the segments to be added in Stage 2 of the
construction sequence.

Fal=s
e

~H
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Segmental Construction of a Post Tensioned Bridge

e Assign the activation attribute Activate from the & Treeview. Enter Stage 2 in the
loadcase combo box and ensure that Set as the active loadcase is checked. Click
OK to finish activation of the selected sections.

Assigning Loading

e Now select all the activated segments (i.e. the lines representing the segments from
Stage 1 as well as the lines representing the segments from Stage 2) and assign the
BFP1 (Gravity —ve Y) loading to these lines ensuring the loadcase is set to Stage 2.
Click OK to complete the loading assignment.

Note. As the Stage 1 loadcase has been set as nonlinear with manual control the
subsequent loadcase controls do not need to be defined as they will take the properties
defined in loadcase 1.

Note. If you need to verify loading assignments such as self-weight or to check when
particular lines (and hence elements) become active in an analysis select a line on the
model and then, using the right-hand mouse button, select Properties. Select the
Activate Elements tab. Selecting the Activate entry in the right-hand table of Assigned
properties will show the loadcase to which the activation is assigned.

Stage 3

The elements in the third construction stage now need to be activated.

™
T *

. AN
P

¢ In the graphics window select the segment to be added in Stage 3 of the construction
sequence.

e With the middle segment selected, assign the activation attribute Activate from the
& Treeview. Enter Stage 3 in the loadcase combo box and ensure the Set as the
active loadcase is checked. Click OK to finish the activation of the selected
section.

Assigning Loading

e Now select all of the activated segments (i.e. all lines in the model) and assign the
BFP1 (Gravity —ve Y) loading ensuring the loadcase is set to Stage 3. Click OK to
complete the loading assignment.
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Note. The active elements at each stage can be visualised by removing the Geometry
layer, selecting the Show activated only option on the mesh properties dialog and then
activating each loadcase in turn.

This completes the definition of the model geometry and the staged construction
process.

If rebuilding a model, or creating a model using the
supplied file.

If a previous analysis of this example has failed you need to return to this point to
continue after having run the supplied file stated.

If you created the model using the supplied associated file you need to continue from
this point to complete the modelling required.

Prestress Loading

The calculation and assignment of the equivalent prestress force to the loadcases
already created is carried out by using the multiple tendon prestress wizard. It requires
the following to be defined:

1. Design code and elastic shortening criteria
2. Tendon profiles

3.  Tendon properties

4.  Tendon loadings

5.  Tendon loading assignments

Once entered, and once the multiple tendon prestress wizard has been run, values for
each of these entries are retained and can be viewed and subsequently modified by re-
running the wizard. Previously calculated equivalent loadings are automatically re-
calculated.
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Segmental Construction of a Post Tensioned Bridge

| Prestress Wizard >
| Multiple Tendon...

Using the Multiple Tendon Prestress Wizard

Lines on the model will be selected during the use of the wizard, so:

o Ensure that the Geometry layer is present in the 55" Treeview.

e Ensure that the BS5400-4:1990
design code is selected from the
drop down list.

e Ensure that the User-defined
option for elastic shortening is
selected and then click Set
losses... to proceed to the
Elastic Shortening — Incremental
dialog.

Multiple Tendon Prestre:

55 Wizard

Design cade BS5400 B

Elastic shartening

" Brased on design cade Setiosses

= User-defined Set lasses ¥

 Ignore effect X
= Besetiprevious presiess ot
I=| Berformiclssh chisck

Profile sampling.

ciok | Mews | Cancel

| e |

o Enter the losses as 100, 95 and 90 percent.
(Use the Tab key to create each new line. )

e Click OK to return to the first dialog.

e Click Next to proceed to the Tendon Profile

dialog.

Defining the Tendon Profiles

Elastic Shortening - Incremental

Percentage of applied load remaining after
attaching subsequent tendons

Load (%o}

After 1st stressing of segment

100

After 2nd stressing of segment

95

After subzequent stressing of segment

a0

oK I Cancel

Help

Any number of tendon profiles can be defined on the tendon profile page prior to
moving on to the next page of the Multiple Tendon Wizard. By entering a name the
Create button becomes active and tendon details can be defined. Entering another name
stores the previously defined profile and enables another set of data to be entered, and

SO on.
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Description

Tendon Profile [ x|

¥ = distance along assigned line(s)
y = distance along y axis of assigned element at x
z = distance along z axis of assigned element at x

3d space |Two 2d planes |

0.5
Type x (m}) y (m) z (m)
1 [Stat 0.0 10 0.0 0.3
2 Straight 6.0 1.0 0.0 01
z
-0.1
-0.3
-0.5
01 2 3 4 5 8 7
x
1.5
1.3
1.1
"~ Global coordinates ¥ 0.9
¥ Local coordinates mapped to lines Insert | Delete | 07
~I smoothing 0.5
- ; . o 1 2 3 4 5 & T
Wlimirnurn radios % Ut corner /“__"“\ ®
I 0.0 ) Offset line meeT e
Reverse | Flip |
Mame IShnrttendu:un profile j ﬂ (1of 1) Create | Rename | Delete |

< Back I Mext = I Cancel | Help |

e Enter the attribute name as Short Tendon Profile and click the Create button.
e Ensure the option Local coordinates mapped to lines is selected

e Enter the tendon profile into the grid as

Type X (m) Y (m) Z (m)
Start 0 1 0
Straight 6 1 0

This completes the short tendon profile definition.

e Now, to start entering another tendon profile, enter the name as Long Tendon
Profile and click the Create button. In doing so, this stores the previous short
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tendon profile values and clears the grid for the long tendon profile values to be
entered.

o Enter the tendon profile into the grid as follows:

Type X (m) Y (m) Z (m)
Start 0 1 0
Straight 12 1 0

This completes the long tendon profile definition.
e Lastly, enter the attribute name as Full Tendon Profile and click the Create button.

o Enter the tendon profile into the X, Y, Z part of the grid as follows:

Type X (m) Y (m) Z(m)
Start 0 1 0
Parabola Bulge 15 -1 0
Parabola End 30 1 0

e Change the Type settings from Straight to be as shown by clicking inside the cell
and selecting Parabola Bulge for the second row and Parabola End for the last
row.

This completes the long tendon profile definition
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Tendon Profile [ x|

¥ = distance along assigned line(s)
y = distance along y axis of assigned element at x
z = distance along z axis of assigned element at x

3d space |Two 2d planes |

0.5
Type x (m}) y (m) z (m)
Start 0.0 10 0.0 0.3
23 |Parabola Bulge 15.0 -1.0 0.0 01
2b  |Parabola End 30.0 1.0 0.0 z
-0.1
-0.3
05
0 5 10 15 20 25 30
X
0.9
0.4
" Global coordinates ¥ -0
¥ Local coordinates mapped to lines Insert | Delete | 08
~I smoothing 1.1
- , 0 © 10 15 20 28 30
Wlimirnurn radios % Ut corner /“__"“\ ®
I 0.0 ) Offset line S
Reverse | Flip |
Name | Full Tendon Profil - i’ (3of3) Crecie | Rename | Delete |

< Back I Mext = I Cancel | Help |

Note. Tendon profile definitions can be reviewed before proceeding further by
/ clicking the up and down buttons adjacent to the tendon profile name.

e Click Next to proceed to the Tendon Properties dialog.

Defining the Tendon Properties

The Multi-strand prestressing system being considered here consists of 12, 15mm
diameter strands that give a nominal area of 1800mm*
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e  Enter the attribute name as B 5t 40liehdon Biopertics
Strand Properties and click P
the Create button

todulus of elasticity |200EE kN /m#

i~ Short term losses

Fielaxation loss IZ 5 %

Shrinkage coeff. |0.2E-3

e Enter the tendon area as 1800

Tendon area 1.6E3 e
m

e Enter duct friction coeff. as

Creep coeff ID O36E-6 ey
“obhle factor 5383 4
0.2

Duct friction coeff.  |0.2 Stress at tratsfier |15E3 ke

e Select Long term losses

Defaults
Any number of tendon properties
could be defined on this page prior ez =] e oo | Renane] Do |
to moving on to the next page of
the Multiple Tendon Wizard, but <Bock [ Wewr | Comel | Hep |

for this example just the one
tendon property will be defined.

e  Accept the defaults for the remaining properties by clicking the Next button.

Defining the Tendon Loading

This page allows a tendon load to be associated with previously entered profiles and
properties.

For tendon 1:

e Enter the attribute name LEIZIEEEE E
as Tendon 1 and click Jacking delai
the Create button. ¥ End1 I End2

Angle IU * IU-D

e Enter the prestress force Prestiess faree [2£3 kn
as 2E3 Sl [2E I m

e Ensure that jacking from
End 1 Only |S Selected Frnh\eISholtTendonProhIa j ﬁ

and enter the slip as 2E-
3 Property ISlrand Fropertiez j jl

* E Siur?sthi;roT(l)e C&T Obrot Attribute: [Terdon 1 -] H o ﬂl ml %
tendon profile and the
property combo box is <Back [ Mews | cancel | Hep |
set to Strand Properties

This completes the tendon loading for tendon 1.
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For tendon 2:

e Enter the attribute name as Tendon 2 and click the Create button. In doing so, this
stores the previous tendon loading values and clears the dialog for the next tendon
to be defined.

e  Enter the prestress force as 2E3
e  Ensure that jacking from End 2 only is selected and enter the slip as 2E-3

e Ensure the profile combo box is set to Short tendon profile and the property
combo box is set to Strand Properties

This completes the tendon loading for tendon 2.
For tendon 3:

Enter the attribute name as Tendon 3 and click the Create button.

Enter the prestress force as 2E3

Ensure that the jacking from End 1 only is selected and enter the slip as 2E-3

Change the profile combo box so that Long tendon profile is displayed and the
property combo box so that Strand Properties is displayed.

This completes the tendon loading for tendon 3.

For tendon 4:

o Enter the attribute name as Tendon 4 and click the Create button.

e Enter the prestress force as 2E3

e Ensure that the jacking from End 2 only is selected and enter the slip as 2E-3

e Change the profile combo box so that Long tendon profile is displayed and ensure
the property combo box is set to Strand Properties

This completes the tendon loading for tendon 4.

For tendon 5:

e Enter the attribute name as Tendon 5 and click the Create button.
e Enter the prestress force as 4E3

e Ensure that the jacking from End 1 and End 2 is selected and enter the slip as 4E-3
at each end.
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e Change the profile combo box so that Full tendon profile is displayed and ensure
the property combo box is set to Strand Properties

This completes the tendon loading for tendon 5.

Note. Tendon loading assignments can be reviewed and corrected if necessary before
proceeding further by clicking the up and down buttons adjacent to the tendon profile
name.

e Click Next to proceed to the Tendon Loading Assignment dialog.

Defining the Tendon Loading Assignment(s)

The page of the wizard is used to

assign the tendon loads that have O || Cr—
been defined in the previous dialog to [(cmim==m | o -
selected lines on the model. e
* Offsetfromend 1 |0.0 m

e Click the New button and the = crem=

Assignment will change to 1 Gt
e Drag the dialog so that the

analysis model can be clearly

i i i =
seen in the graphics window e

Assignment | 1 hd j(lnf 1) New Delete.
<tk [ Fnsh | cencd | Hep |
e Select the line tendon 1 acts on.
- T T I
| |
| |
| Foal ol . . . A
| ‘““ | ’ iy * "% !

e On the Tendon Loading Assignment dialog click the Copy from selection button

and the selected line number will be entered in the text box.

Ensure the tendon combo box has Tendon 1 displayed.
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e In the loadcases section of the dialog, ensure Stage 1, Stage 2 and Stage 3 are
selected.

e Ensure Generate graph datasets is selected.

This completes the tendon assignment for line 1.

Note. Clicking a higher loadcase will select or deselect loadcases beneath it.
o Click the New button and the Assignment will change to 2.

e Select the line tendon 2 acts on.

e Click the Copy from selection button and the selected line number will be entered
in the text box.

e Change the tendon combo box so that Tendon 2 is displayed.

¢ In the loadcases section of the dialog, ensure Stage 1, Stage 2 and Stage 3 are
selected

e  Click the New button and the Assignment will change to 3.

e Select the two lines tendon 3 acts on.

i)

e Click the Copy from selection button and the selected line numbers will be
entered in the text box.

e Change the tendon combo box so that Tendon 3 is displayed.

¢ Inthe loadcases section of the dialog, ensure Stage 2 and Stage 3 only are selected
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e Click New and the Assignment will change to 4.

e Select the two lines tendon 4 acts on.

e Click the Copy from selection button and the selected line numbers will be
displayed in the text box.

e Change the tendon combo box so that Tendon 4 is displayed.

¢ Inthe loadcases section of the dialog, ensure Stage 2 and Stage 3 only are selected
e Click New and the Assignment will change to 5.

e Select the lines tendon 5 acts on. (All the lines in the model.)

e Click the Copy from selection button and the selected line numbers will be
displayed in the text box.

e Change the tendon combo box so that Tendon 5 is displayed.

¢ Inthe loadcases section of the dialog, ensure that the check box for Stage 3 only is
selected.

e Ensure that the compute loading and generate graph datasets and generate

report options are selected. Graph datasets will be created in the < Treeview for
graphing if required. A report will be generated in the directory that you are
currently working in but this can be changed if required.

e Select the Finish button to complete the wizard and press Yes to confirm that your
model is to be saved prior to calculating and generating the equivalent prestress
loading.

On completion, an HTML report will be opened automatically in the default web
browser. This report is also saved into the specified folder. The report is a complete
summary of the tendon profile, properties and loading assignments made.

On closing the report the tendon loading assignments on the model can be seen for
Stage 1. By changing the active loadcase the assignments can be seen for the other
construction stages also.
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Note. Tendon profile visualisations and the display of start and finish coordinates can
be controlled by accessing the Utilities layer Properties dialog and on the Tendon
Profile tab pressing the Settings button to change the visualisation setting to Show
definition coordinates. Visualisations will then be identified by their start and finish
identifiers (1 or 2) and by the coordinates of these points. Because all tendons are active
in loadcase 3 the visualisations will overlap.

£.000,1.0,00) 2,(6.0,1.0,0.0) 2,(12.0,1.0,00) 1,(180,1.0,0.0) 1,(24.0,1.0,0.0) 2,(300,10,00)

F?—rrm\l' fg R e T M S T S S B L r#
Notes on Prestress Wizard-created data
In using the Prestress Wizard, prestress —E-C3 Loading (8)
loading is added to the analysis model as =43 Discretz ()
equivalent discrete point loading. Attributes B33 Point (5)

.. . . =423 Tendon Force (S)
containing this data can be seen in the & & 2:Assigrment 1 Tendan 1
Treeview in the Tendon force folder. &, 3ihssignment 2 Tendan 2

%, 41Assignment 3 Tendon 3
Search areas are created and used & SiAssignment 4 Tendon 4
automatically by the prestress wizard to - Bifssignment 5 Tendan 5
define the target geometry (in this case, the =423 Struetural (1)
lines) to be loaded. These can be seen in the - b LBFPL (Gravity ve V)
& T K Ela Activate Flements (1)
reeview. e Liactivate
. =143 Deactivate Elements (1)

Load factors are used to represent elastic | & i.peactivate
shortening and these can be seen for each =3 Search area (5)
stage in the /=) Treeview. =43 Tendon force ()

1:Assignment 1 Tendon 1
Graphing datasets (which allow of graphing &b 2thssignment: 2 Tendan 2

oo 3rhssignment 3 Tendon 3
of prestress losses etc) are added to the ﬁ 4:Assignment 4 Tendon 4

Treeview. i, S:Assignment 5 Tendon 5

Notes on editing Prestress Wizard-created data

If any tendon assignments are incorrect, the Multiple tendon prestress wizard must be
re-run (previously entered values will be retained) and the Next button can be clicked to
get to the tendon loading assignment page. Incorrect assignments can be deleted or
simply corrected as required before clicking the Finish button to recalculate the
equivalent tendon loading on the model.

Tendon profile data defined within the Prestress Wizard is also stored in the e
Treeview.

383



| File
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| Save

e Editing of tendon profile data in the & Treeview (that is, outside of the
wizard) is permitted but all attributes that require re-calculating by re-running

the prestress wizard will be marked with the A symbol. Re-running the
prestress wizard will update all values accordingly.

e Editing of any attribute data calculated and generated by the prestress wizard
is not permitted.

Save the model

El Saving the model file also saves all the multiple tendon prestress input. This allows
the prestress definition and assignment data to be modified by re-entering the multiple
tendon prestress wizard.

Running the Analysis

A

With the model loaded:

El Open the Solve now dialog. Ensure Analysis 1 is selected and press OK to run the
analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the () Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U segmental bridge.out this output file contains details of model data,
assigned attributes and selected statistics of the analysis.

U segmental bridge.mys this is the LUSAS results file which is loaded
automatically into the (X Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Select Yes to view the
output file. Any errors listed in the text output window should be corrected in LUSAS
Modeller before saving the model and re-running the analysis. Note that a common
error is to forget to assign attribute data (such as geometry, mesh, supports, loading
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| File

Viewing the Results

[New...

| File

| Script

| Run Script...

etc.) to the model. If the errors cannot be identified the model may be rebuilt and the
prestress loading redefined.

Rebuilding the Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model up to the point of defining the Prestress Loading.

O segmental_bridge modelling.vbs carries out the geometric modelling
of this example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as Segmental Bridge

e To recreate the model, select the file segmental_bridge _modelling.vbs located in
the \<LUSAS Installation Folder>\Examples\Modeller directory.

The geometry of the model has been created. Now return to the section entitled
Prestess Loading earlier in this example and re-define the tendon properties.

Viewing the Results

Analysis loadcase results are present in the (X Treeview for each stage. The last solved
loadcase (Increment 3) will be set active.

Bending moments of Mz over the segments are to be investigated for each stage of the
construction process. A summary of results on each results plot also allows a
comparison of maximum displacements for each stage.

In the following images the tendon profile visualisations are not shown. They can be
turned off by editing the tendon profile properties of the Utilities layer in the Layers
Treeview.

Stage 1 results

o Inthe ™ Treeview right-click on Stage 1 and select the Set Active Option.

e Turn off the display of the Mesh, Geometry, Utilities and Attributes layers from
the =" Treeview.

e If not there already, add the Deformed mesh layer to the = Treeview.
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e Using the Deformations... button at the bottom of the Treeview and specify
factor as 1E3. Click the Window summary option.

e Add the Diagrams layer to the =¥ Treeview. On the dialog, select Force/Moment
- Thick 3D Beam results from the entity drop-down list and component Mz. Select
the Diagram Display tab.

e Select the Label values options and deselect the Peaks only option.

e  Set the % of element length to 60. Set the Angle to 90 degrees and the number of
significant figures to 4.

e Click OK to display the bending moment diagram for the active elements for Stage
1.

Note. The maximum deflection and maximum and minimum bending moments are
shown in the window summary.

Stage 2 results
o Inthe "= Treeview right-click on Stage 2 and select the Set Active option.

Stage 3 results

o Inthe ™ Treeview right-click on Stage 3 and select the Set Active option.

This completes the example.
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Description

Linear Cable Tuning
Analysis of a
Pedestrian Bridge

For software product(s):

LUSAS Bridge / Bridge plus, LUSAS Civil & Structural/
Civil & Structural plus only

With product option(s):

None.

Description

This example demonstrates the procedure for setting up a cable tuning analysis on a
simplified 3D beam model of a cable-stayed pedestrian bridge. Optimum cable forces to
maintain a flat deck and vertical tower under permanent loads are to be determined.

Units of kN, m, t, s, C are used throughout the analysis.
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Discussion

Modelling

Linear Cable Tuning Analysis of a Pedestrian Bridge

Objectives

The required output from the analysis consists of:

O Calculation of cable forces required to maintain a horizontal deck and vertical
tower under permanent loading.

Keywords

Cable tuning analysis, targets, exact solution, linear

Associated Files

U cable_tuning.mdl contains the model geometry with all of the attributes
assigned. The example will use this model file as a starting point.

Cable tuning analysis enables automatic calculation of cable forces to optimise certain
specified criteria, for example, to limit displacements in a bridge deck and/or tower
during construction.

The analysis of cable structures is strictly a nonlinear problem because the effects of
cable sag require large deflection theory (geometric nonlinearity) for accurate
estimation. However, because bridge cables are typically stressed to such a high force
that the amount of sag is small, it is often acceptable to idealise such analyses to
equivalent linear problems by neglecting the sag effects.

A common method of doing this is to represent the cables with a single linear bar
element. Bar elements only carry axial force (ho moment or shear) and by using a single
element no lateral deflection (i.e. sag) is permitted, so a reasonable approximation to
true cable behaviour is achieved. It is important to note that this method would
potentially permit the cable elements to carry compressive forces, so the predicted
forces must be checked to ensure this is not the case under any in-service combination
of loading.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Creating the Model

For this example a model file is provided:
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| File

Open...

| File

Save As

Modelling

To create the model, open the read only file cable_tuning.mdl located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

El Save the model file to the \<Lusas Installation Folder> \Projects directory to
avoid over-writing the provided file.

L) .
The Undo button ﬂ may be used to correct a mistake. The undo button allows any
number of actions since the last save to be undone.

Model Supplied

The model geometry and attributes are already defined in the supplied model file.

The bridge to be analysed consists of a 46m high tower supporting a deck of total
length 108m.

The tower is a steel square hollow section, varying from 4m square at the base to 2m
square at the top, with 50mm thick walls throughout. It is fully fixed at its base and is
not connected directly to the deck where the two features cross.

The deck is a steel box section of total width 7m, having a cross-section as shown on
the following image. The deck consists of 9no. 12m spans between supporting cables.
The deck is pin-supported at the left-hand end and roller-supported at the other.
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Bz B

=)
végl

B3 B4

Steel box section for the deck

The lines representing the tower and the deck are meshed with thick 3D thick nonlinear
beam elements (BMI21). The lines representing the cables are each meshed with a
single 3D bar element (BRS2). Each cable is represented by a circular solid section of
50mm diameter.

Checking the Modelling so Far

The model contains a single analysis, with two linear structural loadcases — Self-
Weight (where the self weight is assigned to all members using ‘auto gravity’ as a
property of the analysis) and Surfacing (20kN/m assigned to the deck members only).

e Switch off section fleshing by clicking 1' and rotate the model into the X-Z
plane by pressing s Ut in the status bar.
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| Utilities

Modelling

Print Results
Wizard...

| Analyses

Cable Tuning
Analysis...

Solving the Supplied model

El Press the Solve Now button to check the assignments made so far.

The Deformed Mesh layer will now be visible, and can be used to check that the
deformed shape for each of the two loadcases is reasonable.

e Check the reactions using Utilities> Print Results Wizard, and ensure that
Selected, All loadcases, for entity Reaction and for type Summary are selected
and click Finish.

e With the Self weight tab selected ensure that the total self-weight reaction is
11930kN. With the Surfacing tab selected ensure the total surfacing reaction is
2160kN (both in the Z-direction).

Creating a Cable Tuning Analysis

During the design of cable structures it is usually desirable to determine a set of cable
forces that will result in a certain deck profile. In this case we will calculate forces to
maintain a horizontal deck and vertical tower under permanent loading (gravity plus
surfacing). In LUSAS this can be done by setting up a ‘Cable Tuning Analysis’.

The first stage of this process is to select the lines representing the cables.

e In the & Treeview, right-click the geometric attribute Cable and click Select
assignments.

In the first tab of the Cable Tuning Analysis dialog you should see a list of the lines
which represent the cables under the Selected heading. Optimised forces for all of these
lines will be required.

e Click the All button in the middle of the dialog to copy them all to the Included list
on the right-hand side of the dialog.

e Switch to the Loadcases tab of the dialog.

This tab enables a combination of loads to be specified for optimising the cable forces.
In this instance we are interested in the bridge profile under permanent loads.

e Select both Self-Weight and Surfacing loadcases and click 2 in the centre of the
dialog to add both loadcases to the Included list.

e Switch to the Targets tab of the dialog.

Under the Targets tab the desired deflections and/or load effects from the cable tuning
analysis can be specified. In this instance we want to keep the deck flat and the tower
vertical, so we will specify that each of the points on the deck should have vertical

391



Linear Cable Tuning Analysis of a Pedestrian Bridge

deflection of zero and the point at the top of the tower will have a horizontal deflection
of zero.

e Move the dialog to the bottom-left-hand side of the screen and pan the model view
so that a clear image of the bridge is shown.

e Inthe = Treeview switch the Deformed mesh layer off.

e Holding the P key (to select only points), box select the whole deck with the
exception of the two end points as shown below. The two end points are
supported vertically so there is no need to fix their displacement.

— i

¢ In the cable tuning dialog, click Add Selected. In the window that pops up, select
entity Displacement and set component DZ = 0. Click OK to add the selection of
points to the targets list.

e Click on the top point of the tower, then click Add Selected on the cable tuning
dialog again and specify entity Displacement and this time set component DX =0

e For this analysis the number of selected lines representing cables is equal to the
number of targets so an Exact solution can be calculated.

Note. If the number of selected lines representing cables exceeded the number of
targets, there would be more than one possible solution to the cable tuning problem. It
would therefore be possible to optimise the cable forces so that the targets were all met
exactly, while some additional criteria was also optimised; for example the lowest total
force in the cables. This would be set up by ticking the Optimised button at the top of
the dialog and entering optimisation data in the additional tab which appeared.

Note. If the number of targets exceeded the number of selected lines representing
cables, an exact solution would not be possible. In this case the Best Fit button should

392



Modelling

be ticked, and best fit data entered in the additional tab. It is usually possible to achieve
a good match to the desired targets using the Best Fit method.

To check that the correct solution method has been selected:

Click the Validate Input button in the bottom-left corner of the dialog. If the above
instructions have been followed correctly a pop-up stating Input is valid will be
shown. If not, check the three cable tuning tabs to determine the problem — there is
probably a mismatch between the number of cables and the number of targets.

Assuming that your inputs were successfully validated, click OK to conclude the
Cable Tuning setup. A Cable tuning analysis entry Cable tuning 1 will be added to

the 12 Treeview along with a loadcase entry for each of the cables selected for

tuning, and a cable tuning results entry shown by a s symbol representing a
loadcase that will contain the combination of optimised cable forces and the
loadcases specified during the cable tuning setup.

Solve the model again by clicking the Solve El button.

Viewing the results from the Cable Tuning Analysis

Set active the Cable Tuning 1 Results entry / combination by right-clicking the

Cable tuning entry 4 and selecting Set active to check that the targets have been
met.

In the Treeview switch the Deformed mesh layer on. This should show that the
deck points are all vertically aligned with the original flat deck profile, and that the
tower top point is horizontally aligned with the original vertical tower profile as
shown below.

.

393



Linear Cable Tuning Analysis of a Pedestrian Bridge

e To see the calculated load factors for individual cables, in the (X Treeview right-
click the loadcase Cable Tuning 1 Results and select Calculated Factors.

]|

Calculated Factors
Cables Loadcazes Calculated Factor

1| Line: 4 Loadcase 33 [Cable - Line: 4] A.007139E3
2| Line: 15 Loadcase 34 [Cable - Line: 15) 2027E3

3| Line: 16 Loadcasze 35 [Cable - Line: 16) 1.53036E3
4| Line: 17 Loadcase 36 [Cable - Line: 17) 1.42843E3
5| Line: 18 Loadcase 37 [Cable - Line: 18) 1.42549E3
E| Line: 19 Loadcase 33 [Cable - Line: 19) 1H7153E3
7| Line: 20 Loadcase 39 [Cable - Line: 20) 1.83762E3
8| Line: 21 Loadcase 40 [Cable - Line: 21) 211483E3
9| Line: 22 Loadcase 41 [Cable - Line: 22) 283073E3

Close I Help

Note. Although the values shown in the Calculated Factors dialog cannot be edited,
they can be copied for pasting into spreadsheets and reports by selecting the data and

pressing Ctrl+C

This concludes the example.
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Description

3D Nonlinear Static
Analysis of a Cable

Stayed Mast

For software product: Any Plus version.

With product options: Nonlinear.

Description

A 10m tall mast with three supporting
guy cables is to be analysed. The guy
cables are spaced at 120° intervals
around the mast and are fixed at ground
level at a radius of 7m. Both the mast
and cables are made of steel with a
Young’s Modulus of 210e9 Pa, Poisson’s
Ratio of 0.3 and a mass density of 7800
kg/m®.

Units of N, m, kg s, C are used
throughout.

Four load types are to be considered:
1. Initial force in the cables of 5000N.

. Self-weight of the structure.

-

2
3. Horizontal wind load of 500N/m distributed along the length of the mast.
4

. Ahorizontal point load at the top of the mast of 5000N (acting in the negative

global X direction).




A

Modelling

3D Nonlinear Static Analysis of a Cable Stayed Mast

Objectives

The required output from the analysis consists of:

0 Deformed shape plot

O Force diagram and peak forces in cables

0 Bending moment and force diagram of the mast
0 Reaction summary at the base of the mast

Keywords

3D, Thick Nonlinear Beam, Nonlinear Control, Geometric Nonlinear Analysis,
Axial Force Diagram, Shear Force, Bending Moment Diagram

Associated Files

U mast_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name and model title as Mast
e Use the Default working folder.

e Set model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the model startup template Standard

e Select the Vertical Y axis option and click OK.
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| Geometry
Pont >
| Geometry
| Line >
By Sweeping...
| Geometry
| Paint >
Coordinates...
| Geometry
| Line >
| Paints...

Modelling

Defining the Geometry

El Enter co-ordinates of (0, 0, 0) and click OK to define a point at the bottom of the
mast.

e Select the Point

él Enter 10 in the Y direction (vertical) and click OK to sweep the point.

El Enter co-ordinates of (-7, 0, 0), (3.5, 0,
6.0622) and (3.5, 0, -6.0622). Click OK to
define points where the guy cables are fixed to
the ground.

El Select the isometric view button to rotate
the model so that all points are visible

o Define a cable by selecting a base Point
followed by an apex Point. (Use the Shift key
to make multiple selections)

il The lines defining the cable will be drawn.

o Repeat for the other two pairs of points.

Defining Groups

To simplify the assignment of model attributes and assist with post processing the
features will be grouped together.

e Select the Line representing the mast.

Select the Group button.

e Change the group name to Mast and click OK

e Select the three Lines representing the cables. (Use the Shift key to make multiple
selections)

Select the Group button.

e Change the group name to Cables and click OK
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3D Nonlinear Static Analysis of a Cable Stayed Mast

|Mesh
| Line...

| Attributes

| Geometric

| Section Library...

>

Meshing

The Line features are to be meshed using three-dimensional nonlinear beam elements.

e Select Thick beam, 3 dimensional, Linear elements. (This will select beam
element BMI121)

e Change the number of divisions per line to 10

e Enter the attribute name as Mast and click the Apply button.
e Change the attribute name to Cables and click the OK button
o Select the line representing the mast.

e Drag and drop the mesh attribute Mast from the Treeview onto the selected Line
features using an element orientation with a beta angle of 0. Click OK to assign.

e Select a line representing a cable and holding down the Shift key, select the other 2
lines representing the cables.

e Drag and drop the mesh attribute Cables from the Treeview onto the selected Line
features using an element orientation with a beta angle of 0. Click OK to assign.

Geometric Properties
Mast

For the purposes of the example the mast will be defined as a Circular Hollow Section
(CHS).

e From the Usage section select 3D Thick Beam (Any beam) with no rotation
specified.

e From the UK Sections library select the CHS (EN10210) section type and select
the 168.3x8 CHS section.

e Enter an attribute name of Mast
e Click the OK button to add the CHS attribute to the Treeview.

Cables

The 10mm diameter guy cables will be defined using a standard section but with the
bending properties subsequently adjusted to a value of 1/100" of the actual bending
stiffness in order to not attract any bending moments. The torsional constant and shear
area values will be left unaltered.
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| Utilities

Section Property
Calculator >
Circular Sections
> Solid

| Attributes
| Geometric >

~ [section Library...

Modelling

Enter a diameter (D) of 0.01
Leave the section name as the default name of CSS D=0.01

Ensure Add to local library is selected and press the OK button to add the defined
section to the user library.

To make the adjustments to the section properties and add the amended cable geometry
dataset to the Treeview:

The cable geometry dataset will be added to
the Treeview.

i i
From the Usage section select 3D Thick === =
Beam . (Any t.)eam) and from the r;;gwiickseam(nnyheam) =] [user Sections =
Definition section select the Enter = =

Properties radio button.

In the Value table change the lyy value to
be 5e-12 and change the 1zz value to be
5e-12 (both 100 times smaller than
initially calculated)

Enter the attribute name as 10mm Cable
and click the OK button.

Value
Tioss secl onal area 4] TEEIES
Second moment: of area aboul y s (1] 512

Second moment of area about 2 as [Izz) Ge12 a3
Product mament of zrea 2] il
Tarsianal constant i

0.381746E-5
70.6858E-6
70.6858E &
coe oo

Eccentiicity in z diection 0.0

Visualise:,.. Tapering >

Name [ 10mm cable

= 2w

ok Can[e\l Apply | Help |

Assigning Geometry Properties

In the Treeview, right-click on the group name Mast. Choose the Select
Members option. Click Yes to deselect members already selected.

Drag and drop the geometry attribute Mast (168.3x8 CHS major y) from the &
Treeview onto the selected Line. The section assigned will be visualised.

In the Treeview, right-click on the group name Cables. Choose the Select
Members option. Click Yes to deselect members already selected.
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| Attributes

3D Nonlinear Static Analysis of a Cable Stayed Mast

| Material

| Material Library...

e Drag and drop the geometry attribute 20mm Cable from the & Treeview onto the
selected Lines.

. ﬂ Select the fleshing on/off button to turn-off the geometric visualisation.

Material Properties

A linear approximation to steel properties will be used for the mast and cables.
e Select material Mild Steel, Ungraded, and click OK.

e Select the whole model (Control + A keys) and drag and drop the material attribute
Isol (Mild Steel Ungraded) from the & Treeview onto the selected features.

Supports

The Standard template provides the more common types of support by default. These
can be seen in the Treeview. The structure will be supported at the base of the mast
with a fully fixed support condition. The cables will be supported in translation
directions only.

Assigning the Supports

e Select the Point at the base of the mast.

e Drag and drop the support attribute
Fully Fixed onto the selected Point for
all loadcases. Click OK to assign.

e Select the 3 Points at the base of the
three cables.

e Drag and drop the support dataset
Pinned from the & Treeview onto the
selected Points for all loadcases. Click
OK to assign.

Loading

Four load types will be considered: Initial stresses in the cables, self-weight, horizontal
wind loading, and a point load acting at the top of the structure. The loading will be
assigned to four loadcases.
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| Attributes

Modelling

| Loading...

Load type 1 - Initial Stress

o In the & Treeview expand Analysis 1 then rename Loadcase 1 to be Initial stress
in cables by selecting Loadcase 1 with the right-hand mouse button and using the
rename option.

An initial force in the guy cables of 5000 N is to be defined and assigned to the model.
Since the elements used to represent the mast and cables are BMI21 elements which are
formulated using forces and strains (see the Element Reference Manual for details) the
force is entered by selecting the Stress and Strain option on the structural loading
dialog.

e Select the Stress and Strain option and click Next
e Select a Line element description

e Select Thick beam from the upper drop-down list, and 3 dimensional from the
lower list.

e Ensure the Stress and Strain Type is set to Initial

e Enter a value of 5000 for Fx.

e Enter the attribute name as Initial Stress

e Click Finish to add attribute to the &% Treeview.

The copy and paste facility will be used to assign this loadcase to the cable group.

o In the &b Treeview, right-click on

the loading attribute Initial Stress “\\
and select the Copy option. .;-"’: N
N

e In the Treeview, right-click on i N
the group name Cables and select } \
the Paste option. / \

e On the Loading Assignment dialog ,/ b« \u\
select the loadcase name Initial ,/ K X
Stress in Cables. Click OK to / 7 g
assign loadcase. /’ :#

Load type 2 - Self Weight )f

Load type 2 represents the self-weight of the structure. This is modelled automatically
by applying gravity to the loadcase. The self-weight will be assigned to both Loadcase
2 and Loadcase 3 for reasons that are explained during the Nonlinear Analysis Control
section of this example.
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Loadcase...

| Attributes

Loading...

3D Nonlinear Static Analysis of a Cable Stayed Mast

Select the Automatically add gravity to this loadcase option
Name the loadcase Self Weight and press Apply.

Now change the loadcase name to Self Weight Freeze and press OK to create the
second self-weight load type.

Note. With this method of assigning gravity (to the loadcase) no visualisation of the
loading will take place in the View window.

Load type 3 - Horizontal Wind Load

Load type 3 is a horizontal wind load of 500 N/m distributed along the length of the
mast.

Select the Global Distributed option
and click Next

Select the Per Unit Length option.
Enter a value of -500 N/m in the X
direction.

Enter the attribute name as Distributed
Wind Load.

® & B & B & % B &b

A

Click Finish to add the attribute to the
&Treeview.

In the &b Treeview, right-click on the
loading attribute Distributed Wind Load and select the Copy option.

In the Treeview, right-click on the group name Mast and select the Paste
option.

On the Loading Assignment dialog change the loadcase name to Wind and Point
Load.

Click OK to assign the loading to that specified loadcase.
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| Loading...

Modelling

Load type 4 - Concentrated Point Load
A point load of 5000 N is acting at the top of the mast.

e Select the Concentrated option and click
Next

e Enter a value of -5000 in the X direction.

e Enter the attribute name as Point Load

« Click Finish to add the attribute to the &%
Treeview. 4 x

e Select the Point at the top of the mast then K z
drag and drop the loading attribute Point
Load from the &b Treeview onto the
selected Point.

e Ensure that the loading is assigned to the Wind and Point Load loadcase and press
OK.

Nonlinear Analysis Control

Nonlinear control is defined as a property of a loadcase and must therefore be set for all
four loadcases required for this analysis.

Loadcase 1

e Inthe (5 Treeview, right-click on Initial Stress in Cables and select Nonlinear &
Transient from the Controls menu.

e Select Nonlinear incrementation with Manual control.
o Use default settings for this initial manual loadcase. Do not modify the dialog.

e Click OK to finish.

Note. A ¥& Nonlinear and Transient object will be added to the Treeview. Double-
clicking on this object will allow any changes to be made to the control properties for
this loadcase.

Loadcase 2

Loadcase 2 (the self weight loadcase) uses automatic load incrementation. In doing so,
the load is applied as a very small initial step to overcome any potential convergence
problems. The specification of the number of iterations per increment determines how
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the load step is varied from one increment to the next. The analysis generally converges
in 2 or 3 iterations. By setting this value to 12 the load step will rapidly increase.

Note. In LUSAS, the use of automatic nonlinear incrementation immediately
following a manual nonlinear incrementation (as in this case) causes the results from the
previous analysis to be retained and used as the starting point for the subsequent
analysis.

o Inthe ™ Treeview, right-click on Self Weight and select Nonlinear & Transient
from the Controls menu.

e Select Nonlinear incrementation with Automatic control.

e Enter the Starting load factor as 0.01

e Leave the Max change in load factor setto 0

e Leave the Max total load factor as 1

e Set the Iterations per increment to 12

¢ Inthe Incrementation section of the dialog select the Advanced button.

e Enter the Stiffness ratio to switch to arc length as 0. Click the OK button.

e Ensure that the Solution strategy and Incremental LUSAS file output are set to
Same as previous loadcase.

e Click the OK button to finish.

Loadcase 3

Loadcase 3 reapplies the self-weight in a single Manual load step. This effectively
freezes the self-weight load allowing the wind loadcase 4 to be incrementally increased.
If an Automatic (loadcase 4) nonlinear control were to follow a previous Automatic
(loadcase 2) nonlinear control then the loading would be overwritten.

Note. In LUSAS, using manual nonlinear incrementation immediately following an
automatic nonlinear incrementation (as in this case) allows a subsequent automatic
nonlinear incrementation to be applied without overwriting any previous loading.

o Inthe ® Treeview, right-click on Self Weight Freeze and select Nonlinear &
Transient from the Controls menu.

e Select Nonlinear incrementation with Manual control.

e Ensure that the Solution strategy and Incremental LUSAS file output are set to
same as previous loadcase.
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e Click the OK button to finish.

Loadcase 4

Loadcase 4 applies the wind and point load using Automatic load incrementation. In a
similar manner to that used for loadcase 2.

o Intheft Treeview, right-click on Wind and Point Load and select Nonlinear &
Transient from the Controls menu.

e Select Nonlinear incrementation with Automatic control.

e Enter the Starting load factor as 0.01

e Leave the Max change in load factor setto 0

e Leave the Max total load factor as 1

e Set the Iterations per increment to 12

¢ Inthe Incrementation section of the dialog select the Advanced button.

e Enter the Stiffness ratio to switch to arc length as 0. Click the OK button.

e In the Solution strategy section of the dialog deselect the Same as previous
loadcase option and then select the Advanced button.

e Set the Maximum number of line searches to 0 and click OK

e Click the OK button to finish.

Defining a Geometric Nonlinear analysis

One additional setting is required to allow a geometric nonlinear analysis to take place.
« Double-click on the Y& Nonlinear analysis options object in the (X Treeview.

e Select the Co-rotational Formulation option.

e Click the OK button to finish.

Note. The & Nonlinear analysis options object sets parameters for the whole

analysis and the ® Nonlinear and Transient object sets control properties for each
loadcase.

Save the Model

The model is now complete and the model data is to be saved before an analysis is run
using the LUSAS Solver.
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|save

El Save the model file.

Running the Analysis

| File

[New...

With the model loaded:
El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to run
the analysis from Modeller.

During the analysis 2 files will be created:

U mast.out this contains the statistics of the analysis, for example how much
disk space was used, how much CPU time was used, and any errors or warning
messages from LUSAS. Always check the output file for error messages.

U mast.mys This is the LUSAS results database which will be used for results
processing.
If the analysis is successful...

Analysis loadcase results are added to the G Treeview.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

U mast_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as mast
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| File
Script >
Run Script...

Viewing the Results

To recreate the model, select the file mast_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results

Viewing the Results

Selecting the results to be viewed

For a nonlinear analysis the loadcase results for the last loadcase increment to be solved
are set to be active by default.

e Inthe’™ Treeview, right-click on the first load increment Increment 1 and select
the Set Active option.

Note. With reference to the loadcase & |E |& @ | @ |

= =3 mast.mdl

results opposite, the first increment relates -3 Structural analyses
initi s =% Analysis 1
to the initial stress loadcase. The first set of -2 Geomstric
load factor increments relate to the self- - Material
. = Q 1:Initial Stress in Cables
weight loadcase. Increment 7 relates to the -3 Supports
3 : s . H H B4 Loadi
freezm_g of the self: welght Ioadca_se prior B il Stress (x 1.0
to loading the structure with the wind and -y Horlinear and Transient
H . Sl 1 :Iricrement
point load. The remaining load factor B 25ek
increments relate to the application of the & [ Loading _
. . . W Norlinear and Transient
wind and point loading on the on the pre- 1 2iInerement 2 Load Factor = 0,100000E-01
Stressed Structure ' 3iIncrement 3 Load Factor = 0,446410E-01

17 #:Increment 4 Load Factor = 0.164641
-1 SiIncrement 5 Load Factar = 0.580333
- 17 GiIncrement 6 Load Factor = 1.00000
EI@ 3:5elf Weight Freeze
-2 Loading
-4 Morlinear and Transient
-1 7iIncrement 7
=1 @ 414wind and Point Load
Ha Loading

i 3iDistriblbed Wind Load (x 1,0)
- &iPoint Load (x 1.0)
W Monlinear and Transient
-1 BiIncrement 8 Load Factor = 0, 100000E-01
-1 @:Increment 9 Load Factor = 0,344949E-01
-1 10:Increment 10 Load Factor = 0,944949E-01
-1 11:Increment 11 Load Factor = 0,241464
7 12:Increment 12 Load Factor = 0,601464
&7 13:Increment 13 Load Factor = 1,00000
"b MNorlinear analysis options
'lb Model properties

INona j Specify... |
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Deformed Mesh Plot

e If present in the [ Treeview turn off
the Geometry, and Attribute layers.

e Click Close to accept the default
properties and view the deformed
mesh for the first results loadcase
Initial Stress in Cables

e Turn off the Mesh layer

Axial Force Diagram for Initial Stresses

e With no features selected, click
the right-hand mouse button in a
blank part of the graphics
window and select the Diagrams
option to add the diagrams layer

to the Treeview.

11.91E3

#844E3

e Select the entity Force -
/Moment - Thick 3D Beam of < -11.91E3
z

. 4.844E3
component Fx (axial force)

e Select the Diagram Display tab
and select the Label values and
Peak values option. Untick the Also use for labels option and set the number of
significant figures to 4.

4.844E3

e Click OK to add the Diagrams layer to the display.
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Viewing the Results

Combined Initial Stress and Self weight

In the "= Treeview right-click on
the on the last results increment
inside the Self Weight section for
Load Factor = 1.00000 and select
the Set Active option.

This shows axial force from the
combined effect of the initial stress
and the self-weight on the mast.

112 09E3
41B43E3

—x%

< J1e7ES 4.843E3

Combined Initial Stress, Self Weight and Wind Load

e Inthe @ Treeview right-click on

the last results increment in the
Wind and Point load section for
Load Factor = 1.00000 and
select the Set Active option.

If excessive overlapping of
values is seen using the
significant ~ figures  option,
double-click the Diagrams entry
in the Treeview, and select
the Diagram Display tab and set
the number of decimal places to
1. This setting is shown in the
adjacent iamge..

20138.9

120321

& X

< 232231 12032 1
Z

This image shows axial force for the combined effect of the initial stress, the self-

weight and the wind loading on the mast.
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Axial Force Diagram for the mast only

e Inthe L=l Treeview, right-click on the group name Mast and select the Set as Only
Visible option. The corresponding image for Force /Moment - Thick 3D Beam of
component Fx (axial force) for this loadcase is shown in a table below.

Shear Force Diagram for the mast

e Inthe [&=F Treeview double-click on the Diagrams entry and select Force/Moment
— Thick 3D Beam results for axial force Fy. Click OK to update the graphics
window. The corresponding image for this loadcase is shown in a table below.

Bending Moment Diagram

e Inthe Treeview double-click on the Diagrams entry and select Force/Moment
— Thick 3D Beam results for bending moment Mz. Click OK to update the graphics
window.

Diagram results for Wind and Point load loading (Load factor 1)

20.14E3 11 527E3 -2.248
-1 B27E3

-1.011E3
d}ﬁB@-’ﬂS 31049E3
5571
F074ES
1 HBES
27071E3

2'543E3
& bl

2:5%Eg, } 78233
L 232263 ol
. 2:69

z z

Axial force Fx Shear force Fy Bending moment Mz
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| Utilities

Viewing the Results

| Print results wizard

Plotting Reactions at the Mast and Cable Supports

Printing a Results Summary of Reactions

In the [ Treeview turn off the Diagrams layer.

With no features selected,
click the right-hand mouse
button in a blank part of the
graphics window and select
the All Visible option.

With no features selected,
click the right-hand mouse
button in a blank part of the
graphics window and select
the Values option to add the
values layer to the it
Treeview. Select results of
entity Reaction of component
RSLT.

z

Select the Values Display tab and plot 100% of Maxima values

Click the OK button.

With the last results increment Wind and Point load loading (Load factor 1) still
selected in the Treeview:

BE LusAS Yiew: Reaction Components in Global Axes Loadcase =

With the Active loadcase option selected press Next.

Select entity Reaction for type Component.

Click Finish to view the tabulated results summary

=|EN e

13 Results File = ... [Hi=] E3

Moce & Fx F FZ 53 I ME RSLT
1 Mode Fx FY FZ T, Ml ML RSLT
2 1 3.47595E3 98405263 -5.957HES Pr, ML, PrL, 12.0322E3
3 11 181 608 -239.151 -1.61311E-G: biA i, flr, 305443
4 12 3.23962E3: 23.2231E53 ¢ 0.0153049 0130451 | 363585E-5 -7 §2269E5: 25 4479ES
a3 4 3.47585E5:-9.84049E3: 5.93759E3 R M2, Mra, 12.0321E5

4 4 ¢ M E Madel info }\ 13:Wind and Point Load, Increment 13 Load Factor = 1.00000 /

This completes the example.
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Description

2D Consolidation
under a Strip
Footing

For software product(s):

Any Plus version.

With product option(s):

Nonlinear, Dynamic.

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

The pore  water
pressure dissipation
and settlement in a
soil following the
application of a
distributed load is to
be investigated.

Horizontal
displacement at the
left edge is restrained
to model the
symmetrical
boundary condition.
Vertical
displacement at the
base of the soil is
restrained as the soil
rests on solid rock.

I

Fsm-

XS
‘L 100m |
o Young’s modulus of the soil ~ E= 34.7 x 10° kN/m?
E Poisson’s ratio v=0.35
§ Density p=19tm°
Bulk modulus of water Ky = 2.2 x 10°kN/m?
Void ratio e=1174
Unit weight of water 7= 9.812 kN/m®
Soil permeability ke=ky=kz=1.0 x 10 m/s

The pore pressure at ground level is prescribed to zero.

Units of kN, m, t, s, C are used throughout.
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&

Modelling

2D Consolidation under a Strip Footing

Objectives

The required output from the analysis consists of:

U Settlement at the centre of the footing with time.

O Pore pressure distribution immediately after application of the load (undrained
response)

U Pore water pressure dissipation with time at the centre of the footing

Keywords

Consolidation, Pore Water Pressure, Time Stepping, Nonlinear, Transient,
Settlement, Two Phase Materials, Default Assignments, Graphing

Associated Files

U pwp_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the File name as pwp

e Use the Default working folder.

e Enter the title as Consolidation under a Strip Footing

e Select model units of kN,m,t,s,C from the drop down list provided.
e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the startup template Standard

e Select the Vertical Y axis option and click OK.
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| Attributes
|Mesh >
Surface...

Modelling

Note. The Undo button may be used to correct a mistake. The undo button allows any
number of actions since the last save to be undone.

Prior to defining the geometry of the model default surface mesh and material
properties will be set-up.

Mesh Definition

Since this analysis requires the modelling of pore water pressure, plane-strain two phase
elements will be used.

e Select Plane strain two phase, Quadrilateral, Quadratic elements. Ensure the
Regular mesh option is selected with Automatic divisions so that Modeller uses
the mesh divisions assigned to each line.

e Give the attribute the name Plane Strain Two Phase and click the OK button to
add the mesh attribute to the & Treeview.

o In the &b Treeview click on the mesh attribute Plane Strain Two Phase with the
right-hand mouse button and select the Set Default option. This will ensure all
newly created surfaces will be assigned the elements defined in this mesh attribute.

Material Properties

For consolidation analysis both the elastic and two-phase soil properties need to be
defined. The overall ‘equivalent’ bulk modulus of the soil is related to the bulk modulus
of the pore fluid and the bulk modulus of the solid soil particles by the formula:

Ke Kf Ks Kf

Where
Ke is the equivalent bulk modulus of the soil
Kf is the bulk modulus of the pore fluid
Ks is the bulk modulus of the solid soil particles
n is the porosity of the soil

The porosity of the soil is related to the void ratio by the formula:

€
Porosity N=——-=0.54
l+e
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| Attributes e Enter the isotropic material properties for the soil as Young’s Modulus 34.7E3,
| Material _ > Poisson’s Ratio 0.35 and Mass density 1.9
Isotropic...

e Click on the Two phase check box at the top right-hand corner of the dialog and
select the Undrained option.

Using the following properties
[™ Plastic [ Creep [~ Damage [ Shrinkage I viscous V¥ Two phase
Elastic Two Phase I
& Fully saturated Value
€ Parbially saturated Bulk modulus of solid phase 22e6
Artialy satrats Bulk modulus of fluid phase 2256
" Piecewise linear partially saturated Parosity of medium 0.54
Unit weight of fluid 5812
Define cUrves:.. | Hydralic conductivity in global X dirsction 0.01e6
] ; Hydralic conductivity in global Y direction 0.01e&
™ Incompressible solids Hydralic conductivity in global Z direction 001e6
Density of fluid 0.1
Mame | Fissured Clay| j ﬁl {new)
QK | Cancel | Apply | Help

e Enter the properties as shown in the dialog above..

Note. For the purposes of this example and to comply with a corresponding test case
/ the undrained bulk modulus of the soil is set to be the same as that of the pore fluid.

e Enter the attribute name as Fissured Clay and click the OK button to add the
attribute to the &% Treeview.

o Inthe &b Treeview click on the attribute Fissured Clay with the right-hand mouse
button and select the Set Default option. This will ensure all newly created features
will be assigned the properties defined in this material attribute.
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| Geometry

Surface >
Coordinates...
| Geometry
Surface >
Coordinates...
| Attributes
Mesh >
Line...

Modelling

Feature Geometry

_I Enter coordinates of (0, 0), (5, 0), (5, 10) and (0, 10) to define the soil under the
load. Use the Tab key to move to the next entry field on the dialog. When all
coordinates have been entered click the OK button.

J Enter the coordinates of (5, 0), (100, 0), (100, 10), (5, 10) to define the remainder
of the soil.

Mesh Grading

Define a Line mesh with element type None and 16 divisions.
Select the Spacing button.

Choose the Uniform transition option and set the Ratio of first to last element to
0.1

Click OK to accept the spacing properties.

Give the attribute name as Null 16 Graded and click the Apply button to add the
attribute to the &% Treeview and keep the dialog active.

Define a Line mesh with 12 divisions.

Select the Spacing button.

Enter the Uniform transition option and set the Ratio of first to last element to 5
Click OK to accept the spacing properties.

Give the attribute name as Null 12 Graded and click OK to add the attribute to the
c&; Treeview.
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Support...

2D Consolidation under a Strip Footing

Select these 2 horizontal Lines
and assign "Null 16 Graded"

W
Y i

Select these 3 vertical Lines and assign "Null 12 Graded"

L 3

Select the horizontal lines of the larger surface as shown and assign the mesh attribute
Null 16 Graded

o Select all the vertical lines as shown (Use the Shift key to add to the initial
selection) and assign the mesh attribute Null 12 Graded

Note. If the mesh is graded with the smaller elements at the wrong end of a line
reverse the line by selecting the line, and using the Geometry>Line>Reverse menu.

Supports

Define a support to prescribe zero pore pressure.

e Click on the option to make the Pore pressure Fixed

e Enter the attribute name as Fixed PWP and click the OK button.
Assign the supports to the model.

e Select the vertical Line on the left-hand side of the model and drag and drop the
support attribute Fixed in X from the & Treeview onto the selection. With the
Assign to lines option selected click OK to assign the support attribute to All
analysis loadcases

o Select the 2 horizontal Lines representing the base of the soil and drag and drop the
support attribute Fixed in Y from the & Treeview onto the selection. With the
Assign to lines option selected click OK to assign the support attribute to All
analysis loadcases
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| Attributes

Loading...

Modelling

e Select the Line at ground level on the right-hand side of the model (see image) and

drag and drop the support attribute Fixed PWP from the & Treeview onto the
selection. With the Assign to lines option selected click OK to assign the support
attribute to All analysis loadcases

Select this line %

Loading

e Select the Face option and click Next
e Enter loading of 3450 in the y Direction
e Enter the attribute name of Distributed Load and click the Finish button.

e Select the top line on the left-hand side of the model and drag and drop the
Distributed Load attribute onto the selection. With the Assign to lines option
selected click OK to assign the loadcase attribute to Loadcase 1.

Select this line

e n i rn B o B ] fral fral fral fral fhal fral el ! fral

1y

Analysis Control

With this consolidation problem an automatic time stepping procedure is adopted. This
is because consolidation is a typical diffusion process in which the field changes rapidly
at the start of the process before settling down to a steady state condition a considerable
time after the initial load is applied. The automatic time stepping procedure enables the
time step to be modified so that the small time steps required at the start of the problem
can be increased as the analysis progresses. In some cases the overall response time can
be orders of magnitude larger than the initial time step.

The initial time step is important since the early variations in pore pressure must be
accurately accounted for. Vermeer and Verruijt suggest the following criteria for
determining the initial time step where Ah is the minimum distance between nodes.
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9.812
6 X34 7E3 X 1E -8

At > 7—‘”(Ah)2 = x 0.14% ~100 secs
6Ek

Note. The distance between two nodes can be determined by selecting the two nodes
/ and then picking the Utilities>Mesh>Distance between Nodes entry.

o In the "= Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Nonlinear & Transient from the Controls menu.

MNonlinear & Transient |

— Incrementation — Solution stategy

W Monlinear I Same as previous loadcase

Incrementation Im b ax number of iterations
Starting load factor |D1— Fesidual farce normn

tax change in load factor IUU— Incremental displacement nom 1.0
I ax total load factor I'ID— Advanced...

= i
I | Ediist |mad based on conyergence ~Incremental LUSAS file output

Iterations per increment I4 I” | Same as HTEVIGE [FanEase:
Advanced,. | Dutput file

Plat file

IEnnsnIidatinn "I Restart file
Initial tirne step |'| 0o b ax nurmber of saved restarts

Tatal rezpanze time I‘l E7 Lag file

¥ &utomatic time stepping Hiztary file

Advanced... |

W Time domain

TR

— Common ta all

& time stepz or increments ISEI
QK I Cancel Help

In the Incrementation section:

e Select the Nonlinear option and choose Manual incrementation.

e Select the Time domain option and chose Consolidation from the drop down list.
e Enter an Initial time step of 100

e Select the Automatic time stepping option.
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| File

Save

Running the Analysis

e Select the Advanced button in the Time domain section of the dialog.

e On the Advance time step parameters s RO CIEE S
dialog set the Time step increment =
C . Time step scale safety factor 0.9
restriction factor to 2 _ -
Time step increment restriction factor I 2
e Set the Minimum time step to 100 Minimum time step 100
i i Maximum time step I 1E7
e Set the Maximum time step to 1E7 R Sy S — o
e Set the Minimum time step for | T&mnatonvale [o0
termination to0 Expoment: For increasing time. step (CEE-FIFT IE.III
e Click OK to return to the Nonlinear Integration factor alpha [o0
and Transient control dialog. EplenEZEar I2E [Lo
Integration factor gamma I 0.5
e On the _ Nonlinear an_d Transient I Allow step reductions
control dialog set Max time steps or Maximum step reductions -
increments to 50
Cancel | Help |

e Click OK to set the loadcase control.

Saving the model

El Save the model file.

Running the Analysis

A

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to run
the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (2 Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U pwp.out this output file contains details of model data, assigned attributes
and selected statistics of the analysis.

U pwp.mys this is the LUSAS results file which is loaded automatically into
the Treeview to allow results processing to take place.
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| File
[New...
| File
| Script >
| Run Script...

2D Consolidation under a Strip Footing

If the analysis fails...

If the analysis fails, the output file will provide information relating to the nature of the
error encountered. Any errors listed in the output file should be fixed in LUSAS
Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O pwp_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as pwp

e To recreate the model, select the file pwp_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results.

Viewing the Results

Loadcase results can be seen in the ‘! Treeview and results for a nonlinear analysis the
last solver time step is set active by default.

o If present, turn off the Geometry, Mesh and Attributes layers in the [l Treeview.

Settlement

o Inthe™ Treeview, right-click on the first load increment Time Step 0 and select
the Set Active option to view results immediately after the loading is applied.

e Click the Deformations button in the Treeview and select the Specify factor
option. Specify a factor of 1 and click OK to visualise the deformed mesh for the
first time step.
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| Utilities

Graph Wizard...

Viewing the Results

prAa

A graph of the deformation over time will be created using the graph wizard.
e Zoom into the left-hand side of the Select this node

model and select the node on the

centre line at the centre of the

e With the Time history option ]
selected click Next

Firstly define the data to be used for
the X axis.

e Selected the Named option and
click Next

¥

e Select Response Time from the
drop down list and click Next

Secondly define the data for the Y axis.
e With the Nodal option selected and click Next

e Select Displacement from the Entity drop down list and DY from the Component
drop down list.

e The selected node number will appear in the Specified single node drop down list.
Click Next

For the X Scale enter Manual values of minimum 100 and maximum 10e6
respectively.

e Select the Use logarithmic scale option.
o Title the graph as Settlement under centre of footing

e Click Finish to display the graph of settlement over time under the centre of the
strip footing.
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2D Consolidation under a Strip Footing

Consalidation under a strip footing

oettlement under centre of footing

-0.45
0.5

085 [
0B i
-0.65

PR . S T R P,

Disp ¥ Made 18(16)

Response Time(15)
#-Disp ¥ Mode 18(16) / Response Time(13)

E Close the graph window
Maximise the graphics window.

Pore water pressure

The distribution of pore pressure is to be shown using contours.

Select the Contour Range tab and set the Interval to 250

With Time Step 0 set active in the (5 Treeview, and with no features selected, click
the right-hand mouse button in a blank part of the view window and select

Contours to add the contours layer to the 5= Treeview.

Select Displacement from the Entity drop down list and PRES from the component
drop down list.

Click the OK button to display contours of the undrained pore pressure distribution
(Time step 0) immediately after the loading is applied.
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| utilities

Graph Wizard...

Viewing the Results

Note. The dissipation of pore water pressure over time may be observed by creating
an animation of the contour display.

e To observe the distribution of pore water pressure at a particular time after the

application of loading activate the appropriate time step from the () Treeview by
selecting the time step with the right-hand mouse button and choosing the Set
Active option.

The dissipation of pore water pressure under the footing is to be presented on a graph.
e Select the node on the centreline under the footing as before.

e With the Time history option selected click Next

Firstly define the data to be used for the X axis:

e Selected the Named option and click Next

e Select Response Time from the drop down list and click Next

Secondly define the data for the Y axis:

e With the Nodal option selected and click Next

e Select Displacement from the Entity drop down list and PRES from the Component
drop down list.

e The extent to be graphed will be set to Specified single node and the node selected
will be seen in the Specify node field. Click Next
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| utilities

Graph Wizard...

2D Consolidation under a Strip Footing

e For the X Scale
ensure that
Manual values of

Consalidation under a strip footing

Dissipation of pare water pressure

e For the Y Scale
leave the values as a0n
the defaults.

minimum 100 and 2500
maximum  10e6 '
respectively  are 4
used. 2000 i
§ '

e Select the Use = 1500 i
Logarithmic > :

le opti E :

scale option = 1000 3

e Title the graph as o
Dissipation  of =] = =] = ] S
— (] - - — -—
pore water - = =
pressure -
Fesponse TimeH)

e Click Finish to _
display the -Node 18(10) / Response Time(H)

dissipation of pore water pressure over time under the centre of the strip footing.

E Close the graph window.
Maximise the graphics window.

As the pore water dissipates the load is carried by the soil. The increase in effective
stress in soil can be observed on a graph of effective stress against response time.

e Ensure the node on the centreline under the footing still selected.
e With the Time history option selected click Next

Firstly define the data to be used for the X axis

e Select the Named option and click Next

e Select Response Time from the drop down list and click Next
Secondly define the data for the Y axis

e With the Nodal option selected and click Next

e Select Stress - Plane Strain from the Entity drop down list and SY from the
Component drop down list.
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Viewing the Results

e The extent to be Consolidation under a strip footing
graphed will be

set to Specified
single node and
the node selected
will be seen in the
Specify node
field. Click Next

Effective soil stress

-1000

-1500

e For the X Scale -2000

ensure that
Manual values of
minimum 100 and
maximum  10e6
respectively  are

used. 23500
=
e Select the Use =

Logarithmic
scale option.

FREYEIT
|
i
i
i

[NERLN
FRYEIT

L1 N

atress 3% Mode 18(14)

1000
10000
100000

Response Time(13)
e For the Y Scale  -#Stress S Mode 18(14) / Response Time(13)
leave the values as
the defaults.
o Title the graph as Effective soil stress

e Click Finish to display the graph of the effective soil stress over time under the
centre of the strip footing.

This completes the example.
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2D Consolidation under a Strip Footing
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Description

Drained Nonlinear
Analysis of a
Retaining Wall

For software product(s): | Any Plus version.

With product option(s): | Nonlinear

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

The behaviour of a single
propped retaining wall is to
be investigated in the long
term. Drained  soil
parameters are used
throughout.

Horizontal displacement is
restrained at the left and
right hand edge and both
horizontal and  vertical
displacement is restrained at
the base of the soil as the
soil rests on solid rock.

The wall is ‘wished-in-place’
in that construction of the
wall is not modelled.

Units of kN, m, t, s, C are
used throughout.

Original ground lewel
20m —»‘
Excavation
t015.26m

Wall 1m thi
o
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&

Modelling

Drained Nonlinear Analysis of a Retaining Wall

Objectives
The required output from the analysis consists of:

U Displacement of the wall toe towards the excavation
O Surface heave immediately behind the wall

O Contours of plastic strain around the excavation

O Prop force per m length of wall

O Bending moment in the wall at 10m depth

Keywords

Retaining wall, Drained, Nonlinear, Excavation, Surface heave, Plane strain, Prop
force, Bending Moment

Associated Files

U drained_wall_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file.

Creating a new model

e Enter the File name as drained_wall.

e Use the Default working folder.

e Enter the title as Drained analysis of a propped retaining wall.

e Select model units of kN,m,t,s,C from the drop down list provided.
e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Set the startup template as None

e Select the Vertical Y axis option and click OK.
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| Attributes

[Mesh

| Surface...

| Utilities

| Variation...

Modelling

Note. Save the model regularly as the example progresses. Use the undo command
to undo mistakes as far back as the last save.

Mesh Definition

The surfaces are to be meshed using plane-strain quadrilaterals with a quadratic
interpolation order (QPNS).

e Select the Plane Strain, Quadrilateral, Quadratic elements. Ensure the Regular
mesh option is selected with Automatic divisions so that Modeller uses the mesh
divisions assigned to each line.

e Give the attribute the name Plane Strain quads and click the OK button to add the
mesh attribute to the &% Treeview.

e Inthe & Treeview click on the mesh attribute Plane Strain quads with the right-
hand mouse button and select the Set Default option. This will ensure all newly
created surfaces will be assigned the elements defined in this mesh attribute.

General Field Variations

The Young’s Modulus of the soil and the in situ stresses vary with depth and therefore
general field variations are required.

e Select General Field Variation and press Next.

e Enter the function as -6000*Y and the attribute name as y_maod for the definition of

Young’s Modulus with depth and click Apply to add the attribute to the &
Treeview and keep the dialog active.

e Enter a new function as 20*Y and the attribute name as sig_v for the definition of
vertical stress and click Apply.

e Enter a new function as 2*20*Y and the attribute name as sig_h for the definition of
horizontal stress and click Finish.

Note. The LUSAS convention assumes that negative stresses are compressive. The
Y coordinate datum is at ground level and so increasing depth will lead to increasingly
negative Y coordinates. The variations as entered will ensure that stresses increase
negatively with depth while the Young’s Modulus increases positively with depth.

Feature Geometry
e Turn off the display of the Mesh layer in = Treeview.
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| Geometry
Line
Coordinates...

\%

| Geometry
Surface >
By Sweeping...

| Geometry

Surface >
By Sweeping...

| Geometry
Point >
Move...

Drained Nonlinear Analysis of a Retaining Wall

il Enter coordinates of (0, 0), (20, 0), (21, 0), (25, 0) and (101, 0) to define four lines
representing the original ground level (all Z coordinates should be zero or left blank).
Use the Tab key to move to the next entry field on the dialog. When all coordinates

have been entered click the OK button.

e Press CTRL-A to select all the Lines just drawn.

él Ensure the Translate option is selected and enter a value of —-1.5in Y.

e Click OK to sweep the Lines to create the Surfaces.

Drag a box around these 4 Lines

e Select the bottom four horizontal Lines by dragging a box around them.

él Ensure the Translate option is selected and enter a value of —1.5in Y.

e Click OK to sweep the Lines to create the Surfaces.

Repeat the preceding commands eight times, selecting the bottom four lines of the
model each time and sweep the lines by -2.0, -2.13, -2.13, -2.0, -2.0, -2.0, -2.49 and

-2.25 metres in Y as shown above.

F .
Point B/\

e Select Point A shown.

ﬂ Ensure the Translate option is selected and enter a value of =81 in Y.

e Click OK to move the Point.
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Modelling

e Select Point B shown.

|GeF?(;nin‘:"y S I Ensure the Translate option is selected and enter a value of -33.25in Y.
Move... . .
e Click OK to move the Point.
e Select the two Lines shown. i
| Geometry . —
Surface S ﬁl Ensure the Translate option is
By Sweeping... selected and enter a value of —81 in
Y.
Click OK to sweep the Lines to
create the Surfaces.
Select these 2 lines
e Select the Point shown. y
|Ge;,’;:§"y S B ensure the Transtate option
Move... is selected and enter a value of 38

in X.

e Click OK to move the Point.

Select this point
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| Geometry
Line >
Points...
| Geometry
Surface >
Lines...
| Attributes
Mesh >
Line...

Drained Nonlinear Analysis of a Retaining Wall

e Select the two Points shown. %

il Create a Line between the
two selected Points.

Select these pagints

e Select the Line just drawn
along with the three Lines as
shown.

EI Create a Surface from the
four selected Lines.

%

@ Select'these 4 lines

Mesh Grading

e Define a Line mesh with element type None and 1 division.

e Enter the attribute name as Null 1 and click the Apply button to add the attribute to
the &% Treeview and keep the dialog active.
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Modelling

e Define a Line mesh with 5 divisions.

e Select the Spacing button.

e Select the Uniform transition option and set the Ratio of first to last element to 4
e Click OK to accept the spacing properties.

e Give the attribute name as Null 5 Graded and click Apply to add the attribute to
the &% Treeview and keep the dialog active.

e Define a Line mesh with 10 divisions.
e Select the Spacing button.

e Select the Uniform transition option and set the Ratio of first to last element to
0.2

e Click OK to accept the spacing properties.
e Give the attribute name as Null 10 Graded and click OK to add the attribute to the
c&; Treeview.

Assigning the mesh attributes

r———=7717

= ————————tH+HHA

Lines tp assign Null] dataset

e mmm e — -

e Box-select the lines as shown and assign the mesh attribute Null 1.
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Drained Nonlinear Analysis of a Retaining Wall

Note. The selection of some of the sets of lines as shown in the next two images is
best done by changing the selection cursor and additionally using a special keyboard
shortcut which causes any lines passing through a box-selection to be selected.

To prepare for this:

M Change the cursor to the Select Lines cursor.

e Hold down the ALT key and ,
box-select each set of s S
horizontal lines as shown in the t
preceding image and assign the : :
mesh attribute Null 5 Graded. —

Lines to assign Null 5 graded dataset

e Select the remaining lines as 3
shown and assign the mesh
attribute Null 10 Graded.

Note. See the Keyboard Shortcut
Guide for more details on the use of
keyboard shortcuts.
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| Attributes

Material >
Isotropic...

Modelling

e Turn on the Mesh layer in the &
Treeview to see the mesh.

\
\

Note. If the mesh is graded with the smaller elements at the wrong end of a line
reverse the line by selecting the line using the Geometry>Line>Reverse menu
selection. If errors have been made in mesh assignments simply re-select any lines with
an incorrect mesh assignment and re-assign the correct line mesh.

Material Properties

An isotropic elastic material will be used for the retaining wall while an isotropic
nonlinear material utilising the Mohr-Coulomb failure surface will be used for the soil.

With the Elastic tab selected enter the isotropic material properties for the wall as
Young’s Modulus 28E6 kN/m? Poisson’s Ratio 0.15 and Mass Density 2.03874
tonne/m°.

e Enter the attribute name as Concrete Wall.

e Click the Apply button to add the attribute to the & Treeview and keep the dialog
active.

e With the Elastic tab selected enter the isotropic material properties for the soil as
Young’s Modulus 1*y mod, Poisson’s Ratio 0.2 and Mass Density 2.03874
tonne/m®,

Note. The 1*y mod indicates that the Young’s Modulus is defined by a variation
scaled by a factor of 1. As an alternative to typing in the formula, enter 1 in the grid
location and click on the ® button. Select the y_mod variation from the drop down list.
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Drained Nonlinear Analysis of a Retaining Wall

e Click the Plastic option and from the Model drop-down list select the Mohr-
Coulomb (model 65) entry.

e Enter an Initial cohesion value of 0

e Enter an Initial friction angle value of 25

e Enter an Final friction angle value of 25

o Enter a Dilation angle value of 25

¢ In the tension section enter a Cohesion hardening value of 0

¢ In the tension section enter a Limiting plastic strain value of 1000
e Enter the attribute name as Nonlinear Soil

e Click the OK button to add the attribute to the & Treeview.

Tsotropic
Using the following properties
v Plastic [~ Creep [ Damage [~ Shrinkage [~ Viscous I Two phase
e Plasﬁcl
Model [Mohr-Coulomb (model 65) =l Value
Initizl cohesion 0
Initial friction angle 25
Final friction angle 25
Dilation angle 25
Tension
B Limiting
Cnhz‘.ufm plastic
strain
1 0 1000
Name | Nonlinear Soil j ﬂ (new)
oK | Cancel | Apply | Help

Assigning material properties

To assign the material properties groups will be used. Groups are very useful in
allowing features of the model to be turned-on and off to aid the assignment of
attributes or the viewing of results on selected features of the model.
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| Geometry
Group >
New Group...
| Geometry
Grou >
New Group...

Modelling

il Change the cursor back to the normal cursor.

o Select the ten surfaces that form the retaining wall as shown.

i

-

i
I
T
|
I
)
1
]
|
T
)
1
L

4

Surfaces to assign Concrete YVall materi

NOTE: Mesh not shown for clarity

Create a group containing the wall elements only and rename it Wall. Click OK.

e With the ten surfaces of the wall still selected drag and drop the material attribute

Concrete Wall from the &b Treeview onto the selection. With the Assign to
surfaces option selected click OK to assign the material attribute.

e Inthe L=l Treeview right-click on the Wall group and select Invisible.

o Select the whole visible model by pressing the Ctrl-A keys.

Create a group containing the soil elements only and rename it Soil. Click OK.

e Drag and drop the material attribute Nonlinear Soil from the & Treeview onto the
selection. With the Assign to surfaces option selected click OK to assign the
material attribute.

e Inthe L=l Treeview right-click on the Wall group and select Visible.

Supports

Define supports to prescribe zero horizontal displacement as well as zero horizontal and
vertical displacement.
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| Attributes

Support...

Drained Nonlinear Analysis of a Retaining Wall

Click on the option to fix the Translation in X.

Enter the attribute name as Fixed in X and click the Apply button to add the
attribute to the &% Treeview and keep the dialog active.

Click on the option to fix the Translation in Y.

Enter the attribute name as Fixed in X and Y and click the OK button to add the
attribute to the & Treeview.

Assign the supports to the model.

Select the vertical Lines on the left-hand side and right-hand side of the model and drag

and drop the support attribute Fixed in X from the & Treeview onto the selection.
With the Assign to lines option selected click OK to assign the support attribute to All
loadcases.

Select the 3 horizontal Lines representing the bottom limit of the soil and drag and
drop the support attribute Fixed in X and Y from the & Treeview onto the
selection. With the Assign to lines option selected click OK to assign the support
attribute to All analysis loadcases.

Select the Point which
represents the top-left
corner of the concrete
wall as shown and
drag and drop the
support attribute Fixed

in X from the &b
Treeview onto the
selection.  With the
Assign  to  Points
option selected click
OK to assign the
support attribute to All
analysis  loadcases.
This support
represents the prop.

S ;E
] Select this Paint
N, ““‘“‘*\
\ ~_|

- \

- \ .
- \

. YT i \T
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| Attributes

Modelling

| Loading...

| Attributes
| Loading...

Loading

The initial in situ ground conditions must be established in the first loadcase of the
analysis. This is carried out using a stress and strain type load and a gravity (body
force) load.

e Select the Stress and Strain option and click Next

e On the Stress and
Strain dialog ensure - Usage —
the Stress And Strain % Element descriplion = e h
Type is set to Initial € Paint € Line @ Surlace © Yolume giy 1*3‘09—"
. Select a Surface ™ Includs joints ESXZ 1*zig_h
element description [Prane st =l B
|3 dimensional j Ez

e Select Plane strain
from the drop down

" Element name

list |
. 5 d Sitrain T,
e Enter 1*sig_h for Sx. o
— * Initial

(This can be done ¢ Residual (NL o)
most easily by clicking
in the right-hand side Attt [in st svess ==
of the Sx field and
selecting the variation
attribute  from  the
drop-down list)

< Back | [Hexts | Finizh | Cancel | Apply | Help |

e Enter 1*sig_v for Sy.

e Enter 0 for Sxy

e Enter 1*sig_h for Sz. The remaining fields may be left blank (to signify zero)
e Enter the attribute name as In situ stress and click Finish.

e Select the Body force tab from the Structural Loading dialog and click Next
e Enter -9.81 in Linear acceleration in Y Dir.

e Enter the attribute name as Gravity and click Finish.

Assign the loads to the model.
The in-situ stress is to be assigned to the whole model:
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| Attributes

Drained Nonlinear Analysis of a Retaining Wall

| Birth and Death...

o Select the whole model by pressing Ctrl-A and drag and drop the loading attribute

In situ stress from the &b Treeview onto the selection. With the Assign to
Surfaces option selected rename the loading attribute to Loadcase 1 and click OK.

Gravity is assigned to the whole model

o With the whole model selected drag and drop the loading attribute Gravity from the

& Treeview onto the selection. With the Assign to Surfaces option selected click
OK to assign the loading attribute to Loadcase 1

e Inthe Treeview drag and drop the Geometry layer name beneath the Attributes
layer name.

Birth and Death

The Birth and Death feature must be used to simulate the removal of soil during
excavation in front of the wall. Excavation will take place over eight loadcases.

e Select the Deactivate tab and click Next. Select Percentage to Redistribute and
ensure the value is set to 100%. Enter the attribute name as Excavation.

e Click Finish to add the attribute to the c&: Treeview.
Assign the deactivation to the model.

e Use the zoom-in button to enlarge the view of the 4
top-left corner of the model.

e Select the top surface representing the first layer
of soil to be removed in front of the retaining wall
and drag and drop the deactivation attribute
Excavation from the & Treeview onto the
selection. With the Assign to surfaces option I
selected enter the Loadcase name as Excavation
to —1.50m and click OK to assign the attribute.

o Select the next surface down in front of the wall and drag and drop the deactivation
attribute Excavation from the & Treeview onto the selection. With the Assign to
surfaces option selected enter the Loadcase name as Excavation to —3.00m and
click OK to assign the attribute.

e Repeat this procedure, selecting the next surface down each time and renaming the
loadcases Excavation to —5.00m, Excavation to —7.13m, Excavation to —9.26m,
Excavation to -11.26m, Excavation to —-13.26m and Excavation to —15.26m
respectively. The adjacent image shows the final excavation assignment made.
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Running the Analysis

Note. Deactivated surfaces (and hence elements) can be visualised and checked by
/ setting each loadcase active in the (2 Treeview.

Analysis Control

The use of a Mohr-Coulomb nonlinear material in this example dictates that a nonlinear
analysis control must be specified.

e Inthe & Treeview right-click on Loadcase 1 and rename it to In situ

o In the "2 Treeview right-click on In situ and select Nonlinear & Transient from
the Controls menu.

In the Incrementation

Sectlon ~Incrementation — Solution strategy
¥ Morlinear IT| S ane &z previous loadtase

Se I ect the N on I | near Incle.mentalinn IManuaI j' Maw number of iterations 50

. Starting load factor IW Fiesidual force norm lnm—
Optlon A and C_hoose Max change in load factar ID Incremental displacement norm lnm—
Manual incrementation. Ra— e f—

vanced...
. [¥ | dilist oad based or convergeres Histan
In the Solution Strategy Iterations per inciement |4 - Incremental LUSAS file output
section: Options... Advanced... = Gone as previns lnadoase
Output file: 1

e Set the Max number [Trema <] Pitfle I

of iterations to 50. et [ Festat i E—

Tatal respons time IW
. ax number of saved restarts |0

e Set the Residual force = i e seppig st saeSiesiat

norm to 0.01. EEEmi e l1—

Hiztory file: 1
I ax time steps o increments ID 5
e Set the Incremental
. aK I C. | Hel|
displacement norm to | |

0.01.

e Click OK to set the loadcase control.

Saving the model

[File = | [S——

|Save

Running the Analysis

El Open the Solve Now dialog. Press OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.
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A

| File
[New...
| File
| Script >
| Run Script...

Drained Nonlinear Analysis of a Retaining Wall

If the analysis is successful...
Analysis loadcase results are added to the (5 Treeview

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U drained_wall.out this output file contains details of model data, assigned

attributes and selected statistics of the analysis.

U drained_wall.mys this is the LUSAS results file which is loaded
automatically into the Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, the output file will provide information relating to the nature of the
error encountered. A common mistake made when using LUSAS Modeller for the first
time is to forget to assign particular attribute data (geometry, mesh, supports, loading
etc.) to the model. Any errors listed in the output file should be fixed in LUSAS
Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If errors are listed that for some reason cannot be corrected, a file is provided to re-
create the model information correctly, allowing a subsequent analysis to be run
successfully.

U drained_wall_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as drained_wall

To recreate the model, select the file drained_wall_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results

Viewing the Results

Loadcase results can be seen in the (2 Treeview, and for a nonlinear analysis the load
case results for the last solved loading increment are set active by default.
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Viewing the Results

e |If present, turn off the Geometry, Mesh, Utilities and Attributes in the it
Treeview.

Wall Displacement

e In the ‘X! Treeview right-click on the results for Excavation to —13.26m and Set
Active.

e If not already on, add the Deformed mesh to add the deformed mesh layer to the
Treeview.

¢ In the panel at the bottom of the Treeview press the Deformations... button,
select the Specify factor option and specify a factor of 5. Press OK to return.

e Double click the View properties control in the Treeview. On the View tab
ensure the option to Show only activated elements is selected. Click OK to
visualise the deformed mesh for the active elements at increment 8, magnified by a
factor of 5.

b

[

f"il
/
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| utilities

Graph Wizard...

Drained Nonlinear Analysis of a Retaining Wall

A graph of the deformation of the wall toe will be created using the graph wizard.
e Zoom into the top left-hand side of the model and select the node at the wall toe.

e With the Time history option Select this node
selected click Next. Lﬁ

Firstly define the data to be used for
the X axis.

e Selected the Named option and
click Next.

e Select Loadcase ID from the drop |
down list and click Next.

Secondly define the data for the Y
axis.

e With the Nodal option selected and click Next.

o Select Displacement from the Entity drop down list and DX from the Component
drop down list.

e The selected node number will appear in the Specify node drop down list. Click
Next.

e Enter suitable text for the graph titles and click Finish to display the graph of
displacement of the wall toe towards the excavation.

Haorizontal displacerment of wall toe

0.2

015}
014

placermnent

onsfE---- S O S S S U S . S

Dis

0.2

= W W W
=t il

Loadcase ID
—#—Dizplacement X Mode 46003) / Loadcase 1D(7)

. E Close the graph window.
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| utilities

Graph Wizard...

Viewing the Results

. Maximise the graphics window.

Surface Heave
e Select the node at the top of the back of the wall.

e With the Time history option
selected click Next.

Firstly define the data to be used for 7 !
the X axis.

e Selected the Named option and  Selectthis node
click Next.

e Select Loadcase ID from the drop
down list and click Next.

Secondly define the data for the Y
axis.

e With the Nodal option selected and click Next.

e Select Displacement from the Entity drop down list and DY from the Component
drop down list.

e The selected node number will appear in the Specify node drop down list. Click
Next.

o Enter suitable text for the graph titles and click Finish to display the graph of heave
behind the wall.
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Drained Nonlinear Analysis of a Retaining Wall

Surface heave behind wall
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Loadcase ID
—#—Displacement ¥ Mode 7500107 / Loadcase 1D(E)

E Close the graph window then =J81%] maximise the graphics window.

Plotting contours of plastic strain in the soil

Because the model contains elements with two different material properties the active
set on which results are to be plotted must be selected.

In the Treeview right-click on the group name Soil and select Show Results >
Show Results Only On This Group

With no features selected click the right-hand mouse button in a blank part of the
graphics window and select Contours to add the contours layer to the [=¥ Treeview.

Select Plastic strain — Plane strain from the Entity drop down list and EPE from
the component drop down list.

Select the Contour Range tab and set the Maximum to 0.01 (1% strain).

Click the OK button to display contours of the plastic strain distribution around the
wall.
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Viewing the Results

Loadcase: §Excavation ta -13.26
Ertity: Plastic strain - Plane Strain
Component. EFE

0.0
1.25E-3
25E-3

3.75E-3
3 .0E-3
G.25E-3
7.5E-3
3.73E-3
0.

Msximum 0.375332 st node 301
Minimum 0.0 &t node 2

Prop Force

Turn off the display of the Deformed Mesh and Contours layers in the i
Treeview.

Turn on the display of the Mesh layer in the = Treeview.

In the Treeview right-click on the group name Wall and select Show Results >
Show Results Only On This Group

Right-click on the group Wall in the L=] Treeview and select Set as Only Visible.
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Drained Nonlinear Analysis of a Retaining Wall

e Select the node at the top-left of the wall
that is supported by the prop in the X T

direction. -
| utilities e With the Time history option selected click B
Graph Wizard... Next. ||

Firstly define the data to be used for the X axis.

e Selected the Named option and click Next. Select this node —

e Select Loadcase ID from the drop down list L
and click Next.

Secondly define the data for the Y axis. —
e With the Nodal option selected and click Next.

e Select Reaction from the Entity drop down list and RSLT from the Component
drop down list.

e The selected node number will appear in the Specify node drop down list. Click
Next.

e Enter suitable text for the graph titles and click Finish to display the graph of heave
behind the wall.

Prop force

1200
1100
1000
900
800
700
B0 |
500 |---
400 |-
300
200
100

Resultant Reaction

55 f--ie-

=

Loadcase [D(11)
—#—Resultant Reaction Mode 1(12) / Loadcase 1D(11)

Note. The resultant reaction has been graphed in the above figure. Since the wall is
/ propped only in the horizontal (X) direction at this location (see Supports section) there
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| Utiities

Viewing the Results

| Graph Through 2D...

is no reaction in the vertical direction and therefore the resultant reaction is identical to
the horizontal reaction.

. E Close the graph window.
. Maximise the graphics window.

Bending moment in the wall at 10m Depth

Because the model contains elements with two different material properties the active
set on which results are to be plotted must be chosen.

e Turn off the Deformed mesh layers in the Treeview, and restore the Geometry
layer by right-hand clicking on a blank area of the model view and selecting
Geometry.

e Ensure the Snap to grid option is selected and enter a value of 1 for Grid size.
e Click on OK.

e Draw a line with the mouse through the wall at 10m depth as shown.

e Select Resultant effects from 2D model and select Bending stress in the list and
click Next.
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Drained Nonlinear Analysis of a Retaining Wall

Slice Data
" Results component % Resultant effects from 2D modsk
Bl Im {° Fesultant effects fom slice
[ tean axial stress ;I

Eomponent] j‘ Bending stress
T i d [lActual axial stress
wl [ 1tean shear shess

[lactual shear stress

Argles.. | ;I

< Blark I Nest > I Cancel | Help |

e Enter suitable text for the graph titles and click Finish. A graph is drawn and the
bending moment (and other information) is displayed in the Text output pane.

*##% ) Forcez-Moment=s. Loadcase 8 Result=s File 1]
Axial Force Per Unit Width = =51 .20

Shear Force Per Unit Width = —-148 .6

Homent Per Unit Waidth = 4280.

Section Depth = 1. 000

Mean Hormal Stress Sz = =51 .20

Hominal Bending Stres=s = 0. 2568E+05

.. .done
1]

The bending moment reported is 4280 kN/m? per metre run of the wall.

This completes the example.
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Description

Embedded
Retaining Wall

For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.
With product option(s): | Nonlinear.

Description

An embedded retaining wall is Surcharge, g=10kN/m?
required to retain 6.5m of loose sand
along with an additional surcharge of

o VTV TV TV NV TNV
10kN/m% A 2D analysis is to be 2%
carried out with the soil represented ~m Loose sand
i~ present Prop v 1| y=12k/im?
by Tri-linear earth pressure joint g5, force 050
material for both an unpropped and a Ko=0.65
propped wall condition. Kp=2.75

The units of the analysis are kN, m, t,
s, C throughout.

Objectives

O To calculate bending
moment and shear forces in
the embedded wall and
ensure that deflections are
within serviceable limits.

U To investigate the effects of
installing a prop and
reducing the pile length.

Keywords

Embedded, Retaining, Wall, Trilinear Earth Pressures, Modulus of Subgrade Reaction,
Soil-Structure Interaction, Geotechnics
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Modelling

| Geometry

Point >
Coordinates...

Embedded Retaining Wall

Associated Files

U embedded_wall_modelling.vbs carries out the modelling of this example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller in
the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model
o Enter the file name as Embedded Wall

e Use the Default working folder.
e Enter the title as Embedded Retaining Wall Example
e Select units of kN,m,t,s,C

e Ensure that the Timescale units are Seconds, the Analysis type is Structural and
the Startup template is set to None

e Choose a vertical Y axis and click the OK button.
Note. Save the model regularly as the example progresses. Use the Undo button to

correct any mistakes made since the last save was done.

Defining the Wall Geometry

Enter coordinate (0, 0, 0) to define ground level and the top point of the wall. Click
the OK button to create a single point at the origin.

e Select the newly created Point.
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| Geometry
Surface >
Sweep...
| Geometry
Surface >
Sweep. ..
| Geometry
Surface >
Sweep...
| Geometry
Line >
Copy...
| Geometry
Line
Copy...
| Geometry
Line
Delete...

Modelling

ﬂl Sweep the selected point with a Y translation of -2.5 and click
the OK button to create the new Line.

e Select the newly created lower point

ﬂl Sweep the selected point with a Y translation of -4.0 and click
the OK button to define the new Line.

e Select the newly created bottom point

ﬁl Sweep the selected point with a Y translation of -20.0 then click
the OK button to define the new Line.

Note. Separate lines must be used to represent each change of soil
type.

Defining the Earth Geometry

The earth pressure acting on the wall is modelled using joint
elements connected between the wall itself and fixed supports.
Additional lines are required to assign the fixed sides of the joint
elements to.

Note. Joint elements should normally have a zero length,
however to reduced confusion from overlapping features during
definition they are usually initially located with a gap that is later
closed once the model has been setup.

e Select all lines and points (Ctrl + A)

ﬂ Copy all the geometry by 3.0 in the X direction and click
OK to define the retained soil.

e With the wall structure still selected:

ﬂ Copy all the geometry by -3.0 in the X direction and click
OK to define the retained soil.

E Select the upper two lines of the excavated side and delete them.
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Embedded Retaining Wall

The geometry is now complete. The central series of lines model the wall. The lines to
either side are used to model the soil. A load to model the propping force applied to the
upper part of the wall will be added to the model later in the example.

|File El Save the model file.

|Save

Meshing

model, the joint elements that the soil material will be assigned to must be orientated in

Note. Due to the underlying implementation of the Tri-linear earth pressure material
a specific way:

e For both 2D and 3D joint elements the joint element local x axis must align with
the horizontal and connect the support to the structure.

e For 2D joint elements the local y axis must be aligned to the model vertical axis
e For 3D joint elements the local z must be aligned to the model vertical axis.

Note that the model vertical axis is defined in the new model dialog and can be
accessed subsequently by the Utilities > Vertical Axis menu item.

Defining local coordinate systems

To ensure the joint elements are orientated correctly two local coordinate systems are
needed: one in the direction of the main model X axis, and one in an opposing

direction.
| Attributes e Create a local Cartesian coordinate system rotated O M
| Local Coordinates... degrees about the Z-axis with an Origin of (-3,0,0), enter P "‘1
the dataset name as Excavated and click Apply k < ,

e Create a second local Cartesian coordinate system rotated
180 degrees about the Z-axis with an Origin of (3,0,0),
enter the dataset name as Retained and click OK

Defining element types

The joint elements are required to have displacements in the u
and v directions to represent horizontal and vertical pressures.
For this 2D problem the JNT3 element with only translational
freedoms is sufficient.

| Attributes e Select the element type as Joint no rotational stiffness,
[Mesh > the number of dimensions as 2 dimensional and the
|Lne.. interpolation order as Linear. Select an Element length of
1.0. Enter the dataset name as Soil Mesh and click the OK

button.
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Modelling

The wall requires thick beam elements:

| Attributes o Select the element type as Thick beam, the number of dimensions as 2 dimensional
Wesf‘—> and the interpolation order as Linear. Select an Element length of 1.0. Enter the
lLee.. dataset name as Thick Beam and click the OK button.

Assigning the elements

The wall is meshed first, and the joint elements are then assigned between the lines
representing the soil and the wall.

o Select the three central lines representing the wall and drag the dataset Thick Beam

the c&n Treeview onto the model.

e Select the left-hand line representing the excavated earth and
then, at the same time, also select the corresponding adjacent

line of the wall. Drag the dataset Soil Mesh from the
Treeview onto the model. In the Line Mesh Assignment dialog,
select Excavated from the specified local coordinates list and
ensure Mesh from master to slave is selected. Click OK to
complete the assignment

-

To assign the mesh for the retained side:

o Select the three central lines representing the wall.

Note. To make joint mesh assignments to sets of multiple lines the
/ selection memory must be used:

| Edit Add the lines to the selection memory.
| Selection Memory >
Set e Select the three lines on the far right representing the retained

soil. Drag the dataset Soil Mesh from the & Treeview onto the
model. In the Line Mesh Assignment dialog, select Retained
from the specified local coordinates list and ensure Mesh from
master to slave is selected. Click OK to complete the
assignment

T, A

| Edit This clears the selection memory.

Selection Memory >
Clear

Note. If necessary the joint element axes can be visualised and checked by editing the
/ Mesh layer properties (double-click the Mesh layer name in the Treeview) and selecting
Show element axes.
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| utilities
Section Property
Calculator >
Rectangular
Sections >
Solid...
| Attributes
Geometric >

Section Library...

| Attributes
Material >
Material Library...
| Attributes
Material >
Joint...

Embedded Retaining Wall

Geometric Properties

Geometric properties are visualised by default.

ll Select the fleshing on/off button to turn-off the geometric
visualisation.

name of Wall, ensure Add to local library is selected and

Enter a depth D of 0.5 and a breadth B of 1.0. Enter a dataset k
click the OK button.

In the Geometric Line dialog select 2D Thick Beam for the
usage, select User Sections in the top right list and dataset
Wall from the available Local sections. Enter the dataset Wall
1m run and click OK to create the geometric attribute.

Select the three lines representing the wall and drag the

geometric attribute Wall 1m run from the &b Treeview onto
the model.

In the Treeview re-order the layers so that the Attributes
layer is at the top of the Treeview, followed by the Mesh layer,
followed by Geometry layer.

Material Properties

Select material Concrete EU from the from drop-down list, select grade EN1992-1-

1 Table 3.1 fck=40MPa and click OK to add the material dataset to the c&n
Treeview.

Select the three lines representing the wall and drag and drop the geometry attribute

Isol (EN1992-1-1 Table 3.1 fck=40MPa) from the & Treeview onto the selected
lines.

In the Joint Material dialog select Trilinear Earth Pressure and select Next. Three
earth pressure material attributes are required: one for the Loose Sand, and two for
the Dense Sandy Clay (where one is for the retained side and one is for the
excavated side). All materials are to be defined for use with Two dimensional joint
elements with the defining geometry being Lines.
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Modelling

To create the Loose Sand material, enter the following properties:

Datum used for the calculation of effective overburden pressure | Zo 0.0
Surcharge (vertical load per unit area) q 10.0
Unit weight of soil Y 12.0
Angle of shearing resistance between soil and structure {3 0.0
Coefficient of passive earth pressure Kp 2.75
Coefficient of passive earth pressure due to cohesion Kpc |0.0
Cohesion c' 0.0
Coefficient of at-rest earth pressure Ko 0.65
Coefficient of passive earth pressure due to cohesion Ka 0.20
Coefficient of active earth pressure due to cohesion Kac 0.0
Empirical constant used in calculation of kh A 1E3
Empirical constant used in calculation of kh B 250.0
Empirical constant used in calculation of kh K 1.0
Soil width Weff | 1.0

Observing the local coordinate system established for the retained side, select
Active pressures to define just what the positive displacement of the local x axis
mobilises (i.e towards the wall) and Matches gravity (points down) to define just

what the positive direction of the local y axis represents.

Deselect Consider angle of structure, enter a dataset name of Loose Sand

Retained and click Apply to create the attribute.

Then, change the parameters to the following:

Datum used for the calculation of effective overburden pressure | Zo -6.5
Surcharge (vertical load per unit area) q 88.0
Unit weight of soil v 17.0
Angle of shearing resistance between soil and structure d 0.0
Coefficient of passive earth pressure Kp 3.0
Coefficient of passive earth pressure due to cohesion Kpc ]0.0
Cohesion c' 0.0
Coefficient of at-rest earth pressure Ko 0.5
Coefficient of passive earth pressure due to cohesion Ka 0.33
Coefficient of active earth pressure due to cohesion Kac |0.0
Empirical constant used in calculation of kh A 1E3
Empirical constant used in calculation of kh B 250.0
Empirical constant used in calculation of kh K 1.0
Soil width Weff | 1.0
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Embedded Retaining Wall

e Enter a dataset name of Dense Sand Retained and click Apply to create the
attribute.

Finally, change the Surcharge value to 0.0 and observing the local coordinate system
established for the excavated side, ensure Active pressures is set to define just what the
positive displacement of the local x axis mobilises and select Opposes gravity (points
up) to define just what the positive direction of the local y axis represents. Leave any
other settings unchanged. Change the dataset name to Dense Sand Excavated and click
Finish to create the final soil material attribute.

Note. When creating soil layers, if a different soil weight is used for each layer the
overburden pressure from any soil layers above must be calculated manually and
entered as a surcharge. Where all layers have the same unit weight the datum for each
layer can be the same (that is, ground level) remembering that any additional surcharge
(q) at ground level needs to be included in the definition of all lower layers. In this
example the dense sandy clay on the retained side was given a surcharge of 88kN/mz2,
This was calculated from the depth of sand above plus the applied surcharge such that g
=6.5x12 + 10 = 88

e Select the upper two lines representing the loose sand on the retained side of the
wall (not the wall itself) and drag the material attribute Loose Sand Retained from

the e?b Treeview onto the model.

e Select the bottom line representing the dense sand on the retained side of the wall

and drag the material attribute Dense Sand Retained from the &b Treeview onto
the model.

e Select the line representing the dense sand on the excavated side of the wall and

drag the material attribute Dense Sand Excavated from the &% Treeview onto the
model.

Note. Earth pressure joint material attributes are held in the & Treeview. Context
menu entries named Edit Definition... and Edit Attribute... can also be seen by right
clicking on an attribute.

Note. Selecting the Edit Definition... menu entry or double clicking the attribute name
displays the original definition dialog with all the original input data for viewing or
editing.

Note. Selecting the Edit Attribute... menu entry displays the joint type and stored
piecewise linear joint material values that are used to define the earth pressure joint
material. These values may be changed but the link to the original definition dialog will
be broken.
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| Attributes

Modelling

| Support...

| Attributes

| Support...

| File

|Save

Supports

'y
For the wall it is assumed that a supported end condition exists. T—»

e Select a Fixed translation for the Y axis, enter a dataset name of
Fixed in Y and click OK to create the attribute.

e Select the point representing the bottom of the wall then drag the

support attribute Fixed Y from the the & Treeview onto the
model.

The Trilinear earth pressure material generates forces in the joint
elements appropriate to the position (depth) of the joint element in
the model. These forces must be resisted by supporting the free end
of the joint elements.

e Select Fixed translations for the X, Y and Z axes, enter a dataset
name of Fixed and click OK to create the attribute.

e Select the lines representing the excavated and retained soils and

drag the support attribute Fixed from the &b Treeview onto the
model. Accept the defaults in the assignment dialog.

Setting the Analysis

The Trilinear earth pressure material is a nonlinear material and therefore a nonlinear
analysis is required.

e In the Analyses (L) Treeview, right click on Loadcase 1. From the Context menu
select Controls > Nonlinear and Transient

¢ In the Nonlinear & Transient dialog check the Nonlinear check box and select the
OK button to return to the model.

Saving the model

El Save the model file.

Caution. For ease of definition the joint elements used have been inserted into the
model a set distance away from where they will be acting and, as a result, they have a
non-zero length. Prior to an analysis taking place, the lines and points representing the
soil should normally be set to be unmergeable prior to being moved to overlay the line
representing the wall. For some modelling situations the use of joint elements with a
non-zero length will produce unreliable results, and in general joint elements should
always be modelled with a zero-length. For clarity in this example merging has been
omitted, as there is no significant difference in the results obtained.
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Embedded Retaining Wall

To model joints with zero-length

To correctly model the soil joints the joint elements would normally be modelled with
zero-length. For this example this would be done as follows:

e Select the lines on either side of the wall that represent the soil.
e Select Geometry > Line> Make unmergable

e Select Geometry > Point> Make unmergable (because making a line unmergable
does not make the points defining it unmergable too.)

e Select the left-hand line representing the soil and select Geometry > Point> Make
unmergable and move the line 3 metres in the X direction

e Select the right-hand lines representing the soil and select Geometry > Point>
Make unmergable and move the line -3 metres in the X direction

e Save the model with an appropriate filename.

Running the Analysis

A

With the model loaded:

El Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

Note. For this analysis the use of non-coincident joints (i.e. omitting the merge step)
and linear beam elements within a nonlinear analysis will cause warnings to be written
to the text output window. These warnings can be ignored.

If the analysis is successful...
Analysis loadcase results are added to the () Treeview

In addition, 2 files will be created in the Associated Model Data where the model file
resides:

U Retaining Wall~Analysis 1.out this output file contains details of model
data, assigned attributes and selected statistics of the analysis.

U Retaining Wall~Analysis 1.mys this is the LUSAS results file which is

loaded automatically into the () Treeview to allow results processing to take
place.
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| File
[New...
| File
| Script >
| Run Script...

Viewing the Results

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

0 embedded_wall _modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as Embedded Wall

e To recreate the model, select the file embedded_wall_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the @ Treeview.

A Deformed mesh layer will be added to the Layers [ Treeview:

e Double-click on the the Deformed WEEES
Mesh layer in the 5 Treeview and in  omer ™ |wsseel
the Mesh tab set the pen to be blue ¥ wirsfrome  pen# [3 =] [EEE] Chasse pen... |

I soid B vemmches [E00 o
1 i ™ Hidden parts ¥ Doted
* Turn Othe Dlagrams Iayer In the ™ show nodes I outline only Thrashnld|25-0 %
Layers Treeview. In the Diagrams
Propertles dlalog Set the Entlty tO % of elements remaining | 100.C
Force/Moment — Thick 2D Beam and cobouwrby [rencoor =] o |
the Component to Mz

Close | Carncel | Apply: | Help I

e In the panel at the bottom of the Layers
Treeview, tick Window Summary.
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| File
| Save

| Attributes
| Loading...

| Analyses
| Loadicase...

Embedded Retaining Wall

A maximum Bending Moment of 343kNm can be seen to occur in the retaining wall.

Double click the Diagrams item in the Layers [=F Treeview. In the Diagrams Properties
dialog set the Entity to Force/Moment — Thick 2D Beam and the Component to Fy

A maximum Shear Force of 78kN is seen to occur in the retaining wall.

El Save the model file.

Turn on the Values layer in the Layers Treeview. In A

the Values Properties dialog set the Entity to 4\@
Displacement and the Component to DX | 9

On the Values Display tab check Show values of
Selection, check the Deform option, set a font Angle of
45°, click the choose font button and select a font size of
16, click the OK button to return to the Properties dialog
and click the OK button again to return to the model.

Select the top-most node of the deformed mesh to display
the maximum deflection. A maximum deflection of
100mm is seen to occur.
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In the Layers Treeview turn-off the display of the .
Diagrams, Values and Deformed mesh layers. *
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Loadcase 2: Adding a propping force

For this example the previously calculated deflection of the wall has been considered to
be too large and the wall is to be propped at a depth of 2.5m from the top of the wall.
The propping force will be modelled using a concentrated load that will be increased
incrementally to calculate the propping force required to reduce the deflection to
30mm. The calculated propping force can then be used to design the anchoring system.

Select Concentrated and click Next

Enter a value of 10 in the X direction, enter a dataset name of Prop Force and
click the Finish button to create the attribute

Click OK to create a second loadcase with the default name Loadcase 2
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Viewing the Results

Select the prop point on the wall at (0,-2.5). Drag and drop

the loading dataset Prop Force from the &b Treeview onto
the model »

In the Loading Assignment dialog select Single loadcase,
select Loadcase 2 from the Loadcase list and ensure that »
Set as active loadcase is checked. >

Click the OK button to make the assignment

In the Analyses C Treeview, right click on loadcase 2.
From the Context menu select Controls > Nonlinear and
Transient

In the Nonlinear & Transient dialog check the Nonlinear check box and select
Automatic Incrementation.

Set the Starting load factor to 1.0, set the Max change in load factor to 1.0 and
the Max total load factor to 10.0

Click the OK Button to make the changes and return to the model.

El Select the Solve Now button from the toolbar and click OK to run the analysis.

Loadcase results for Analysis 2 will be added to the () Treeview. The last solved
nonlinear increment (Load factor = 10.0) will be set active by default.

Designing the wall

In the Layers Treeview turn-on the display of the Diagrams, Values and
Deformed mesh layers.

With the top node of the wall selected (and the values still set to display the
horizontal displacement), set each of the load increments (load factors) of Loadcase
2 active in turn to investigate the effect of applying different prop forces to the top
of the wall.

From examination it can be seen that a 30mm top of wall displacement is achieved at
Increment 6. This increment has a load factor of 5.0 leading to a required propping
force of 5x10 = 50kN.

Double click the Diagrams layer in the Layers Treeview. In the Diagrams
Properties dialog set the Entity to Force/Moment — Thick 2D Beam and the
Component to Mz
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| Geometry
Point >
[Move...
| utilities
Mesh >
Mesh lock...
| File
Save As...

Embedded Retaining Wall

The moments in the wall can now be seen to be significantly Q
reduced, with the maximum being 78kNm b"-é{\

Note. This example shows a prop force applied externally to the L»
wall. If a soil anchoring system were to be used to provide the -
restraint, a different modelling approach would be necessary. In T
addition, the propping force required to reduce the wall -
deflections may not be achievable in practice due to the soil type. N
In this case the design may require some iteration and re-running
of the analysis to achieve acceptable forces, moments and
deflections.

Once suitable deflections and design forces have been established — —
the required length of pile can be determined by reducing the ™
embedded length and ensuring the effect on the required
deflection is acceptable.

An initial estimate of the reduction can be sought by considering
where wall forces become negligible. To do this a diagram of
Shear force in the wall is to be plotted.

e In the Diagrams Properties dialog set the Entity to
Force/Moment — Thick 2D Beam and the Component to Fy

By inspection the shear within the wall for the bottom 5m length
is negligible and can be removed. |

ﬂ Select the bottom three points of the model and enter 5 in Y translation. Click OK
to reduce the wall depth.

Note. Because results are currently loaded whilst the geometry has been modified, the
mesh will have been locked and the updated joint mesh arrangement will not be
immediately visible. The me4sh assignments will still be present for those lines and the
model will solve, but to see the updated mesh arrangement the mesh can be unlocked
prior to a re-solve taking place:

This will display the updated mesh arrangement.

El Save the model file with a different name, such as embedded_wall_reduced.mdl if
desired.

El Select the Solve Now button from the toolbar and click OK to re-run the analysis.
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Viewing the Results

e With the top node of the wall selected and the values layer still set to display the
displacement in X, set each of the load increments (load factors) of Loadcase 2
active in turn to investigate the effect of applying different prop forces to the top of
the wall.

From examination it can be seen that a 30mm top of wall displacement is still achieved
at Increment 6 so the reduction in length has not altered the top of wall displacement.
Maximum bending moment in the wall is similarly unaltered at 77kNm.

Further reduction in embedded length maybe possible by repeating the previous steps
and ensuring deflections remain suitable.

This concludes the example.
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Description

Trapezoidal earth
dam with drainage

toe

For software product(s):

Any Plus version

With product option(s):

Nonlinear, Dynamic, Thermal, Heat of hydration

Description

This example illustrates water seepage through a trapezoidal earth dam to drain in the
granular filter in the downstream toe. The flow unconfined, with the dam built on an

impermeable foundation.

On the upstream side, the water is at the reservoir level of 12m which results in
equipotential line along AB with maximum head of 12m. The filter drain on the
downstream side is considered fully effective.

The modelling units used are N, m, kg, s, C throughout.

Partially Saturated Sand

SIS SA ]
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Trapezoidal earth dam with drainage toe

Objectives
The required output from the analysis consists of:
U The calculation of steady-state seepage flow through the body of the dam.

U Contours of pore water pressures.
[

Keywords

Pore Pressure, Two Phase Material, Consolidation, Geostatic step, Transient,
Seepage

Associated Files

H U earth_dam_modelling.vbs carries out the modelling of the example.
i

Discussion

Not all the flow networks of an earth dam are known from the beginning. The free flow
surface, or top flow line (where the pressure is atmospheric), can only be approximated
when using hand methods. The uppermost flow line inside an earth dam follows a
parabolic path, which is corrected to be tangential to the upstream slope and discharge
surface, as well as at different material boundaries. Earth dams almost always include
drainage filters (having a large value of permeability) positioned in the downstream
slope to keep seepage entirely within the dam, and prevent erosion of the downstream
surface.

There are two basic assumptions in such analyses:

a) Between two consecutive points of equipotential lines in contact with the free
surface there is a constant piezometric difference

b) At the point that the flow from the upstream side to the downstream side begins,
the upper most flow line is positioned perpendicular to the upstream slope of the
dam

Modelling

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.
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| Geometry
| Surface >
Coordinates...
| Geometry
Point >
Coordinates...
| Geometry
Surface >
Points...

Modelling

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as Earth_dam

e Use the Default working folder

o Enter the title as Trapezoidal earth dam with drainage toe

e Select units of N, m, kg, s, C

e Select a timescale unit of Days

e Ensure the Structural analysis type is selected.

e Select a startup template of None

e Select the Vertical Y Axis option.

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to

correct any mistakes made since the last save was done.

Defining the Geometry

X Y

J Enter the following coordinates to define the partially

saturated sand part of the dam. 0.0 0.0

17.8064 12.0

19.0345 | 12.8276

23.5862 | 12.8276

36.2038 | 4.34484

33.5172 0.0

El Enter the following coordinates (42.6207, 0.0) to define the downstream toe point.

J Holding down the P key to ensure only points are selected, box-select the three
points that form the bottom-right corner (Points 7, 6 and 5) in order to create the filter
discharge surface.
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Trapezoidal earth dam with drainage toe

P4

il 6 P7
Defining and Assigning Mesh Attributes
| Attributes e Select Plane strain two phase elements types with Quadrilateral shape and
I% Quadratic interpolation order (QPN8P elements).
urrace. ..

e Unselect Automatic mesh, tick Element size and enter 0.5
o Enter the attribute name as QPN8P 0.5m and click OK

e Select the two surfaces on the model and drag and drop the QPN8P 0.5m mesh
from the Treeview onto both surfaces.

,0"::'0'
o ‘v
SIS
S
peSete et titie
SIS
SIS SR SN Ly
SRS SEOs S
% Q‘&O‘«»o}"&& XL
e riuunt et et 1
e

."'":'.:::.:':.::E:..;'%‘%&‘
Material Properties
| Attributes Two different materials need to be defined; one for the partially saturated sand and one
Material > for the filter. For this example both materials need two phase properties defined.

Isotropic...

Two-phase material properties are required when performing an analysis in which two-
phase elements are used to define a drained and undrained state for soil.

e With the Elastic tab selected enter a Young’s modulus 1.0E9, Poisson’s ratio 0.2
and Mass density 2.0E3.
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Modelling

e Tick Two phase option and select the Two phase tab. Ensure the Partially
drained option is selected, and enter the Bulk modulus of fluid phase as 1.0e9, the
Porosity of medium as 0.333333, the Unit weight of fluid as 10.0e3 the Hydraulic
conductivity in every global direction as 0.152e-3, the Density of the fluid as 1.0e3
and the Degree of saturation to be considered as fully saturated as 1.0.

[™ Plastic [~ Creep [~ Damage [~ shrinkage [~ viscous [+ Two phase

'Elastic Two Phase |

" Undrained Value
. . ; Bulk modulus of solid phase ]
P e Bulk modulus of flud phase 1069
" Piecewise linear partially drained Porosity of medium 0333333
Unit weight of fluid 10.0e3
Define curves... | Hydraulic conductivity in global X direction 0.152e-3
Hydraulic conductivity in global ' direction 0.152e-3
I Incompressible solids Hydraulic conductivity in global Z direction 0.152e-3
Density of fluid 1.0e3
Imeducible saturation 0.0
Degree of saturation to be considered as fully saturated 10

Mame | Partially Saturated Sand j ﬂ (new)

OK | Cancel | Apply | Help |

Note: Usually the value of Bulk modulus during the solid phase is substantially larger
than the fluid phase, and therefore does not typically form part of the geotechnical
testing. If the bulk modulus of solid phase is left as 0, LUSAS assumes an
incompressible solid phase.

Note: All time dependent material units (e.g. Hydraulic conductivity) are entered as
model units (i.e. seconds). The timescale units are only used when defining analysis
properties, such as nonlinear timesteps. The units expected by each input are shown as a
tooltip.
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| Analyses

Loadcase...

Trapezoidal earth dam with drainage toe

Press Define Curves to define a
new pressure-effective saturation
curve.

Enter the Rate of water extraction
as 1.3774, the Weight factor as
1.0 and the Air entry to -
0.261097.

Press OK to leave the curve
definition dialog.

Enter the Name of the newly
defined material as Partially
Saturated Sand and press Apply

Draining curve
Value
Rate of water extraction 1.3774
Weight factor 1.0
Air entry -0.261097
| Permeaility 0.0
¥ Filling curve is same as draining curve
" sSpedify filing curve
Scanning curve factor I 0.01
Value
Rate of water extraction 1.3774
Weight factor 10
Air entry 0261097
Permeability 0.0

To define the granular filter material; in the Two Phase tab, change the Hydraulic
conductivity to 1.0 in all three global (X, Y and Z) directions.

Change the attribute name to Filter and press OK

Assign the two attributes to their corresponding surfaces by dragging and dropping

them onto the relevant features.

Loadcases

to Initial Condition

Add a second loadcase, changing the name to Seepage and press OK.

The geometry specified for the dam represents the as-constructed state, prior to any
settlement and the filling of the reservoir. A geostatic loadcase will be used to model
the initial stresses in the earth structure (due to self-weight) without any deformation. A
second loadcase will then be used to apply the hydrostatic water pressure to the ‘as-
constructed’ dam.

o Inthe ™ Treeview right-click on Loadcase 1 and click rename. Change the name
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| Attributes

Modelling

[ Supports. ..

| Attributes

[ Supports. ..

Supports

Using two consecutive loadcases requires support attributes to be defined to both add
and remove the restraint to the model for each stage.

During the Initial Condition (geostatic) stage pore-water will be allowed to flow freely
through the dam to prevent the build-up of pore pressure during the construction stage.

e Leaving all other degrees of freedom Free, set Pore pressure to Fixed. Enter the
name of the support as Free Flow then press Apply to define a constant (zero)
pressure attribute.

e Switch the X and Y translation freedoms to Fixed. Change the attribute name to
Fixed XY (Free Flow) and press OK to define a fixed structure support.

Once the support attributes have been defined, they must be assigned to define the
initial condition.

o Inthe 'Z Treeview right-click on Initial Condition and press Set active

o Select both surfaces and, from the & Treeview, drag and drop the support attribute
Free Flow onto the model. Press OK to assign the support.

o Select the two bottom lines of the dam, and assign the Fixed XY (Free Flow)
support attribute. Press OK to assign the support.

During the seepage stage the pore pressure will be allowed to build-up within the
structure, with flow restricted to the drainage filter material in the downstream toe.

e Leaving all degrees of freedom Free (including Pore pressure). Enter the name of
the support as Seepage Flow and press Apply to define a ‘freeing’ support.

e Change the X and Y translation freedoms to Fixed and enter the name as Fixed XY
(Seepage Flow). Press OK to define a structural support that restricts flow.

Nonlinear analyses inherit support conditions from the previous stage. These new
support attributes are therefore used to free the Pore pressure fixity where required.

o Inthe "= Treeview right-click on Seepage and press Set active

e Select both surfaces and, from the & Treeview drag and drop the support attribute
Seepage Flow onto the model.

e In the Assign support dialog choose the From loadcase option, and select the
Seepage loadcase. Press OK to assign.
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| Attributes

Trapezoidal earth dam with drainage toe

[ Loading...

o Select the left-hand bottom line of the dam (i.e. not within the filter), and assign the
Fixed XY (Seepage Flow) support attribute, the ensuring From loadcase option
and Seepage loadcase are selected in the Assign support dialog.

There is no need to assign a new support attribute to the line at the bottom of the filter
material, as the required support, assigned in the previous loadcase (structurally fixed
with free flow), will carry forward.

Structural Loading
The effects of the self-weight of the dam will be modelled throughout this analysis and
can be applied as directly to the analysis.

o In the *X Treeview right-click on Analysis 1 and select Gravity

For this analysis it will be assumed that the reservoir retained by the dam does not drain
significantly due to seepage, or emptying, and therefore the total pressure head can
remain fixed at 12m.

¢ In the Prescribed section select Displacement, click Next and in the Pore pressure
select the Fixed radio button and click the 3 button in the Displacement field.

¢ In the Unit Converter and Variation Utility dialog, select New... from the Variation
drop-down menu to open the Variation dialog.

e Select General Field Variation, click Next and enter 12-y in the function field.
e Click Function limits, then tick Max. x coordinate and enter a value of 17.8065

e Click OK, ensure Global Coordinates is selected, enter Hydrostatic Variation as
the name and click Finish to exit the dialog.

e To convert the variation, defined in m-
head, to hydrostatic pressure, select kN/m? - [Fumit converter
from the Unit converter options. Then Frrei
enter a value of 10 in the Convert from [10.0 [lomz =]
box. and click OK

To model units
| 10.0E3 |

e Name the attribute Hydrostatic Pressure
and click Finish J—Variah’on

x |Hydrostatic Variation j

Cancel Help |
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Modelling

e Select the bottom line of the upstream slope of the dam (line 1) and from the &
Treeview and drag and drop the loading attribute Hydrostatic Pressure onto the
selected line, ensure the loadcase Seepage is selected, then click OK

Nonlinear Control

Use of Geostatic steps and two-phase consolidation materials are inherently non-linear.

o Inthe "= Treeview right-click Initial Condition and select the Nonlinear &
Transient option from the Controls menu.

A % Nonlinear and Transient entry will be added to the Treeview. Double-clicking on
this entry will allow any changes to be made to the control properties.

¢ Inthe Nonlinear & Transient dialog select the Nonlinear option in the top-left hand
corner and leave the incrementation type as Manual

e Select the Geostatic step option.

e Change the Incremental displacement norm to 0. This leads to convergence being
assessed based on the (total) Displacement norm. Click OK to exit the dialog.

Note: Most geotechnical problems begin from a geostatic state where the undisturbed
soil or rock body remains in equilibrium with the prescribed boundary conditions and
geostatic loads, including gravity. The geostatic step produces zero deformations, but
establishes the initial stress field that can be used in a subsequent static or coupled field
diffusion/stress analysis.

o Inthe = Treeview right-click on Seepage and select the Nonlinear & Transient
option from the Controls menu.

e In the Nonlinear & Transient dialog select the Nonlinear option and leave the
incrementation type as Manual

e Select the Time domain option and select a Consolidation time domain. Enter the
initial time step as 0.01, the total response time as 30 and the maximum number of
time steps as 30. Note that analysis time is measured in days, which was the
timescale option set when creating the model.

e Tick the Automatic time stepping option, press Advanced and change the Time
step increment restriction factor to 5.0 and the Maximum time step to 5.0. As
consolidation/seepage effects decay exponentially this will allow the time interval to
grow accordingly. Press OK to exit the dialog.

e Ensure the Solution strategy is set to Same as previous loadcase
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| File

A

Trapezoidal earth dam with drainage toe

[New...

e Having set all the Nonlinear & Transient options select OK to return to the
Modeller graphics window.

Running the Analysis

El Open the Solve Now dialog, ensure Analysis 1 is selected and press OK to solve.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (2 Treeview.

In addition, solution files will be created in the Associated Model Data\Earth dam
folder.

U Earth_dam.dat this data file contains details of model data and assigned
attributes.

U Earth_dam.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U Earth_dam.mys this is the LUSAS results file from the analysis which is
loaded automatically into the () Treeview to allow results to be viewed.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered is written
to the output files in addition to the text output window. Any errors listed in the text
output window should be corrected in LUSAS Modeller before saving the model and
re-running the analysis.

Rebuilding the Model

If errors have been made in the modelling of this example that for some reason you
cannot correct, a file is provided to re-create the model information correctly, allowing
a subsequent analysis to be run successfully.

0 earth_dam_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as earth_dam

478



Viewing the Results

| File e To recreate the model, select the file earth_dam_modelling.vbs located in the

Script 2 \<LUSAS Installation Folder>\Examples\Modeller directory.
Run Script...

;l Run the analysis to generate the results.

Viewing the Results

Analysis loadcase results for each time step are present in the () Treeview.

Viewing the Initial Stress Distribution

Two steps take place in Initial Condition; a first increment and then the Geostatic step.

o In the ' Treeview right-click on the Initial Condition result-set for Increment 1
and Set Active.

o Inthe =" Treeview turn-off the Mesh and Attributes layers.

e In the panel at the bottom of the Treeview press the Deformations... button,
select Specify factor enter a factor of 2.0e3 and press OK.

e With no features selected right click in a blank part of the Graphics window and
select the Contours option to add the Contours layer to the I=* Treeview.

e On the dialog set the results entity to Stress — Plain Strain and component SY, then
press OK.

The results from Increment 1 show how the structure would behave if gravity was
applied to the structure immediately after a wished-in place construction. This is used to
get the ‘in-situ’ stresses then used for the Geostatic step.
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Trapezoidal earth dam with drainage toe

o Inthe = Treeview right-click on the Initial Condition result-set for Geostatic Step
and Set Active.

In the Geostatic Step loadcase, the deformations are set to zero (to match the as-built
geometry) with in-situ stresses maintained
Viewing the Phreatic Line Development

o In the ‘& Treeview right-click on the Seepage result-set for Time Step 1, and Set
Active.

o Inthe =" Treeview switch off the Deformed Mesh layer.

o Double-click the Contours layer in the [= Treeview. On the dialog, set the results
entity to Displacement and component to PRES.

e Select the Contour Display tab and deselect Deform.

e Select the Contour Range tab and set an Automatic contour range using an
Interval of 10e3. Enter a Maximum value of 120e3 (12m head) a Minimum value of
0. Click OK.
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| utilities

Viewing the Results

Print Results
Wizard...

e By setting each time-step active (right-click the time-step in the (1) Treeview and
Set Active) in turn the gradual development of a semi-steady state seepage flow can
be seen. During the first three time-steps (~7.5 hours) the effects of primary
consolidation can be observed. From the fourth time-step onwards, however, there is
very little change between results.

o In the /= Treeview right-click on the Seepage result-set for Time Step 10, and Set
Active.

From the basic parabola, the top flow (zero pressure) line curves correctly upward on
the upstream side, and downward reaching the filter toe.

Dam Discharge

To calculate the seepage flowrate into the filter (i.e. the rate of water draining through it
the body of the dam), the flow reaction of the filter bed is going to be used (as water is
being drained only from this location).

e Select the bottom line of the toe-drain filter and press to define a new Group.
Enter the name as Filter and press OK to create the new group.

e Ensure that the last time-step increment of the Seepage results (Time Step 10 Time
=30.0000) is set active in the (5 Treeview:

e Select Active results.

e Select the entity Reaction and use the results type Component.

e Press the Extent... button and select the Specified group named Filter.

e Press Finish to view the tabulated results summary.
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Trapezoidal earth dam with drainage toe

8B LUSAS Yiew: Reaction Components in Global Axes Loadcase =

=[]

12 ResultsFile = o0 [H=]E3

Mode & Fx FY “Flo RSLT
1 Mode Fx Fy “Flo RELT
2 135 -6.01233E3; 17.166E3 [, 158.1884E3
3 136 -11 AB35E3: 33 7625E3 [, 35.5622E3
4 137 -5.35537TE3 165152E3: 125022 17.3618E3
5 135 -10.0486E3: 32 2052E3 [ia, 33.7365E3
B 139 -4 52496E3 15 7E07E3: 423815 (16548283
7 140 @2BB43E3 3079E3 N 32154263 [ oo wocofEecal., ||
g 141 -4 46435E3 15.045E3 © 158784 15.6934E3 8]
9 142 -5 6112363 29.3719E3 A, 30.B083E3 ;
10 143 -4 15867E3 14 3347E3: 577935 14 9258E3 At
11 144 -3.039VES ¢ 27 .944E3 A, 289.077EE3
12 145 -3.88883E5 13 6144E3: 2339858 14 .1538E3 % Prink... Chrl+P
13 1456 -7 52903E3: 26 4523E3 A, 27 8317ES Properties...
14 147 -3.64544E5 12.871E3 105219 133773E3 -
15 145 -7.0B153E3: 24 9613E3 A, 25 941E3
4 4 » M '\-\ Madel infa ?\ 12:Seepage, Time Step 10 Time = 30.0000 ,‘r

The value of VFlo is the volume of flow during the selected time-step.

Calculations

Considering the semi-steady flow achieved by 30 days, the average flow-rate into the
filter drain can be calculated from the total discharge shown in these results over the
duration of the time-step between the last and second-to-last increments.

e Save the results in a spreadsheet by right-clicking on the Print Results Wizard
output and selecting Save as Microsoft Excel.

e In the saved spreadsheet, sum the VFlo column to get the total discharge over the
time-step (193m?).

o Identify the time of the last and second-to-last timesteps from the (X Treeview 4.2

days)

o Divide the total discharge over the final interval to calculate the average flow rate
into the filter dam (45.9m*/day/m)

This completes the example.
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Description

Staged
Construction of a
Concrete Dam

For software product(s): | Any Plus version
With product option(s): Nonlinear, Dynamic, Thermal, Heat of hydration

Description
A 30m hlgh Analysis: Thermal

concrete dam, Loadcase: 60:Thermal Stage 3, Time Step 59 Time = 23.0391
Results file: concrete_dam~Thermal mys

tapering from 10m Response time: 23,0391
thick at the base to  compenent Pri unts: )
3.1735m thick at l 200

. 25.0
the crest is to be

30.0

. 35.0
constructed in 0o
three stages, each 500
. 55.0
10 metres high. g 00
Each  stage iS  yinimumzz 0650 at node 330

added 10 days
after the previous
stage, and the
analysis runs for a
total of 30 days.

Animations are created showing the variation of temperature and stress during its
construction.

Simplified geometry is used to allow the example to concentrate on the definition of the
concrete heat of hydration loading and staged construction techniques required.

Units used are N, m, kg, s, C throughout
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A

Modelling

Staged Construction of a Concrete Dam

Objectives

The required output from the analysis consists of:

O A time history of the temperature throughout the dam during construction.

O A time history of the distribution of maximum principal stress (S1) throughout
the dam.

Keywords

Birth, Death, Staged Construction, Activate, Deactivate, Heat of hydration, Semi-
coupled analysis, Concrete

Associated Files

U concrete_dam_geometric_modelling.vbs carries out the geometric
modelling of the example.

concrete_dam_modelling.vbs carries out the complete modelling of the
example ready for a solve to be carried out.

Discussion

Concrete is generally unique among structural materials in that it interacts with its
environment undergoing unavoidable physical and chemical volume changes. Concrete
exhibits certain characteristics such as ageing, creep and shrinkage, which are
collectively known as time dependent deformations; these are dealt with in other
examples in this manual. See the Concrete Tower example if age and creep is of interest
to you.

The process of hydration is an exothermic chemical reaction, which leads to large
amounts of heat generation. This leads to thermal stresses, which may potentially cause
the concrete to crack. A semi-coupled analysis can be used to investigate the connection
between the heat generated due to concrete hydration and the thermal stresses induced
as a result.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.
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Modelling

started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Note. This example is written assuming a new LUSAS Modeller session has been

Creating a new model

e Enter the file name as Concrete_Dam

e Use the Default working folder

o Enter the title as Concrete dam example to model heat of hydration
e Set the Timescale units to Days and the Model units to N,m,kg,s,C

e Ensure the Coupled user interface is selected.

e Select a startup template of None

e Select the Vertical Z Axis option.

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to
/ correct any mistakes made since the last save was done.

Defining the Geometry

The base of the dam is 10m
thick, 54.97m along its
centreline, and subtends an angle
of 30 degrees. The thickness of
the dam tapers with increasing
height in a nonlinear manner
(such that the thickness at the
abutments is very slightly larger
than at the centre of the dam).

Since the geometry of the dam is
not the focus of this example a
script file has been provided which will automatically create the model.

| File e Select the file concrete_dam_geometric_modelling.vbs which is located in the

cht Sot > \<LUSAS Installation Folder>\Examples\Modeller directory and click OK
un Script...
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| Geometry

Staged Construction of a Concrete Dam

| Group

| New Group

| Geometry

| Group

| New Group

| Geometry

| Group

~ [NewGroup

| File

| Model properties...

| Attributes

[Mesh
|Line...

>

El Select the isometric button which, because of the way the geometry has been
defined, will give a front view of the dam. The three volumes represent the three stages
of construction.

Defining Groups

It is useful in staged construction analysis to make use of the group facility in LUSAS.
This allows parts of the model to be displayed in isolation according to the construction
stage being modelled and simplifies the viewing of results.

o Select the lowest volume representing the concrete in construction stage 1.

Enter the group name as Stage 1 and click OK to finish defining the group.

e With the previous volume still selected, hold the Shift key down and add the middle
volume representing construction stage 2 to the selection.

Enter the group name as Stage 2 and click OK to finish defining the group.

e With the previous two volumes still selected, hold the Shift key down and add the
upper volume representing construction stage 3 to the selection.

Enter the group name as Stage 3 and click OK to finish defining the group.

Defining and Assigning Mesh Attributes

To ensure a well-proportioned mesh, line mesh attributes will be assigned to define a
mesh with three elements through the thickness of the dam, and eight elements across
the width of the dam. Vertically, lines defining each volume will be split into two
divisions. To create this mesh arrangement both default and individual line mesh
divisions will be used.

e On the Model Properties dialog select the Meshing tab. Change the default line
divisions to 3 and click OK.

This specifies the default number of mesh divisions to be used along a line unless a line
mesh attribute is subsequently assigned.

e On the Line Mesh dialog ensure that the Structural element type is set to None. Set
the number of divisions to 2, name the attribute Divisions = 2 and click Apply to
create the attribute.

e Change the number of divisions to 8, change the name to Divisions = 8 and click
OK.
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| Attributes
[Mesh >
Volume...
| Attributes
Material >
Isotropic...

Modelling

Tip. To assign these mesh divisions to the model the selection of lines could be done
individually, but lines can also be selected by holding-down the L key while box-
selecting with the mouse. When this is done any part of a line that is within the area
dragged is selected.

Select the twelve near-vertical lines that define four edges of the dam. Assign the
line mesh attribute Divisions = 2 from the & Treeview onto the selected features.

Select the eight horizontal curved lines from the model. Assign the line mesh
attribute Divisions = 8 from the &% Treeview onto the selected features.

The dam is to be modelled
with  Stress, Hexahedral,
Linear elements (HX8M
elements) in the structural
analysis. By clicking on the
Thermal tab it can be seen that
these elements are —
automatically coupled to Field, I

Hexahedral, Linear elements R

(HF8 elements) in the thermal q‘—*—

analysis. Ensure that a

Regular mesh is used. (The mesh spacing will be governed by the assigned line
mesh attributes). Enter the dataset name as Coupled Brick Elements and click OK

Select all volumes in the model (or use the Ctrl + A keys to select all features) and

drag and drop the Coupled Brick Elements mesh from the &b Treeview onto the
selected features.

Material Properties

Enter a Young’s modulus of 30e9, a Poisson’s ratio of 0.2, and a mass density of
2.4e3. Click the Thermal expansion check box and enter a Coefficient of thermal
expansion of 10e-6.

Click on the Thermal tab. Leave the Phase change state set to None and enter a
Thermal conductivity of 2.0 (J/m?s°C) and a Specific heat coefficient of 2.5075E6
(I/m3°C).

The heat of concrete hydration thermal loading will now be defined.

Select Concrete Heat of Hydration from the Exothermic behaviour panel. Then
set the Exotherm option to Concrete for Cement type Type I. Note that the
timescale units have already been set when the model was first created and will be
used in any heat of hydration analysis.
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Staged Construction of a Concrete Dam

e Set the remaining values required in the dialog as follows: Weight of cement 307,

Water/Cementitious ratio 0.47, Weight of slag 0, Weight of fly ash 0, CaO content
of fly ash 0, Assumed cure temperature 21.1

e Change the attribute name to Concrete Ungraded and click OK. See the following

dialog for confirmation of the thermal values required:

¥ Elastic ¥ Thermal
I Plastic I Creep I Damage I Shrinkage I viscous I~ Two phase
"Elastic Thermal |
Phase change state INnne j Value
Thermal conductivity 20
Volumetric heat capacity 25075E6
Exothermic behaviour
~ Value
Mane Weight of cement per unit volume 307.0
@+ Concrete Heat of Hydratior Water/Cementitious ratio 047
Weight of slag per unit volume 0.0
Ci t I I
ement type Typel > Weight of fly ash per unit volume 0.0
Cal content of fly ash (%) 0.0
Assumed cure temperature 211
Mame | Concrete Ungraded j é’ &)}
Close I Zance] | Lpply | Help |

Note. The Specific heat coefficient is the specific heat capacity multiplied by the
density.

Note. When computing the heat due to the rate of hydration of concrete, hours or days
are convenient units to use for the time step and elapsed time. Due to the way the
solution algorithms are formulated this is independent of the fundamental units of
seconds and Newtons that are defined for the model.

Note. The concrete heat of hydration loading is a type of internal heat generation.
From the input parameters LUSAS automatically calculates the amount and rate of this
internal heat generation based on formulae presented in published research by Schindler
and Folliard. Reference [S18] LUSAS Theory Manual.
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Assign the Material Properties

e With all three volumes in the model selected, drag and drop Concrete Ungraded

from the &b Treeview onto the selected volumes. Press OK to assign to Analysis
1. (This analysis name will be renamed later to be ‘Structural’)

Note. In a coupled analysis, a material with Elastic and Thermal properties defined
should always be assigned to the Structural analysis.

Structural Supports

A fully fixed support is required for the base and abutments of the dam. All degrees of
translation in the X, Y and Z-axes must therefore be set as Fixed. Enter the attribute
name as Fixed and click OK

e Select the surfaces that
define the base and —
abutments of the dam and

from the & Treeview
drag and drop the support
attribute Fixed onto the
selected features, ensure I R
the Analysis 1 and the All
analysis loadcases option
is selected and click OK S

Tip. Hold-down the Shift +S
keys and box-select the surfaces required.

Thermal Supports

A thermal support needs to be defined for use later in the example.

e Ensure the temperature support is set to Free and enter the attribute name as Free
and click OK.

Do not assign this support to the model yet. It is to be used during the activation and
deactivation of the thermal loadcases to free-up elements that have had their
temperature restrained at the concrete placement temperature.

Thermal Loading

Several thermal loads need to be defined for applying to the model later. Environmental
temperature loads for the air and ground temperatures will be defined first, followed by
the initial concrete placement temperature.
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Staged Construction of a Concrete Dam

Air temperature

e Select Environmental Temperature and click Next

e Enter a value of 21.1 (°C) for the environmental temperature, and 8.333 (J/m?s-°C)
for the convection heat transfer coefficient. Leave the other two inputs blank. Enter
the attribute name as Air temperature. Click Apply

Ground temperature

e In the first row of the dialog, keep the value of 21.1 (°C) for the environmental
temperature, but over-type a value of 2.777 (J/m?s.°C) for the convection heat
transfer coefficient. Change the attribute name to Ground temperature and click
Finish

Initial concrete temperature

The initial concrete temperature will be defined:
e Select Prescribed Temperature and click Next

e Select Fixed and enter a value of 21.1 (°C). Ensure the Total option is selected.
Enter the attribute name as Initial concrete temperature. Click Finish

Modelling Staged Construction

In order to correctly model the staged construction of the dam, volumes (and hence,
elements) in the model must only be included in the analysis after they have been
constructed. Similarly, loading attributes (such as surface heat transfer) will need to be
applied only for a certain portion of the analysis to reflect the construction stage being
considered. In general, model attributes are assigned and changed using Loadcases,
whilst loading attributes that apply during particular times during an analysis are
applied to selected features of the model using Load curves.

Creating Activation and Deactivation datasets

Modelling of staged construction processes that require activation and deactivation of
elements is carried out in LUSAS using the birth and death facility.

e Choose the Activate option and click Next

e Enter the attribute name as Activate and click Apply. Then click Back so the dialog
can be reused to define the deactivate attribute.

e Choose the Deactivate option and click Next
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e Enter the attribute name as Deactivate, select Percentage to redistribute and leave
the value as 100%, then select Finish

When building staged construction models it is often very helpful to see the elements
that are actually activated in the loadcase being viewed.

e Inthe Treeview, double-click the View properties control, and under the View
tab ensure the Show only activated elements option is selected, then click OK.

Defining Loadcase properties

o In the ‘2 Treeview two analysis entries can be seen — one structural and one
thermal. These are created automatically as a result of selecting a Coupled user

interface option at the beginning of the example There is also a L Coupled
analysis options object. Loadcases need to be created for each construction stage to
be modelled — for both the structural loadings and for the thermal loadings.

Defining a structural initialisation loadcase
To make the model easier to manipulate, the default analysis names will be changed to
something more descriptive.

e Inthe @ Treeview right-click on = Analysis 1 and rename it to Structural

e In the {5 Treeview right-click on = Analysis 1 (Thermal) and rename it to
Thermal

Defining a structural initialisation loadcase

¢ Right-click on Structural > Loadcase 1 and rename it to Structural Initialisation

e Select Structural Initialisation using the right-hand mouse button and from the
Controls menu select the Nonlinear and Transient option.

e On the Nonlinear & Transient dialog select the Nonlinear option and leave the
incrementation type as Manual

e Select the Time domain option. Choose a Viscous time domain from the drop-
down list. Enter the Initial time step as 1le-6, leave the Total response time as its
default value, and set the Max time steps or increments to 1

e Click OK to return to the Modeller window.

Note. The small initial time step of 1e-6 has been used to minimise the curing effects
during this loadcase. In this instance the large default total response time has no
significance because only one time step is processed. This load case will finish after the
first small time step.
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[ Loadcase

Defining a structural loadcase for construction stage 1

Ensure the Structural analysis is selected, then enter a loadcase name of Structural
stage 1 and click OK

Select Structural stage 1 using the right-hand mouse button and from the Controls
menu select the Nonlinear and Transient option.

On the Nonlinear & Transient dialog select the Nonlinear option and leave the
incrementation type as Manual

Select the Time domain option. Choose a Viscous time domain from the drop-
down list. Enter the Initial time step as 0.05, the Total response time as 10, and set
the Max time steps or increments to 100

Select the Automatic time stepping option and then click the Advanced button.

On the Advanced Time Step Parameters dialog set the Time step increment
restriction factor to 1.5, the minimum time step to 0.05 and the Maximum time step
to 0.5 This will allow the time step to increase from its initial value of 0.05 up to the
maximum value of 0.5 and thus reduce the number of increments required.

Click OK to close the Advanced Time Step Parameters dialog and return to the
Nonlinear & Transient dialog. On this dialog pick the Coupling button and change
the Interval between coupled reads and the Interval between coupled writes to
0.05, and click OK. Click OK to return to the Modeller window.

Defining a structural loadcase for construction stage 2

Loadcases can be copied and pasted in the Treeview. This saves having to re-enter
similar details for each loadcase. Then, just the different values can be defined for each
newly copied loadcase.

Click on loadcase Structural stage 1. Press the copy toolbar button, followed

by the El paste toolbar button. This will create a new loadcase that is an exact
copy named Copy of Structural stage 1. Rename this new structural loadcase to
Structural stage 2

Double-click the %& Nonlinear and Transient object for Structural stage 2 and
set the total response time as 20

Defining a structural loadcase for construction stage 3

Repeat the last two procedures to create another copy of the first loadcase called
Structural stage 3, but set the total response time as 30
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Defining a thermal initialisation loadcase

Right-click on the thermal Loadcase 2 and rename it to Thermal Initialisation

Select Thermal Initialisation using the right-hand mouse button and from the
Controls menu select the Nonlinear and Transient option.

On the Nonlinear & Transient dialog select the Nonlinear option and leave the
incrementation type as Manual

Select the Time domain option. Choose a Thermal time domain from the drop-
down list. Enter the Initial time step as le-6, leave the Total response time as its
default value, and set the Max time steps or increments to 1

In the Solution Strategy section set the Max number of iterations to 15

Click OK to return to the Modeller window.

Note. The small initial time step of 1e-6 has been used to minimise the curing effects
during this loadcase. In this instance, again, the large default total response time has no
significance because only one time step is processed. This load case will finish after the
first small time step.

Defining a thermal loadcase for construction stage 1

Select the Thermal analysis
Enter a loadcase name of Thermal stage 1

Click on loadcase Thermal stage 1 using the right-hand mouse button and from the
Controls menu choose the Nonlinear and Transient option.

On the Nonlinear & Transient dialog tick the Nonlinear option and leave the
incrementation type as Manual

Select the Time domain option and note that the Thermal time domain option is
the only one available for selection. Enter the Initial time step as 0.05, the Total
response time as 10, and set the Max time steps or increments to 100

Ensure the Automatic time stepping option is selected and then click the
Advanced button.

On the Advanced Time Step Parameters dialog set the Time step increment
restriction factor to 1.5, the minimum time step to 0.05 and the Maximum time step
t0o 0.5

Click OK to close the Advanced Time Step Parameters dialog and return to the
Nonlinear & Transient dialog. On this dialog, pick the Coupling button and change
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the Interval between coupled reads and the Interval between coupled writes to
0.05, and click OK. Click OK to return to the Modeller window.

Now create a copy of this loadcase:

Defining a thermal loadcase for construction stage 2

e Click on loadcase Thermal stage 1. Press the copy toolbar button, followed by

the EI paste toolbar button. This will create a new loadcase that is an exact copy
named Copy of Thermal stage 1. Rename this new structural loadcase to Thermal
stage 2

o Double-click the & Nonlinear and Transient object for Thermal stage 2, set the
total response time as 20

Defining a thermal loadcase for construction stage 3

e Repeat the last procedure to create another copy of the first loadcase called
Thermal stage 3, but set the total response time as 30

All loadcases have now been defined. Element activations and model attributes will be
assigned to these loadcases later.

Note. The total response time in each loadcase represents the total time at which that
loadcase in the analysis ends, and the next one begins.

Set coupled analysis options

In this analysis, the thermal results affect the structural behaviour (that is, temperatures
cause thermal stresses), but the structural results do not affect the thermal behaviour. A
semi-coupled analysis is therefore required, and the appropriate coupled analysis
options must be chosen.

« Double click on the ¥ Coupled analysis options

object in the @ Treeview. Coupling type Thermal fst -]
™ Parallel coupling
Set the COUpling type as Thermal first from the drop V' Initidlise reference temperatires
dOWn IISt I Suppress recalculation of view factors

" Step coupling
% Time coupling

e Select the Initialise reference temperatures

Option_ First data write at [0.05
First data read at 0.05
e Ensure the Time coupling radio button is selected. ok | cowce [[ Fep |

e Set the First data write to 0.05 and the First data
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read to 0.05 (i.e. every step)
Click OK

Load Curves

Load curves are used to describe the variation of the loading in nonlinear, transient and
Fourier analyses. In a transient thermal analysis, such as in this example, the
environmental temperature loading on specific surfaces of the dam will change with
time. As the construction progresses some surfaces that were initially external surfaces
(that could dissipate heat to the outside environment) become internal ones that can
only dissipate heat to other parts of the structure.

Defining Load Curves

Right-click on the = Thermal analysis icon, and choose New and Load Curve to

open the Load Curve dialog box.

Defining a concrete placement load curve:

In the User-defined section of
the dialog enter a Time of 0
and a Factor 1, press the Tab
key to create a new row.

On this new row enter a Time
of 30 and a Factor of 1.

Leave the default values of
Activation time (0.0) and

Scaling factor (1.0
unchanged.

Name the load curve
Concrete placement and
click Apply

With reference to data that
follows, repeat this procedure
four more times to add four
more load curves called
External surface stage 1,
External surface stage 2,

Load Curve
@ User-defined 10
Time Factor 1.008
1 on 1.0
2 an.n 1.0 < 1.008
H B 1 ona
w
1.002
1
-520000 930000 2 48FR
Time:
" standard curve " Wariation
Type Sing 'l Termination kime I 0.0
Amplitude 1.0 Sampling increment I 0.0
Frequency I 0.0 INone defined j
Fhase angle 0.0 °
Activation time 0.0 Scaling Factor I Lo
Analysis ITherma\ j
Mame IConcrete Placement j i’ 1G)]
Close I Cancel | Apply: | Help

External surface stage 3 and Base and abutments. The User-defined area of each
of the dialog boxes should be filled-in according to the tables that follow.

495



Staged Construction of a Concrete Dam

Table 1. External surface stage 1

Time Factor Time Factor
0 1 10 1
9.999 1 19.999 1

Table 2. External surface stage 2

Time Factor Time Factor
20 1 0 1
30 1 30 1

Table 3. External surface stage 3 Table 4. Base and abutments

Assigning Activation and Deactivation attributes

Construction Stage 1

o

|
|

.
S

By
i
Wi

The elements not required for the first
construction stage must be deactivated.

]

e In the Graphics window select the top
two volumes of the dam.

[

2

Structural activation/deactivation

e Drag and drop the deactivation attribute Deactivate from the & Treeview,
ensuring that it is assigned to analysis Structural and loadcase Structural
Initialisation and then clicking OK

Because the option to show the activated mesh only was set earlier in the example the
view window will update to show only the mesh elements for the lowest volume.

Thermal activation/deactivation

e With the top two volumes still selected, assign the deactivation attribute

Deactivate from the &b Treeview onto the selected features ensuring that it is
assigned to analysis Thermal and loadcase Thermal Initialisation

Verifying self weight and activation assignments

e If, during the course of this example, you need to check when particular elements
become active in an analysis, select a feature and then, using the right-hand mouse
button, choose Properties. Go to the Activate Elements tab. Highlighting an entry
in the right-hand panel (that shows the assigned attributes) will show the loadcase
in which the activation is assigned in the Loadcase box.
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Construction Stage 2

The elements in the second construction stage now need to be activated.

e In the graphics window select only the second stage of the dam (i.e. the middle
volume).

Structural activation/deactivation

e Assign the activation attribute Activate
from the &b Treeview, ensuring that it is
assigned to analysis Structure and
loadcase Structural Stage 2, then and
clicking OK

Thermal activation/deactivation

e With the middle volume still selected, assign the activation attribute Activate from
the &b Treeview ensuring that it is assigned to analysis Thermal and loadcase

Thermal Stage 2
Construction Stage 3

The elements in the third construction stage
now need to be activated.

e In the graphics window select only the top
volume of the dam.

|

Structural activation/deactivation

il

e Assign the activation dataset Activate from

the &% Treeview, ensuring that it is assigned to analysis Structural and loadcase
Structural stage 3, and then clicking OK

Thermal activation/deactivation

e With the top volume still selected, assign the activation attribute Activate from the
Treeview ensuring that it is assigned to analysis Thermal loadcase Thermal

stage 3
Adding self-weight

In the = Treeview right-click on the = Structural analysis icon and select Add
gravity to apply self-weight loading to all the structural loadcases in the analysis.

Note. Loadcases with automatic self-weight loading can easily be identified by the
& gravity loadcase icon.
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Assigning thermal loading (load curves)

Load curves were defined to model the thermal loading and these need to be assigned to
appropriate features of the model.

Assigning the Initial Concrete Temperature

The Initial Concrete Temperature attribute will apply to all the stages of the model as
they are activated.

e With all three volumes selected, assign the
thermal loading attribute Initial Concrete
Temperature from the & Treeview,
ensuring that it is assigned to Load curve maaa..
Concrete Placement in the drop-down list rhlﬁ'
before clicking OK. ‘

Assigning ground temperature

Ground temperature loading only applies to selected surfaces. These could be selected
one-by-one but, as an alternative, they can also be selected by through their support
assignment. First, a structural loadcase must be set active to allow selection of an
assigned structural attribute:

e Inthe @ Treeview right-click on the Structural Initialisation loadcase and select
Set active.

e In the & Treeview right-click on the Supports entry Fixed and choose Select
Assignments

e With the bottom and side surfaces only
selected, assign the thermal loading
attribute Ground temperature from the
& Treeview, ensuring that it is assigned to
Load curve Base and abutments in the
drop-down list before clicking OK.

Assigning air temperatures and thermal supports

The surfaces in contact with the air change as the construction progresses. To help
ensure the correct surfaces are selected prior to assigning air temperature loading the
pre-defined Groups (that were set-up at the start of the example to mimic the
construction process) will be used. Thermal supports also need to be assigned to the
model at each construction stage to free-up nodes in the model that are restrained at a
prescribed temperature by the LUSAS Modeller.
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Construction Stage 1

In the Treeview right-click on the group name Stage 1 and select the Set as
Only Visible option.

Click in the graphics area to allow a keyboard short-cut to be used.

Holding-down the Shift + S keys
select the front, back and top
Surfaces of the concrete that forms
stage 1

Assign the thermal loading attribute

Air temperature from the & Treeview, ensuring that it is assigned to Load curve
External surface stage 1 in the drop down menu before clicking OK

Select the Volume and assign the thermal support Free from the & Treeview,
ensuring that it is assigned to volumes and selecting Thermal stage 1 from the
loadcase drop down list before clicking OK

Construction Stage 2

In the Treeview right-click on
the group name Stage 2 and select
the Set as Only Visible option.

Click in the graphics area to allow
a keyboard short-cut to be used.

Holding-down the Shift + S keys
select the front, back and top surfaces of the concrete that forms stage 2 (5 surfaces
in total)

Assign the thermal loading attribute Air temperature from the & Treeview,
ensuring that it is assigned to Load curve External surface stage 2 in the drop
down menu before clicking OK

Select the two Volumes representing this construction stage and assign the thermal
support Free from the & Treeview, ensuring that it is assigned to volumes, and the
Thermal analysis. Enable From loadcase (nonlinear and transient analysis) and
then select Thermal stage 2 from the loadcase drop down list before clicking OK

Construction Stage 3

In the Treeview right-click on the group name Stage 3 and select the Set as
Only Visible option.

Click in the graphics area to allow a keyboard short-cut to be used.
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e Holding-down the Shift + S keys
select the front, back and top surfaces
of the concrete that forms stage 3 (7
surfaces in total)

e Assign the thermal loading attribute
Air temperature from the &
Treeview, ensuring that it is assigned
to Load curve External surface
stage 3 in the drop down menu
before clicking OK

o Select the three Volumes representing this construction stage and assign the thermal

support Free from the & Treeview, ensuring that it is assigned to volumes and
selecting Thermal stage 3 from the loadcase drop down list before clicking OK

The model is now complete.

|File El Save the model file.

| Save
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Checking the Attributes and
Loadcase Treeviews

= & 18 1 18 |
=23 Concrete_dam.mdl
B3 Attrbutes [13)
B2 Mesh (3]
=23 Line [2)
& T:Divigiong = 2
- P Divisinns = B
“olume (1]
& ZCoupled Brick Elements
=29 Material [1)
E1-23 Isotrapic [1]
& 1:Conciete Ungraded [M.m.kg.s.C]
=- a Supports (2]
----- &%, 1:Fined
..... & >Fiee
223 Loading (3)
B3 Thermal [4]
&, Z:A0 temperature
& ZiGround temperature
L dlritial concrete temperatue
I'_'l a Activate Elements (1]
& T:Activate
E| a Deactivate Elements (1)
----- & 1:Deactivate

In defining and modelling the staged
construction of the dam the Attributes c&:

Treeview and the Loadcase @ Treeview now
contain all the information for the LUSAS
Solver to carry out an analysis.

For a successful analysis your model should
contain Treeviews similar to those shown..
Right-clicking on attribute and loadcase data
allows any defined values to be checked. If your
model has potential errors in your Attribute data
or in your Loadcase Treeviews, a file is
provided to enable you to re-create the model
from scratch and run the analysis successfully.
See the next page for details.

Note. The structural and thermal loadcases are

always tabulated and solved in (5 Treeview
order from top to bottom. The thermal loadcases
can be solved before the structural ones by
stating the coupling type in the Coupled analysis
object.

g E |1& &

=l

= =3 Concrete_Dam.mdl
Ela Structural analyses
Bl Structural
E| a Material
i - 1:Concrete Ungraded
= {a 1:5tructural Tnikialisation
= a Supports

aravity

a Deactivate

- LiDeackivate

W Morlinear and Transisnt

-4 3:5truckural Stage 1

£+ Loading
- Sravity

¥ Maorlinear and Transient

=- {E—) 4:5tructural Stage 2

- Lihckivate
W Morlinear and Transisnt
-4 S:Structural Stage 3
53 Loading

- Sravity
a Activate

- i hckivate
4 Marlinear and Transient
-y Morlinear analysis options
=423 Thermal analyses
E-%2 Thermal
223 Load Curves
EN :Concrete Placement
B a Loadlng

E| N 10:External Surface Stage 1
=8 a Loading

E| H 12:External Surface Stage 3
| =23 Loading

E| F&’ 13:Base & Abutments
=423 Loading

=5 @ 2:Thermal Initialisation
a Deactivate
- LiDeactivate
% Morlineat and Transient
=] @ 6:Thermal Stage 1
B2 Supports
i 2iFreE
W% Morlinear and Transisnt
[—]@ 7:Thermal Stage 2
Ié! a Supports
i i e ZiFPEE
a Activate
e 1 Auckivabe
W Marlinear and Transient
- (D) 8:Thermal Stags 3
23 Supports
e 21FrEE

H e 1t ickivate

W Marlinear and Transient
Wy Morlinear analysis options
% Coupled analysis options
% Model properties

4 |

- 3iInitial concrete temperature

- 1A kemperature (x 1.0)

- 11 Ar kemperature (x 1.0)

2iGaround kemperature (x 1.0)

|+

-

2

ﬂ Spedfy. .. |
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Running the Analysis
With the model loaded:

El Open the Solve Now dialog. Ensure that the Thermal and Structural analyses are
selected, and press OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the () Treeview.

In addition, 4 files will be created in the Associated Model Data directory where the
model file resides:

U concrete_dam_therm.out this output file contains details of model data,
assigned attributes and selected statistics of the thermal analysis.

U concrete_dam_struct.out this output file contains details of model data,
assigned attributes and selected statistics of the structural analysis.

U concrete_dam_therm.mys this is the LUSAS results file from the

thermal analysis which is loaded automatically into the @ Treeview to allow
results to be viewed.

U concrete_dam_struct.mys this is the LUSAS results file from the

structural analysis which is loaded automatically into the (X Treeview to allow
results to be viewed.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered is written
to a output files in addition to the text output window. Any errors listed in the text
output window should be corrected in LUSAS Modeller before saving the model and
re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported the following file is
provided to enable you to re-create the model from scratch and run an analysis
successfully:

U concrete_dam_modelling.vbs carries out the modelling of the example.
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Viewing the Results

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

Enter the file name as concrete_dam

Select units of N,m,kg,s,C

Ensure the Coupled user interface is selected and click the OK button

To recreate the model, select the file concrete_dam_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

;l Run the analysis to generate the results.

Viewing the Results

Analysis loadcase results for each time step are present in the () Treeview. The time
step result for the last thermal loadcase to be solved is set to be active by default.

Temperature contours throughout the dam are to be investigated for each stage of the
construction process. Animations of the change in temperature and of the stress in the
dam will be created.

Thermal Results

To illustrate the variation of temperature throughout the model with time, an animation
will be created showing contours at different time steps. Firstly, contours of temperature
for the current time step will be viewed.

e Turn off the display of the Mesh, Deformed Mesh and Attributes layers in the
Treeview.

o Inthe = Treeview right-click on the Thermal loadcase results for Time Step 1 and
Set Active

e  With no features selected click the right-hand mouse button in a blank part of the
Graphics window and select the Contour option to add the contour layer to the
Treeview. Select Potential from the entity drop down list and ensure PHI is
selected in the component drop down list. Click OK.

A plot showing initial contours at ambient temperature will be displayed.

When creating animations of contours it is preferable to have a static contour scale. By
setting a Time Step active for the end of the construction stage under consideration an
estimate of the maximum and minimum values required for the contour key can be
obtained.
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e In the 2 Treeview right-click on the Thermal loadcase results for Time Step 25
and Set Active

e Inthe [=F Treeview double-click on the Contours layer.

e Select the Contour Range tab and ensure that the contour Interval contour is set
to 5.0. Set the Maximum and Minimum values to 60.0 and 20.0 respectively.
Click OK

Analysis: Thermal

Loadcase: 26: Thermal Stage 1, Time Step 25 Time = 10.0000
Results file: concrete_dam~Thermal.mys

Response time: 10.0

Entity: Potential

Component: PHI (Units: C)

20.0
25.0
30.0

35.0
40.0
45.0
50.0

55.0
B o00
Maximum 78.1401 at node 41
Minimum 22.3072 at node 73

Animating Thermal Results

Note. The viewing parameters (e.g. the view angle and contour options) used in the
animation are those that are currently specified in the window when the animation is
loaded. It is therefore important to have an appropriate view visible in the Modeller
window when running the animation wizard.

To create and save an animation of the temperature variation on the external surfaces of
the dam throughout the whole analysis, complete the following procedure:

e Select the Load history radio button and click Next

e From the File drop-down menu on the Animation Load History dialog choose the
Thermal results file

Note. In some analyses fine time increments are required for solution convergence
but are not required for animation purposes. It is possible to reduce the size of (and the
time required to produce) an animation by using the filter area of the dialog box.

e For the purposes of this example animate every 2" Time Step by entering a Start
value of 1, a Step value of 2 and click Filter. Only every 2" Time Step will appear
in the Available area of the dialog. Select all of these filtered thermal results time
steps (by clicking on the first time step, holding the Shift key, scrolling all the way
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Viewing the Results

to the bottom of the list and clicking on the last time step). Include these time steps
by clicking on the il button and then clicking Finish

*4 Animation: LUSAS3

Analysis: Thermal

Loadcase: 34: Thermal Stage 2, Time Step 33 Time =12 0391
Results file: concrete_dam~Thermal.mys

Response time: 12.0391

Entity: Potential

Component: PHI (Units: G)

20.0
25.0
30.0

35.0
- 40.0
45.0
50.0

550
o e
Maximum 73.6144 at node 41
Minimum 22 6075 at node 42

RIDWININSFINITANEN=EY

LUSAS will load-in the selected time step results and open a window showing an
animation of the variation of temperature with time. Animations may be saved in
compressed AVI format for playback in other applications.

e Save the animation to your projects folder and enter concrete_dam_thermal.avi
for the filename and press Save

e Close the Animation window.

Animating Thermal Results on a Slice Section

With heat of hydration analysis the maximum temperatures reached will occur within
the concrete. To plot the change of temperature over time inside the dam slice sections
are used:

Note. When creating animations using slice sections the animation results are only
created for the elements that are sliced. This means that for this example one of the
Thermal loadcase Time Step results for Stage 3 must be set active so that the complete
mesh for the dam can be seen.

o In the ‘X! Treeview right-click on the Thermal Stage 3 loadcase results for Time
Step 60 and select Set Active
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Section Through
3D...

Analysis: Thermal
Loadcase: 60:Thermal Stage 3, Time Step 59 Time = 23.0391
Results file: concrete_dam~Thermal.mys
Response time: 23.0391

Entity: Potential

Component: PHI (Units: C)

20.0
250
30.0

35.0
- 40.0
45.0
50.0

55.0
o oo
Maximum 70.0859 at node 186
Minimum 21.6096 at node 7

Click OK to accept a grid size of 1

Position the cursor above the dam in-line with the Z-axis and click and drag
vertically downwards to define a slice section right through the centre of the dam. A

group named Slice 1 will be created in the L=l Treeview.

In the I=* Treeview select double-click the Contour option, ensure the Display on
slice(s) option is selected and click OK

El Use the Dynamic rotate button to rotate the model around to the view shown.

Analysis: Thermal
Loadcase: 60: Thermal Stage 3, Time Step 59 Time =23.0391
Results file: concrete_dam~Thermal.mys
Response time: 23.0391

Entity: Potential

Component: PHI (Units: C)

20.0
25.0
30.0

35.0
- 40.0

Maximum 68.3511 at node 734
Minimum 22.0958 at node 330

To create and save an animation of the temperature variation on this slice section
through the dam, complete the following procedure:
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Animation Wizard...

| File

Save As AVI...

Viewing the Results

e Select the Load history radio button and click Next

e From the File drop-down menu on the Animation Load History dialog choose the
thermal results file Concrete_Dam_therm.mys

e For the purposes of this example animate every 4" Time Step by entering a Start
value of 1, a Step value of 4 and click Filter. Only every 4™ Time Step will appear
in the Available area of the dialog. Select all of these filtered thermal results time
steps (by clicking on the first time step, holding the Shift key, scrolling all the way
to the bottom of the list and clicking on the last time step). Include these time steps

by clicking on the il button and then clicking Finish

Save the animation to your projects folder and enter concrete_dam_thermal_slice.avi
for the filename. Click OK

e Close the Animation window.

Plotting contours on the whole model after slicing

¢ Inthe & Treeview select double-click the Contour option and deselect the Display
on slice(s) option and click OK.

The display will revert to show contours of Potential of entity PHI on the whole model.

e Remove any slices generated by picking the Slices group from the Treeview,
clicking right-hand mouse button and choosing the Delete menu item from the
context menu.

Structural Results

Viewing and animating structural results is done in a similar manner to that described
for thermal results, ensuring that only Structural loadcase results Time Steps are set
active or used in an animation.

o In the & Treeview right-click on the structural results for Time Step 60 and Set
Active

e Double-click the contours layer in the Treeview. On the dialog, set the results
entity to Stress — Solids and component S1.

e Select the Contour Range tab and ensure that an Automatic contour range using 9
contours is being used. Deselect the Maximum and Minimum values and click
OK
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Analysis: Structural
Loadcase: 61:5tructural Stage 3, Time Step 60 Time = 23.5391
Results file: concrete_dam~Structural. mys
Response time: 23.5391

Entity: Stress - Solids

Component: 81 (Units: N/m?)

-12.0612E8
-9.0455E8
-5.030B6EB

-3.0153E8
|
3.0153E8

6.0306EB
9.0459E6
12.0612E6

Maximum 13.9142E6 at node 57
Minimum -13.2235E6 at node 182

This will show contours of the maximum principal stress (S1) at the current time step.

Graphing of Results at a Selected Node

In analyses of this type it may also be useful to graph the changing temperature at a
selected node (or nodes) as the construction progresses. This can be done by selecting a
node of interest and using the Graph Wizard - making sure that only thermal results and
thermal time steps are selected for plotting.

Continuing on from the last animation created:

Delete the animation window and maximise the Model window

In the Treeview, turn off the Contour and Geometry layers and turn on the
Mesh layer.

In the ) Treeview right-click on Time Step 60 in the Thermal Stage 3 loadcase
results and Set Active

Double-click the Mesh layer and select Hidden parts and deselect Dotted to view
all the mesh.

Select the stage 1 node for results graphing.
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Stage 1 node selected for results graphing

Select Time history and click Next.

| utilities

Graph wizard...

To define the graph X axis details:

Select Named entity data and in the Entity data panel.

In the Sample loadcases panel ensure Whole analysis is selected and choose the

Thermal analysis from the drop-down box. Click Next to continue.

Select Response time for the data to be plotted and click Next.

To define the graph Y axis details:
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| Graph wizard...

e Select Nodal en“ty data and click Thermal results for selected intemal nodes
Next. AR AT U U U O U SN U S S

e Ensure entity Potential and
results component PHI are
selected for the node shown on
the dialog and click Next.

Temperature (Degrees)

e Enter the title as Thermal results
for selected internal nodes

e Enter the X axis title as Response Mmoo dTe2RNILRES
time (DayS) Response time (Days)

e Enter the Y axis as Temperature (Degrees) and click Finish to create the graph.

e Without deleting the Graph Window return to the Model Window

Graphing Results for Other Nodes

When a node in the mid-section of the dam for the other two construction stages is
selected the following graph can be created, which clearly shows the initial rise and
subsequent reduction of temperature after each stage of concrete is constructed.

For each additional node identified, select it, and run the Graph Wizard. Repeat the
above steps, instead selecting Previously defined for the X-Attribute Entity Data and
re-using the Response time dataset.

Make sure that results for these additional modes are plotted onto the initial graph
created by selecting the Add to existing graph option at the final stage of the wizard.
Graph properties (such as editing axis or curve titles etc) can be edited by right-clicking
on the Graph and choosing Edit Graph Properties
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Thermal results for selected internal nodes
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This completes the example.
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